Managing OS/400 with Operations Navigator V5R1
Volume I: Overview and More

A graphical interface for the highly scalable OS/400
Enhancements to the powerful Work Management component
Remarkable management of multiple systems

Jim Cook
Murtuza Cholawala
Steve Dillen
Stephan Leisse
Dwayne Lindner
Steven Murray
Lindsay Porter
Marios Symeonides

ibm.com/redbooks
Take Note! Before using this information and the product it supports, be sure to read the general information in “Notices” on page ix.

First Edition (December 2002)

This edition applies to Operations Navigator of OS/400 Version 5 Release 1, 5722-SS1.

Comments may be addressed to:
IBM Corporation, International Technical Support Organization
Dept. JLU Building 107-2
3605 Highway 52N
Rochester, Minnesota 55901-7829

When you send information to IBM, you grant IBM a non-exclusive right to use or distribute the information in any way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 2002. All rights reserved.
Note to U.S Government Users - Documentation related to restricted rights - Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>xi</td>
</tr>
<tr>
<td>Redbook series overview</td>
<td>xii</td>
</tr>
<tr>
<td>The team that wrote this redbook</td>
<td>xii</td>
</tr>
<tr>
<td>Become a published author</td>
<td>xiv</td>
</tr>
<tr>
<td>Comments welcome</td>
<td>xv</td>
</tr>
<tr>
<td>Chapter 1. Operations Navigator synopsis</td>
<td>1</td>
</tr>
<tr>
<td>1.1 Scope of this redbook</td>
<td>2</td>
</tr>
<tr>
<td>1.2 Introducing V5R1 Operations Navigator</td>
<td>3</td>
</tr>
<tr>
<td>1.3 Operations Navigator major components and redbooks</td>
<td>4</td>
</tr>
<tr>
<td>1.3.1 Major components</td>
<td>4</td>
</tr>
<tr>
<td>1.3.2 Complex functions</td>
<td>10</td>
</tr>
<tr>
<td>Chapter 2. Operations Navigator introduction</td>
<td>11</td>
</tr>
<tr>
<td>2.1 Operation Navigator overview</td>
<td>12</td>
</tr>
<tr>
<td>2.2 Primary functional components</td>
<td>14</td>
</tr>
<tr>
<td>2.2.1 Basic Operations</td>
<td>14</td>
</tr>
<tr>
<td>2.2.2 Work Management</td>
<td>15</td>
</tr>
<tr>
<td>2.2.3 Configuration and Service</td>
<td>16</td>
</tr>
<tr>
<td>2.2.4 Network</td>
<td>21</td>
</tr>
<tr>
<td>2.2.5 Security</td>
<td>23</td>
</tr>
<tr>
<td>2.2.6 Users and Groups</td>
<td>26</td>
</tr>
<tr>
<td>2.2.7 Database</td>
<td>28</td>
</tr>
<tr>
<td>2.2.8 File Systems</td>
<td>31</td>
</tr>
<tr>
<td>2.2.9 Backup</td>
<td>32</td>
</tr>
<tr>
<td>2.2.10 Application Development</td>
<td>33</td>
</tr>
<tr>
<td>2.2.11 Commands</td>
<td>33</td>
</tr>
<tr>
<td>2.2.12 Packages and Products</td>
<td>35</td>
</tr>
<tr>
<td>2.2.13 Monitors</td>
<td>37</td>
</tr>
<tr>
<td>2.2.14 Logical Systems (logical partitioning)</td>
<td>39</td>
</tr>
<tr>
<td>2.2.15 AFP Manager</td>
<td>43</td>
</tr>
<tr>
<td>2.3 Cross-component functions</td>
<td>43</td>
</tr>
<tr>
<td>2.3.1 Application Administration</td>
<td>44</td>
</tr>
<tr>
<td>2.3.2 Management Central</td>
<td>45</td>
</tr>
<tr>
<td>2.3.3 Clusters</td>
<td>47</td>
</tr>
<tr>
<td>2.3.4 Inventory</td>
<td>49</td>
</tr>
<tr>
<td>2.3.5 Operations Navigator online help</td>
<td>50</td>
</tr>
<tr>
<td>2.3.6 Plug-ins overview</td>
<td>50</td>
</tr>
<tr>
<td>2.3.7 Summary</td>
<td>51</td>
</tr>
<tr>
<td>Chapter 3. Installation and general navigation</td>
<td>53</td>
</tr>
<tr>
<td>3.1 Operations Navigator requirements and installation</td>
<td>54</td>
</tr>
<tr>
<td>3.1.1 iSeries server requirements</td>
<td>54</td>
</tr>
<tr>
<td>3.1.2 PC client workstation requirements</td>
<td>55</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>3.2 Installation introduction</td>
<td>56</td>
</tr>
<tr>
<td>3.2.1 Installation sources</td>
<td>57</td>
</tr>
<tr>
<td>3.2.2 Types of installation</td>
<td>58</td>
</tr>
<tr>
<td>3.2.3 Other installation options</td>
<td>60</td>
</tr>
<tr>
<td>3.3 Installation example: Tailored installation image</td>
<td>63</td>
</tr>
<tr>
<td>3.3.1 Service packs overview</td>
<td>69</td>
</tr>
<tr>
<td>3.3.2 Setting up connections</td>
<td>74</td>
</tr>
<tr>
<td>3.4 General navigation</td>
<td>82</td>
</tr>
<tr>
<td>3.4.1 The main Operations Navigator window</td>
<td>82</td>
</tr>
<tr>
<td>3.4.2 Using Function Availability to determine missing components</td>
<td>105</td>
</tr>
<tr>
<td>3.5 GUI Command Prompter</td>
<td>108</td>
</tr>
<tr>
<td>3.5.1 Help information and sources</td>
<td>113</td>
</tr>
<tr>
<td>3.6 Setting up connections</td>
<td>123</td>
</tr>
<tr>
<td>3.7 The main Operations Navigator window</td>
<td>123</td>
</tr>
<tr>
<td>4.1 Basic Operations overview</td>
<td>120</td>
</tr>
<tr>
<td>4.2 Messages</td>
<td>121</td>
</tr>
<tr>
<td>4.2.1 Message security</td>
<td>123</td>
</tr>
<tr>
<td>4.3 Printer Output functions</td>
<td>124</td>
</tr>
<tr>
<td>4.3.1 Displaying and changing printer properties</td>
<td>130</td>
</tr>
<tr>
<td>4.3.2 Printers and Printer Output tips</td>
<td>131</td>
</tr>
<tr>
<td>4.3.3 AS/400 NetServer integration</td>
<td>131</td>
</tr>
<tr>
<td>4.3.4 Printer security</td>
<td>131</td>
</tr>
<tr>
<td>4.4 Printers</td>
<td>127</td>
</tr>
<tr>
<td>4.4.1 Displaying and changing printer properties</td>
<td>130</td>
</tr>
<tr>
<td>4.4.2 Printers and Printer Output tips</td>
<td>131</td>
</tr>
<tr>
<td>4.4.3 AS/400 NetServer integration</td>
<td>131</td>
</tr>
<tr>
<td>4.4.4 Printer security</td>
<td>131</td>
</tr>
<tr>
<td>4.5 Jobs</td>
<td>132</td>
</tr>
<tr>
<td>4.5.1 Job properties</td>
<td>134</td>
</tr>
<tr>
<td>4.6 Basic Operations hints and tips</td>
<td>135</td>
</tr>
<tr>
<td>4.6.1 Dragging and dropping spooled files</td>
<td>135</td>
</tr>
<tr>
<td>4.6.2 Sample CL program to create printer device descriptions</td>
<td>137</td>
</tr>
<tr>
<td>5.1 Introduction</td>
<td>140</td>
</tr>
<tr>
<td>5.1.1 Work Management folder context sensitive menus</td>
<td>142</td>
</tr>
<tr>
<td>5.2 Active Jobs folder</td>
<td>143</td>
</tr>
<tr>
<td>5.2.1 Active Jobs: job management</td>
<td>145</td>
</tr>
<tr>
<td>5.3 Server Jobs folder</td>
<td>155</td>
</tr>
<tr>
<td>5.3.1 Managing server jobs</td>
<td>157</td>
</tr>
<tr>
<td>5.4 Job queues</td>
<td>158</td>
</tr>
<tr>
<td>5.4.1 Managing job queues</td>
<td>159</td>
</tr>
<tr>
<td>5.4.2 Managing waiting jobs on the job queue</td>
<td>160</td>
</tr>
<tr>
<td>5.5 Subsystems</td>
<td>164</td>
</tr>
<tr>
<td>5.5.1 Active Subsystem folder functions</td>
<td>166</td>
</tr>
<tr>
<td>5.5.2 Selected subsystem functions</td>
<td>166</td>
</tr>
<tr>
<td>5.6 Memory pools</td>
<td>168</td>
</tr>
<tr>
<td>5.6.1 Managing Active Pools</td>
<td>171</td>
</tr>
<tr>
<td>5.6.2 Managing Shared Pools</td>
<td>175</td>
</tr>
<tr>
<td>5.7 Operations Navigator Work Management tips</td>
<td>177</td>
</tr>
<tr>
<td>5.7.1 Use the menu bar cues Edit -&gt; Find, Options -&gt; Sort, Columns, Include</td>
<td>177</td>
</tr>
<tr>
<td>5.7.2 Use desktop shortcuts for frequently used active jobs, memory pools</td>
<td>178</td>
</tr>
<tr>
<td>5.7.3 Use the Server property of a server job to find the attached workstation</td>
<td>179</td>
</tr>
<tr>
<td>5.7.4 Set target job queue to hold status when moving jobs to that job queue</td>
<td>179</td>
</tr>
<tr>
<td>5.7.5 Consider using the system, job, and message monitors</td>
<td>179</td>
</tr>
<tr>
<td>6.1 Introduction</td>
<td>181</td>
</tr>
</tbody>
</table>

Chapter 6. Management Central and Monitors

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.7.1 Use the menu bar cues Edit -&gt; Find, Options -&gt; Sort, Columns, Include</td>
<td>177</td>
</tr>
<tr>
<td>5.7.2 Use desktop shortcuts for frequently used active jobs, memory pools</td>
<td>178</td>
</tr>
<tr>
<td>5.7.3 Use the Server property of a server job to find the attached workstation</td>
<td>179</td>
</tr>
<tr>
<td>5.7.4 Set target job queue to hold status when moving jobs to that job queue</td>
<td>179</td>
</tr>
<tr>
<td>5.7.5 Consider using the system, job, and message monitors</td>
<td>179</td>
</tr>
</tbody>
</table>
Chapter 8. File Systems component ........................................... 335
  8.1 General File System operations ........................................ 336
    8.1.1 Integrated File System ........................................... 337
    8.1.2 Directories, folders and libraries ................................ 339
    8.1.3 Files ..................................................................... 340
    8.1.4 Using the Integrated File System Include option ............... 345
    8.1.5 Creating a User-Defined File System (UDFS) ................... 346
  8.2 File Shares subcomponent ................................................ 349
  8.3 File system hints and tips ................................................ 350
    8.3.1 Creating a new directory ........................................... 351
    8.3.2 Copying files and folders from the PC to the iSeries server .. 351
    8.3.3 Sharing a directory on the network using AS/400 NetServer ... 353
    8.3.4 Mapping a network drive to an AS/400 NetServer file share ... 354
    8.3.5 Stopping a directory from being shared on the network ....... 355
    8.3.6 Creating a library and file in the QSYS.LIB file system ... 357
    8.3.7 Sending file system objects to another iSeries server ......... 358
    8.3.8 Using the Integrated File Systems interface to assign object permissions .... 360

Chapter 9. Backup component .................................................. 363
  9.1 Backup ........................................................................ 364
  9.2 Backup policies ............................................................ 364
    9.2.1 Properties general page ............................................. 366
    9.2.2 Policy properties: what to backup .................................. 366
    9.2.3 Advanced options .................................................... 368
    9.2.4 Backup policies: when to backup ................................... 369
    9.2.5 Backup policies: where to backup .................................. 370

Chapter 10. Advanced Function Printing (AFP) Manager .................. 373
  10.1 AFP overview .............................................................. 374
  10.2 AFP resources ............................................................. 375
  10.3 Print Services Facility (PSF) configurations .......................... 378
  10.4 Font mapping tables ........................................................ 380

Chapter 11. Plug-in support ........................................................ 385
  11.1 Introduction ............................................................... 386
    11.1.1 Viewing installed plug-ins ......................................... 386
    11.1.2 Installing and uninstalling the plug-ins ......................... 387
    11.1.3 How the plug-in support works ..................................... 390
    11.1.4 How Operations Navigator learns about a plug-in .............. 391
  11.2 BRMS plug-in ............................................................... 392
    11.2.1 Prerequisites ......................................................... 394
    11.2.2 Operations Navigator hierarchy integration .................. 394
    11.2.3 Using BRMS Wizards ................................................ 398
  11.3 Advanced Job Scheduler plug-in ........................................ 400
    11.3.1 Advanced Job Scheduler integration .............................. 402
    11.3.2 Using the Advanced Job Scheduler under Management Central ........................................ 402
    11.3.3 Monitoring your Advanced Job Scheduler jobs .................. 409
    11.3.4 Advanced Job Scheduler properties ................................ 414
  11.4 OnDemand plug-in ........................................................ 415
    11.4.1 Starting the OnDemand Server ..................................... 416
    11.4.2 Spool File Archive Administration feature ...................... 416
    11.4.3 Media Administration selection ....................................... 419
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing, IBM Corporation, North Castle Drive Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrates programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. You may copy, modify, and distribute these sample programs in any form without payment to IBM for the purposes of developing, using, marketing, or distributing application programs conforming to IBM's application programming interfaces.
Trademarks

The following terms are trademarks of the International Business Machines Corporation in the United States, other countries, or both:

Advanced Function Printing™
AFP™
AS/400®
AS/400e™
BookMaster®
DB2®
DB2 Universal
Database™
DFS™

DRDA®
IBM ®
IBM.COM™
IBM eServer™
IMS™
iSeries™
MVS™

Net.Data®
Netfinity®
Network Station™
OfficeVision®
Operating System/400®
PartnerWorld®
Perform™
Print Services Facility™
Redbooks™

Redbooks(logo)™
Server Advantage™
Service Director™
SP™
SystemView®
Tivoli®
WebSphere®
xSeries™

The following terms are trademarks of International Business Machines Corporation and Lotus Development Corporation in the United States, other countries, or both:

Domino™
Lotus®
Lotus Notes®
Notes®

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel Corporation in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

SET, SET Secure Electronic Transaction, and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service marks of others.
Preface

OS/400 Operations Navigator is the graphical interface to manage your IBM iSeries runtime environment. V5R1 Operations Navigator contains major function and interface enhancements over previous releases. This IBM Redbook presents an overview of all V5R1 Operations Navigator functions. It is the first volume in the "Managing OS/400 with Operations Navigator V5R1" series.

The key enhancements include a new Work Management component; new job, message, and B2B activity monitors; and new graph history for viewing performance data. It also includes new and updated interfaces to networking capabilities like Quality of Service, Virtual Private Network, TCP/IP configuration and connection verification utilities. And they include new and improved multiple system management of system values and user and group profiles. Other important enhancements include graphical configuration and management of logical partitions and “switched disk” clusters. Database enhancements include improved Visual Explain output and a new Database Navigator for viewing database object relationships.

V5R1 Operations Navigator has also improved Windows operating systems administration such as managing virtual disks, enrolling OS/400 users in the Windows domain, and enabling OS/400 NetServer to be the log on server for a Windows domain. It has also greatly improved the online help. This IBM Redbook builds on the help information by providing examples, tips, and additional details that can make you even more productive sooner with V5R1 capabilities.

This volume focuses on installation and function navigation, and provides an overview of all V5R1 Operations Navigator functions. It also provides details on specific Operations Navigator components, most of which are essential to understanding the functions described in the other volumes of this redbook volume set:

- Overview of Operations Navigator primary and cross-component functions
- Installation and general menu to window navigation
- Basic operations: Includes managing messages, jobs, printers
- Work Management: Looks at managing jobs, subsystems, job queues, and memory pools
- Management Central capabilities: Including endpoint systems, task scheduling and monitoring, inventory managing, managing definitions, monitoring system performance metrics, jobs and messages, and Collection Services
- Basic network capabilities: Explains managing TCP/IP activity and configuration and managing OS/400 servers
- Integrated file system directory and object management
- Simple backup capabilities
- Advanced Function Printing Manager capabilities
- Plug-in capabilities
- Application Administration capabilities
- OS/400 system values
- OS/400 server jobs
- Setting time values
- Problem determination facilities

Note to reader: This redbook is based on OS/400 V5R1. All Operations Navigator windows shown in the book, as well as references to the Information Center, are also based on V5R1 interfaces. Starting with V5R2 the term Operations Navigator is replaced with the term iSeries Navigator. Appendix F, “V5R2 iSeries Navigator enhancements summary” on page 507, contains information summarizing enhancements in V5R2.
Redbook series overview

The “Managing OS/400 with Operations Navigator V5R1” redbook series explains how to install V5R1 OS/400 Operations Navigator, use its functions, and work with Windows operating system-based navigation to use these functions. This series covers the following topics in the corresponding volumes:

- **Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More**, SG24-6226 (this redbook): This volume presents an overview of Operations Navigator V5R1 and all the functions it supports.
- **Managing OS/400 with Operations Navigator V5R1, Volume 2: Security**, SG24-6227: This volume covers the following security-related Operations Navigator capabilities:
  - iSeries security capabilities summary
  - Users and Groups management
  - Security policies and authorization list management
  - Assigning object permissions examples
- **Managing OS/400 with Operations Navigator V5R1, Volume 3: Configuration and Service**, SG24-5951: This volume describes most of the functions that are available under the Configuration and Services components:
  - System value management
  - Hardware configuration management
  - Software and fixes management
- **Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products**, SG24-6564: This volume covers:
  - Creating and distributing a package definition
  - Creating and managing a user-defined software product
- **Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management**, SG24-6565: This volume builds on the monitor, graph history, and Collection Services capabilities described in Volume 1. It shows how to use these functions in an application environment.
- **Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking**, SG24-6566: The volume builds on the basic networking topics covered in Volume 1. It presents an overview of the management capabilities over more advanced networking facilities.

The team that wrote this redbook

This redbook was produced by a team of specialists from around the world working at the International Technical Support Organization (ITSO) Rochester Center, with significant assistance from iSeries Operations Navigator developers. The Rochester ITSO team includes:

**Jim Cook** is a Senior Software Engineer at the International Technical Support Organization, Rochester Center. He leads teams that produce iSeries Announcement presentation sets that are maintained on the as400service Web site and presented at ITSO iSeries Forums internationally. Jim also produces redbooks about OS/400 topics.

**Murtuza Choilawala** is a Software Customer Support Specialist for Tivoli Systems. He provides customer support for the Tivoli Management Framework and iSeries servers. Prior to joining Tivoli Systems, he provided advanced technical support to iSeries business partners and software developers.
Steve Dillen is an IT Architect at the IBM Pacific Development Centre in Vancouver, British Columbia. He has 12 years experience in iSeries system administration and technical support. His areas of expertise include iSeries system administration and security, as well as large-scale application development and source management disciplines.

Stephan Leisse is an AS/400 and iSeries Advisory Technical Support Specialist in Germany. He has 11 years of experience in the AS/400 and iSeries and Client/Server field. He is an IBM Certified Specialist for Client Access, System Administration, and Operating. His areas of expertise include Windows NT, SNA and TCP/IP communication, printing, and system integration.

Dwayne Lindner is a Senior Analyst with Wesfarmers Rural Division in Western Australia. He has over five years experience in iSeries operations and system administration, and holds an iSeries Technical Solutions Implementer (V4R5) certification. His areas of expertise include personal digital assistants, wireless technologies, and system integration.

Steven Murray wrote the study guides for the IBM AS/400 Associate System Operator and Professional System Operator certification exams. The books are entitled AS/400 Associate System Operator Certification Study Guide and AS/400 Professional System Operator Certification Study Guide. Steve has achieved the status of IBM Certified Specialist as an AS/400 Associate System Operator, AS/400 Professional System Operator, and AS/400 System Administrator. He currently designs and develops iSeries and AS/400 curriculum for the iSeries and AS/400 certification programs at Rochester Community and Technical College, in Rochester, Minnesota. Steve has more than eight years of experience with the iSeries and AS/400. Steve previously was a technical writer while working at IBM and at several IBM Business Partner companies.

Lindsay Porter is an iSeries System Support Specialist with Assist/400. He has 10 years of AS/400 and iSeries experience. He is professionally certified in Operations and Administration, with expertise in the areas of microcode and IPL, database, and languages such as DB2, SQL, and Query.

Marios Symeonides is a Software Services Specialist (Advisory) for the iSeries server for IBM Cyprus. He has 15 years of experience in the Information Technology field. Since 1997, his main areas of expertise include iSeries problem determination and resolution, Systems Management, Client Access, and PC connectivity to the iSeries server. He teaches networking and Client Access classes. He holds a bachelor's degree in Electrical Engineering from the University of South Alabama.

Thanks to the following people for their contributions to this project:

Tom Barlen
Masahiko Hamada
Nick Harris
Brian Smith
International Technical Support Organization, Rochester Center

Tony Bachand
Stacy Benfield
Ken Brown
Kenneth Burger
Karolyn Chambers
George DeStefano
Joe DiCecco
Randy Esch
Teresa Greene
Ron Haugen
Become a published author

Join us for a two- to six-week residency program! Help write an IBM Redbook dealing with specific products or solutions, while getting hands-on experience with leading-edge technologies. You'll team with IBM technical professionals, Business Partners and/or customers.

Your efforts will help increase product acceptance and customer satisfaction. As a bonus, you'll develop a network of contacts in IBM development labs, and increase your productivity and marketability.

Find out more about the residency program, browse the residency index, and apply online at:

ibm.com/redbooks/residencies.html
Comments welcome

Your comments are important to us!

We want our Redbooks to be as helpful as possible. Send us your comments about this or other Redbooks in one of the following ways:

► Use the online Contact us review redbook form found at:
  ibm.com/redbooks

► Send your comments in an Internet note to:
  redbook@us.ibm.com

► Mail your comments to:
  IBM Corporation, International Technical Support Organization
  Dept. JLU  Building 107-2
  3605 Highway 52N
  Rochester, Minnesota 55901-7829
Chapter 1. Operations Navigator synopsis

Operations Navigator is the graphical interface to configuring, monitoring, and managing the OS/400 environment. Operations Navigator functions are included under several, individually installed components. This chapter provides:

- **Scope of this redbook**
- An introduction (high level list) of Operations Navigator capabilities up to and through OS/400 release V5R1, and highlights of those functions and interfaces with significantly new support starting with V5R1.
- Identifies which volume of the following V5R1 Operations Navigator redbook volume set contains additional functional details:
  - **Overview:** Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226 (this redbook)
  - **Security:** Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227
  - **Configuration and Service:** Managing OS/400 with Operations Navigator V5R1, Volume 3: Configuration and Service, SG24-5951
  - **Packages and Products:** Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products, SG24-6564
  - **Performance Management:** Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565
  - **Networking:** Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566

**Note to reader:** This redbook is based on OS/400 V5R1. All Operations Navigator windows shown in the book, as well as references to the Information Center, are also based on V5R1 interfaces. Starting with V5R2 the term Operations Navigator is replaced with the term iSeries Navigator. Appendix F, “V5R2 iSeries Navigator enhancements summary” on page 507, contains information summarizing enhancements in V5R2.
1.1 Scope of this redbook

Operations Navigator is the Windows-based graphical interface to configuring, monitoring, and managing the OS/400 environment.

This chapter introduces Operations Navigator and provides a high level list of capabilities under each of the Operations Navigator components that can be individually installed on a client PC workstation.

Because Operations Navigator offers an interface to system-wide OS/400-based functions, coverage of all these capabilities in a single redbook volume is not reasonable. Therefore, we have grouped descriptions of the functions into a set of Operations Navigator redbook volumes, generally organized according to major categories of function. With Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226, we provide a broad overview of all Operations Navigator functions, selected topics that generally apply to all or most Operations Navigator functions (such as installation, general screen navigation, and application administration), and miscellaneous selected component functions that we have included in Volume 1.

A version of this chapter appears in each redbook volume, giving:
- A list of the major Operations Navigator functions covered in that volume
- A high level overview of Operations Navigator functions
- References for topics covered in the other redbook volumes

The following chapter topics are contained in this redbook:
- A major overview of all V5R1 Operations Navigator functions
- Operations Navigator Installation and general navigation
- Basic Operations component functions
- Work Management component functions
- Management Central Overview and Monitors component functions
- Network component basic functions
- File Systems component functions
- Backup component functions
- AFP Manager component functions
- Plug-in support
- Application Administration component functions
- Appendices
  - Operations Navigator functions by OS/400 release summary
  - Operations Navigator and OS/400 System Value terminology cross-reference
  - OS/400 server job names and functions cross-reference
  - Instructions for setting the correct time of day for Operations Navigator and Management Central functions

Following the general introduction to V5R1 Operations Navigator, this chapter lists the major Operations Navigator components and identifies which redbooks contain more detailed information on the functions within that component.
1.2 Introducing V5R1 Operations Navigator

Operations Navigator was originally available with V4R3 with significant enhancements added in V4R4 and some V4R5 enhancements, primarily in the Database - Visual Explain (query analysis) and Hardware - Disk configuration areas. V5R1 Operations Navigator provides twice as much function as is available in previous releases. In addition to new V5R1 functions, some interfaces to existing functions have been improved and there is a new Taskpad section on the bottom of most windows that offers a “quick access” to selected sub-functions under major function categories.

Operations Navigator server functions are part of base OS/400. Access to Operations Navigator from a PC workstation is enabled by specifically installing all or some Operations Navigator components on the workstation as part of Client Access Express installation. The Operations Navigator functions are available as part of the no additional charge functions of Client Access Express. Chapter 3, “Installation and general navigation” on page 53, includes installation considerations and PC workstation hardware and software requirements.

While OS/400 continues to provide a powerful set of command level interfaces to managing your environment, V5R1 Operations Navigator should be your first choice for managing jobs, printed output, disk storage, simple clustering configuration, system resource utilization, message responses, TCP/IP-based network configuration and, file system content, database and security and system value management.

Those new to OS/400 can typically be “more productive sooner” getting to “know the system” through the Operations Navigator interface compared to learning the OS/400 command interface. Some network configuration is possible only through the Operations Navigator interface.

Management Central is an integrated component that enhances managing multiple iSeries servers from a central server. Functions such as running a command, collecting performance data, distributing software and files, collecting hardware and software-based inventory, use the central server regardless of whether the function is done on a single system or multiple systems. Management Central supports basic job scheduling of supported functions “one-time only” or repetitively (daily, weekly, monthly) by interfacing to the OS/400 no charge job scheduler.

Prior to V5R1 Management Central was a separately installable Operations Navigator component. To get certain functions you had to install Management Central as part of Client Access Express installation. Starting with V5R1 Management Central is no longer explicitly installed. Rather, its functions are included with base support and these functions are invoked by other specifically installed components, such as those available under Configuration and Service. Chapter 6, “Management Central and Monitors” on page 181, provides additional Management Central details.

Application products can be integrated into Operations Navigator interfaces as “plug-ins”. Typical plug-in application areas include Domino for iSeries (licensed product 5769-LNT), Backup Recovery and Media Services (licensed product 5722-BR1), OnDemand (licensed product 5769-RD1), Advanced Job Scheduler (licensed product 5722-JS1), and user-written Java programs.

These applications must first be installed on your iSeries system. They can be run independent of the Operations Navigator interface. However, if you wish, you can also (or only) run these applications through the Operations Navigator interface by installing them as plug-ins.
A system administrator can control which Operations Navigator functions a specific workstation or signed on user can perform using one or a combination of the following techniques:

- Installing only specific Operations Navigator components on certain workstations
- Using normal OS/400 object security and user profile passwords and user profile “special authorities” (Operations Navigator system privileges). For example a user profile may be able to view active jobs but without a “job control” privilege, that user cannot hold, or end a job they are viewing.
- Use Operations Navigator Application Administration (a separately installed Operations Navigator component) to restrict which functions installed on the workstation will actually appear within the Operations Navigator window.

Note: Those familiar with the OS/400 command interface can have the best of both worlds, using primarily the graphical Operations Navigator interfaces, but judiciously using a command interface, where one exists, for special situations. Throughout these redbook volumes, we make reference to corresponding OS/400 commands, where appropriate.

1.3 Operations Navigator major components and redbooks

This topic provides a high level list of Operations Navigator functions and identifies the volume within the set of V5R1 Operations Navigator redbook volumes that contains additional information.

For iSeries, V5R1 Information Center articles and Supplemental manuals should be considered the first source of information to be reviewed when investigating most functions. Additionally, in an active Operations Navigator session, we recommend first using the online Help information (“What's New?”, “What can I do with...?” and the Help button) when you need additional information. The V5R1 level online Help information has greatly improved over previous releases.

1.3.1 Major components

Operations Navigator functions can be performed through the following major components (as part of V5R1 Client Access Express installation):

- **Basic Operations**: Basic Operations is automatically included when Operations Navigator is installed. Message, printed output and job management functions are included under the following sub components (folders):
  - Messages
  - Printer output (spool output queues and spool files)
  - Printers (printer devices and assigned output queues)
  - Jobs

Starting with V5R1, you may perform automated monitoring for messages and jobs, taking a pre-defined action.

Basic Operations is described in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226.

- **Work Management**: The Work Management component is new for V5R1 and must be specifically installed on your workstation. In contains a more powerful set of functions than
those available under Basic Operations - Jobs. Job, job queue, and memory pool (main storage) management functions are included under the following sub components (folders):

- Active Jobs
- Server Jobs (for example, HTTP servers, Management Central servers, and more)
- Job Queues
- Subsystems
- Memory Pools

Job monitors are supported from the interfaces under these folders.

Work Management is described in *Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More*, SG24-6226.

**Configuration and Service:** Configuration and Service provides a wide range of functions and must be specifically installed on your workstation. These functions can be performed on a single system or multiple systems. Many functions were available prior to V5R1, and there are new V5R1 enhancements.

Configuration and Service functions are grouped into the following sub components (folders):

- System Values (*starting with V5R1, you can manage values on one or more systems
- Hardware (view information based on hardware group categories on one or more systems, configure disk pools which requires new service tools security set up with V5R1)
- Software: (view software products on one or more systems, send and install a product on a remote system)
- Fixes: (view and manage fixes on one or more systems, send and install fixes on a remote system, compare fixes on multiple systems). *Starting with V5R1 you can identify extra fixes as well as missing fixes.*
- Collection Services: (collect system wide performance data). This data is used by Graph History and the System monitor function support. The performance database files generated from Collection Services data is also used by the PM/400 service offering or the Performance Tools for iSeries, 5722-PT1 product.

Details on Collection Services are contained in *Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management*, SG24-6565. Overview information on Collection Services is also discussed in *Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More*, SG24-6226.

- Extreme Support: (a *new for V5R1* interface to connect to and use a suite of IBM service and support functions included under the Extreme Support Personalized banner).

Details on Extreme Support are contained in IBM @server iSeries Universal Connection for Electronic Support and Services, SG24-6168. Overview information on Extreme Support is also discussed in *Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More*, SG24-6226. However, for current service and support capabilities, go to [http://www.ibm.com/servers/support](http://www.ibm.com/servers/support) and select iSeries.
Network: Network component must be specifically installed. This component supports a wide range of TCP/IP based connectivity configuration and management functions grouped into the following sub components (folders):

- IP Policies (Virtual Private Network (VPN), IP address translation, packet filtering rules, new for V5R1 Quality of Service, and more)
- Remote Access Services (connection profiles, modems)
- Servers (TCP/IP servers, Client Access Express servers, Domain Name System (DNS) servers)
- Windows Administration (Windows operating systems on the IBM @server Integrated xSeries Server on iSeries, including new for V5R1 disk administration and OS/400 user enrollment)
- Internet (access to browser based configuration and management of HTTP servers, Digital Certificate Manager (DCM), and more)
- TCP/IP Configuration (routes, interfaces, connections, and connection verification tests)

Operations Navigator Network function details are included in Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566. A subset of the more commonly used TCP/IP interface and connection status and connection validation tools are described in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226. This includes the new for V5R1 functions for IP connection status and "route verification" utilities.

Security: Security must be specifically installed. OS/400 authorization list (used to secure objects with similar security requirements) and security-related system value management functions are grouped into the following sub components (folders):

- Authorization lists
- Policies (OS/400 system values for security level, sign on and password rules and object auditing)

This component also offers a Security wizard to help setup security policy values.

Other aspects of OS/400 security are interfaced through the File Systems component and the Users and Groups component. Operations Navigator Security function details are included in Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227. Overview level information is also included in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226.
Chapter 1. Operations Navigator synopsis

Uses and Groups: Users and Groups must be specifically installed. Creating, deleting and other user profile management functions are grouped into the following sub components (folders):

- All Users
- Groups
- All Users Not in a Group

Operations Navigator Users and Groups function details are included in Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227. Overview level information is also included in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226.

Database: Database must be specifically installed. This component supports a wide range of interfaces to OS/400 DB2 Universal Database (UDB) for iSeries functions using SQL terminology. Creating and maintaining database objects (such as tables), creating and maintaining triggers, referential constraints, running and saving SQL statements, analyzing query performance, and viewing the interrelationship of database objects, and other functions are grouped into the following sub components (folders):

- Libraries (SQL collections or schemas)
- Database Navigator (new for V5R1)
- SQL Performance Monitors


File Systems: File Systems must be specifically installed. This component interfaces to the standard library-based OS/400 QSYS.LIB file system and other Unix or Windows based file systems stored on the iSeries which support a folder (directory) hierarchy tree structure.

Managing library or folder contents ("objects") file shares on these folders and objects, specifying object permissions (authorities), and other functions are grouped into the following sub components (folders):

- Integrated File System (folder/directory hierarchy)
- File Shares (sharing objects within a Windows network)

V5R1 includes enhancements in the ability to copy between QSYS.LIB libraries.

File Systems is described in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226 in Chapter 8, “File Systems component” on page 335. Assigning permissions to file system folders and objects is included in Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227.

Backup: Backup must be specifically installed. Backup allows you to schedule simple backup procedures, based upon daily, weekly, monthly backup policies. Starting with
you can use more sophisticated backup functions by installing Backup Recovery and Media Services (licensed product 5722-BR1) as a plug-in to Operations Navigator.

The base backup functions are described in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226, in Chapter 9, “Backup component” on page 363. BRMS capabilities available through Operations Navigator are discussed in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226, in Chapter 11, “Plug-in support” on page 385.

- **Application Development**: Application Development must be specifically installed. This component allows you to work with some application development tools, primarily in the UNIX environment.

  Additional details on Application Development functions are not described in the redbook volumes for V5R1 Operations Navigator. The Applications Development component has not been enhanced since the V4R3 time frame as other development tools for these kinds of applications are commonly available and have more robust function.

- **Commands**: Commands must be specifically installed. Commands support enables you to define commands that can be scheduled to run on a local or remote system.

  Starting with V5R1 Operations Navigator has a general command prompt function for all OS/400 and user-created commands on a system.

  Commands functions are described in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226, in Chapter 6, “Management Central and Monitors” on page 181.

- **Packages and Products**: Packages and Products must be specifically installed. Packaging allows you to group files or specific objects into a group - a package definition, for purposes of sending to another system.

  Starting with V5R1 you can create your own product of programs, files and other objects and fixes (PTFs), similar to IBM products. These products are then managed similar to other Operations Navigator functions for managing software and fixes.

  Operations Navigator Packages and Products function details are included in Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products, SG24-6564. Overview level information is also included in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226, in Chapter 2, “Operations Navigator introduction” on page 11.

- **Monitors**: Monitors must be specifically installed. Three types of real-time monitors can be defined:
  - System (system-wide performance metrics graphically displayed with optional automated run of OS/400 command). Starting in V5R1 Graph History can display data collected longer than 60 minutes
  - Message (new for V5R1 monitoring messages on message queues with automated actions)
– Jobs (new for V5R1 monitoring of jobs for performance metrics, status changes, and more with event logs and automated run of OS/400 command).

Monitor support is described in *Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More*, SG24-6226, in Chapter 6, “Management Central and Monitors” on page 181.

▶ **Logical Systems**: Logical Systems must be specifically installed. Starting with V5R1 Operations Navigator can configure a logical partition and manage (move) processor and memory resources across partitions on the same system.


▶ **AFP Manager**: AFP Manager must be specifically installed. New with V5R1 the AFP Manager helps you to work with Advanced Function Print resources (including code pages, overlays, page definitions and segments, and more), font mapping tables, and PSF (Print Services Facilities, OS/400 installation options 36-38). These functions are grouped into the following sub components (folders):

– Resources
– PSF Configurations
– Font Mapping Tables

AFP Manager functions are overviewed in *Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More*, SG24-6226, in Chapter 10, “Advanced Function Printing (AFP) Manager” on page 373. For detailed information on using AFP Manager, see *iSeries Printing VI: Delivering the output of e-business*, SG24-6250.

▶ **Application Administration**: Application Administration must be explicitly installed. Application Administration can be used to restrict Operations Navigator functions installed on a workstations based upon the Operations Navigator signed on user’s OS/400 user profile.

Application Administration capabilities are described in *Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More*, SG24-6226, Chapter 12, “Application Administration component” on page 433.

▶ **Optionally installed plug-ins**: There is no specific Plug-ins component. Rather, as part of Operations Navigator installation or later using Selective Setup, you can have a properly “registered” application installed on an iSeries system can be installed as a plug-in.

The following applications are used as plug-in examples:

– Advanced Job scheduler
– Backup Recovery Media Services
– Domino
OnDemand

Plug-in support is generally described in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226, in Chapter 11, “Plug-in support” on page 385.

Operations Navigator also includes new for V5R1 interfaces to “simple” (two system), “switched disk”) Clustering support. Clustering support is not an explicitly installed Operations Navigator component, but rather is included under Configuration and Services disk management capabilities and under a Management Central Clusters folder.

In the Operations Navigator set of redbook volumes, Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226, in Chapter 2, “Operations Navigator introduction” on page 11, contains an overview of Clustering functions. Complete coverage of V5R1 Operations Navigator functions for Clustering is included in Clustering and iASPs for Higher Availability on the IBM iSeries Server, SG24-5194.

For additional information use this Operations Navigator redbook volume or other redbook volumes as referenced earlier in this chapter.

1.3.2 Complex functions

For some complex functions that are interfaced through Operations Navigator, thorough coverage is beyond the scope of this set of Operations Navigator redbook volumes.

Other documentation, such as other redbooks, iSeries Information Center articles, or component specific Web sites should be used to properly set up and manage these functions.

Examples of these more complex functions would include:

- Database Components:
  - Referential Constraints
  - SQL Procedures
  - Database Navigator
  - SQL performance analysis tools

- Network Component
  - IP Profiles
  - Virtual Private Network (VPN)
  - Domain Name System (DNS) services
  - Quality of Service

- Logical Partitions

- Clustering
Operations Navigator
introduction

This chapter provides an overview of V5R1 level Operations Navigator installation, navigation, and functions. Its content assumes you have reviewed the information in Chapter 1, though some information is repeated for the Operations Navigator components in this chapter.

In this overview chapter, we have expanded the information for selected topics. These topics are:

- **Primary functional components**
  - Basic Operations
  - Work Management
  - Configuration and Service
  - Network
  - Security
  - Users and Groups
  - Database
  - File Systems
  - Backup
  - Application Development
  - Commands
  - Packages and Products
  - Monitors
  - Logical Systems (logical partitioning)
  - AFP Manager

- **Cross-component functions**
  - Application Administration
  - Management Central
  - Clusters
  - Inventory
  - Operations Navigator online help
  - Plug-ins overview
However, some Operations Navigator components or functions cover such a wide range of capabilities, often with complex setup parameters, that they only receive minimal coverage in this set of V5R1 Operations Navigator redbook volumes. For those topics we reference you to other sources of documentation for more details that include the Operations Navigator interfaces. These areas include:

- Database
- Logical Partitions
- Clusters
- TCP/IP functions, such as:
  - Virtual Private Networking (VPN)
  - Domain Name Services (DNS)
  - Quality of Service
  - Directory Services

### 2.1 Operation Navigator overview

Operations Navigator is the Windows-based “face of the iSeries”.

This chapter assumes you have read Chapter 1, so you have at least a high level understanding of:

- Most of the functions available under each Operations Navigator component. This chapter expands the descriptions of these components and discusses some cross-component capabilities.
- How to control a signed-on Operations Navigator user’s access to an Operations Navigator function. More specifically, Chapter 12, “Application Administration component” on page 433, shows how to limit access to an Operations Navigator function installed on a client workstation.

All of the chapters are written assuming all Operations Navigator components have been installed on the workstation and the signed-on user has access to the functions being discussed.

Figure 2-1 is an example of the main Operations Navigator window after starting an Operations Navigator session with system As01. This figure shows the menu bar (1), toolbar icons (2), left pane with the Operations Navigator function tree (A), and the right details pane (B) listing all the Operations Navigator components that can be used to system As01 listed under My Connections. At C we also show an example of the new for V5R1 Taskpad pane.
Figure 2-1 Operations Navigator main window example

Using Figure 2-1 as a reference, we note the following items:

- Navigating Operations Navigator’s functions is generally based upon Windows operating system techniques using left-click and right-click (mouse button) to expand/compress the function tree, change the window and pane within a window size, use the menu bar and tool bar, and select menu items.

- There are several terms that people use such as “component”, “sub component”, “function”, “folder”, or “sub function” to refer to the various levels of the Operations Navigator function tree “branches”. In this example “branches” include Task Activity, Monitors, and System Groups under Management Central and Work Management, Network, Users and Groups and File Systems under My Connections. In these redbooks we will normally use the word folder when describing the functions available for each one of these branches, such as the Work Management folder. We use folder to refer to all levels of the hierarchy tree structure, for example, the second level folders under Work Management.

- At the menu bar and “Help for related tasks” in the Taskpad pane we show two of the ways to initiate access to online Help provided through Operations Navigator. Online Help information is much improved in V5R1.

- In the right Details pane you see text descriptions of the Operations Navigator components (folders) under the column headings Name and Description. Depending on which left pane folder you have selected with your mouse, both the columns of information displayed in the right details pane and the items in the Taskpad pane may change.
Depending on the Operations Navigator tree folder you have selected, there is a default set of information (columns) and sequence of items in the list displayed in the Details pane. Options in the menu bar at 1 enable you to control the columns of information displayed, the column left to right sequence and the sort order of the list of items displayed.

At 3 we have expanded the function tree under the Management Central central system As01 to illustrate the available function folders. Note, certain functions require a central system be defined, even when your environment has only one system, so you see As01 on this window under both Management Central and My Connections.

At 3 we see an example of how an application plug-in (Advanced Job Scheduler, in this case) folder might appear if it were installed on the workstation - under Management Central and under My Connection system As01 Work Management.

At 4 we have expanded the system As01 under My Connections and see the list of Operations Navigator folders installed on this workstation and not prohibited by Application Administration for the currently signed on user.

At 5 we show an example of a context menu for the Users and Groups folder. For Users and Group you see possible actions include displaying the list of user profiles and group profiles on As01 (Explore or Open), creating a new user profile on As01, and creating a new group profile (multiple user profiles) on As01.

Context menus are available for every “folder”. The menu for an iSeries server under My Connections provides access to powerful set of functions for that system.

You get a context menu displayed by right-clicking a folder.

At 7, just below the AFP Manager folder you see another system - As01b that has been added to the My Connections environment.

Chapter 3, “Installation and general navigation” on page 53 covers the previous items in more detail.

Next is an extensive overview of the major capabilities of V5R1 Operations Navigator, indicating significant V5R1 enhancements. The key functions are discussed under two major topic headings:

- Section 2.2, “Primary functional components” on page 14
- Section 2.3, “Cross-component functions” on page 43

## 2.2 Primary functional components

This topic overviews Operations Navigator functions under the major components that may be selected during Operations Navigator installation or Selective Setup after installation.

### 2.2.1 Basic Operations

Basic Operations is included with the Operations Navigator base installation. That is, Basic Operations is not a selectable component during installation. Selective Setup can be used later to uninstall Basic Operations.

Base installation includes Inventory collection and Management Central functions for defining a central server (required for some specifically installed components, such as Configuration and Service), groups of systems, and task scheduling. Management Central is referenced in this chapter but more specifically discussed in Chapter 6, “Management Central and Monitors” on page 181.
Basic Operations is accessed for a system under My Connections. Message, printed output and job management functions are included under the following sub components (folders) as shown in Figure 2-2:

- **Messages**: You can send, view and manage (reply and delete) messages sent to the System Operator (message queue QSYSOPR), or any user-created named message queue.

  *Starting with V5R1*, you may monitor for messages and define automated responses (no operator interaction) if the Monitors component is available on your workstation. When properly configured under Management Central this monitoring and associated actions can be activated on multiple iSeries systems.

- **Printer Output**: You can display and manage spooled output (files) on any OS/400 output queue, including copying or moving the output to another output queue or an active printer for printing and send a spooled print file to a user on another system. You can also copy and paste (and use the mouse to drag-and-drop) to copy a spool file to a printer on another system.

- **Printers**: You can view print devices, spooled print output they are printing, start and stop spool writers printing a file, vary the print device on (make available) and off (Make unavailable). A printer can be shared with other Windows clients in your network through the NetServer component that is part of OS/400. Print devices are created by OS/400 auto-creation or the OS/400 Create Print Device (CRTDEVPRT) command.

- **Jobs**: You can hold, release, delete (cancel) and manage jobs running under OS/400.

  *Starting with V5R1* the user may monitor jobs for specific performance metric resource consumption and other actions such as job status change, if the Monitors component is available on your workstation. When properly configured under Management Central this monitoring and associated actions can be activated on multiple systems.

![Figure 2-2  Basic Operations folders example](image)

Basic Operations details are included in Chapter 4, “Basic Operations” on page 119.

---

### 2.2.2 Work Management

The Work Management component became available with **V5R1** and must be specifically installed on your workstation. Prior to V5R1 Operations Navigator had a “Job Management” folder for each My Connections system. In V5R1, the “Job Management” folder functions have been moved to “Work Management”. Work Management has a more powerful set of functions than those available under **Basic Operations -> Jobs**. Job, job queue, and memory pool (main storage) management functions are included under the following folders (as shown in Figure 2-1 on page 13):

- **Active Jobs**: You can view all jobs on the system or subset the view by job name prefix, job user name, job number, or within a specific OS/400 Work Management subsystem that is currently active.

- **Server Jobs**: You can view jobs determined by the system to be “server jobs”. This view is new for V5R1 and includes all the IBM-supplied servers such as Directory Services (Lightweight Directory Architecture Protocol), NetServer, database servers for ODBC and
SQL Call Level Interfaces (CLI), Web servers, Management Central itself, Domino, and more. When using this folder you do not see 5250 jobs or “traditional” batch jobs.

Your can subset the views similar to Active Jobs and also include jobs not yet run but on job queues and jobs already completed with spooled output.

This “server job” classification support under this component gives a different view than “Servers” under the Network Component, available in releases prior to V5R1. We discuss Network -> Servers functions in Chapter 7, “TCP/IP network” on page 289

- **Job Queues**: You can view jobs on active job queues (assigned to an active subsystem) or all job queues. For jobs on a job queue, you can hold or release the job and move a job from one queue to another job queue.

  A job queue must be created and deleted using OS/400 commands

- **Subsystems**: You can view jobs by Subsystem name. For example, view only the active jobs in the QBATCH subsystem. For each subsystem defined on the system, you can start or end an active subsystem and access job queues for that subsystem.

  A subsystem description can be created or deleted using OS/400 commands.

- **Memory Pools**: You can view memory storage pools, storage pool status, jobs running in the storage pool and subsystems using the storage pool. From the memory pool windows folder, the user can access system values associated with storage pools, such as whether to use the OS/400-provided automatic adjust function, and can change the size and number of active threads (“activity level”) allowed in the pool.

  From each of the major Work Management folders you can hold, release, delete (end) a job, view the job’s run time parameters, and monitor the job. *New with V5R1* you can view “job details” such as the library list, objects locked by the job, and more.

  Work Management details are included in Chapter 5, “Work Management” on page 139.

### 2.2.3 Configuration and Service

Configuration and Service provides a wide range of functions and must be specifically installed on your workstation. These functions can be performed on a single system and many of them for multiple systems. Selecting to use Configuration and Service requires your workstation to have a Management Central central system configured. In a single system environment the central system is the same as the My Connections system, as shown in our example in Figure 2-3.

A Configuration and Service folder appears under a My Connections system and also under a Management Central Endpoint Systems, as shown at 1 and 2, respectively, in Figure 2-3.

As you review the further description of Configuration and Service functions, note also, the My Connections context menu for system As01 with the Configuration and Service-related items identified at 3.
The Configuration and Service functions for a system under an Endpoint System and a My Connection system are very similar, but not exactly the same. The following overviews the Configuration and Service functions as grouped into the following folders under a My Connections system:

- **System Values**: Starting with V5R1, you can view and change system values on the local system. You can schedule collection of system value inventory from one or more systems and store that information on the Management Central central system. Once an inventory of system values has been collected onto the central system, you can do the following:
  - Compare system values collected from one or more remote systems to system values on a “model” system
  - Change a system value on a remote system to the value on the model system
You can also export system values to a PC file format for additional review or other processing by a PC application such as Microsoft Excel.

- **Hardware**: You can view the hardware on a local system under various hardware group categories such as “all hardware, processor information”, and so forth. For disk devices the list and graphical view capabilities are very powerful. You can graphically view a tower containing disks, the physical location of a disk within a tower or rack configuration, and a disk’s Properties, such as percent of total storage currently utilized. Figure 2-4 shows examples of tower and disk capacity graphical displays.
The sub folder list shown at 4 and the expanded “View by” list shown at 6 demonstrate the many ways to view the disk configuration on a single iSeries server. In this example we have shown to view only one tower (Fr01), shown in the window at 2.

At 3 we have selected one of the disks and displayed its “capacities property” in the window at 4.

A newly added disk device can be configured into an I/O tower “rack” and assigned a disk protection option (mirrored or RAID protected) and optionally assigned to a user-defined Disk Pool (Auxiliary Storage Pool). A disk may be assigned to the new for V5R1 “independent Auxiliary Storage Pool”, which is intended for simple clustering (“switched disk”) usage.

Wizards are provided for disk and disk pool configuration.

You can schedule to collect hardware configuration inventory from one or more systems and store that information on the Management Central central system. Once an inventory of hardware information has been collected onto the central system, you can the search the inventory for hardware features (resources) installed or not installed on the systems.
You can also export hardware inventory information to a PC file format for additional review or other processing by a PC application such as Microsoft Excel.

**Attention:** You need two special setup steps performed before you can view disk configuration and configure new disk pools:

1. You need an iSeries Service Tools user profile and password (separate and distinct from an OS/400 user profile) authorized to disk and logical partition configuration functions. You will be required to sign on to the service tools server to perform any disk configuration functions or logical partition functions through Operations Navigator. This is configured through the Dedicated Service Tools (DST) interface.

2. The Operations Navigator Applications Administration component must have been used to explicitly enable access to Disk units on Logical Partition functions.

Only specific users should have access to these capabilities. Additional information on this subject is included in Chapter 12, “Application Administration component” on page 433.

**Software:** You can:

- View a list of all software products that your system could support for all systems that your system may manage in a network. A particular product need not be installed on your system for your system to support it on a remote system.
- View a list of the software products installed on your system

You can schedule to collect software inventory from one or more systems and store that information on the Management Central central system. Once an inventory of software information has been collected onto the central system, you can search for inventory installed or not installed on those systems. You can also send and install the software product onto a remote system.

You can also export software inventory information to a PC file format for additional review or other processing by a PC application such as Microsoft Excel.

**Fixes Inventory:** You must first collect fix inventory, even in a single system environment, to perform the following functions. V5R1 has wizards to assist you in doing the following tasks:

- View a fix description and associated cover letter
- Install a fix or uninstall a temporarily applied fix
- Send fixes to another iSeries server
- Send and install fixes on another iSeries server
- Clean up applied fixes, such as deleting the save file and associated cover letter
- Copy fixes from media

Using a model system, you can compare inventoried software products and associated fixes to identify missing or new for V5R1 extra fixes compared to a model system. Based on the comparison of missing fixes, you can send and install the “missing fixes” to the appropriate iSeries server.

**Collection Services:** Collection Services is the primary V5R1 tool for collecting system wide performance information (“metrics”). The collected performance data is placed into a collection object. Performance data in that object can be:
– Used by the PM/400 service to report resource utilization over time and identify trends that could indicate it is time to consider additional resources before incurring performance problems

– Used to generate a set of “performance database” files (SQL tables) that can be used by third party applications, user-written queries or the Performance Tools for iSeries licensed program, 5722-PT1. 5722-PT1 provides various performance reports and a capacity planning tool - BEST/1.

Using Management Central capabilities you can schedule when to start and stop Collection Services - all on a single system or on multiple systems. You can also customize Collection Services performance metric collection and the time periods to keep detailed, graph history, and summary performance data.

Starting with V5R1 the system monitor (real-time graphical display of performance metric activity) support uses Collection Services. Starting a system monitor when Collection Services is not active will automatically start Collection Services. If Collection Services is already active a system monitor accesses the Collection Services performance data already being collected.

New with V5R1 Graph History support can graphically display performance metric utilization over extended time periods by using the graph history, and summary performance data collected by Collection Services. See topics within Chapter 6, “Management Central and Monitors” on page 181 for additional information.

Extensive coverage of Collection Services is contained in Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565. Information Center, either CD-ROM SK3T-4091 or the Web site: http://www.ibm.com/eserver/iseries/infocenter; also has good instructions on how to setup and use Collection Services under Systems Management -> Performance.

Because V5R1 Collection Services completely replaces the similarly functioned OS/400 performance monitor (Start Performance Monitor (STRPFRMON) and End Performance Monitor (ENDPFRMON) commands) that has been available since the first release of OS/400, we expand somewhat on the Collection Services interface and capabilities in this chapter.

Starting with V4R4, Collection Services has been enhanced significantly beyond the Start/End Performance Monitor support capabilities. This includes collecting information such as logical partition number, TCP/IP performance statistics, Interactive Feature utilization, and Database CPU capacity utilization.

Note: The performance database files (QAPMcccccc) created on releases prior to V5R1 continue to be supported by the V5R1 Performance Tools for iSeries, 5722-PT1, licensed program. You must first copy or restore the performance database file objects to the V5R1 system. Then you must use 5722-PT1’s release level format conversion function, before processing by other 5722-PT1 functions.

► Extreme Support: Extreme Support is a new for V5R1 interface (supported on V4R5 via fixes (PTFs)) to connect to and use a suite of IBM service and support functions included under the Extreme Support Personalized banner. Functions include switched dialup and LAN connections and support facilities such as problem reporting, fix ordering and IBM service offering including:

– Performance Management for AS/400e (PM/400e)
– Software Upgrade Assistance
– Service Agent inventory and reporting
– Problem reporting
– Fix review and reception

Extreme Support does not appear under My Connections or Management Central Endpoint Systems Configuration and Service folders as the other Configuration and Service function folders do. Instead it appears under the Management Central server as separate Extreme Support folder.

Details on Extreme Support are contained in IBM @server iSeries Universal Connection for Electronic Support and Services, SG24-6168. However, for current service and support capabilities, go to http://www.ibm.com/servers/support and select iSeries.

Note that you can also collect inventory of user profiles and group files on the local system or from remote systems. Inventory capabilities are summarized in this chapter in 2.3.4, “Inventory” on page 49. How to set up collection of Inventory information for users and groups, hardware and software, system values and fixes is also covered in Chapter 6, “Management Central and Monitors” on page 181.

Details for inventory-based functions for system values, hardware, software, and fixes is described in Managing OS/400 with Operations Navigator V5R1, Volume 3: Configuration and Service, SG24-5951. Details for inventory-based functions for user profiles and group files is described in Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227.

2.2.4 Network

The Network component must be explicitly installed on your workstation. Network provides an extensive array of functions, focused primarily on capabilities using TCP/IP communications protocols and must be specifically installed on your workstation. Figure 2-5 shows the primary folders for Network functions.

Figure 2-5   Major Network function folders

- **IP Policies** (IP Security folder prior to V5R1): You can configure and activate Packet Filter rules and Network Address Translation rules, and, *new for V5R1*, Quality of Service (traffic prioritization based upon data type or application type attributes.)
Additionally VPN (Virtual Private Network) can be configured and managed. New for V5R1 are VPN diagnostic tools for the VPN server jobs and an activity trace.

- **Remote Access Services** (Point-to-Point (PPP) folder in previous releases): You can configure point-to-point and wide area network (WAN) connections with originator connection profiles, receiver connection profiles, and modem protocols to be used. Additionally, DHCP (Dynamic Host Configuration Protocol, which has the new V5R1 function to perform dynamic updates to DNS records) and new for V5R1 RADIUS (Remote Authentication Dial-In User Service) can be enabled for use under the TCP/IP Configuration folder. RADIUS is an industry accepted way to authenticate clients, assign IP addresses, and audit client connection time over a PPP connection.

- **Servers**: You can view and manage (start and stop), and for certain servers, configure a server supported on the system under three major server types:
  - Client Access servers, such as database (Open Database Connectivity (ODBC) and Java Database Connectivity (JDBC) protocols), sign on, data queue, file and others
  - TCP/IP servers, which includes a variety of servers that may need to be active to perform certain functions. Many of these servers are defined and all can be viewed, stopped, and started through this interface, including Management Central, Telnet, FTP, OS/400 NetServer, HTTP, VPN, Directory Services (LDAP), Distributed Data Management (DDM), LPD (Line Printer Daemon), cluster management, and more. The OS/400 jobs performing the associated server functions can also be displayed.

  The Management Central central system must be active for all functions actually performed by Management Central, such as running a command, monitoring messages, jobs and system performance metrics, using inventory-based functions, and scheduling these tasks. The OS/400 NetServer is one of the TCP/IP servers that enables OS/400 objects to appear as resources in a Windows like “network neighborhood. You can control what appears in this neighborhood. New in V5R1 you can turn off WINS proxy enablement to avoid network traffic caused when acting as a proxy.

  The Directory server is one of the TCP/IP servers that is used to store and publish directory information, such as user mail information and hardware configuration information as supported under LDAP (Lightweight Directory Architecture Protocol). V5R1 support includes LDAP Version 3.2 and a default Directory server configuration can be chosen.

  - DNS (Domain Name Services) servers, which provide name resolution for associated IP addresses.

Note: OS/400 determines which jobs are designated as “servers”. The Network -> Servers folder provides a different way of looking at “server jobs” than does the new for V5R1 Work Management -> Server Jobs folder. Basic management of the commonly used servers for database, NetServer, and Management Central are discussed in Chapter 7, “TCP/IP network” on page 289.

- **Windows Administration**: You can define, start and stop and view the properties of Windows 2000 and NT running on an available Integrated Netfinity Server (includes the Intel processors associated with the Integrated xSeries Server for iSeries features for both the internal and new for V5R1 external server configurations). New for V5R1 are the capabilities to graphically define and manage disk drives for a Windows server and enroll OS/400 user profiles into the Windows domain.

  Operations Navigator Windows administration capabilities are overviewed in Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566. Refer also to:

  - The Information Center PDF file, Networking: Windows server on iSeries, available at: Information Center at either CD-ROM, SK3T-4091, or the Web site

- Redbook Consolidating Windows 2000 Servers in iSeries, SG24-6056
- Redbook Direct Attach xSeries for the IBM @server iSeries Server, SG24-6222

► Internet: This links you to very powerful browser-based interfaces to iSeries “sub-components” including:

- The IBM-provided HTTP *ADMIN server Tasks page, which, depending on what you have installed on your system, includes configuring or changing other HTTP Web servers to run under OS/400.
- Digital Certificate Manager (creating and maintaining digital certificates for use with applications using Secure Sockets Layer (SSL) functions)
- New with V5R1 IBM IPP (Internet Printer Protocol)
- 4758 Cryptographic Coprocessor functions.

From the Internet folder you can use the new for V5R1 Internet Setup Wizard which links to an extensive set of wizards available for configuring your system's connection to the Internet with these capabilities:

- Three connection methods: (1) through a private network and (2) through a protected network, each of which can connect through a firewall or router and (3) through a direct dial-up to an ISP or through a router.

- Depending on the connection method selected, wizards are provided for configuring the following services: Web serving, Proxy serving, Use of Net.Data, FTP access, packet filtering rules, VPN setup, and use of a Virtual IP interface.

► Network Stations: This links to configuring and managing Network Stations if the product IBM Network Station Manager for AS/400, 5733-A07, is installed on the iSeries server.

► TCP/IP Configuration: You can configure and view IP interface and routes and view connections and physical interface activity (such as send and transfer rates). For V5R1 there is a graphical view of the commonly available NETSTAT functions and you can access additional information, such as the jobs associated with a connection.

Starting with V5R1 there are “connection test” utilities for well-known TCP/IP functions, including:
- Ping
- Trace route
- Host lookup

In this redbook, Chapter 7, “TCP/IP network” on page 289, describes commonly used Network functions for TCP/IP configuration, such as starting and stopping interfaces, viewing connection and interface status and using the basic network connection investigation functions such as ping, trace route, and host lookup.

Additional Network component functions are described in Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566.

2.2.5 Security

OS/400 has rigorous security capabilities based upon OS/400 security facilities, TCP/IP based security, and optional user exit program security facilities. These include:

► OS/400 security-based system values specifying such things as security level, password rules, object and user auditing, sign on rules, job recovery rules, and more. These values can be viewed and set up with the Operations Navigator Security component.
User profile and group profile attributes such as passwords, “privilege class” (security officer, user, programmer, system operator security administrator) and “system privileges” (all object access, auditing control, job control, spool control, save/restore, associated digital certificate, and more.) User profile and group profile attributes can be viewed and managed with the Operations Navigator Users and Groups component. See *Managing OS/400 with Operations Navigator V5R1, Volume 2: Security*, SG24-6227, for more complete coverage of Operations Navigator interfaces to iSeries security capabilities.

An overview of Users and Groups functions is included in 2.2.6, “Users and Groups” on page 26.

Objects can be secured through “permissions” (authorities) to an object, such as use, change, exclude, existence (delete) and object data permissions such as read, write, execute (run a program) and defaults for new objects. These permissions can be based up specific user profile names, a generic “public authority” (no specific user profile), or an authorization list containing a list of user profiles, with each profile’s specific privilege. *New for V5R1* an object can be secured (“signed”) through a digital certificate assigned to the object.

Object permissions can viewed and managed through the Operations Navigator File Systems component. See 2.2.8, “File Systems” on page 31 and Chapter 8, “File Systems component” on page 335, for more information.

OS/400 Windows operating system-based NetServer file sharing

A suite of TCP/IP-based security capabilities that includes:

- Connection authentication and data encryption using the Secure Sockets Layer (SSL), based upon a digital certificate
- IP address filtering and Network Address Translation
- Virtual Private Network (VNP) protocols
- Kerberos technology algorithms
- Remote Access Services

These capabilities can be managed with the Operations Navigator Network component and the Administration HTTP server provided with OS/400. See *Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking*, SG24-6566 for more overview information on TCP/IP-based security capabilities through Operations Navigator interfaces.

Managing OS/400 security capabilities is made significantly easier through the various Operations Navigator interfaces.

The Operations Navigator Security component must be specifically installed on your workstation. It provides interfaces to a portion of the iSeries security facilities through the following folders:

- **Authorization lists**: An OS/400 authorization list groups OS/400 objects with similar security requirements. An authorization list contains OS/400 users (user profiles) and groups (group profiles) and the specific permissions (authority) for each user to an object secured by that authorization list. An authorization list is an alternative to specifying authority to an object for a specific user or group.
  
  You can create and change authorization lists, add and remove users and groups to the list, change the permissions (authorities) and display the objects secured by the list.
Figure 2-6 is an example window showing authorization list Onrb (at 1), with user profiles, each user’s generic object authorities (privileges), and the buttons to manage more detailed privileges (for example, read, write, execute) and to perform the functions just described. Note the Details and Customize buttons for viewing and assigning more specific privileges.

<table>
<thead>
<tr>
<th>Policies</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auditing Policy</td>
<td>Recording various actions performed on an object, actions to take if the audit journal has an error, and more</td>
</tr>
<tr>
<td>Password Policy</td>
<td>Password length, valid characters, password expiration date, and more</td>
</tr>
<tr>
<td>Security Policy</td>
<td>System security level, default public authority for new objects created into the QSYS.LIB file system, restore object rules for security-sensitive objects, and more</td>
</tr>
<tr>
<td>Sign-On Policy</td>
<td>Number of failed sign-on attempts before taking an action, the failed signon action and more</td>
</tr>
</tbody>
</table>

This component also has a powerful Security wizard that can be used by those who are new to OS/400 or by those experienced with OS/400 who want to review their current security-based system values in a nicely formatted list.
The security wizard generates recommended settings for most of the OS/400 security-based system values, based upon a question and answer dialogue with you. A set of recommended values based upon that dialogue are output that can be viewed or printed. You can choose to review your answers, review the recommendations and optionally apply the recommended settings.

The Security component provides an interface to a subset of iSeries security capabilities. In addition to the Operations Navigator components listed at the beginning of this topic that include interfaces to security-related functions, consider limiting a workstation user's access to Operations Navigator functions by:

- Selectively installing only specific Operations Navigator components on certain workstations. Installation details are discussed in Chapter 3, “Installation and general navigation” on page 53.
- Use the Operations Navigator Application Administration component functions to selectively allow or restrict specific signed on users to Operations Navigator functions already installed on a workstation. Details on Applications Administration are provided in Chapter 12, “Application Administration component” on page 433.

Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227, provides additional security-based information on the following Operations Navigator components:

- Security
- Users and Groups
- Application Administration
- File System (permissions)

Complete coverage of all of the iSeries security capabilities is beyond the scope of Operations Navigator interfaces to these security capabilities. For more complete coverage of iSeries security we refer you to:

- Tips and Tools for Securing Your iSeries, SC41-5300 (available on Information Center, Supplemental Manuals)
- iSeries Security Reference for V5R1, SC41-5302 (available on Information Center, Supplemental Manuals)
- Redbook IBM @server iSeries Wired Network Security: OS/400 V5R1 DCM and Cryptography Enhancements, SG24-6168
- Non-IBM documents, including Implementing AS/400 Security. 4th Edition by Carol Woodbury and Wayne Madden, New400 books, 2002 - available as ISBN 1-58304-073-0

### 2.2.6 Users and Groups

The Users and Groups component must be specifically installed on your workstation. Users and Groups functions help you manage user and group profiles on a single system and also multiple systems. Prior to V5R1 Operations Navigator provided a basic set of user and group management functions for a single or multiple systems. However, the V5R1 set of functions provide a powerful set of functions for managing users and groups on a single system, and are especially useful for managing users and groups on multiple systems.

Users and Groups functions are performed in the following folders under a My Connections system and under Management Central Endpoint Systems, as shown in Figure 2-7, at 1 and 2, respectively.
As you review the further description of Users and Groups functions, note also, the My Connections context menu for system As01 Users and Group items at A.

![Figure 2-7 Users and Groups folders example](image)

Users and Groups functions for a system under an Endpoint System and a My Connection system are very similar, but not exactly the same.

Using Figure 2-8 as a reference, the following overviews the Users and Groups functions available under a My Connections system set of folders:

- View and manage users as grouped into All Users, Groups, Users Not in a Group: For each user you can (as shown at 1 in Figure 2-8):
  - Create, edit, and delete a user profile, including creating a new user based upon another user.
  - Specify password, personal (directory type) information and capabilities (privilege class (“user”, “security officer”, and more) and special privileges (all object, job control, spool control, and more), audit action settings, use of a digital certificate, and “application access” (similar to the way the Applications Administration component works).
  - See 12.1, “Application Administration categories” on page 434 for more information
  - Send a message
  - View a user’s “associated objects:” (for example, associated printer output, jobs running under this user, owned objects, and more)
  - Copy (also use the mouse to drag-and-drop) or send a user to another system

- Collect users and group inventory from one or more systems and store that information on the Management Central central system. Once the users and groups inventory has been collected onto the central system, you can perform advanced search functions with search criteria, such as “all users with a specific system privilege”, or “date of last activity”.
  
  See 2 in Figure 2-8, for an example.

You can export the inventory to a PC file for additional processing.
Managing OS/400 with Operations Navigator V5R1 Volume 1: Overview and More

2.2.7  Database

OS/400 provides a robust set of DB2 Universal Database functions. In this topic we provide an extensive overview of the Operations Navigator interfaces to these functions.

However, a detailed description of iSeries database capabilities is not included in this set of V5R1 Operations Navigator redbook volumes. For a complete description of OS/400 database capabilities we refer you to the following:

- Information Center at either CD-ROM SK3T-4091 or Web site: http://www.ibm.com/eserver/iseries/infocenter
- Select Database and File Systems -> DB2 UDB for iSeries and Database and File Systems -> DB2 UDB for iSeries -> Manuals and Redbooks.
- Redbook: Stored Procedures and Triggers on DB2 Universal Database for iSeries, SG24-6503
- Redbook: Advanced Database Functions and Administration on DB2 Universal Database for iSeries, SG24-4249. This book contains detailed examples of V5R1 Operations Navigator interfaces to iSeries database functions.

The Operations Navigator Database component must be specifically installed. Using Figure 2-9 on page 30 as a reference, the following summarizes the set of Database functions available under a My Connections >system:
Create, view, edit, delete, and manage database objects, such as tables, views, referential constraints, triggers (includes enhancements available with V5R1), associated journals, user defined functions and data types. You can assign permissions (authorities) to the individual database objects.

With the Libraries folder context menu (as shown at 1) you can create an OS/400 library in file system QSYS.LIB, access database objects within an OS/400 library, and perform the Database component functions on those objects, such as Generate SQL or assign permissions, including column level permissions.

Run SQL Scripts (as shown in window 2) includes support of new V5R1 SQL functions, such as, support of SQL triggers by OS/400.

In our example, we show the selected SQL statement we ran in the top pane (A) of the window. In the lower pane of that window you see a portion of the query results.

You can select from an IBM-supplied set of SQL prototype statements to assist you in building the “right” SQL statements by selecting the drop down control button 4. Whether you explicitly enter an SQL statement into the statements area (A) or select one of the IBM-supplied prototype statements to be inserted into that area, you can save the set of statements into an Integrated File System folder for later use (via the File menu bar item).

Generate SQL statements (new with V5R1) so you can have the statements used to create the database object. Typically this would be used against database objects created through non-SQL interfaces, such as the OS/400 Create Physical File (CRTPF) command, or objects imported from another system.

Analyze SQL statement performance through the SQL Visual Explain function and the more detailed SQL Performance Monitors (shown at 5) to assist you in improving the performance of your query.

In our example we reran our SQL statement after selecting Visual Explain in the menu bar of the 3 window, to get the lower left Visual Explain window. This Visual Explain output includes icons representing objects processed and query optimizer processing “decisions” to help evaluate the query performance. With V5R1 the Explain function makes it easier to view SQL optimizer decisions (messages) as shown at 6.

You can optionally print the Visual Explain results and save the Visual Explain results as a set of SQL Performance Monitor data for later more detailed analysis.

View a currently running SQL statement in a job or view row (record) locks held by jobs. This is primarily a problem determination aid.

Starting with V5R1 the Database Navigator folder (shown at 7) functions may be used to show and save graphical relationships (a “map”) among SQL objects. This can assist you in minimizing unnecessary database object relationships and maintaining those that are required.

An IBM-supplied stored procedure can be run to create a sample “schema” that contains over 60 database objects. This schema (OS/400 library) can be used to learn the Database Navigator functions and be used for other educational purposes without impacting your “production mode” database objects.

At 4, we show a partial view of the IBM-provided SQL statement to call this stored procedure.
Figure 2-10 is a simple example of a Database Navigator output map showing the relationships between views and the associated table (file) and an alias (used by SQL to access a member of a database multiple member file).
2.2.8 File Systems

OS/400 has an Integrated File System that supports the OS/400-specific library file system ("QSYS.LIB") and other file system structures such as those available on UNIX based or Windows based file systems, typical used by applications such as:

- Web serving
- Domino for iSeries
- Windows operating systems running on the Integrated xSeries Server for iSeries

The Operations Navigator File Systems component must be specifically installed on your workstation and provides access to and functions for objects within the Integrated File folder and supports Window operating system-like File Shares. The two major File Systems sub folders are Integrated File Systems and File Shares, shown in Figure 2-11.
The Integrated File Systems folder provides a Windows Explorer look to the file systems on the iSeries server.

Functions available include:

- Create, delete, rename and view the contents of folders ("directories")
- Move files to and from your PC workstation and within the OS/400 system. Starting with V5R1 you can move QSYS.LIB objects within QSYS.LIB and other file systems.
- Specify permissions (authorities) for each of the objects within the file system
- Send the file to another iSeries server
- Specify iSeries journaling actions for physical files/SQL tables stored in QSYS.LIB and byte stream files in other file systems
- With a Management Central server active, send one or a group of files to another iSeries as part of the packages support in the Operations Navigator Products and Packages component
- Share the specified folder and or file with others, including your PC workstation (note the "hand" icon indicating a share in Figure 2-11.

File Systems functions are described in Chapter 8, “File Systems component” on page 335.

### 2.2.9 Backup

The Operations Navigator Backup component must be specifically installed on your workstation. Backup allows you to schedule simple backup procedures. As shown in Figure 2-12, you can schedule daily, weekly, monthly backup policies, the objects to be saved and the device to contain the backup data.
Starting with V5R1, you can include as a backup plug in, Backup Recovery and Media Services (BRMS), licensed program 5722-BR1. The graphical interfaces of BRMS provide a sophisticated set of backup and recovery policies and associated definitions that include when and what to back up, backup history information and recovery instructions as well as backup media management. The original Backup Component is not accessible to the workstation user after this plug-in is installed.

A large set, but not the total set of BRMS functions are available through this plug-in support at V5R1. Additional BRMS functions accessed through Operations Navigator are planned in a release following OS/400 V5R1.

Basic Backup functions are described Chapter 9, “Backup component” on page 363. An overview of BRMS backup and recovery capabilities as an Operations Navigator plug-in is discussed in Chapter 11, “Plug-in support” on page 385.

2.2.10 Application Development

The Operations Navigator Application Development component must be specifically installed on your workstation. Application Development allows you to work with some application development tools, primarily in the UNIX environment. For example, through the InterProcess Communication (IPC) function you can work with the states and properties of IPC objects created by your program.

Additional Application Development information is not available in any of the V5R1 Operations Navigator redbook volumes. Its functions are rarely used as there are other “Unix-based” application development tools with more function and ease of use.

2.2.11 Commands

The Operations Navigator Commands component must be specifically installed on your workstation. This component is not explicitly shown as one of the major Operations Navigator tree-structure folders in the left pane of Operations Navigator windows.

Using Figure 2-13 as a reference, the Commands component enables you to:

- Create a command definition under the Management Central Definitions folder (shown at 1). Run that command definition on a local or remote iSeries server. You would typically use a command definition when the command is to be run repetitively.
- Run an ad hoc command on a local system (shown at 2).
In this example, we show screen captures for the Start Printer Writer (STRPRTWTR) command and the new with V5R1 command prompt window at 3.

This command prompt is supported for any OS/400 command or user-created command. The user command must be in a library included in the system’s User Library List (QUSRLIBL) system value or entered into the command area as: userlib/usercommand. For example, command prompt would work for PFREXP/SBMCHAINUC.
The command runs under control of Management Central and be run “immediately” or at a scheduled time through Management Central's scheduling capability. You can see the task’s activity (progress) by expanding the Management Central Scheduled Tasks and Task Activity folders (shown at A).

When “defining” a command you specify what to do with messages or job logs relating to the command, if any, via the Options tab.

Note that Commands may also be entered to run “real time” threshold trigger or reset conditions for system monitors and new for V5R1 message and job monitors.

Commands functions are described in more detail within Chapter 6, “Management Central and Monitors” on page 181.

### 2.2.12 Packages and Products

The Packages and Products component must be specifically installed on your workstation.

Packages support has been available since V4R4. Packaging allows you to group files or specific objects into a group - a package definition, for purposes of sending to another system. The objects can be in any Integrated File System directory supported on the system, but all objects in the package must be in the same file system.

The files or objects could include database files/SQL tables, Java applications, program objects, HTML pages, SQL statements saved from the Database component Run SQL Scripts function, and others.

The standard package is a list of objects and their folder paths. When the package is actually sent, Management Central servers internally use OS/400 save functions to copy the data just before sending and then restore functions on the target system.

You can also define a package to be a “snapshot” of the selected objects - that is, a copy of each object is made when the snapshot is being defined. A snapshot would be used, for example, to use “files” as of 5:00 pm today but schedule the send to be later - during the early morning hours of the next day.

Since OS/400 save (and restore on the target) functions are performed, there are options to specify “save while active” options (what to do if the object being saved is currently in use) and restore options (such as what action to take if the object is already on the target system).

### Note:

- You can also optionally specify a command to be run on the target system after the package has been received and objects restored.
- You can update an existing snapshot package save file to be used for the next send.
- For dependent objects, such as a logical file and its associated physical file, you are responsible for defining the package to contain both objects, otherwise, the restore of a logical file will fail on the target system.

Starting with V5R1 you can create your own product of programs, files and other objects. You can install and test the product, create fixes for the product, send and install the product on multiple systems. Once created a product is treated as any other IBM or non-IBM product on the system for listing, distribution and inventory maintenance.
Any fixes to your product can be maintained, distributed and installed under the Inventory function as described under 2.2.3, “Configuration and Service” on page 16.

Management Central scheduling can be used to distribute the package/product. The package/product can also be defined to run a program after the distribution has successfully completed.

Figure 2-14 shows some of the steps to create a package and get ready to send it.

Figure 2-14  Packages and Products example

Packages and Products capabilities are accessed through the Management Central Definitions folder as shown at 1 in Figure 2-14.

In this example, after naming the package and specifying the system containing the objects we selected the Add button (2) to bring up a window showing the entire Integrated File Systems directory tree structure. We selected a program and a multiple member file from a QSYS.LIB library as shown at 3.

At 4 we have opened the Management Central Definitions package sub folder and selected to send, which enables us to select the target systems (Management Central Endpoint Systems or System Groups and optionally schedule the sending for a later time.

Details on Packages and Products functions are described in Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products, SG24-6564. See 6.10.2, “Defining and sending a package” on page 282 for a Packaging example.
General Management Central capabilities are described in Chapter 2, “Operations Navigator introduction” on page 11.

2.2.13 Monitors

The Operations Navigator Monitors component must be explicitly installed on your workstation. The Monitors component enables you to perform real-time monitoring of system activity, grouped into 3 categories - monitor types:

- Message monitors (new for V5R1)
- Job monitors (new for V5R1)
- System (performance metrics) monitors (available since V4R4, formerly known simply as a “monitor”)

The term metric is applied to the items that can be monitored.

Under Management Central you can run a monitor on one or multiple systems and view the monitor activity on those systems. All monitors are primarily intended for “real-time” display of information or automated action, rather than historical review, but each monitor does have an event log and system monitors support a new for V5R1 Graph History function.

If you wish, you can have the event log “open” on the desktop and see events as they occur. Depending on the monitor definition, you can define a monitor to run an OS/400 command when a certain condition occurs, and for a message monitor, give an automatic response to a message.

You can interface to defining a new monitor from several different Operations Navigator interfaces, including:

- My Connections system context menu (shown at 1 in Figure 2-15)
- Management Central Monitors folders (shown at 2 in Figure 2-15)
- When viewing messages on a message queue under Basic Operations > Messages
- When viewing a job under several Operations Navigator folders, such as Work Management > Active Jobs. Details on all interfaces to monitors and monitor capabilities are described in Chapter 6, “Management Central and Monitors” on page 181.
The following is a short summary of capabilities available with each monitor type:

- **System monitors**: A system monitor is intended to identify trends of increased or decreased hardware resource utilization or I/O activity that may require further investigation or indicate some action should be taken. You can define a monitor to graphically show the utilization of one or more of the metrics and optionally specify criteria for metric thresholds to be triggered or reset (for example, above 70% average system CPU utilization and later, below 10% average CPU utilization). At a trigger or reset occurrence a graph line color change will occur and optionally a command can be run.

While viewing the real-time graph data most metrics support identifying the “top 20” jobs or resources (depending on the metric) with highest utilization of that metric.

*New for V5R1*, you can hold, release, delete (end), and see job details similar to the Display Job (DSPJOB) OS/400 command and also through the Operations Navigator Work Management component.

*Starting with V5R1*, new Graph History can graphically display historical values for specific performance metrics monitored by a System monitor (and Collection Services).

System monitor details are discussed in this redbook in Chapter 6, “Management Central and Monitors” on page 181.

- **Job Monitors**: *New for V5R1* a job monitor is intended to monitor activity at a specific job level or groups of jobs level rather than system wide as a System monitor would be used for. Job level monitor metrics include hardware resource utilization or I/O activity, job status change (held, end, and so forth), job count and job log messages.

For hardware resource utilization or I/O counts you may use a monitor to identify one or more jobs consuming more or less resource than expected. For a job status change, for example the job ends, you may run a command that starts another application that processes the data created by the job that just ended.
Criteria for metric thresholds can be specified, that, when triggered or reset cause an event to appear in an event log you are reviewing. Similar to System monitors, you can define a command to be run when a threshold is triggered or reset.

Job monitor details are discussed in this redbook in Chapter 6, “Management Central and Monitors” on page 181.

- **Message Monitors:** *New for V5R1* a message monitor is intended to bring attention to a specific user that a specific message has occurred or for expected messages, take some automated action based on the message, such as a response to the message or run a command.

  You can define a monitor for specific message queues, specifying message IDs or message types or select from a list of IBM-supplied message titles without needing to know the associated message ID. One example of these IBM-supplied message titles is “auxiliary storage threshold reached”.

  You can also use a message monitor to automatically remove a message from the queue to keep the queue “clean” with only new messages.

  Message monitor details are discussed in this redbook in Chapter 6, “Management Central and Monitors” on page 181.

- **B2B Activity Monitors:** *Introduced with V5R1* Client Access Express service pack SI02795, you can monitor transaction activity for the Connect for iSeries product, 5733B2B. This redbook contains overview information on this monitor in 6.7, “Monitors” on page 240.

### 2.2.14 Logical Systems (logical partitioning)

OS/400 provides powerful Logical Partitioning (LPAR) support, that is, running multiple OS/400 or *new with V5R1* Linux “instances” on the same physical iSeries server. V5R1 level of LPAR support includes sharing processors among partitions and dynamic movement of processor, main storage and hardware I/O processors across partitions.

Partitions can be configured and managed through iSeries Dedicated Service Tools (DST) and System Service Tools (SST) 5250 workstation interfaces. In this topic we provide a moderately detailed overview of the *new for V5R1* Operations Navigator graphical interface to these LPAR capabilities.

A detailed description of iSeries Logical Partitioning capabilities is not included in this set of V5R1 Operations Navigator redbook volumes. For a complete description of iSeries OS/400 logical partitioning capabilities, including Operations Navigator interfaces, we refer you to the following:

  
  Select System Management -> Logical Partitions.


The Operations Navigator Logical Systems component (*new with V5R1*) must be specifically installed. Using Figure 2-16 on page 41 as a reference, you can access LPAR functions through the following folders:
My Connections system Logical Partitions (at A): You can configure and view partitions (A) on that system and move resources between partitions on that system. The right details pane (B) shows the currently defined partitions on system As01. This details pane information includes partition name, current status (On means Restarted (IPL-ed)), release level, and more.

The rightmost window (C) shows the existing partitions tree structure in the left pane and the Physical System hardware configuration in the right pane as part of the partition configuration process.

Management Central Systems with Partitions (at D): You manually add an iSeries server (at D), which enables the Management Central central system to retrieve LPAR information from that system through the Management Central server jobs on that system. Once that system information has been retrieved by the central system that system name appears as a tree folder under Systems with Partitions. From that folder you can view and configure the partitions and move resources on that system, similar to the way you do through the My Connections folder interface at A.

Important: You need two special setup steps performed before you can access the partition information:

1. You need an iSeries Service Tools user profile and password (independent of an OS/400 user profile) authorized to logical partition functions as you will be required to sign on to the service tools server to view and perform LPAR configuration. This is configured through the Dedicated Service Tools (DST) interface.

2. The Applications Administration component must have been used to explicitly enable access to LPAR Administration and Operation.

Only specific users should have access to these capabilities. Additional information on this subject is included in Chapter 12, “Application Administration component” on page 433.
With changing workloads in each partition, you may need to move a resource from one partition to another. For example, primary partition As01 is active during the 8:00 am to 06:00 pm time period. After that time, its resources could be moved to another partition (for example, As01c) that requires additional resources to complete its work before the primary partition again needs its normal resources.

With V5R1 you move the resources either through the 5250 workstation service tools interfaces or through the Operations Navigator interface, which also supports scheduling of the movement through Management Central facilities.

Figure Figure 2-17 shows some of the steps to move some main memory from the primary partition to secondary partition As01c.
In this example we selected system As01 from under Management Central Systems with Partitions to get a list of the partitions on system As01 and then selected the Primary partition to get the upper window of this figure. At 1 in the upper window we have selected Memory in the primary partition which brings up the left middle window at 2. Selecting the Move button brings up the lower right Move Memory window at 3.

In the Move Memory window we have selected to move 256 MB of main storage to partition As01c. In this window you can see memory status of the primary partition before and after the move. You can also see similar information for the target partition at A.

In the Move memory window you could chose the Schedule button to schedule the move for a later time. The scheduling function uses the Management Central scheduling capabilities which defaults to using the OS/400 job scheduling function (similar to the Work with Job Scheduler Entries (WRKJOBSCDE) OS/400 command). If the Advanced Job Scheduler has been installed as an Operations Navigator plug-in, the Advanced Job Scheduler interface will be used.
2.2.15 AFP Manager

The AFP Manager component must be explicitly installed on your workstation.

The AFP manager enables you to work with Advanced Function Print resources (including code pages, overlays, page definitions and segments, and more), font mapping tables, and PSF (Print Services Facilities) objects. PSF is included in 5722-SS1 OS/400 options 36-38.). Functions are access under the following My Connections system folders listed below as shown in Figure 2-18:

- **Resources**: You can view and manage code pages, coded fonts, font character sets, form definitions, overlays, page definitions, and page segments. You can import an AFP resource on a PC workstation and import it to the iSeries.
- **PSF Configurations**: You can view and create new PSF configurations including font usage, and output options such as creating the output as a print file, a byte stream file, or send as e-mail.
- **Font Mapping Tables**: Font mapping table support enables you to handle differences between fonts stored on your iSeries and your workstation printer. OS/400 has IBM-supplied mapping tables and you can create your own.

![Figure 2-18 AFP Manager folders example](image)

Chapter 10, “Advanced Function Printing (AFP) Manager” on page 373, provides additional overview information. For detailed information on using AFP Manager, see *iSeries Printing VI: Delivering the output of e-business*, SG24-6250.

**Note**: The AFP Manager is a completely separate product from the AFP Workbench Viewer, which ships as part of Client Access Express and is used to view and print iSeries Advanced Function Printing (AFP) and SNA character set (SCS) spooled files.

2.3 Cross-component functions

This section covers major functions that:

- Do not appear in the Operations Navigator major function (component) tree folder when expanding the functions under a particular My Connection system name or Management Central central system.
> Appear as a tree folder but are not explicitly selected as a component during Operations Navigator installation.

### 2.3.1 Application Administration

The Operations Navigator Application Administration component must be specifically installed on your workstation. It is a key component in helping a user with OS/400 "security administration" (*SECADM) system privilege (user class authority) to control which Operations Navigator components and functions are actually available to each signed on workstation user.

You can restrict some functions or object access by a specific user through standard OS/400 object-user profile permissions and/or Authorizations lists. For specific Internet functions you can use digital certificate support or authorization control lists.

Applications Administration can be integrated with these security interfaces.

This topic overviews only the "permissions" capabilities provided through Applications Administration. Chapter 12, "Application Administration component" on page 433, provides additional details.

You can access Application Administration functions at either the Management Central central system (1) or for a system under My Connections (2) as shown in Figure 2-19. The Applications Administration functions available under Management Central apply to the Management Central folders, such as Commands, Products and Packages, Monitors, Inventory and so forth. The Applications Administration functions available under My Connections apply to the folders for a system name under My Connections, such as Basic Operations and its folders, and Work Management and its folders.

The following overviews the Applications Administration functions available under My Connections for system As25b, grouped into three categories as shown in the window at 3:

- Operations Navigator components and Applications Administration itself. You can control the sub folder level function under each major component. For example, under Basic Operations you can specifically authorize access to the message folder functions, but not the print folder functions.
- Client Access itself
- Host applications, which includes TCP/IP utilities, Digital Certificate Manager, Simple Clustering support, Logical Partitioning, Disk management under Configuration and Service.

**Note:** When defining or editing a user profile you can also interface to the Applications Administration function for that user through an Operations Navigator Users and Groups interface.
You can restrict specific functions from use by individual users or groups of users with default authority, all object access privilege (that is, if a user has all object authority, they can use the function), and customized authorization. The customize button (A) enables you to specifically list users or groups as authorized for use or excluded from use.

As shown, only users with all object access system privilege can access any of the Basic Operations folder functions or the Configuration and Service System Values and Hardware folders.

### 2.3.2 Management Central

Operations Navigator Management Central is an integral part of overall management of many Operations Navigator individual functions which may be defined and initiated for a system under My Connections, as well as under the Management Central central system. Starting with V5R1 Management Central is not explicitly installed as part of Operations Navigator installation, as it was in previous releases.

Many of these functions associated with Management Central can be performed on a single or multiple iSeries servers and are discussed within other component topics in this chapter. However, this topic summarizes them in one place:

- **Inventory collection**: Hardware, software products, fixes, system values, and users and groups) and management functions based on that inventory data
- **Managing fixes**: Installing, cleaning up, searching for fixes on a system, sending and installing on remote iSeries servers, identifying missing and extra fixes
- **Managing software products**: Displaying and installing software products, searching for software, sending and installing products on remote iSeries servers
- **Managing user and group profiles**: Creating, deleting, sending, viewing, editing user and group profiles on multiple iSeries servers, searching collected user and group inventory information for users, groups, profile attributes, activities, and other “attributes”

- **Managing system values**: Comparing system values inventory information and updating system values on multiple iSeries servers

- **Managing packages of objects**: Defining a package of related objects such as programs and files, and sending and installing that package on multiple iSeries servers

- **Managing a user-defined application product**: Defining a product, similar to a licensed program and sending and installing that product and any associated fixes on multiple iSeries servers

- **Running commands**: Defining repetitively run commands and or “one time commands” and running them on multiple iSeries servers

- **Collecting performance data**: Running Collection Services on one or multiple iSeries servers that can later be analyzed by the PM/400 performance service or used by performance analysis and capacity planning tools such as is available through the Performance tools for iSeries, 5722-PT1 product. Operations Navigator V5R1 Graph History can graphically display this collected data over extended periods of time.

- **Scheduling, running, and monitoring Management Central tasks**: All the functions listed above can be run immediately or scheduled to run on multiple iSeries servers, using the OS/400 standard job scheduler support, or, optionally, the Advanced Job Scheduler licensed program, 5722-JS1. Task scheduling and activity is monitored.

- **Monitoring messages, jobs, or selected system performance metrics**: Real time monitoring, displaying, and optionally taking an automated action based upon monitor “events”. These monitors can run on multiple iSeries servers. Graph History functions work on data collected through the either a system monitor or Collection Services.

- **Managing iSeries from remote browsers or hand-held Personal Digital Assistant (PDA) devices**: Through the optionally installed and activated java servlet-based Management Central - Pervasive tool one of these remote devices can view and take advantage of functions provided by active system, job, and message monitors and manage inventoried Integrated xSeries Servers for iSeries.

- **Configuring and managing endpoint systems and system groups**: Management Central functions can be specified to run on iSeries servers included under Management Central Endpoint Systems as individual systems or under Management Central System Groups as a group of endpoint systems identified by a system group name. A system group is a convenient way to specify running a task on multiple systems without having to individually select each system. An endpoint system enables you to perform a function on that system without requiring an active session under My Connections.

- **Configuring and managing logical partitions**: Configure partitions, view partition configuration and move resources (processor, main memory, I/O components between partitions, optionally using the Management Central scheduling functions for resource movement.

- **Configuring and managing simple clustering**: Configure independent disk (auxiliary) storage pools and 2 iSeries server cluster nodes and switch the independent auxiliary storage pool between systems or partitions on the same system.

- **Configuring and managing Extreme Support**: Configure and connect your iSeries server to the IBM iSeries services Web site — user profiles on those systems)
Although Management Central is no longer explicitly installed starting with V5R1, a Management Central central system must be active and “signed on to” to perform most of the functions described earlier in this topic. In a single system environment Operations Navigator assists you in configuring a central system with the same name as you have under the My Connections folder.

New for V5R1 the Scheduled (not yet run) Tasks and Task Activity (currently active or already completed tasks) are categorized into “task types”, for quicker access:

- Commands
- Packages and Products
- Inventory
- Fixes
- Collection Services
- Users and Groups
- Logical Partitions
- System Values
- Clusters
- Logical Partitions including partitioning configuration and, new for V5R1 partition resource movement

Additional Management Central overview information is contained in Chapter 6, “Management Central and Monitors” on page 181. Inventory collection set up and monitor support are covered in this chapter as well.

Details on other functions are not included in this redbook. Refer to other topics in this chapter for additional documentation references or refer to 1.3, “Operations Navigator major components and redbooks” on page 4.

For the latest information on Management Central, including how to obtain, configure and operate Management Central - Pervasive, refer to:

### 2.3.3 Clusters

Cluster support (associating systems and system resources that enable one iSeries server to “take over for another iSeries server”) has been available through the base OS/400 5250 workstation interface since V4R4. High Availability business partners use the OS/400 support and their own product to implement various multiple iSeries servers and communications configurations to automatically take over for a system that is temporarily no longer available.

Starting with V5R1 there is new “simple clustering” or “switched disk” support that makes it relatively easy to move hardware resources from one of two iSeries servers to the other that will take over running the application. One simple use of this support would be where one of the iSeries servers needs to be shut down for either hardware or software maintenance.

The word “simple” is used because there are only two systems involved and the switch over is done manually without sophisticated automatic take over of such things as IP address. The term switched disk is used to emphasize that the primary resource configuration supported are disks configured into a new for V5R1 Independent (Private) disk pool.

Though the term is not used within Operations Navigator, some people refer to an Independent disk pool as an IASP - Independent Auxiliary Storage Pool. In this redbook we use the term independent disk pool.

With V5R1, Operations Navigator builds on its previous release capability to assign disk devices to disk pools by adding the capability to assign disks to an independent disk pool.
The V5R1 Clustering folder supports the configuring of two iSeries servers as a cluster node. With this V5R1 clustering support you can manage the cluster node resources and switch the independent disk pool between each node (system) within the cluster node.

Even the simple clustering support requires careful planning at both the hardware configuration level and the orderly quiescence of active applications before performing the switch over.

For more details on this simple clustering support refer to:

- Information Center at either CD-ROM SK3T-4091 or Web site http://www.ibm.com/eserver/iseries/infocenter. Select System Management -> Clusters
- For details on V5R1 simple clustering support refer to Clustering and iASPs for Higher Availability on the IBM iSeries Server, SG24-5194.

Figure 2-20 is an example showing an already configured “simple clustering configuration” with two nodes (As01 and AS01c) and an independent disk pool Iasp2 (previously configured using the Operations Navigator Configuration and Service, disk hardware interface).

The window at 1 shows the Management Central central system (As01c) Clusters folder Onrb, which is used to manage the two nodes. The two nodes are communicating with each other (status is Started), and independent disk pool Iasp2 is treated as switchable hardware (at 2).

Context sensitive menus enable you to perform the switch as shown at 3.
2.3.4 Inventory

The Inventory function is discussed under other Operations Navigator component topics in this chapter. Since inventory information is key to being able to perform certain functions under those components and functions based upon that inventory can be invoked from several different Operations Navigator context menus, this topic is used to summarize general inventory capabilities in one place:

- **Hardware features installed on the inventoried systems**: You can display and search for certain hardware features per the inventory information from one or more systems.

- **Software (products) installed or not installed on the inventoried systems**: You can identify products installed or not installed (the system does not have the product installed, but supports the product including distributing fixes for other iSeries servers). You can search the inventoried systems for product information.

- **Fixes installed on the inventoried systems**: You can compare for missing and extra fixes based upon a model system. You can send missing fixes or new fixes (and optionally install) for specific products on remote systems. You can view and search the inventoried systems for fixes by fix number or product number.

- **System Values (new with V5R1) on the inventoried systems**: You can compare an update system values on systems, based upon a model system.

- **Users and Groups (new with V5R1) on the inventoried systems**: You can scan for owned objects for a user on the inventoried systems. For inventoried users and groups you have advanced search functions including searching for users and groups and associated “attributes”, such as last signed on date, privilege class, and more.

You can export each collected inventory to a PC file with various file formats.

To perform the set of supported functions for Hardware, Software, Fixes, and System Values you must have the Configuration and Service component installed and available on your workstation.

**Important**: For V5R1 simple switched disk support, you must have the following installed or set up on each of the two systems that will be used to switch the disk configuration:

- **5722-SS1, Option 4, Feature 5116**: OS/400 HA Switchable Resources (additional cost) installed.

- You need an iSeries Service Tools user profile and password (independent of an OS/400 user profile) authorized to use disk hardware configuration (to view and configure disks to an independent storage pool) under the Configuration and Service Hardware folder.

  This is configured through the Dedicated Service Tools (DST) interface.

- The Applications Administration component must have been used on Host Applications to explicitly enable access to Cluster Administration and Operation, as well as Disk Management.

- A file system other than QSYS.LIB mounted on disks assigned to the Independent Auxiliary Storage Pool. QSYS.LIB objects, including OS/400 journals, will be supported on a release following V5R1.

Only specific users should have access to these capabilities. Additional general information on service tools security and Application Administration for clustering functions is included in Chapter 12, “Application Administration component” on page 433.
To perform the set of Users and Groups functions, you must have the Users and Groups component installed and available on your workstation.

Inventory is generally discussed in Chapter 6, “Management Central and Monitors” on page 181 of this redbook, but more detailed information is contained in Managing OS/400 with Operations Navigator V5R1, Volume 3: Configuration and Service, SG24-5951 and Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227.

**Important:** Remember that inventory-based functions are based upon the most recent inventory collection time stamp. For example, if you perform the compare and update system values function on June 27, 2002, with inventory data collected on March 23, 2002, you may not achieve the results you expect. You are responsible for using the appropriate inventory data, though many Operations Navigator windows and wizards assist you in this by “highlighting” the last collected time stamps.

### 2.3.5 Operations Navigator online help

Operations Navigator has significant online help information, enhanced in V5R1. Ways to access this information include:

- On the main Operations Navigator window you can use the menu bar Help to:
  - Select Help topics to access:
    - An index tab with search words across all Operations Navigator functions
    - What's new for V5R1
    - What can I do with....
      This expands into a significant set of information in the online Help, organized according to the primary folders in the left pane on the main Operations Navigator window.
    - What functions are available with each OS/400 release
    - Links to related Operations Navigator information on the Internet
  - Access to Information Center (on the local system's Information Center articles included on the CD-ROM shipped with your new release or access to the Information Center articles located at the iSeries Information Center Web site. Over time, the Web site would have more up to date information than the CD-ROM.
- On most Operations Navigator “specific component” windows there is component specific online Help information, accessed either via a Help button or a (?) symbol for field level help.
- *New for V5R1* “Help for related tasks” selectable on the major Operations Navigator windows taskpad area.

These help access options are discussed in more detail in this redbook in Chapter 3, “Installation and general navigation” on page 53.

### 2.3.6 Plug-ins overview

- There is no specific Plug-ins component. Rather, as part of Operations Navigator installation or later using Selective Setup under Client Access Express on your desktop, or a context sensitive menu, you can select to have a properly “registered” application installed on an iSeries server installed as a plug-in on your workstation.
Plug-in support is generally described in Chapter 11, “Plug-in support” on page 385. The following applications are used as plug-in examples:

- Advanced Job Scheduler
- Backup and Recovery Media Services
- Domino
- OnDemand

The application must be first installed on one of the iSeries servers you are connected to and can be used independent of the Operations Navigator interface, for example using OS/400 5250 command interfaces. The advantage of installing an application as an Operations Navigator plug-in is to use Operations Navigator’s graphical interface to more easily take advantage of the application’s functions.

Figure 2-21 shows an example of a context sensitive menu item to install plug-ins in the left window, and the installation wizard window after system As01c has been scanned to see the list of registered plug-ins, You can select to install any or all of the identified plug-ins onto your workstation.

2.3.7 Summary

After reviewing this overview chapter you can see V5R1 Operations Navigator enables you to use graphical interfaces to the powerful set of iSeries functions and the capability to manage use of these functions.

Those familiar with the OS/400 command interface to iSeries capabilities can “have the best of both worlds”. When the graphical interface is the easiest or only way to perform a function Operations Navigator is there for you. You should use the command interface where appropriate, such as putting a set of OS/400 command into a program to automate a function.

This overview should have given you a desire to use the Operations Navigator interface as a first choice. The enhanced for V5R1 Operations Navigator online Help information should be reviewed before looking elsewhere for assistance. The wizards and Help Topics - What can I do with...?” are great places to get assistance when performing a task through Operations Navigator. Section 3.5.1, “Help information and sources” on page 113 include examples of using this online Help information.
Use 1.3, “Operations Navigator major components and redbooks” on page 4 for a quick way to find documentation that has more details than this overview chapter. The preface of each Operations Navigator volume includes an overview of the contents of all of the Operations Navigator redbook volumes. In most cases you should need to reference only this Volume 1 redbook in addition to the volume you are reading to take full advantage of the function you are reviewing.
Installation and general navigation

This chapter describes the Operations Navigator hardware and software requirements, overall installation process as part of Client Access Express installation, and general navigation to access Operations Navigator functions and control what is viewed on a window.

The requirements and installation section includes:
- iSeries and OS/400 hardware and software resource requirements for Operations Navigator functions
- PC workstation software and hardware requirements for Operations Navigator functions
- Operations Navigator installation options
- Client Access Service Pack installation which could include Operations Navigator fixes
- Connecting to an iSeries server
- Using Function Availability to determine which functions you should be able to access on your workstations
- General installation of Operations Navigator plug-ins

The general navigation section should be used as the basis for understanding how to use Operations Navigator general navigation techniques to control what is viewed on an Operations Navigator window, and generally how to access Operations Navigator functions described in other chapters of the V5R1 Operations Navigator redbook volumes.

Topics in this section include:
- Use of menu bars, tool bars, and context sensitive menus
- Accessing functions from a system name under a “My Connections” environment or at a higher level under Management Central
- Controlling columns of information displayed and the order in which a list of information is displayed
- Use of shortcuts and desktop icons to quickly access specific functions
- Use of the new for V5R1 Taskpad area to quickly access specific functions
3.1 Operations Navigator requirements and installation

Installation of Client Access Express and Operations Navigator in V5R1 is easier and more flexible than with previous releases. This section describes:

- iSeries and OS/400 hardware and software resource requirements for Operations Navigator functions
- PC workstation software and hardware requirements for Operations Navigator functions
- Operations Navigator installation options
- Client Access Service Pack Installation which could include Operations Navigator fixes
- Connecting to an iSeries server
- Using Function Availability to determine which functions you should be able to access on your workstations
- General installation of Operations Navigator plug-ins

In order to use AS/400 Operations Navigator, you need to satisfy the following iSeries or AS/400 system and PC client workstation requirements.

3.1.1 iSeries server requirements

V5R1M0 Client Access Express is required to perform all the V5R1 Operations Navigator functions. The following OS/400 options and licensed programs are required on your iSeries server:

- Operating System/400, 5722SS1 at V5R1M0
  V5R1M0 is required for all V5R1 Operations Navigator functions performed from a client PC workstation with V5R1 Client Access Express Operations Navigator installed.
- iSeries Client Access Express 5722XE1 V5R1M0 licensed program installed
- TCP/IP Connectivity Utilities (5722TC1) licensed program installed
- Host Servers (OS/400 install option 12) installed
- IBM (AS/400) Toolbox for Java (5722JC1)
- IBM Developer Kit for Java, at least JDK 1.1.8

All of the above requirements are “no charge”, but TCP/IP Connectivity Utilities and Host Servers must be explicitly installed. Other licensed programs or OS/400 options may need to be installed to access some functions within AS/400 Operations Navigator.

For example, to use OS/400 Secure Sockets Layer (SSL) support with Operations Navigator requires:

- No charge Digital Certificate Manager (DCM) OS/400 install option 34
- No charge IBM HTTP Server for iSeries (5722DG1) V5R1M0 LPP or IBM HTTP Server for iSeries (5722DG1) licensed program
- One of the no charge IBM Cryptographic Access Provider products that provide encryption key and data encryption support: 5722AC2 (56-bit), or 5722AC3 (128-bit)
Additionally, for one or more Client Access Express functions, including Operations Navigator, to use SSL, you must also install a corresponding client workstation Client Encryption product: 5722CE2 (56-bit), 5722CE3 (128-bit) under V5R1M0.

For more information on SSL support, refer to the following:
  - Securing Client Access Express and Operations Navigator
  - Securing Management Central
- Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566, which contains an SSL example

The functions available from the client workstation running Operations Navigator vary between different release levels of the Operating System/400. For a summary of functions by release, see “Operations Navigator release cross reference” on page 474.

**Tip:** The only software requirement for Operations Navigator to connect to your iSeries or AS/400 system is OS/400 Option 12 Host Servers. If you are installing Operations Navigator from an iSeries server, then Client Access Express, 5722-XE1 is required on the system that you install from. If you wish to use components such as PC5250 or Data transfer that require a license, you will need to install 5722-XW1 for V5R1 or 5763-XW1 for V4R5 or lower.

### 3.1.2 PC client workstation requirements

To use Operations Navigator, your PC client workstation must meet the software and hardware requirements described in this topic.

An IBM-compatible PC is required with these operating systems installed: Microsoft Windows 95, Microsoft Windows 98, Microsoft Windows Me, Microsoft Windows NT 4.0, Microsoft Windows 2000, or Microsoft XP Professional.

iSeries Client Access Express V5R1M0 must be installed on the workstation to use V5R1 Operations Navigator functions. When installing Client Access Express you must specifically install the Operations Navigator component and one or more Operations Navigator subcomponents. You can use Client Access Express Selective Setup to select all or specific Operations Navigator subcomponents after the original installation on the workstation.

Client workstation hardware and software requirements are listed below:

- Additional information on selecting all or specific Operations Navigator sub components is described 3.2.2, “Types of installation” on page 58 and 3.3, “Installation example: Tailored installation image” on page 63.
- Windows 95/98/2000/Me/XP, NT 4.0 client workstation hardware:
  - Processor: Pentium 200Mhz or faster (400 Mhz or faster is recommended)
  - Memory: 64MB (128 MB or more is recommended)
  - Hard disk: This is dependent on what Operations Navigator functions are installed and will be used
- For Windows XP Professional installed:
  - V5R1 Client Access Express installed. Refer to the Support Statement in Information APAR II12900 for requirements, restrictions, and a link to Management Central fixes.
For Windows 2000 installed:
- V4R4M0 with service pack SF60698 or later (IBM special bid support required)
- V4R5M0
- V5R1M0
- Refer to Support Statement in Information APAR II11853
- Also see Information APAR II12664 "Known Problems/Restrictions When Using Windows 2000 and NTFS Write Restrictions on Client Access Express Directories (V4R4M0 and V4R5M0)"
- Also see Information APAR II11791 "Client Access Express Support on VPN Connectivity". This info APAR contains requirements for VPN connections, which include the Windows 2000 operating system.

For Windows Me installed:
- V4R5M0 with service pack SF62213 or later
- V5R1M0
- Refer to Support Statement in Information APAR II12268

For Windows 98 installed:
- V4R4M0 (IBM special bid support required)
- V4R5M0
- V5R1M0
- Refer to Support Statement in Information APAR II11274

For Windows NT 4.0 installed (Service Pack 5 or later):
- V4R4M0 (IBM special bid support required)
- V4R5M0
- V5R1M0

For Windows 95 installed:
- V4R4M0 (IBM special bid support required)
- V4R5M0
- V5R1M0

Use the following URL to view the latest Client Access Express Windows operating system information:

http://www-1.ibm.com/servers/eserver/iseries/access/supportedos.htm

**Note:** Operations Navigator support does not require PC5250 emulation or Data Transfer components. If you want to use 5250 emulation or Data Transfer, they are licensed functions under the Client Access Express client and are available at an additional cost.

### 3.2 Installation introduction

Operations Navigator is installed as a component of iSeries Client Access Express. During a Custom installation, you can select some or all of the separate subcomponents of Operations Navigator to be installed on the client workstation.

Installation of specific subcomponents per workstation will vary according to your working environment. You may not want some client workstations to have Operations Navigator installed or want only some Operations Navigator subcomponents installed on specific client workstations.
The installation source (CD-ROM or iSeries server) also affects the installation process. For example, SSL support and plug-ins are not available when installing from the V5R1 iSeries 400 Setup and Operations Version 5, Release 1, SK3T-4098 — CD-ROM.

Subsequent topics in this chapter discuss Client Access Express installation types and installation options. For the most complete installation information, including configuration of Netserver, refer to Client Access Express for Windows - Setup, SC41-5507, available from the iSeries Information Center CD or online at:

http://www.ibm.com/eserver/iseries/infocenter

Click Client Access Express -> Manuals and Redbooks -> Client Access Express for Windows - Setup.

Client Access Express makes service packs (contain several fixes for Client Access and Operations Navigator functions) available approximately every 4-6 months. After the initial installation of Client Access Express and Operations Navigator components, we recommend keeping your Client Access Express Service Pack level current. See “Service packs overview” on page 69, for more information.

3.2.1 Installation sources

Client Access Express uses an installation wizard to enable selection of components for installation to the client PC Workstation. You may install from the following installation sources:

- **CD-ROM:** The installation software is available on the iSeries 400 Setup and Operations Version 5, Release 1, SK3T-4098 — CD-ROM. If the autorun function is enabled, your PC will launch the Welcome screen and give you the option to install Client Access V5R1M0. If the installer does not automatically run, you can launch the setup process by running launch.exe from x: (where x is the letter of the CD-ROM drive).

  **Attention:** The software installed from the iSeries 400 Setup and Operations Version 5, Release 1, SK3T-4098 — CD-ROM must have service pack SI01037 or higher applied after installation. SI01037 is a required service pack for V5R1M0. This service pack code for your client workstation is on the iSeries Operations Console Update Version 5, Release 1, SK3T-4114 — CD-ROM. To install this service pack, insert the CD and run x:\setup (where x is the letter of the CD-ROM drive).

  See “Service packs overview” on page 69 for more information.

- **NetServer Share:** With Client Access Express V5R1M0 (5722XE1) installed on your iSeries server and OS/400 Netserver configured and active, you can install Client Access Express from the Integrated File System on that iSeries server. The install image is stored in \QIBM\ProdData\CA400\Express\Install\Image.

  For the first (original) installation, the installation wizard knows the iSeries server you are connected to so you just have to follow the wizard's instructions. This installation will include options to install plug-ins, SSL, secondary languages, and add-ins.

  For a selective install (after the original Client Access Express installation), you are prompted for a source path. Using system As01c as an example, specify \QAs01c\QIBM.

  The original installation and selective setup (describe later) installation process will include the option to install plug-ins and SSL support if the requirements have been met on the iSeries server.
This description assumes the NetServer on As01c is set up correctly. The initial “Q” character depends on your OS/400 configuration for OS/400 NetServer and is not required with V5R1. Refer to Client Access Express for Windows - Setup, SC41-5507, for more assistance in setting up OS/400 NetServer.

▲ Peer Server: You may copy the install image files from CD or from the NetServer share to a peer server and use a mapped network drive from the client workstation to the peer server. The install image files are located in the Express\Install\Image directory in QIBM\ProdData\CA400\Express\Install\Image on the Peer server.

Notes:

1. To use an iSeries server name as we do in our examples, you must have a Domain Name Services (DNS) server in your network and your client workstation TCP/IP properties DNS parameters specified to use that DNS server. Also the iSeries server must be defined to use that DNS server and the iSeries server name must be known to that DNS server. The DNS server could be active on the same iSeries server you are connecting to or some other system and product that provides DNS support. Alternatively, you can specify the iSeries server name and its associated IP address in the PC’s host or LMHOSTS table that is provided by the Windows operating system.

2. When installing from a peer server, the service pack level depends on where you copied the install image from. If you copied the image from the NetServer share, then the install code will be at the service pack level (also called Program Temporary Fix or PTF) that was applied to the 5722-XE1 product at the time the copy was made. If you copied the install image from the CD, you will need to apply the latest service pack. For more information on Client Access service packs, see “Service packs overview” on page 69.

3. When installing Client Access Express or a Client Access Express Service Pack from a NetServer share, you must have the OS/400 NetServer server (and its associated jobs) started on the iSeries server. This server is shipped with the IBM default to start when OS/400 TCP/IP is started. However, someone may have changed this to not start or the NetServer may have been ended. You can start, stop, and configure NetServer through Operations Navigator My Connections system name -> Network -> Servers -> TCP/IP and select the NetServer in the list of servers. You may also start the NetServer through Start TCP Servers (STRTCPSVR) command: STRTCPSVR SERVER(*NETSVR).

3.2.2 Types of installation

iSeries Client Access Express V5R1M0 offers four installation types:

▲ Typical
▲ PC5250
▲ Custom
▲ Full

The only Operations Navigator subcomponents (of Client Access Express) installed in a Typical installation are Operations Navigator Base Support and the Basic Operation subcomponent.

To install all Operations Navigator components (sub components of Client Access Express), you must select a Full installation type. To selectively install Operations Navigator components, you must select a Custom installation.
An example of the Operations Navigator components that can be installed during an installation (or later, after the original installation, Selective Setup) is shown in Figure 3-1 with check marks against components installed in a Typical installation.

![Component Selection](image)

**Figure 3-1** Typical installation with typical components pre-selected

The list of Operation Navigator components that can be installed are:

- Basic Operations
- Work Management
- Configuration and Service
- Network
- Security
- Users and Groups
- Database
- File Systems
- Backup
- Application Development
- Commands
- Packages and Products
- Monitors
- Logical Systems
- AFP Manager
- Application Administration
- Plug-ins

Note that starting in V5R1 Management Central is not a specifically installed Operations Navigator component. Management Central support necessary to perform the functions in a specifically installed component, such as Monitors or Packages and Products, are implicitly included when that component is installed.
3.2.3 Other installation options

In addition to the standard installation types available from the Client Access Express installation wizard, there are a number of other installation options. We overview these options in this topic:

- Selective setup
- Migration wizard
- Silent installation
- Tailored installation image
- Installing plug-ins

We use the Tailored installation image option as our installation example in “Installation example: Tailored installation image” on page 63.

For more information regarding the different types of installation and installation options, refer to Client Access Express for Windows - Setup, SC41-5507.

Selective setup

After Client Access Express is installed on your workstation, the Selective Setup application allows you to further modify the installation by adding or removing individual components of the product. You can launch selective setup by using either of the following sequences:

- From the Windows desktop, select the IBM AS400 Client Access Express icon (folder). Select Selective Setup from the IBM AS400 Client Access Express window

- From the Windows desktop, select the My Computer icon, select Add/Remove Programs from the Microsoft Windows Control Panel, and then select IBM AS/400 Client Access Express for Windows. Select Selective Setup from the next window.
From the Windows desktop, select the Start button, then Programs -> IBM AS/400 Client Access Express -> Selective Setup.

From the main Operations Navigator window, select a system you are in session with (signed on). Select File from the menu bar. Select Selective Setup from the File menu. See “General navigation” on page 82 for more information on connecting to a system and use of the menu bar.

If you run Selective Setup from the Microsoft Windows Control Panel, you have the additional options of uninstalling the entire Client Access Express product and also the option to re-install the product. Re-installing can be useful if the files or code on the workstation are damaged.

You are given the option to choose an installation source or to ignore an installation source if you are only going to uninstall components. Choosing the installation source will allow you to install components that are available from that source. For example, if you wish to install SSL support you will only be able to do this from a suitably configured iSeries or AS/400 system. For more information refer to Section 3.2.1, “Installation sources” on page 57.

Selective setup is the first option to consider for restricting which Operations Navigator functions are available from a specific workstation.

**Important:** If you are using Selective Setup to add a component to your workstation, you must use an installation source that is at the same Client Access Express service pack level as your workstation, or re-apply your service pack after installation.

**Migration wizard**

The migration wizard is invoked when the Client Access Express installation program detects that 5769-XD1 Client Access for Windows 95/NT was previously installed on your workstation. The migration wizard's appearance is dependent on the 5769-XD1 version of Client Access having been previously installed. For more information in respect to the migration wizard, please refer to Client Access Express for Windows - Setup, SC41-5507.

**Silent installation**

A silent installation allows you to create a dedicated installation for users that does not require user interaction to install or migrate the product. This is done by creating a response file that is read by the setup process to automate the installation or migration. For more information on silent installation, refer to the V5R1 InfoCenter CD-ROM or Web site at:

http://www.ibm.com/eserver/iseries/infocenter

Click Client Access Express -> Administering Client Access Express -> Installing or migrating on multiple PCs -> Installing or migrating silently

**Tailored installation image**

You can use the Tailored Installation wizard provided with Client Access Express to create a tailored installation image containing only the components you need for installation. This has the advantage of being able to provide an installation source that both reduces the size of the installation image and restricts the install options available. You can run this utility by running cwbinimg.bat from the Install Image directory, either from the NetServer share or from the iSeries 400 Setup and Operations Version 5, Release 1, SK3T-4098 — CD-ROM. This will begin the tailored installation process. The CD-ROM will also allow you to run the tool using the autoplay feature or by manually running x:\launch.exe where x is the letter of your CD-ROM drive.
Installing plug-ins

Plug-in support provides the capability to integrate (plug-in) custom tools and applications with formally supported Operations Navigator functions. This integration includes adding new “tree branches” folders (this term is defined in “General navigation” on page 82) in the Operations Navigator navigation tree hierarchy and selectable items to existing context menu list of items. This enables applications to be accessed and managed as if they were part of the standard Operations Navigator navigation tree of functions.

An application has to be registered to Operations Navigator as a plug-in. Key IBM-provided plug-ins for V5R1 include:

- Advanced Job Scheduler (5722JS1)
- Backup and Recovery Media Services (5722BR1)
- Domino for iSeries, 5722LN1
- OnDemand for iSeries, 5722RD1

You can install plug-ins during your original installation if your install source is an iSeries with the plug-in application installed.

After starting the Operations Navigator and connecting to the iSeries the Autodetection of Plug-ins is started and a window showing registered plug-ins, if any, is shown. From that list you can select to install none or each registered plug-in.

Figure 3-2 shows an example of a plug-ins automatically detected window.
Chapter 11, “Plug-in support” on page 385 contains a more complete overview of Operations Navigator plug-in support.

Plug-in support has been available for Operations Navigator prior to V5R1. V5R1 Autodetection makes it easier to install a plug in after the original install.

### 3.3 Installation example: Tailored installation image

We show the new for V5R1 Tailored installation image wizard as an example for Client Access Express and Operations Navigator installation. While you are not actually installing Client Access and Operations Navigator components on a workstation in this example, the Component Selection window and most of the other windows in this example are similar to the ones you would see doing a Custom installation.

In this example, we create an installation image that later would be used to install Client Access Express and Operations Navigator on a workstation.

Figure 3-4 and Figure 3-5 show the options to take from the CD-ROM to use the Tailored Installation Wizard.
From the Installation menu on the CD-ROM you can access a number of options. *Set up your iSeries 400* allows you to configure your operations console or twinaxial attached console when installing a new iSeries server. *Install Client Access Express for Windows (V5R1M0)* takes you to the Installation Wizard for Client Access Express where you would do a Typical, Custom, or Full (and PC5250) installation.

To access the Tailored Installation Image Wizard, select the *Additional information and tools* option, which leads to the window shown in Figure 3-5.
Within the *Additional Information and Tools* menu, you can view or print the *Client Access Express for Windows* - Setup, SC41-5507, manual in PDF or HTML format and access various IBM Web sites.

In this example, however, we select *Create tailored installation image for Client Access Express for Windows*.

From this point, the steps are the same as launching `cwinimg.bat` from the Install Image directory, either on the CD itself or from a Netserver share.

![Figure 3-6 The Create Tailored Installation Image window](image1)

Figure 3-6 shows the welcome window to the Create Tailored Installation Image tool. This window introduces the tool and gives you a quick overview of the function that it provides. Clicking the **Next** button, brings up the Select Language dialog box as shown in Figure 3-7.

![Figure 3-7 The Select Language dialog box](image2)

The language selection dialog box allows you to select the install language for the image you are creating from a list of supported languages that can be shown by clicking the down arrow on the right of the language field.

Note, the available languages are dependent on your installation source. On the Client Access Express CD-ROM there will be only one language, per your order. In the install source is an iSeries server any installed primary and secondary language is available for selection.
In this example we have selected 2924 - English. Click the Next button to bring up the Select Destination Directory dialog box as shown in Figure 3-8.

With this window you can select the directory where the tailored installation image files are to be created. This defaults to C:\Client Access Install Image.

Clicking on the Browse button allows you to select a directory or network drive, or to manually enter a destination directory. If the destination directory does not exist, you will be prompted to create it. Once you have selected a destination directory, click Next to proceed.

The install process will scan for available components and then present you with the Components Selection dialog box as shown in Figure 3-9.

Tip: Ensure the directory where you create the installation image is accessible by the users who need to install Client Access Express, or plan to copy the installation image to such a location so your users can access it.
The component selection (Figure 3-9) windows shown here are similar to the ones that would be shown for Custom installation and the Selective setup option.

Note that, like an install from CD-ROM or a network drive, you cannot install SSL or plug-ins when creating a tailored installation image, even if using a NetServer share.

Select your required components for the custom image. In this example we have deselected Operations Navigator Security and Logical Systems subcomponents, which would not appear on any client workstation that installs Client Access Express with this installation image we are creating.

Notes:

- By default all Client Access Express components are automatically selected (check marked) in a **Tailored** installation. **Custom** installation defaults to components that would be in a **Typical** installation. Selective setup defaults to selecting what is already installed on the workstation.

  You should carefully review the selected items to verify what you actually want to installed.

- When you deselect a Client Access Express component including Operations Navigator components, the wizard validates any cross component dependencies. You will be
prompted if other components are found to have a dependency on the deselected component. You can either also deselect these dependent components or select the component you originally deselected.

Once you are satisfied with your component selections click Next to continue. This brings up the Start Copying Files window shown in Figure 3-10.

![Start Copying Files window](image)

Figure 3-10 The Start Copying Files information window

Use the Start Copying Files window to verify your installation image destination directory and selected components. When satisfied, click Next to begin copying the files.

If not satisfied with your current settings and destination directory, do not click Next. You may either click Back to go back and change any details or click Cancel to exit without starting the copy files process.

Assuming you clicked Next, the copying files window shows messages indicating the copy progress. When the copy has completed successfully, you get the window shown in Figure 3-11.

![Create Tailored Installation Image complete window](image)

Figure 3-11 The Create Tailored Installation Image complete window

Click Finish. Your installation image has now been created.
If you had been performing either the **Custom** installation or Selective Setup, you may be presented with a window that requests you to re-start your client workstation to have the installation become active. This is dependent on whether Client Access Express determines the restart is required.

After an actual installation of Client Access Express - Operations Navigator onto a client workstation and having restarted you workstation (if necessary), select the Operations Navigator icon on your desktop. This brings up the initial Operations Navigator window. Since you do not have an Operations Navigator connection to an iSeries server defined you get a prompt window requesting a connection be defined.

The window enables you to specify a system name (known by a Domain Name Services (DNS) server in your network or a name-IP address entry made in your Windows operating system host/LMHOST file). The value you specify can be the simple system name, the fully qualified domain name (for example, iseries01.ibm.com) or the actual IP address.

After entering values into other prompt fields, you click the **Verify** button and Operations Navigator verifies your connection to that system.

This defining a connection process must be replicated for each iSeries server you wish to connect to.

“Setting up connections” on page 74 describes how to define (set up) a connection to an iSeries server.

### 3.3.1 Service packs overview

Client Access Express service packs provide a group of fixes for Client Express and Operations Navigator functions. V5R1 Service Pack SI01037 is part of the initial installation of Client Access Express. We used service packs SI01907 and SI02795 (available February, 2002) to develop the V5R1 Operations Navigator redbook volumes.

New service packs are typically available every 4-6 months. We recommend keeping your Client Access Express Service Pack level current. For the latest service pack information you can periodically review information at:

http://www.ibm.com/eserver/iseries/clientaccess

Select **Service Packs**.

At this Web site you can also register your e-mail address to be automatically notified when a Client Access Express service pack becomes available.
You should always review the readme file (service pack downloaded to a PC workstation) or the OS/400 fix cover letter (service pack ordered as an OS/400 fix) before installing the service pack and resuming normal operations.

The readme file or cover letter may recommend additional iSeries fixes or require some configuration set up to take full advantage of the fixes contained in the service pack.

Before describing installing a Client Access Express service pack we give some examples showing how to find out at what Client Access Express service pack level you are already at on both the iSeries server and your client workstation.

**Verifying Client Access Express service pack level on the workstation**

Select the IBM AS400 Client Access Express icon on your desk top. This brings up a window showing several grouped Client Access functions including Express Toolkit, Service, ... Operations Navigator, Client Access Properties, ... Selective Setup, ... and more.

Select **Client Access Properties** which brings up the General tab properties window shown on the left in Figure 3-12.

![Figure 3-12 Client Access properties - service information](image)

In the General properties window you can see the Client Access Express version and service pack level installed on your workstation. We clicked the Service tab to get the service properties shown in the right window. We highlight the source directory.
Note the *When to check service level* values and *Install options*.

**Comparing workstation, iSeries server service pack levels**

Based on the *When to check service level* settings as illustrated in Figure 3-12, you may be notified when either the iSeries or the workstation are at different Client Access Express service levels.

To explicitly compare service levels, Select the IBM AS400 Client Access Express icon on your desk top. Select Service. Select Check Service Level. This brings up the window shown in Figure 3-13 that contains a summary of the service pack level on both the client workstation and the iSeries server from which both Client Access Express and its service pack have been installed.

![Figure 3-13 Comparing service pack level on both the client workstation and iSeries server](image)

Here you can see both the workstation and the iSeries (defined as the "H" network drive) are at the same service pack level. Your network drive to the iSeries must be active for this comparison to complete successfully.

This comparison also works if you installed using the OS/400 NetServer syntax.

The following topics give additional information on installing a service pack

**Applying service packs to an installation image**

This topic applies to any installation image using either a peer server (network drive) or NetServer server in an iSeries directory path `\qibm\proddata\ca400\express\install\image`.

Previous versions of Client Access have been limited in how to integrate the service packs with the installation process to provide a seamless install. When installing from a peer server, NetServer, or CD prior to V5R1, you were required to install Client Access and then install the service pack as separate steps.

With the V5R1, after installing the service pack as an iSeries fix, the resulting image is created at the same service pack level as the source. For example, assume you ordered and installed the Client Access Express service pack as an iSeries fix. Then you load and apply (install) this fix on the iSeries. The fix is then integrated into the install image.

Therefore, if you were to install Client Access Express on to a workstation, the installation would automatically include the service pack fixes on that workstation.
However, if you do not have the 5722-XE1 product installed on your iSeries or AS/400 system, you can copy the install files from the \Express\Install\Image directory on your CD to a separate directory, or utilize the tailored installation image, and apply service packs directly to this image.

**Installing a service pack downloaded to a workstation**


Select the latest service pack for Client Access Express V5R1M0. This will take you to the IBM FTP site, from here you can download the complete Client Access Express service pack. Note that if you enter the subcomponents directory you will see several files. In here, there are two files to assist in applying the service pack to the installation image - PTFFORM.EXE and Readme.1st.

The Readme file can be read using any text editor and contains simple instructions on combining the service pack with a Client Access Express installation image.

PTFFORM.EXE is a self-extracting file that contains the updated files that will replace the older files in the install image or tailored installation image directory. Once these files are replaced, any subsequent installation from that source will be at the new service level. The service pack is integrated with the base installation from this source. It is not possible to uninstall the service pack from the client when installing in this manner.

**Installing a service pack as an iSeries fix**

If you do not have an automated procedure for installing a new service pack, here is a quick example scenario of manually installing a new Client Access Express service pack where the service pack has been ordered as an iSeries fix (PTF) and received on a CD-ROM.

1. Place the service pack CD-ROM in the CD-ROM device for the iSeries server or partition. From an OS/400 command screen enter GO PTF and select option 8 (Install program temporary fix package).

   On the Install Options for Program Temporary Fixes menu screen, enter the following as shown in Figure 3-14 and Figure 3-15.

   In our example our optical drive is OPT02 (in our configuration AS25B is a secondary LPAR partition).
This will apply all fixes (PTFs) that do not require an IPL. You should have read the cover letter to determine if an IPL was required and if Client Access Express activity should be ceased while installing the PTF. After the PTFs have been installed, each PC wanting to install the service pack can have a Netserver connection or peer server network drive to the iSeries server. From such a PC, do the following.

2. Select the Client Access Express icon from your desk top. Select Service. Select Install Service pack. Read the Read me file thoroughly to ensure you know if any corequisite PTFs need to be installed on OS/400 or some special setup instructions also are required to use the functions included in the PTF.

For example, the Service Pack identified by SI01907 required OS/400 Management Central server PTFs and a specific Operations Navigator Management Central setup under Applications Administration if you were going to use Secure Socket Layer (SSL) support.

On the first window enter the directory path structure to the iSeries. Figure 3-16 shows an example using network drive K.
3. Click Next and follow the wizard steps until finished. Remember to read the last window to determine if the PC needs to be restarted.

3.3.2 Setting up connections

Once Client Access Express is installed on your workstation, you need to set up your connection to your iSeries server. If you want to connect to multiple iSeries servers you must “add a connection” for each system. This topic discusses how to do this.

You can have one or more “environments” (systems you are connecting to grouped together) from a single workstation. Operations Navigator comes with a default environment called My Connections.

If you are doing your first add a connection or are going to use the IBM-supplied My Connections environment for additional connections as most users do, you can skip the following environment configuration topics and go straight to “Adding systems to environments” on page 77.

**Note:** Throughout the Operations Navigator redbook volumes the default My Connections environment is used in all function descriptions.

**Setting up your environments**

Under Client Access Express V5R1M0, connections to your iSeries servers are grouped in one or more environments, and managed via Operations Navigator. The default environment is named My Connections and any connections you create are placed into the default environment. If you only wish to manage one or a small number of systems, one environment is usually suitable.

Using multiple environments can allow you to easily change between administering different sets of systems, and you may also define different connection properties for the systems in different environments.
Reasons for having multiple environments include:

- Connecting to the same iSeries from different environments with different User ID’s
- Connecting to iSeries servers according to geographical region
- Connecting to iSeries servers doing application specific processing, such as those doing Web serving or Domino serving

Only one environment’s connection properties may be active at any one time per instance of Operations Navigator on your workstation. You can start more than one Operations Navigator instance on your workstation. Each one of those instances would have a different active environment.

You start an Operations Navigator instance on your workstation by selecting the Operations Navigator icon on your desktop or first select the Client Access Express icon on your desktop and then selecting the Operations Navigator shortcut.

You may configure the environment settings within Operations Navigator at any time by selecting Environments from the File menu, or by right-clicking the current environment name and selecting Environments from the context sensitive menu as shown in Figure 3-17.

![Figure 3-17 Opening the environments settings](image)

This displays the environments window from where you can administer your environments settings. From here, you can click plus (+) symbol to the left of the environment name to expand the tree allowing you to view and edit the systems contained within that environment.

In the example in Figure 3-18, a configuration is shown with Local and Overseas systems separated into different environments. The folder for the active environment is highlighted in green, and the default system for that environment displays a green background. The default system acts as the management central server and is also the system from which code page conversion tables are retrieved.
From the environments window, you can add, rename and delete environments connections to systems. To add an environment, just click the Add Environment button. To rename or delete an environment, simply select the environment by clicking on it and then click on rename or delete. To add a server, click the Add server button. By default, the server will be placed in the environment that is currently selected, although the Add Connection wizard allows you to change the environment when creating the connection to a server. Adding servers is covered in “Adding systems to environments” on page 77.

**Importing and exporting environments**

A useful feature available from within Operations Navigator is the ability to import and export environments. This allows you to define an environment with specific systems configured and export this environment for other Client Access Express users.

To export an environment you must select it from the list of environments you have configured. Once you have selected the environment, the export button will become active. Clicking on **Export** displays the Export Environment window, allowing you to select a destination directory to save the environment file to. The file will be saved with an .env extension. You can save the environment with any name you wish but be aware of limitations such as not being able to use the slash “/” character in Windows file names. We use the name LocalSystems.env in our example in Figure 3-19.
To import an environment, click **Import** from within the environments window and select an .env (environment) file. This environment file will be imported and added to your list of environments. If the name of the environment matches an existing environment from your list, you will be prompted to merge the data with your existing environment. As illustrated in Figure 3-20, the connection properties from the imported environment will replace the properties of any connections in the existing environment that use the same server name.

![Figure 3-20 Dialog when importing an environment name that already exists](image)

**Adding systems to environments**

Before Operations Navigator can interact with an iSeries or AS/400 system, that system must have a connection added into an environment. This connection tells all Client Access Express functions the details for establishing communication to the system. Once a connection has been defined, all Client Access Express applications such as data transfer and PC5250 can use it as well as all Operations Navigator functions.

![Figure 3-21 Operations Navigator with no connection defined](image)

Figure 3-21 shows the initial window presented from Operations Navigator when no connections to iSeries or AS/400 systems have been defined. Selecting Yes to create a connection takes you to the Add Connection wizard pictured in Figure 3-22. Selecting No will exit Operations Navigator. If you have already used any existing functions of Client Access Express such as PC5250 or Data Transfer, or migrated from a previous version of Client Access, the connections are already defined within Operations Navigator.
The Add Connection wizard prompts you to enter the iSeries server name known to your network's Domain Name Services (DNS) server or enter an IP address of your iSeries server. You optionally enter a description for that system, and choose the environment in which to place the server.

**Tip:** You can get the DNS name and IP address information from your network administrator or the person who configures your TCP/IP network within your organization. We recommend that you use the DNS name to resolve the iSeries or AS/400 system - this allows IP address changes to be made without having to reconfigure the clients to see the new IP address. For more information on setting up TCP/IP and DNS on your server or workstation, see *Client Access Express for Windows - Setup, SC41-5507*.

Once you have entered the required information on the welcome screen, click **Next** to continue to the next window.
Chapter 3. Installation and general navigation

Figure 3-23 The Signon information window

The Signon information window allows you define the properties regarding the user ID you will use to connect to the system. You have three choices regarding this, as follows:

▸ Use Windows user name and password, no prompting

This option can be used when the users Windows user ID and iSeries user ID are the same (in this example, ITSCID15) and their passwords are also the same. This allows you to access the iSeries server without the need to enter a user ID or password to establish the connection. Also, selecting some Operations Navigator functions actually perform an additional connection to the iSeries. If you select this setting, you are presented with the Operations Navigator sign on window only the first time you connect to a system. Additional connections default to using the Windows user name and password to sign on to the iSeries.

You will not have the option to establish the connection using another user ID, nor will you see the prompt to signon to establish the connection unless your passwords do not match.

▸ Use default user ID, prompt as needed

This option allows you to specify a default user ID to establish the connection to the iSeries server. When attempting to establish a connection for the first time, you will be prompted with the default ID and asked to enter the password. You may change the user ID if you need to, however once you have signed on that user ID will remain connected for your entire workstation session. Once you have successfully signed on, you will not be prompted to sign on again until you reboot your PC.

▸ Prompt every time

The last option requires you to sign on to the system for every instance of Operations Navigator, including each extra connection may be required by the function for a single instance of Operations Navigator on your workstation.

You will not be given a default user ID to sign on with, so this option allows you to reconnect with different user ID’s within a single workstation session. This option has the advantage of being the most secure option. It has the disadvantage that you may be prompted to signon more frequently than you would expect and you may not realize you signed on with different user profiles until you later try a function and it is not available to you.
Once you have decided on a signon type and clicked Next, you are taken to a window confirming the addition of your server to an environment as shown in Figure 3-24. At this point it is a good idea to check that the connection to your server can be established and that the necessary server applications are running to allow Client Access and Operations Navigator to be used successfully. The **Verify Connection** button opens a window that tests the connection and applications on the system. Figure 3-24 shows this procedure.

---

**Tip:** If you need to change these options after setting up your connection, this can be done very quickly and easily within Operations Navigator. Simply right-click on the system whose connection you need to change, and select properties from the context menu. This will display a window allowing you to change certain connection properties to the iSeries or AS/400 system. This capability is covered further in the general navigation section of this chapter.
Deleting systems from environments

You can delete a system from an environment in a number of ways. Within the Operations Navigator window you can:

- Select the system you wish to delete and press the delete key on your keyboard
- Select the system you wish to delete and press the delete button on the toolbar
- Select the appropriate system, and use the context menu delete option by right-clicking on the system or using the File menu.
- Open the Environments window, select the system in the window and press delete.

You will be asked for confirmation to delete the connection to the system as shown in Figure 3-25.

![Delete a connection confirmation](image)

**Figure 3-25  Delete a connection confirmation**

Important: Host servers

A “server job” is any job that waits on a queue or for an event to occur and then does the work based upon the queue entry or event data. On an iSeries server, there are “official” host server jobs such as those doing TCP/IP functions such as Telnet or FTP, Client Access functions, and so on. For Operations Navigator functions to operate correctly, it is important that the appropriate server jobs are started. Operations Navigator heavily depends on the Java Database Connectivity (JDBC)/ODBC Database server jobs named QZDASOINIT. For more information on host servers, refer to Chapter 7, “TCP/IP network” on page 289.

If any of your host servers are not running, you can start them all by issuing the command:

```plaintext
STRHOSTSVR SERVER(*ALL) RQDPCL(*ANY)
```

This ensures the servers required by Operations Navigator and other important OS/400 functions are started. Once Operations Navigator is active, you can use it to customize the various host server jobs to automatically start when TCP/IP applications and interfaces are started.

By default, V5R1 OS/400 is shipped with a new system start (IPL) IPL Attributes variable Start TCP/IP set to *YES. Unless changed this IPL attribute the system will issue the OS/400 Start TCP/IP (STRTCP) command (with start all TCP/IP applications all IP interfaces set to *YES) at the appropriate time during the IPL process. This is an ease of use improvement over previous releases of having to specify the STRTCP command in the IBM-supplied OS/400 or customer supplied start up program defined in system values QSTRUPPGM. This should automatically start up all host servers.

A V4R5 system automatically starts the host servers with TCP/IP, but requires a manual STRTCP, preferably in the startup program.
3.4 General navigation

This section covers the basics of navigating around the Operations Navigator interface. It includes context sensitive menus, and the new with V5R1 Taskpad and GUI Command Prompter. Many of the options available within Operations Navigator depend on the function or component that you are currently working with. This section covers navigation terminology, includes examples of almost all the common navigation techniques and includes examples of how to use online Help information, which has been significantly improved with V5R1.

The remaining chapters of this volume and other redbook volumes assume you are familiar with the navigation information presented in this section.

This section also assumes a basic knowledge of using and interacting with the various Microsoft Windows operating systems, for functions such as using the mouse to select items, dragging and dropping and so on. It also assumes a knowledge of terminology such as window, menu, toolbar, buttons and icons.

3.4.1 The main Operations Navigator window

You can start Operations Navigator on your workstation by either selecting the icon on your desktop or selecting the desktop Client Access Express icon and then selecting Operations Navigator.

If you do not have any connections configured, you will be prompted to create an initial connection. Refer to “Adding systems to environments” on page 77, if you need to configure a connection — you need to configure at least one connection before you can do work in Operations Navigator.

Starting Operations Navigator brings up the main Operations Navigator window that shows all the systems you have defined in your Environment (My Connections). Click on one of the systems and you are either automatically signed on or prompted to enter your user ID and password.

After successfully signing on, the right side of the main window lists the major Operations Navigator components you have installed on your workstation, such as Basic Operations, Work Management, Configuration and Service, and so on.

We use the main Operations Navigator window shown in Figure 3-26 as our primary “reference point” for describing Operations Navigator navigation techniques and terminology. In this example, we have already expanded the hierarchy tree on the left side (pane) of the window and selected to display active jobs in right side (pane) of the window.

There are three separate panels or panes within the Operations Navigator main window. The left pane contains the hierarchy tree (often just referred to as tree). The hierarchy tree displays the Operations Navigator subcomponents and functions that are installed and available for your Management Central central system and iSeries or AS/400 connections.

When you select an item (folder) from the hierarchy tree, the “contents” of that item are displayed in the right-hand details pane. New, starting in V5R1 is the Taskpad, which is covered later in this chapter.

To expand branches of the hierarchy tree, you click on the + symbol next to the component or branch you wish to expand. This has the effect of being able to drill down into the tree without having to view every branch in the details pane on the way down. Similarly, once expanded, clicking on the - symbol will collapse the branch, which is useful in reducing clutter and unnecessary views in the hierarchy tree.
In the left pane center of this figure you see terms “function”, “folder”, and “sub function” associated with the lower tree “branches”. Sometimes the term “folder” is also used to mean a tree branch.

To be consistent in this series of redbook volumes and chapters and online Help, we will use the term folder to refer to all levels of the tree hierarchy. We will also use the term “function” when we are talking about the functions available for a folder.

Note, this example window includes a branch to the Advanced Job Scheduler plug-in between Active Jobs and Server Jobs as part of the new for V5R1 Work Management function. If you had not installed this plug-in on your workstation this branch would not appear.

You can drag the pane separators to show more or less of the information within each pane. You can use the menu bar View menu option to hide the Toolbar, Status bar, and Taskpad area. As we show later in this topic you can customize the information shown in the right details pane, the columns of information displayed and the order in which the items in the details pane are listed.

The view of functions and components is completely customizable and easy to perform. Characteristics of the interface can be changed quickly and easily. As you become more familiar with Operations Navigator you will find yourself changing the view to suit your particular needs.
Important: Throughout the Operations Navigator redbook volumes we use a shorthand notation for representing the hierarchy of mouse point and clicks to select an Operations Navigator function. That notation is in the form of \texttt{xxxxxx -> yyyyyy}, where we have first selected a folder or menu item \texttt{xxxxxx} and then selected a lower level folder or menu item \texttt{yyyyyy}.

See the following examples.

Using Figure 3-26 as a base, we want to collect inventory for system As01. One of the ways to do this by first selecting system As01 under My Connections in the left pane. Then right-click As01 to get a context sensitive menu (not yet described) that includes Inventory. Click Inventory and select Collect from the lower level context sensitive menu.

The shorthand representation of this starting with the left pane is:

1. My Connections -> system name -> Inventory -> Collect

   Another way to collect inventory for system As01 is to first select the system and then use the menu bar File option. A shorthand representation of this would be:

2. menu bar File -> Inventory -> Collect

   If a function can be accessed by either 1 or 2 above we will use only the shorthand for 1 in most cases in this book. We may even shorten that further to \texttt{Inventory -> Collect} when referring to a function accessed from the left pane hierarchy tree.

When a function is being performed under the Management Central central system in the left pane (for example, defining a new package), the shorthand notation in this book will show something like this:

\texttt{Management Central -> Definitions -> Package}

The Operations Navigator online Help information (as discussed in 3.5.1, "Help information and sources" on page 113) contains instructions on how to use the tree hierarchy to perform a function. Therefore in the other Operations Navigator redbook volumes and later chapters in this redbook, we show the \texttt{xxxxxx -> yyyyyy} notation only when we think it is not obvious from the surrounding text what the mouse point and click path is to a specific function.

Note: The first time you connect to a system, Operations Navigator will perform a scan on that system to determine which functions are available. If you have any plug-ins available, for example, BRMS, Domino or Advanced Job Scheduler, you will be prompted to optionally download these plug-ins to your PC. For more information regarding plug-ins, refer to Chapter 11, “Plug-in support” on page 385.

Taskpad

New for \textit{V5R1} Operations Navigator is the taskpad. The taskpad appears as a new pane in the lower area of the Operations Navigator main window, and it can be enabled or disabled by selecting \texttt{menu bar View -> Taskpad} from the menu bar, as shown in Figure 3-27.
Chapter 3. Installation and general navigation

Figure 3-27  Enabling or disabling the taskpad

The taskpad is a useful tool for quickly accessing commonly used functions and key tasks and is intended to minimize the number of point and clicks required to access the function or perform the task. Note at the (?) Help for related tasks that can quickly get you to specific function help information. (We discuss more about online Help information in “Help information and sources” on page 113.)

The taskpad also contains wizards to perform various operations, such as adding a network interface. The contents of the taskpad, like many Operations Navigator functions, are context sensitive. This means that the contents of the taskpad pane will change based upon what is selected in the hierarchy tree pane. The contents of the taskpad will relate to both the function that you are currently performing, and related functions.

For example, in Figure 3-27, from the main Operations Navigator window, the functions available from the taskpad are related to working with connections to your systems. Clicking on the Network branch in the hierarchy tree changes the taskpad to display items related to network type functions as shown in Figure 3-28.

The wizards available from the taskpad tie together several functions from various areas of Operations Navigator, allowing you to perform a number of operations with just one click on a wizard. There are wizards available for all kinds of tasks, including configuring a DNS server, putting your iSeries or AS/400 system on the Internet, reconfiguring your security settings and even creating and configuring a TCP/IP interface. The taskpad will also display help related to the functions you are working with, so it’s an easy way to find help for the task you are performing. As you work with Operations Navigator, be sure to keep an eye on the taskpad - it’s a quick and easy way to save you time and effort.

If you feel you no longer need the Taskpad, you may want to turn off the taskpad. In some cases, turning off the taskpad may improve performance of your Operations Navigator session.

Alternately select menu bar View -> Taskpad to turn on or off viewing the taskpad. The check mark next to Taskpad in the View menu indicates the taskpad is displayed, as shown in Figure 3-27.
Context sensitive toolbars and menus

The context sensitive toolbars and menus are of great assistance within Operations Navigator. The term “context sensitive” refers to the fact that the function you are enabled to perform is dependent on the selected Operations Navigator component and sub function folder within the window being displayed, any selected item within a window pane, and, in some cases, the status of the selected item.

Using the example window in Figure 3-29 our base, we discuss the active buttons in the toolbar shown at 1. (A button may display as “greyed out”. This means, depending on the item selected and the status of that item the function performed by that button cannot be performed.)
Although you may not be able to clearly see it, in the left pane we have expanded the Work Management tree, selected Active Jobs to get the Active Jobs information in the right pane. We then right-clicked on job Jobas0301 to get the associated job context menu.

The active toolbar button functions in this example include holding the job, deleting (ending) the job, displaying the properties of a job, printing details about what is viewed in the window, and refreshing the information currently on the screen (as shown at 3). The job context menu has these same items plus the Monitor capability.

The greyed out functions include Release the job (job is Running, not held) and Reply (the job is not waiting for a message response).

Note the “6 minutes old” text in the upper right of the window. This indicates the time since the details information was last “refreshed”.

In the toolbar we show the “bubble help” tool tip (for Hold (Job)), you can view by “hovering” your mouse pointer over the toolbar button for a few seconds. A tool tip is a short description of the function that the button performs, and will appear in the bubble window. A longer tip description appears in the status bar at the bottom of the Operations Navigator window at 2.

Like the taskpad, watch the buttons in the toolbar change as you access different functions within Operations Navigator, and experiment to make the best use of these features.

The functions available for Work Management -> Active Jobs are detailed in Chapter 5, “Work Management” on page 139.

In Figure 3-29 we show two examples of context sensitive menus. The right menu is for the active job, while the upper context menu (4) is shown because we selected View from the menu bar.
(Note that in normal operation only one context sensitive menu will be active at a time.)

In the View menu you can see several items (functions) that are for general control of what is being shown on the window, such as the Toolbar, Status Bar and Taskpad. Note that this menu contains the Refresh function for which there is a toolbar button, as well as a function key (F5).

Cancel Request is greyed out because there is no requested function active.

To display the context menu for an item, right-click while the pointer is over the item. You do not need to select (left-click) the item before right-clicking to display the context menu for that item you want to do something with. However if you wish to use the menu bar, you must select (left-click) the item before selecting the menu.

Special connection-related context and pull down menus

While each selected Operations Navigator function or task has its unique context sensitive context and pull down menus, there are three special, connection-related context menus we call to your attention here in the general navigation topic:

- Environment (for example, “My Connections”)
- A system name under an Environment
- Management Central central system

You should be aware of the capabilities via these menus as some of the menu items may not be discussed in other Operations Navigator redbook chapters and volumes. We do not describe each item here. You should review them and associated online Help information when you have an active Operations Navigator session.

Figure 3-30 shows the context sensitive pull-down menu 1 and context menu 2 when an environment name has been selected - in this case “My Connections”.

Note the Selective Setup and Install Plug-ins items, which you would not use in normal day to day operation.

In Figure 3-31, note the large set of File menu 1 and context menu 2 items when we selected a system (in this case As01) rather than the higher level Environment.

These system name context menus have interfaces to the most important Operations Navigator capabilities and will be used frequently in the other redbook volumes and chapters.

Similar to the taskpad, the context sensitive menus can be an excellent way of quickly performing daily tasks associated with the selected item.
Figure 3-32 shows context and file menus for a Management Central central system. As previously described several Operations Navigator functions require a Management Central central system even when performing that function on one system.
Most context menu items are not specifically described in this chapter, but rather as they are naturally used for specific functions described in later redbook chapters and volumes.

There are, however, certain menu items that appear on most context sensitive menus, so we generally highlight what you can do with them in the following topics.

Properties windows
Properties windows are an important function within Operations Navigator. Almost every component and function of Operations Navigator has a properties option. Properties windows allow you to view detailed information about the selected folder object, change some object-unique properties, and control refresh and other options for viewing Operations Navigator components and functions.

Figure 3-33 is an example of the three ways of displaying the properties for a selected item - the properties option from the File pull-down menu 1, the properties button on the toolbar 2, and the properties option from the context menu 3.

![Opening a properties window](image)

Properties for specific functions are described in the appropriate redbook volumes and chapters. However in this general navigation topic we show an example of the properties information (“settings”) for a system selected under My Connections. You should know that using Properties you can view and change these settings that affect your connection to the system.

We show some of the system properties windows, but do not explain all the parameters. Review the online Help information for specific details on each of the setting values as some of them are dependent on configuration steps in other Operations Navigator interfaces.

In Figure 3-34 we show, on the left, the system’s General properties for system As01, showing the system is at V5R1. On the right we show the Connection properties for As01, which include our sign on rules.
In this example we have to sign on at every connection. You can change your current sign on rules, which take effect after you end the current session.

**Note:** If you have installed Secure Sockets Layer (SSL) support on your workstation there would be an additional Secure Sockets tab of properties. The settings in this properties page would assist you in setting up use of SSL for your Client Access or Operations Navigator session. However, much of the configuration for using SSL is through the Digital Certificate Manager (DCM) interface. Setting up SSL is described in *Managing OS/400 with Operations Navigator V5R1 Volume 6: Networking Overview*, SG24-6566.

In Figure 3-35, we show another system property, the restart (IPL) property in the left window. The right window is a capture of a 5250 workstation screen showing the corresponding function Change IPL Attributes (CHG IPLA) command prompt display.
These restart parameters should be changed only by an experienced OS/400 user.

Explore and open actions
The Explore and Open actions are a familiar feature for those with Windows experience. They give you the ability to view selected data either within the current window with which you are operating (Explore) or open a separate window in which to display the data (Open).

Explore and Open actions are available for all items listed in the hierarchy tree of your Operations Navigator window. The Explore and Open actions are accessible by selecting the desired hierarchy tree function and selecting either one from the File pull-down menu, or by right-clicking on the selection and making the choice from the context menu.

By default, Operations Navigator uses the Explore function when you select an item. If you select Open, Operations Navigator continues to Open new windows for each level of the hierarchy tree you drill down.

Using Explore or Open depends on your personal preferences, however, unless you are working with just one iSeries server, it is preferable to use the Explore option rather than opening separate windows for different functions as this consumes more system resources and may cause the desktop to become cluttered.

Drag-and-drop, copy and paste
V5R1 Operations Navigator supports the Windows operating system-like mouse drag/drop (move) and copy/paste menu functions for selected Operations Navigator functions. These functions are supported for selected iSeries objects, including those shown below:

- Drag-and-drop and context menu move a job from one job queue to another job queue, or from one position to another within a job queue
Drag-and-drop and context menu move a spooled output file from one output queue to an output queue associated with another printer device

Drag printer output to the desktop. From the Windows desktop you can click to view the data or save as a Windows file that could be used as input to a spreadsheet application

Copy and paste (from context menu) an OS/400 library object from one library to another

Drag-and-drop (move) an object from one Integrated File System file system folder to another

Copy and paste from context menu an object from one Integrated File System file system folder to another

**View options**

One of the ways to change what you see within an Operations Navigator window is to use the menu bar View options. This can be done either by going to the View pull-down menu on the Operations Navigator menu bar, or by right-clicking on any vacant space within the details pane of the Operations Navigator display. You can see the View menu options as shown in Figure 3-36.

The default is **Large Icons, Small Icons, List** and **Details**. You may find more useful the capability to control the displaying of the toolbar, status bar, or the taskpad.

We discuss **Refresh** and **Function Availability** in later topics in this redbook.

Any setting you change here, for your customized view of Operations Navigator, are saved when you close (end) Operations Navigator on your workstation. They become your default options the next time you start Operations Navigator from your PC.

**Refresh and automatic refresh**

Some functions, such as Management Central task activity, all active monitors, and monitor event logs automatically refresh the details pane when a change occurs. Many other functions, such as Basic Operations messages or printer output, or the Work Management display of active jobs, do not automatically update the details information.

In the example window shown in Figure 3-36, you see, in the upper right corner, the “minutes old” field which tells you how long it has been since the data displayed in the right details pane was last collected from the system. The example shows a time value of 337 minutes since the details pane was last refreshed!
As you select different options from your hierarchy tree, you will notice this minutes old field will change to reflect the age of the corresponding details pane data. Some hierarchy tree selections will always request data from the system when selected, others may not. For example, when you view your printer output for the first time, Operations Navigator will collect the data from the corresponding system and show a value of 0 minutes old for the display. If you then perform other tasks within Operations Navigator, the indicator changes to reflect the age of the current selection. If you then return to the printer output display, you are not actually retrieving any new data from the system because it has previously been cached. Therefore, the indicator will show the elapsed time in minutes since the data displayed was gathered from the system.

Operations Navigator provides flexibility to manually or automatically refresh the data displayed in the details pane when the function displaying the details data normally does not automatically update previously collected and displayed information.

**Manual refresh**
There are several different ways you can perform “adhoc” manual refreshes of your data:

- From menu bar View -> Refresh
- Selecting the Refresh toolbar button
- Pressing F5 on your keyboard

A manual refresh resets all the cached data within that particular instance of Operations Navigator. Therefore, if you have two Operations Navigator windows open on your desktop, a refresh on one will not reset cached information on the other.

**Automatic refresh**
This option may be particularly useful when you need to monitor things such as messages or spooled files being sent to a certain printer or are working with active jobs and want to see job status changes. Automatic refresh can be adjusted from the Refresh tab within the function properties. This is accessible by selecting the Properties toolbar button that is active when the function is selected, or by right-clicking on the function and selecting Properties from the context menu, as shown in Figure 3-37.
Figure 3-37  Function properties - automatic refresh example

In this example we have selected to both refresh the contents every time the list is displayed and refresh the list every (one) minute. The lower Active Jobs window shows a refreshed window with a second job appearing under subsystem Chainbch.

If the tree folder that you want to auto-refresh does not have a refresh tab in its properties, it is inheriting its refresh options from a parent folder higher up in the tree. For example, under **Basic Operations -> Printers** the properties window for individual printers does not have a refresh tab. However, the Printers folder does. Changes to refresh settings on the Printers folder affect every printer.

Unlike a manual refresh, automatic refresh affects only the folder you have selected to be refreshed, not the entire Operations Navigator window. It is a good idea to control the number of auto-refreshes you set to minimize effects on system performance.

You can only make changes to automatic refresh options from the main Operations Navigator window. You cannot make adjustments through individual instances of Operations Navigator such as shortcut desktop icons (to message or job lists, for example). However, once you make an automatic refresh adjustment to a function within Operations Navigator, the change is selected in the next startup of any instance of that function.
Retrieving information from the system

There are times when you select a folder in the left tree hierarchy pane and the response takes longer than a few seconds. This happens when the workstation Operations Navigator software detects that it has to request a significant amount of new or updated data from the iSeries server.

When the software detects its request of the system will “take a while”, you get a “collecting information” symbol in the right-hand pane of the window. An example is shown in Figure 3-38.

The length of time this symbol is displayed is dependent on factors such as the complexity of the requested operation, network speed, and current system loading. One situation where this “retrieving information” window may appear is the first time you select the Network folder or when you change the Management Central central system. These functions require significant iSeries processing.

If this window should appear for longer than 20 seconds, you may be having a network communication problem, perhaps losing the connection to the iSeries. If after 20-30 seconds you do not have a new window of information, consider using the Window operating system’s Control -Alt-Delete key combination to bring up the Windows Task Manager. If the Operations Navigator task shows status of “Not responding”, select End Task. Open another Operations Navigator session to that iSeries server and resume your work.

Cancel request

Some functions may require significant processing time on the iSeries. If you determine that you really do not want that function to complete you can attempt to cancel it by using the Cancel Request button on the toolbar or View -> Cancel Request.
One example, would be you accidentally requested a list of all jobs active on the system. On a busy system this could take some time to collect and take more CPU resource than you want to use at the time. - an you really do not want to see all the jobs active on the system. Cancel the request, change the include criteria, such as only jobs running in a certain subsystem, and collect the job information again.

These options are active only when Operations Navigator is communicating with the system and you have an outstanding request the system is performing.

**Shortcuts and desktop icons**

Operations Navigator’s integration into the Windows desktop means you can create desktop shortcuts and icons to meet your needs and preferences. The nature of creating shortcuts and desktop icons for Operations Navigator is much the same as for any other Windows based application.

Shortcuts apply to folders (components and subcomponents) of Operations Navigator, where desktop icons would be created for connecting to iSeries servers within Operations Navigator.

**Creating desktop icons**

You can create an Operations Navigator desktop icon in the follow ways:

- Selecting Create Desktop Icon from either the File drop-down menu, or by right-clicking on one of your defined iSeries servers and selecting the option from the context menu.
- Right-clicking any vacant space on your Windows desktop and selecting New->AS/400 Desktop Icon.

Figure 3-39 shows the Operations Navigator context menu on the left and the Windows desktop menu that could be used to create the desktop icon for system AS04.
Using the Windows desktop method actually invokes a short wizard that allows you to specify the application to be launched, such as Operations Navigator, a 5250 emulation screen, or a user defined program path. The Operations Navigator menu method simply defaults to Operations Navigator session. You can access the properties window for either method and redefine settings such as startup paths. This is done by right-clicking the icon on the desktop and selecting **Properties->Options** from the context menu for the icon.

Selecting the desktop icon automatically brings up the Operations Navigator main window and a sign on window for the system (As01, in our example). After signing on you can use the main Operations Navigator window.

**Creating shortcuts**

You are also given the flexibility within Operations Navigator to create shortcuts to specific functions of Operations Navigator. A shortcut links to the Operations Navigator executable program cwbunnav.exe, and includes information about which function of Operations Navigator to open. Shortcuts are easily created by either:

- Selecting the Create Shortcut menu option from the File drop down menu or the context menu.
- Select an Operations Navigator folder (for example, **Database**) or an object (for example, a printer device listed under **Basic Operations -> Printers**. Drag-and-drop that folder or object in the Operations Navigator window onto your desktop or into a folder of your choice. The folder or object is now a shortcut on your desktop or as file in a folder.

Shortcuts can be created from folders displayed in either the hierarchy tree pane on the left, or the details pane on the right of the window.

By selecting a desktop shortcut, you are first presented with the sign on window for the associated system, and then presented with only the window associated with the shortcut.

Figure 3-40 shows one way of creating a desktop shortcut for a folder. We selected the Printers folder and then right-clicked to display the context menu showing Create Shortcut, as shown at 1. The resulting icon is shown on your Windows desktop. Opening this icon displays the window as shown at 2 in Figure 3-40. You can then customize this shortcut icon to your needs, including giving it a more relevant name if you want.

![Figure 3-40 Creating desktop shortcuts example](image-url)
Shortcuts are a useful tool in helping you customize Operations Navigator. For example, you may want to place your most commonly used functions on your desktop, such as a printer or message queue you need to closely monitor. You could also create new folders on your desktop in which you group certain tasks together, such as a folder containing your commonly used printers, or a folder containing icons for user profile maintenance on all systems.

Shortcuts that you have created can be customized individually from the main Operations Navigator window, and from other shortcuts. This means that the shortcut will retain its own settings, even though you may have changed display options within the main Operations Navigator window, or other similar shortcuts. You can even create shortcuts to the same folder or object, but each with different settings.

For example, you may use menu bar Options -> Include to set up one shortcut to access only the printer device that is normally associated with your personal output queue. You can set up another shortcut or the standard Basic Operations -> Printers to look at all printers on the system.

**Important:** When you start an Operations Navigator function using the desktop shortcut, you do not have access to any other Operations Navigator folder functions. You may consider that a “restriction” or exactly what you want.

Since each shortcut, when selected, launches a separate instance of Operations Navigator, having many shortcuts selected at the same time may cause the desktop to become cluttered and may impact performance on your workstation based on extensive storage utilization. See “Explore and open actions” on page 92, for related information.

Note that shortcuts are not removed from your desktop when you uninstall Client Access Express for Windows. You need to delete them manually.

**Find function**

When you display a long list of information such as jobs, messages, libraries, objects within a library, or files within a folder with Operations Navigator, you can make use of the Edit -> Find function to search for a string of characters. The text search is performed on the right-hand details pane. Find is also available in windows that are opened separately using the open action from the context menu.

Find can be used to find text in any column of information.

**Print and print preview**

The print function within Operations Navigator allows you to print the contents of the detail pane. The print preview allows you to see those details before they are printed. Both of these functions are available from the File menu, and will give you the option to print using Windows printer drivers to your configured local or network printers. The menu options and print preview window are displayed in Figure 3-41.
Include function

Each Operations Navigator function that displays detail information in the right pane defaults to a selected set of information displayed in that pane. For example, _Basic Operations_ -> _Messages_ defaults to showing messages only for the user who has signed on through Operations Navigator. This is termed the “current user”.

Other functions, such as _Work Management_ -> _Active Jobs_ default to displaying all active jobs and this could show you a longer list than you want. If you have a busy system with thousands of active jobs at any one time, consider using the Include function to limit the number of jobs you display.

Most, but not all, Operations Navigator folder functions support the Include function. Those that support Include have their unique own set of parameters to select from. When supported, the _menu bar Options_ -> _Include_ function can be used to either expand or limit the set of information that will appear in the right pane details list.

The include settings for each associated folder (for example, Active Jobs or Subsystems) are saved and reused for the current and subsequent Operations Navigator sessions.

For example, assume in a session with system Sys01, you use Include to view only the jobs running with a user ID prefix of As03. You view active jobs only for a set of users - As03, AS0301, and AS03BOSS. You then end your operations navigator session. Later you start Operations Navigator and sign on to systems Sys01 and Sys02. When viewing jobs on either system, by default you only see the AS003cccc jobs on each system.

Also note that functions that do support Include have their own unique parameter choices. For example, one function supporting a list of jobs, may support a user profile name parameter, while and another function may not include a user profile parameter.
In the example shown in Figure 3-42, we show including only jobs with job name — user ID starting with “AS03” (generic user profile name) for the new for V5R1 Work Management Active Jobs display.

Note all the parameters that can be specified to control which jobs can be displayed. Note also the Browse buttons for viewing all users defined on the system and all active subsystems. You can subset from all the active jobs on the system based upon:

- Three part job name - any combination of job name, job user (user who started the job), - system assigned job number)
- Job type (batch, interactive, ....)
- Subsystem (all jobs running in the specified active subsystem)
- Any job running under a "current user"- for example a pre-started database server job started under user QUSER, is now running with user profile AS0301

Generic values are supported for the Job-Name and Job-User fields (for example, As03*). See Chapter 5, “Work Management” on page 139 for more information.

**Column selection, sorting and column width**

Each Operations Navigator function that displays detail information in the right pane has a default order of items in a list, a default set of columns of information, a default order of columns displayed, and a default width of the information displayed under each column (“column width”).

In V5R1 most of the detail pane functions enable you to change the order of items in the list, customize the columns of information displayed and modify the column width.
The menu bar Options -> Columns function selects columns to be displayed and column left to right sequential position within the details pane.

The menu bar Options -> Sort function displays a list of columns that be used to order the details pane information list. Note, most Operations Navigator folder functions also support sorting the information by alternately clicking a specific column heading that supports listing items according to ascending or descending values for that column. This “heading click sorting”, sorts according to only that column of information. Menu bar Options -> Sort supports sorting the list based on multiple column content and the hierarchy of these selected columns.

**Note:** Column choices are saved and used in subsequent Operations Navigator sessions. Sort choice are used only during the current session.

The following examples show controlling the columns of information displayed for Work Management -> Active Jobs and controlling column width for Basic Operations -> Messages.

**Adding and ordering columns example**
In the example shown in Figure 3-43, we used the left to right window scroll bar (at 1) to determine that the average percent of Database CPU utilization for each job was not included by default.

We then used menu bar Options -> Column and selected to add DB average percent CPU utilization to follow total job CPU utilization average as shown at 2, for each job in the details pane. After ensuring we had the columns of information in the order we wanted, we clicked OK to get the details pane.

We noted that our Job CPU percent and job Database CPU percent were at zero when the “new” details pane was initially displayed. Therefore, we used the toolbar refresh button (shown at 3) to get the lower window pane in our example to show total job CPU utilization average percent and job CPU utilization that was consumed by database operations as indicated at 4.

Note that we could use menu bar Option -> Sort or click a column, such as CPU DB %, to re-order the list of jobs shown in our example.

**Resizing column width example**

The width of each column can be shortened or lengthened by moving your mouse pointer to the vertical line separating two column headings - to the right of the column you wish to adjust. Once the “+” character appears, hold down your left mouse button and slide the vertical line to the right (lengthens the column width) or left (shortens the column width). In Figure 3-44 we highlight the lengthening of the Message column information with the dark arrow pointing to the right. In the lower pane you can see the expanded message text.

Column width changes are saved and reused on subsequent Operations Navigator sessions.
Finding the current Operations Navigator window

Sometimes when working in Operations Navigator, or when returning to the Operations Navigator window after working with some other Windows operating system task (such as a browser) on your workstation “desktop”, you may temporarily not remember what your last active Operations Navigator window was or find that the Operations Navigator main window is not responsive to mouse clicks.

This can happen when working with an Operations Navigator component or function that opens a separate window. In almost all cases, selecting the Operations Navigator task displaying that separate window from the Windows operating system task bar (usually at the bottom of your display screen) gets you to the active Operations Navigator window where you must complete (click OK, Cancel, Windows close icon) the interaction with that Operations Navigator window.

In some cases you may find it easier to return to the appropriate Operations Navigator window by using the Windows operating system Alt-Tab keys function to change your active task.

You can perform this by holding down the Alt key and tapping the Tab key once. This brings up the window with icons representing each active Windows task. The icons typically include more than merely Operations Navigator related tasks.

With the Alt key still depressed, click of the Tab key once for each left to right movement to an active task. Using this function to switch to an Operations Navigator task will result in the active window being displayed.

See Figure 3-45 for an example, showing the Alt-Tab task selection window in the center.
Chapter 3. Installation and general navigation

105

3.4.2 Using Function Availability to determine missing components

There may be times when in an Operations Navigator session you realize not all Operations Navigator component folders are visible within the window. The Function Availability function can be used to identify the reasons you may not be able to see or use one of these components or associated function folder, such as:

- The Operations Navigator component, such as Work Management, was not installed (or selectively uninstalled) on your workstation.

- The Operations Navigator component is installed on your system, but you are connected to a system at an OS/400 release level that does not support the associated function. For example, Work Management is new starting with V5R1 and only Work Management -> Server Jobs is supported in V4R5. When connected to a V4R5 system, you would not see Work Management -> Active Jobs, Job Queues, Subsystems, or Memory Pools.

- Your system administrator has used the Client Access Operation Navigator Application Administration function to exclude your user ID from being able to access the function from Operations Navigator.
Select the system name under an environment, such as the default My Connections. Then select View -> Function Availability from the Operation Navigator menu bar to determine why you are missing components/folders. See the Function Availability example window in Figure 3-46.

![Figure 3-46 Using Function Availability](image)

Note the “Not supported on OS/400 version”, “Not installed”, and “ITSCID15 denied using Applications Administration” reasons for not being able to use an Operations Navigator function.

**Application Administration summary**

Application Administration is thoroughly covered in Chapter 12, “Application Administration component” on page 433. In this topic we give a short summary of its capabilities. Application Administration is a specifically installed Operations Navigator component. When any other Operations Navigator component or subcomponent has been installed on a client workstation, Application Administration may be initiated for a My Connections -> system name or the Management Central central system name. This support can enable or restrict Operations Navigator and Management Central functions installed on the workstation from being used. This restriction is based upon the OS/400 user profile (user ID) security attributes (privileges) used to sign on to the system under Operations Navigator.

In this topic, we discuss Application Administration only at a summary level. Know that My Connections -> system name ->Application Administration allows you administer the following application categories when any Operations Navigator user connects to the system:

- **AS/400 Operations Navigator**: Controls access to all Operations Navigator hierarchy functions and any plug-ins
**Client Applications**: Controls access from client applications such as client access functions (ODBC, 5250, data transfer and so on).

**Host Applications**: Controls access to selected Host applications that reside on the iSeries server. New starting in OS/400 V5R1 you can control host functions such as TCP/IP File Transfer Protocol (FTP), use of the Digital Certificate Manager (DCM) support, and use of various OS/400 hardware-related functions such as managing disk unit configuration, logical partition configurations, and *new for V5R1* simple cluster configurations.

**Attention**: Application Administration is a simple way to control whether specific Operations Navigator folders appear on the workstation for the currently signed on user. However, Application Administration is not considered a “security feature” because it does not restrict that same user from access to a function provided by that folder through some other interface, such as an OS/400 command from a 5250 emulation session.

For more information, see Chapter 12, “Application Administration component” on page 433.

### Task sharing

Several Operations Navigator or Management Central functions are performed as a separate task that can be started immediately or scheduled as a Management Central task. Examples of such tasks include running a command, collecting inventory, sending a package, sending and installing fixes.

When you define such a task the Operations Navigator and Management Central default is that only you, the definer, can see that task and monitor and control its status. In many cases you may want to enable other OS/400 users (user IDs) to also monitor that task and even also control that task.

With task sharing, you, specify default sharing for new tasks as:

- **None**: Only you can see and control the task
- **Read-only**: Other users can see the task and create a new task based upon the current task
- **Controlled**: Other users can see the task, create a new task based upon the current task, and start or stop the task. Only the definer can change the level of task sharing.

For either a system under My Connections or the Management Central central system you can access task sharing by first selecting the system and then selecting **menu bar Options** -&gt; **User Preferences** from the menu bar and then clicking the Task Sharing tab, which brings up the window shown in Figure 3-47.
Specifying task sharing in this manner applies generally to subsequent tasks during the current session and subsequent sessions.

Important: In addition to tasks, Management Central also has “objects” that can be shared. These objects include Definitions (commands, packages, monitors, and more) as well as system groups. The sharing values for these objects are not the same as for task sharing described here. For a discussion of task sharing and object sharing under Management Central, refer to “Task Sharing (and object sharing)” on page 199.

3.5 GUI Command Prompter

Prior to V5R1 several Management Central related functions supported running a command, such as the Run Command function in the My Connections -> system name context menu item, or defining a performance Monitor (called System Monitor in V5R1).

Prior to V5R1 you had to a command syntax checker, but no help prompts to assist you in building the correct character string for a specific command. New starting with V5R1 is the Graphical User Interface Command Prompter (GUI Prompter). This is an excellent alternative to using PC5250 to run OS/400 commands and is generally available for V5R1 functions that support running a command on your system.

This prompter integrates with a number of Operations Navigator components to allow you to use the prompt capabilities wherever necessary. The GUI prompter replicates the functions of an OS/400 5250 interface command line, allowing you to use normal function keys such as F1 for help, F4 to prompt, F11 for keywords and so on.
We use the example of creating a save file (CRTSAVF command generally demonstrate how to use the command prompter. Our example is based upon using the Run Command function from the context menu for a system, as shown in Figure 3-48.

![Figure 3-48  Running a command on a system](image)

You can enter the full command if you know it or just the generic beginning characters of the command, such as is shown in Figure 3-49 for crts*.
The dialog box in Figure 3-49 is similar to Operations Navigator releases prior to V5R1. However, the Check Syntax button from earlier releases has been replaced by the Prompt button. Run Command can be run as a task immediately (OK button) or later (Schedule button) as in previous releases.

As soon as you enter characters into the Command to run area, the Prompt button becomes enabled. You can click on the Prompt button or press F4 to prompt the entry in the dialog box. In this example we entered crts* and pressed the Prompt button to get the window shown in Figure 3-50.

By default, Operations Navigator uses the default system and user library lists, so if you want to use a command from a specific library, you should enter the fully qualified name (e.g. MYLIB/MYCOMMAND).

Continuing our CRTSAVF command example we have already selected that command as shown in Figure 3-50. We then click OK to bring up the left (basic parameters) window shown in Figure 3-51.
Figure 3-51 GUI prompter window - CRTSAVF (basic and advanced parameters)

From the left window, we can either F10 on the keyboard or the Advanced button in the window to show the advanced options, as shown in the right window in Figure 3-51. Similar to 5250 command prompting, F10 shows additional command parameters and pressing F11 on the keyboard will display the command keywords.

The two windows shown in Figure 3-51 are equivalent to the 5250 command prompt screen shown in Figure 3-52.
After entering the parameters for the command from the GUI prompter window, click OK to return to the Run command dialog box with your CL command displayed, as shown in Figure 3-53.

If you are satisfied with the command, you can view or change the Management Central options associated with running the command. Click the **Options** tab to get the window shown in Figure 3-54.
Select the Job log and Inquiry messages actions you want to use.

On either the General or Options windows you can click **OK** to run the command under Management Central immediately or click the **Schedule** to schedule the command to run at a later time on this system.

The capability to schedule a task and monitor task activity are discussed in Chapter 6, “Management Central and Monitors” on page 181.

### 3.5.1 Help information and sources

There are numerous ways to get online Help information when using Operations Navigator functions, including:

- **iSeries Information Center articles on:**
  - *iSeries 400 Information Center*, SK3T-4091 — CD-ROM shipped with each new OS/400 release, or

- **iSeries manuals on:**
  - *iSeries 400 Information Center Supplemental Manuals*, SK3T-4092 — CD-ROM, or

- **Operations Navigator online Help information accessed under the Help menu bar item:**
  - Welcome to Operations Navigator
  - What's new?
  - What can I do with ...?

- **Operations Navigator function specific window:**
  - Help button
  - The (question mark) ? icon for parameter-specific field level help (in this book we use (?) field level help to indicated this help interface)

- **Operations Navigator main window task pad ? Help for related tasks**

There are additional iSeries Web sites for specific major topics, including:

- **Management Central:** [http://www.ibm.com/eserver/iseries/sftsol/mgmtcetral.htm](http://www.ibm.com/eserver/iseries/sftsol/mgmtcetral.htm)
This topic gives examples on how to access the online Help information to ensure you can take real-time advantage of this information during an Operations Innovator session when actually doing a function or setting up a task.

Figure 3-55 highlights the ways to access online Help information using the Help option in a main Operations Navigator window.

You can:
- Use F1 on the keyboard or menu bar Help->Help Topics to display the online Help window shown in the lower left.
- Select Help -> iSeries 400 Information Center -> Open which displays the initial iSeries information Center in the right window. Location enables to specify opening to Information Center on the Web or to a directory path on your workstation’s disk or CD-ROM drive.

See “Information Center” on page 117 for more details.
- Select Help -> About Operations Navigator (not shown in Figure 3-55).
Online Help window
From the online Help window you can select:

- **Index tab**: Select this and you can use one or more search words to search within a list of words ordered as a typical index. As you enter search word characters the window showing the index is updated, based upon the entered character. At any time you can click on an index entry being displayed to see associated help information.

- **What's new?**: Select this to see a window of scrollable text that nicely summarizes, for V5R1, what is new within each Operations Navigator component.

- **What can I do with ...?**: Select this to access a very powerful set of information, organized according to each major Operations Navigator component (folder). Each component can be expanded to show lower level folders, very similar to the way you expand the left hierarchy tree pane of the main Operations Navigator window. We show an example of this in this topic.

  There is also a sub topic - **What else can I do?**, that can be very helpful. One of the items under this is “Tips”, which discusses many of the navigation topics described in this chapter.

- **Which Operations Navigator functions are available with each OS/400 release**: This is very useful when you are in an environment using more than one OS/400 release level.

- **Related information on the Internet**: Select this and, assuming your workstation has a browser with access to the Internet, you can link to the Web sites for Operations Navigator, Management Central, and how to make an application an Operations Navigator plug-in.

Each installed component of Operations Navigator has its own help interface and associated index. The menu bar Help -> Help Topics functions are intended to give you help information over all Operations Navigator functions and things you can do. Detail help information is available through a component’s help interface - when you are performing functions within that component. For example:

- When you select menu bar Help -> Help Topics the help information and index is for the cwbunovr.hlp file.

- When you select help using a Management Central function, the help information and index is for the cwbunyp.hlp file.

**Function specific window and parameter-specific help**
New for V5R1 is some very powerful online Help information that is oriented to the specific function window currently displayed on your workstation. The available help facilities are:

- **Help button**: This button applies to the whole window contents or task being defined and can lead to help on other related topics.

- **(?) field level (parameter specific) help - (?) field level help**: Select the ? symbol and drag it to a specific field (parameter) within a window to see help information only for that field.

Taskpad ? Help for related tasks links to help information organized and navigated similar to the description in this topic.

Figure 3-56 shows an example of using this window specific help information with Work Management -> Active Jobs -> job name -> Properties -> Performance.
The upper grey background window shows the job Performance properties. We pressed the Help button to get the Performance help information shown in the lower window. In this example we selected and dragged the (?) field level help icon to the Run priority parameter which brought up the middle right help information window.

Note the following:

- The extensive "table of contents" left pane in both help windows
- The forward (>) and backward (<) icons at 1 for navigating through already displayed help windows

Figure 3-56   Window and window parameter-specific help example
The print and print set up icons at for printing help information

**Information Center**

Information Center should be considered the primary place to go to information on all iSeries capabilities.

Included with your V5R1 Operating System are two CD-ROMs containing the iSeries 400 Information Center and related documentation, also referred to as InfoCenter. These CD-ROMs, *iSeries 400 Information Center, SK3T-4091* and *iSeries 400 Information Center Supplemental Manuals, SK3T-4092* contain the files necessary for you to install the Operations Navigator content on your PC workstation, to a shared drive, or to your iSeries server using a Web server.

Using the Web server option rather than these CD-ROMs has the added advantage of being able to search the contents of the InfoCenter. The Information Center Web content is available on the Internet at [http://www.ibm.com/eserver/iseries/infocenter](http://www.ibm.com/eserver/iseries/infocenter) and contains the latest information regarding the entire range of iSeries capabilities.

Information Center should be considered the primary place to go to information on Operations Navigator after first using the following online Help information:

- Operation Navigator menu bar Help
- Operations Navigator window-specific online help information

Because of the importance of Information Center documentation in enabling you to use the entire range of iSeries capabilities, the next topic helps you install Information Center.

**Installing Information Center**

The *iSeries 400 Information Center, SK3T-4091* — CD-ROM will autoplay when inserted into your PC workstation CD-ROM drive. If you do not have autoplay enabled, you can manually run the installation program by running `x:\icinstall.exe` where `x` is the letter of your CD-ROM drive. This will launch the installation wizard for Information Center. You have a number of options for destination systems and installation type, including the ability to leave the content on the CD-ROM and only access the information when the CD-ROM is inserted in your PC workstation. You can also decide if you wish to install the supplemental manuals from the second CD-ROM. The installation wizard will prompt you to insert the supplemental manuals CD-ROM at the appropriate time. If you wish to install the supplemental manuals at a later date, you can do so by running the installation wizard from the first CD-ROM again, and enabling the installation of the supplemental manuals. If you do not wish to go through the entire installation process again, you can insert the *iSeries 400 Information Center Supplemental Manuals, SK3T-4092* — CD-ROM in your PC workstation CD-ROM drive, and run the installation program `x:\sminstall.exe` where `x` is the letter of your CD-ROM drive.

**Accessing Information Center**

When installed, an icon will be placed on your desktop allowing you to access the InfoCenter content without launching Operations Navigator. Selecting this icon will open your default browser and ask you if you wish to access the Internet version or the local version of the content, as shown in Figure 3-57. The Internet version is preferable as it is searchable and contains the latest content.
You can also launch Information Center by selecting Help -> iSeries 400 Information Center -> Open from the Operations Navigator window. The version of Information Center accessed is determined by the Location configuration on the same menu. If you elected to change Operations Navigator to access the local version of Information Center when installing, the details in Figure 3-58 will be changed to reflect the local path to the files.
Basic Operations

This chapter describes the functions and sub functions of the Basic Operations component of Operations Navigator. The following areas are discussed:

- Messages
- Printer Output
- Printers
- Jobs
- Basic Operations hints and tips
4.1 Basic Operations overview

This component of Operations Navigator is installed by default when selecting either the Typical or Full installation options of Client Access Express. If this component is not currently installed, you can use Selective Setup to install it. See “Selective setup” on page 60.

This chapter assumes you are familiar with general navigation terms and techniques described in 3.4, “General navigation” on page 82.

Basic Operations functions are grouped into four subcomponent folders:

- **Messages**: Send, view, manage messages
- **Printer Output**: View and manage printer output (entries) on spooled output queues
- **Printers**: View, start and stop (“print writers”), share printers, and perform other printer management functions
- **Jobs**: View, hold, release and delete (end) jobs and perform other job management functions

Some functions, such as managing jobs and printer output require specific user ID (profile) privileges. See online Help for more details for each function.

Application Administration can be used to control access to the Basic Operations folders based upon user profile security privileges (attributes). See Chapter 12, “Application Administration component” on page 433 for more information.

The Basic Operations folders are shown in Figure 4-1. Context menus for each folder are also shown.

![Figure 4-1 Selecting Basic Operations in the tree view](image)

Prior to V5R1, there was a folder called **Job Management**, which included Jobs and Server Jobs. **Jobs**, which allows users to look at user jobs (similar to the Work with User Jobs, WRKUSRJOB OS/400 command), is now under Basic Operations. **Server Jobs** has become part of the new Work Management component, along with such functions as Active Jobs and Subsystems. Work Management is covered in Chapter 5, “Work Management” on page 139.

With the move of Jobs to Basic Operations, the functions you could perform on user jobs (for example hold, release and delete) in prior releases has not changed.
A new Monitor function has been added to both Messages and Jobs. The Message Monitor enables sophisticated monitoring of message queues and specific message attributes on that queue - automatically giving a message response or calling a program. The Job Monitor enables monitoring of some job performance metrics, job log entries and job status changes. Monitors are described in Chapter 6, “Management Central and Monitors” on page 181.

Printer Output, and Printers functionality has not changed in V5R1.

The following topics provide additional information on folder functions.

### 4.2 Messages

The Messages function enables you to view and manage message on message queues on your iSeries server. The operations you can perform include:

- Displaying messages
- Replying to inquiry messages
- Sending messages
- Deleting messages
- Displaying message properties

This function offers similar functionality to the Display Messages (DSPMSG), Send Message (SNDMSG) and Send Break Message (SNDBRKMSG) OS/400 command functions.

The Messages functions are intended for processing messages by an operator action. If you are considering automated message handling at least for some messages, OS/400 has several facilities to reduce manual interaction with automated message handling. There are also third party products that are dedicated to this automation.

Here is a quick summary of OS/400-provided facilities for automated message handling:

- Setting a message queue to default mode. When an inquiry message arrives on this queue, the default reply is automatically taken.
- Adding an entry into the OS/400 System Reply List via the Add Reply List Entry (ADDRPYLE) command. The entry can specify the message ID, and other message data compare values and the message response. This is used for messages sent to the system operator's message queue - QSYSOPR.
- Using the new for V5R1 Message Monitor support as described in the Management Central Chapter. This offers a powerful set of message monitoring options.

Basic Operations -> Messages defaults to displaying messages only on the message queue associated with the Operations Navigator signed on user. You can use menu bar Options -> Include to include only messages with a message severity of a specific value.

In our example in Figure 4-2 we have used menu bar Options -> Include to change our session to look at messages on the system operator message queue, known as QSYSOPR as shown at [1].
Note the icons to the left of each message and that the inquiry message icon includes a ? question mark.

The lower window in Figure 4-2 shows a message details example for a file open error.

Messages are listed in the following order of message types:

- Unanswered inquiry messages
- Sender's copy of messages needing a reply
- Messages not needing a reply

The newest messages are higher in the list of each message type. For example, an unanswered inquiry message received yesterday is listed higher than a message not needing a reply received today.

**Tip: Message refresh**

The list of messages in the list view pane is not, by default automatically updated when a new message arrives on the queue being displayed. On a "busy" message queue, the displayed list can rapidly become out of date if the list is not refreshed frequently. Use F5 or the Refresh icon to update the message list.

Alternatively you could set up an automatic refresh of the messages on the message queue (such as every 5 minutes) by selecting **Basic Operations -> Messages -> Properties**.

When you right-click a message in the list view (as shown previously in Figure 4-1), you are presented with a context menu of actions which can be performed:
Chapter 4. Basic Operations

123

Chapter 4. Basic Operations

**Details**: Displays a dialog box giving the message ID (if it has one), date and time sent, the full message text, and any associated message help.

**Reply...**: This action is only available for unanswered inquiry messages. A dialog box is displayed giving the user the capability of replying to the selected message.

**Send Message...**: Opens a dialog box which enables you to input and send a message to another user on the iSeries server. There is an option to Interrupt user, which is equivalent to the OS/400 Send Break Message (SNDBRKMSG) command.

**Delete...**: Allows you to delete the currently selected message (or messages, by holding down the Shift key as you select messages). A dialog box is displayed asking you to confirm this action.

**Properties**: Displays detailed properties of the message including the name of the sending job and program.

**Monitor**: This links you to the function that enables you to define and start a Message monitor. When you define a monitor from this interface, the message or messages selected here and their associated message queue are already “entered” into the Message Monitor definition.

### 4.2.1 Message security

In most topics in these redbook volumes we suggest you use online Help to review any special privileges (authorities) needed to do the functions listed. However, in this topic we give you specific details.

To display messages and their properties, you need at least *USE privilege to the message queue. To delete messages or reply to inquiry messages, you must have at least *CHANGE privilege to the message queue. If you try to perform an action on a message, which is on a message queue that you are not authorized to, an error message is issued, similar to the one shown in Figure 4-3.

**Note**: The message will only interrupt the recipient if the user is using a 5250 session at the time the message is received. A user signed on to a client/server session, such as when using Operations Navigator, will not see the message immediately. Assuming the receiver of your message is using Operations Navigator, that person could use the refresh alternatives. For critical messages that person could also use a Message monitor. Message monitors are discussed in Chapter 6, “Management Central and Monitors” on page 181.

To display messages and their properties, you need at least *USE privilege to the message queue. To delete messages or reply to inquiry messages, you must have at least *CHANGE privilege to the message queue. If you try to perform an action on a message, which is on a message queue that you are not authorized to, an error message is issued, similar to the one shown in Figure 4-3.

![Image](AS/400%20Operations%20Navigator.png)

**Figure 4-3** Not authorized to the message queue

The redbook *Managing OS/400 with Operations Navigator V5R1 Volume 2: Security*, SG24-6227 provides additional Operations Navigator security information. For complete information on OS/400 security, refer to *OS/400 Security - Reference V5R1*, SC41-5302.
4.3 Printer Output functions

The Printer Output functions enables you to view and manage spooled files on iSeries output queues and printers printing that output.

These Printer Output functions are generally equivalent to using the Work with Spooled Files (WRKSPLF) OS/400 command.

When you right-click a spooled file (Output name column), you are presented with a context menu of actions as shown in Figure 4-4. These include:

- **Open**: Displays the contents of the spooled file using the AFP Workbench Viewer if it is installed. See “AFP Workbench Viewer” on page 127, for more details. This is similar to choosing option 5 (Display) within the Work with All Spooled Files (WRKSPLF) display, or using the Display Spooled File (DSPSPLF) OS/400 command.

- **Reply...**: If the selected spooled file is in Message waiting status, you can reply to the message. This is equivalent to choosing option 7 (Messages) within the Work with All Spooled Files (WRKSPLF) display.

- **Hold...**: Enables you to hold the spooled file immediately or at end of page. This is equivalent to choosing option 3 (Hold) within the Work with All Spooled Files (WRKSPLF) display, or using the Hold Spooled File (HLDSPLF) OS/400 command.

- **Release**: If currently in Held status, you can release the spooled file for processing. This is equivalent to choosing option 6 (Release) within the Work with All Spooled Files (WRKSPLF) display, or using the Release Spooled File (RLSSPLF) OS/400 command.

- **Print Next**: Prints the selected spooled file immediately after the current spooled file has finished printing. If multiple spooled files are selected, they are printed in reverse order of selection. This is equivalent to entering a value of *NEXT for the Print sequence (PRTSEQ) parameter on the Change Spooled File Attributes (CHGSPLFA) OS/400 command.

- **Send...**: Allows you to send the spooled file to one or more users on the same iSeries server, or other systems (including VM/MVS). This is equivalent to choosing option 1 (Send) within the Work with All Spooled Files (WRKSPLF) display, or using the Send Network Spooled File (SNDNETSPLF) OS/400 command.

Each two part user name you specify must be a valid entry in the System Distribution Directory. An authorized user can manage entries in this directory through the Work with Directory Entries (WRKDIRE) OS/400 command.

Important: This function is supported only when the IBM-supplied SNA Distribution Services subsystem (QSNADS) is active on the sending and receiving iSeries servers or, for VM and MVS systems, the equivalent support is active. When sending to a different iSeries server both systems must also have an SNA APPC-based configuration active.

OS/400 supports ANYNET, which enables SNA protocols over TCP/IP and Sockets protocols over SNA. For more information refer to the iSeries Communications Configuration, SC41-5401, manual which can be found in Information Center under Supplemental Manuals.

Note, however, you can move or copy a spooled file from one iSeries to another under a TCP/IP network. Simply use the Cut, Copy, or Move actions on the from system and the Paste action on the target system. You can also use the mouse drag-and-drop technique. See “Dragging and dropping spooled files” on page 135 for an example.
Cut: Cuts the selected spooled file to the Windows clipboard so that it can then be pasted onto the desktop or onto a printer listed under the Printers branch of Basic Operations.

Copy: Copies the selected spooled file to the Windows clipboard so that it can be pasted elsewhere as described above.

Move...: Allows you to move the selected spooled file to another printer or output queue on the same iSeries server. This would be achieved using the Change Spooled File Attributes (CHGSPLFA) OS/400 command.

You can also move a spooled file to another printer using the left mouse button drag-and-drop technique.

Delete...: Allows you to delete the selected spooled file from the iSeries server. This is equivalent to choosing option 4 (Delete) within the Work with All Spooled Files (WRKSPLF) display, or using the Delete Spooled File (DLTSPLF) OS/400 command.

Properties: Displays the attributes of the selected spooled file, and where possible, allows changes to be made to them. On a 5250 screen, this would be accomplished using a combination of the Work with Spooled File Attributes (WRKSPLFA) and Change Spooled File Attributes (CHGSPLFA) OS/400 commands.

Depending on the status of the specific spool file, some items may not be active (grayed out).

Basic Operations -> Printer Output defaults to displaying all output for the currently signed on user. The output is ordered according to ascending file created date and time of day.

Consider using the menu bar Options -> Include, Sort, or Columns functions to modify the information displayed.

Figure 4-4 show and example of all spooled files for the signed on user - As0301. The default primary sort ordering column is Status, then in descending order of date created and ascending time within the date created. Spooled files assigned to printers appears ahead of spooled files unassigned.

We have changed the column widths to get the example shown.

The Printer Output window is not automatically updated when new spooled files become available or some other printer output action occurs. Remember to use the Refresh function to see the most recent information or set up automatic refresh.
Figure 4-5 is used to give you an idea of what the spooled file Properties look like, showing general and overlay properties.

Note, if you were using print overlays how you could modify some values to see if you like the printed page before finalizing the page format. You can change other file attributes, such as save after printing, user-defined data which helps identify the file contents, number of copies, and more.

4.3.1 Printer output security

In most topics in these redbook volumes we suggest you use online Help to review any special privileges (authorities) to do the functions listed. However, in this topic we give you specific details.

In general, system privilege spool control (*SPLCTL in 5250 command interface terminology) is needed to perform an action on a spooled file. Although any user can retrieve a list of all spooled files on an iSeries server, if you try to view or manage one without the proper authority, you get an error message. For example, trying to display a spooled file without the proper authority results in an error message similar to the one shown in Figure 4-6.
Redbook *Managing OS/400 with Operations Navigator V5R1, Volume 2: Security*, SG24-6227, provides additional Operations Navigator security information. For complete information on OS/400 security, refer to *OS/400 Security - Reference V5R1*, SC41-5302.

**AFP Workbench Viewer**

Client Access Express for Windows provides the full-function Advanced Function Presentation (AFP) Workbench Viewer for Windows 95/NT as an installable option. If it is not currently installed on your PC, you can run Selective Setup to install it. See “Selective setup” on page 60, for more details.

The AFP Workbench Viewer also supports many popular PC file formats, such as ASCII, TIFF and GIF.

The AFP Workbench Viewer can be used to view and print iSeries advanced function printing (AFP) and SNA character set (SCS) spooled files, including Operations Navigator interfaces to Open spooled file output and other job-oriented functions, such as viewing a job’s current print output and job log information.

For more information on the AFP Workbench Viewer, please refer to:

- AS/400 Client Access Express for Windows: Implementing V4R4M0, SG24-5191
- IBM AS/400 Printing V, SG24-2160
- IBM AFP Workbench for Windows NT and 95: Technical Reference, S544-5602 (file named afptech2.afp, located within the AFPViewr\Data sub-directory of the Client Access Express installation path)

This function is separate and provides completely different functions from the Operations Navigator -> AFP Manager component.

### 4.4 Printers

The Printers function allows you to manage all printers on the iSeries server. It combines the operations associated with writers, printer devices, and output queues into one logical *printer* rather than having to work with each separately. In a 5250 screen environment, this function is equivalent to using the Work with All Printers (WRKWTR) OS/400 command.

As shown in Figure 4-7, expanding the Printers folder lists the printers in the left pane and selecting the Printers folder displays the list view of configured printers in the details pane. This figure is also used to show the context menu of possible actions.
When you right-click a printer device (Printer column), you are presented with a context menu of actions as shown in Figure 4-7, which can be performed. These include:

- **Explore**: Displays the spooled files currently on the printer's output queue, in the list view. This is similar to using the Printer Output branch under Basic Operations, except the list view is already filtered to show spooled files for one specific printer. See 4.3, “Printer Output functions” on page 124, for further details on managing spooled files.

- **Open**: This does the same as Explore, except that the contents of the output queue assigned to the printer are displayed in a new window. This is equivalent to using the Work with Output Queue (WRKOUTQ) OS/400 command, providing you know the name of the specific output queue with which you want to work.

- **Create Shortcut**: Creates a shortcut icon on the desktop, which, when double-clicked, does the same as the Open option.

- **Printer Output**: This is similar to the Open action except that the resultant window provides greater flexibility for changing spooled file properties. For example, you can edit the User-specified data field simply by clicking it.

- **Sharing**: Enables you to define the selected printer as a New Share... in AS/400 NetServer. This option is not selectable (grayed out) if the current user does not have +IOSYSCFG special authority. See 4.4.3, “AS/400 NetServer integration” on page 131 for important information on this feature.

- **Publishing...**: Allows you to display or change whether the printer and its print shares are published to an LDAP directory server. You must have Directory Services configured and active on your iSeries server to publish this information.

You can access LDAP configuration through **My Connections -> system name -> Properties -> Directory Services**. For assistance in setting up Directory Services go to Information Center and use search words “print AND publish”. A good article found is titled “Publishing OS/400 information to the directory server.

- **Reply...**: If the selected printer is in Message waiting status, you can reply to the message.
Hold...: Allows you to hold the printer either Immediately, After the current copy, or At page end. This is equivalent to choosing option 3 (Hold) within the Work with All Printers (WRKWTR) display, or using the Hold Writer (HLDWTR) OS/400 command. 

Release...: If the selected printer is in Held status, you can release it. This is equivalent to choosing option 6 (Release) within the Work with All Printers (WRKWTR) display, or using the Release Writer (RLSWTR) OS/400 command. 

Start...: Enables you to start the printer writer. There are several starting options you can change, such as the Output and Message queue. This is equivalent to choosing option 1 (Start) within the Work with All Printers (WRKWTR) display, or using the Start Printer Writer (STRPRTWTR) OS/400 command. 

Stop...: This allows you to end the printer writer. You can choose to stop printing either After current copy, Immediately, or At the end of the page. This is equivalent to choosing option 4 (End) within the Work with All Printers (WRKWTR) display, or using the End Writer (ENDWTR) OS/400 command. 

Restart...: This allows you to restart the print job at the Starting page, Ending page, Next page, or at a Page number of your choice. In a 5250 screen, you would use the CHGSPLFA OS/400 command and specify an appropriate value for the Restart printing (RESTART) parameter. 

Make Available: This makes the printer device available. This is equivalent to using the Vary Configuration (VRYCFG STATUS(*ON)) OS/400 command. 

Make Unavailable: This makes the printer device unavailable. This is the same as issuing the VRYCFG STATUS(*OFF) OS/400 command. 

Paste: If you have used the Copy action on a spooled file (Basic Operations -> Printer Output) in a previous operation, and that spooled file is still on the Windows clipboard, you can paste it onto the selected printer's output queue. 

Properties: Displays a notebook of printer properties, some of which you can change depending on the current status of the selected printer. See 4.4.1, “Displaying and changing printer properties” on page 130, for more details. 

Some actions may not be selectable (text is grayed out), depending on the current status of the printer you have selected.

Basic Operations -> Printers defaults to displaying all printers defined on the system in name alphabetical sequence. Consider using the menu bar Options -> Include or Columns functions to modify the information displayed.

For certain menu actions, such as start and stop, you can select one or more printers in the details pane and perform the function on all of them.

Consider using a shortcut if you frequently do printer management functions.

Figure 4-8 shows an example of the spooled files currently assigned to printer Prtnp17.
The list of printed output files is not, by default, automatically updated when a file is added or deleted. Remember to use the Refresh function or set up automatic refresh.

4.4.1 Displaying and changing printer properties

There are some printer properties worth calling your attention to. Selecting Properties of a printer opens a window similar to the one shown in Figure 4-9.

If a printer is not started, only the General, Output Queue, and Device pages are available. Each properties window displays current information about the printer, and in most cases, allows you to make changes.

For example, the General page (as shown in Figure 4-9) displays:

- The printer name, type, description, and status
- The user that started the printer
- The message queue and library

This page also contains a Changes take effect field. You can choose when you want any changes made to the properties to take effect. The choices are: After all files print or After the current file prints. Additionally, if the printer is in Unavailable status, you can change its description.
4.4.2 Printers and Printer Output tips

By default, the Printers view only shows the spooled files for printers that have a device description. If you utilize remote output queues, we have the following suggestions to view your output in Operations Navigator:

- To view output by user, use the Options -> Include and select (“filter”) by user name as listed in “Printer Output functions” on page 124.
- To view by output queue, you can choose to filter the Printers or Printer Output functions to display all information, use Options -> Columns to include the output queue in the displayed information, and sort the window by output queue.

These methods can be cumbersome. An excellent alternative is to create a virtual printer device name to match the name of your output queue. This displays a printer in the Printers function of Basic Operations that behaves as a normal physical printer when displaying the output queue contents. A sample CL to create virtual device descriptions for all remote output queues is in “Sample CL program to create printer device descriptions” on page 137.

4.4.3 AS/400 NetServer integration

Notice that in Figure 4-7 on page 128, the printer named Murprint (first printer listed) has a hand symbol indicating that it is being shared on the network using NetServer. When a printer is shared using NetServer, any Windows client can send printer output to it across the network, providing they have the proper authorization.

The ability to define new printer shares in NetServer has been integrated into the Printers folder of Basic Operations. You do not need the Network component of Operations Navigator installed on your workstation to create new shares within the Printers function. However, in order to disable sharing of one or more printers, you must have the Network component installed. To disable a print share, open AS/400 NetServer by selecting Network -> Servers -> TCP/IP in the tree view, and then select AS/400 NetServer in the list view.

For more information on NetServer, refer to:
  - Select Networking -> TCP/IP -> AS/400 NetServer. This location has excellent information, including security an performance information.
- iSeries Client Access Express for Windows - Setup: V5R1, SC41-5507
- The AS/400 NetServer Advantage, SG24-5196

4.4.4 Printer security

In most topics in these redbook volumes we suggest you use online Help to review any special privileges (authorities) to do the functions listed. However, in this topic we give you specific details.

Standard OS/400 security rules apply when you try to manage printers. For example, to start a printer, proper authority to the output queue and device description is needed.

A user is authorized to an output queue if one or more of the following statements are true:

- The user has System privilege spool control (*SPLCTL) authority.
- The user has System privilege job control (*JOBCTL) special authority and the output queue has the value *YES for the Operator controlled (OPRCTL) parameter.
The user has Add (*ADD), Delete (*DLT), and Read (*READ) data permissions to the output queue, and the output queue has the Authority to check (AUTCHK) parameter defined as *DTAAUT.

The user is the owner of the output queue and the output queue has the AUTCHK parameter defined as *OWNER.

See Redbook Managing OS/400 with Operations Navigator V5R1 Volume 2: Security, SG24-6227 provides additional Operations Navigator security information. For more detailed information on security, refer to OS/400 Security - Reference V5R1, SC41-5302.

### 4.5 Jobs

The Jobs function enables you to view and manage jobs on the system. You can do many job management functions from this folder, but the Work Management component, provided with V5R1, offers more function and flexibility. You would use the Jobs component as a way to limit some of the job management capabilities.

For example, by default you are presented with only the jobs actively running (or held) on the system that are running under your user ID (profile) name.

In our screen examples in this topic, we have used menu bar Options -> Include to specify “all jobs”. Because displaying job information for “all jobs” could have a performance impact on a production system with thousands of jobs active, we show later a menu bar Options -> Include example to demonstrate the powerful job selection capabilities available with the Jobs folder.

When you right-click a job, you are presented with a context menu of actions as shown in Figure 4-10.

![Figure 4-10 Jobs and context menu example](image)

Menu actions include:

- **Printer Output**: This opens a new window and displays any spooled output associated with the selected job. See 4.3, “Printer Output functions” on page 124, for more details. This is equivalent to choosing option 4 (Work with spooled files) from the Work with Job menu in a 5250 screen.
► **Job Log**: This action opens a new window which displays the job log of the selected job. The messages within the job log can then be viewed in detail. This is equivalent to choosing option 10 (Display job log, if active or on job queue) from the Work with Job menu, in a 5250 screen.

► **Reply...**: Enables you to view and reply to any unanswered inquiry messages associated with the selected job.

► **Hold...**: You can hold the selected job, and if necessary, any associated printer output. This is equivalent to the Hold Job (HLDJOB) OS/400 command or taking option 42 (Hold job) from the Work with Job menu, in a 5250 screen.

► **Release**: If in held status, you can release the selected job. This is equivalent to taking option 43 (Release job) from the Work with Job menu, or using the Release Job (RLSJOB) OS/400 command.

► **Move...**: If the selected job is on a job queue, you can move it to a different job queue. This is equivalent to the Transfer Job (TFRJOB) OS/400 command, or using option 40 (Change job) from the Work with Job menu, in a 5250 screen.

► **Delete...**: This enables you to delete (end) the selected job from the system. When this action is chosen, you are presented with a confirmation dialog which gives you the chance to specify further options such as, *How to end* (controlled or immediately). This is equivalent to the End Job (ENDJOB) OS/400 command or choosing option 41 (End job) from the Work with Job menu, in a 5250 screen.

► **Properties**: This opens a window displaying the properties of the selected job. Depending on the status and type of job, many of the properties can be changed. This is equivalent to using the Display Job (DSPJOB) and Change Job (CHGJOB) OS/400 commands or taking a combination of options from the Work with Job menu, in a 5250 screen.

Note OS/400 “system jobs” properties cannot be changed.

► **Monitor**: This links you to the Job monitor functions where you can define a new Job monitor. The job or jobs selected are already “entered” into the Job Monitor definition. See Chapter 6, “Management Central and Monitors” on page 181.

Some actions may not be selectable (text grayed out), based upon the current job status.

As previously stated **Basic Operations -> Jobs** defaults to only displaying jobs currently running under the Operations Navigator signed on user ID. If there are no active 5250 or non-interactive jobs running under this user ID, the details pane is empty!

**Tips:**

1. Although you are using Operations Navigator, the server jobs running your session were started using the IBM-supplied QUSER profile. **Basic Operations -> Jobs** sees only this QUSER profile.

   This highlights a significant usability enhancement when viewing jobs under the new for V5R1 Work Management component/folder. **Work Management** looks into these QUSER jobs, finds the currently active user and for a job list function would include those server jobs with any other 5250 or non-interactive jobs using that user profile.

2. If you want to look at more jobs than just those running with your user ID, consider using **menu bar Options -> Include**. On a system with thousands of active jobs (for example, many Domino for iSeries or Web serving sessions), make sure you consider using the Include “filtering parameters” to reduce the system overhead required to display all active jobs.
You can use **menu bar Options -> Include** to specify what jobs are included in the list. Basic Operations -> Jobs has a powerful list of parameters to control what jobs are listed as shown in Figure 4-11:

- Three part job name
- Job type
- Job status, including active (running or held), jobs on a job queue, jobs completed but with spooled output

Consider using the **menu bar Options -> Sort or Columns** functions for additional ways to modify the information displayed in the details pane. There are a significant number of columns not displayed by default and you may want a different sorting order of items in the list.

### 4.5.1 Job properties

**Basic Operations -> Jobs -> job name -> Properties** provides much information about the job. Some properties can be changed real-time, except for system and subsystem jobs. See Figure 4-9 on page 130 for an example of the Active properties.
4.6 Basic Operations hints and tips

This section offers some hints and tips on using Operations Navigator Basic Operations more productively.

4.6.1 Dragging and dropping spooled files

Spooled files can be manipulated within Operations Navigator using the mouse drag-and-drop technique. You can:

- Move or copy iSeries a spooled file from one printer to another on the same iSeries server.
- Move or copy iSeries a spooled file from a printer to a printer on a different iSeries server.

**Note:** For this function, the iSeries servers must be able to communicate using TCP/IP and the line printer daemon (LPD) server must be started on the target iSeries server.

- Copy iSeries printer output to the PC desktop (or any Windows folder) to create an ASCII text file (graphic data is ignored).

**Dragging and dropping a spooled file to the PC desktop example**

This example explains how to create a text file on the PC desktop by dragging and dropping an iSeries spooled file from within Operations Navigator:

1. Open Operations Navigator and select **Basic Operations->Printer Output**.
2. Choose an iSeries spooled file from the list view, then drag-and-drop the file to any open area of the desktop. The data is copied to the PC and the ASCII text file is created, as shown in Figure 4-13.
Dragging and dropping spooled file between iSeries servers example

This example shows how to copy two spooled files from an output queue on one iSeries server to a printer on another iSeries server using the mouse drag-and-drop technique.

1. On the from system (As01 in our example), display the printed output on one or more output queues (as shown in the top window of Figure 4-14).

2. Select the file(s) to be dragged (copied). In our example we have selected two files.

3. Scroll down the left pane to get to the Printers folder on the target system (As25b in our example). We have displayed the output files associated with printer Prtnp17 in the middle window.

4. Use the left mouse button to drag the selected file(s) to the target system’s printer. The copy is performed after you release the left mouse button.
Figure 4-14  Copying spooled files between iSeries servers example

The lower right window shows that both files have been copied and the print writer for printer Prtnp17 has already attempted to print the first file as indicated by the Message status (printer was out of paper).

Under the User column on both systems, note the change in the user name on the target system. AS0325 is the user ID of the Operations Navigator session to each system.

4.6.2 Sample CL program to create printer device descriptions

In “Printers and Printer Output tips” on page 131, a technique for showing output queue spooled files when no printer device descriptions exists was described. This topic describes the CL program described in that topic.

The following is a sample CL program to create a virtual device description for any remote output queue in QUSRSYS. The resulting virtual device description will allow you to easily manage the contents of the output queue within Operations Navigator.
Figure 4-15  Sample CL program to create virtual printer descriptions

```
0001.00              PGM
0002.00 /* Variable definitions */
0003.00 /* File QADSPOBJ -- System supplied definition for DSPOBJD to an *OUTFILE */
0004.00 /* -- we use field &ODOBNM (Object Name) from this file */
0005.00
0006.00              DCLF       FILE(QADSPOBJ)
0007.00
0008.00 /* Get a list of all OUTQs in QUSRSYS */
0009.00              DSPOBJD    OBJ(QUSRSYS/*ALL) OBJTYPE(*OUTQ) +
0010.00              OUTPUT(*OUTFILE) OUTFILE(QTEMP/DSPOBJD)
0011.00              OVRDBF     FILE(QADSPOBJ) TOFILE(QTEMP/DSPOBJD)
0012.00
0013.00 /* Start reading the file produced... */
0014.00              LOOP:       RCVF
0015.00              MONMSG     MSGID(CPF0864) EXEC(GOTO CMDLBL(EXIT))
0016.00
0017.00 /* Do not process outqs starting with 'Q' (QEZDEBUG, QEZJOBLOG) */
0018.00              IF         COND(%SST(&ODOBNM 1 1) = 'Q') THEN(GOTO +
0019.00                           CMDLBL(LOOP))
0020.00
0021.00 /* If the DEVD for the out does NOT exist, we need to create it */
0022.00              CHKOBJ     OBJ(QSYS/&ODOBNM) OBJTYPE(*DEVD)
0023.00              MONMSG     MSGID(CPF9801) EXEC(DO) /* DEVD does NOT exist */
0024.00
0025.00 /* Create the virtual device description (which also creates an out */
0026.00              CRTDEVPRT  DEVD(&ODOBNM) DEVCLS(*VRT) TYPE(3812) +
0027.00                           MODEL(1) ONLINE(*NO) FONT(11) +
0028.00                           TEXT('Virtual Printer Definition for Ops +
0029.00                           Nav') AUT(*ALL)
0030.00              MONMSG     MSGID(CPF0000)
0031.00
0032.00
0033.00 /* Read the next record from the file until done... */
0034.00              ENDDO
0035.00
0036.00              EXIT:       ENDPGM
```

138  Managing OS/400 with Operations Navigator V5R1 Volume 1: Overview and More
Work Management

This chapter describes how to use the new for V5R1 Operations Navigator Work Management component interfaces to the powerful OS/400 work management capabilities. These functions are grouped according to the following:

- Active Jobs
- Server Jobs
- Job Queues
- Subsystems
- Memory Pools
5.1 Introduction

OS/400 has provided outstanding capabilities for you to manage work on an iSeries server for several releases through the powerful set of OS/400 work management-related commands that include defining and managing OS/400 subsystems, and the jobs, job queues and memory pools associated with those subsystems.

For a complete description of OS/400 work management, refer to Work Management, SC41-5306, which can be accessed at Web site: http://publib.boulder.ibm.com/html/as400/v5r1/ic2924/index.htm

Starting with V5R1, the Operations Navigator Work Management component offers a powerful graphical interface to these OS/400 work management capabilities that are easier to use than the still available OS/400 commands, including Work with Active Jobs (WRKACTJOB), Work with Job Queues (WRKJOBQ), Work with Subsystems (WRKSBLS), Work with Subsystem Jobs (WRKSBLSJOB), and Work with User Jobs (WRKUSRJOBS). Also included are interfaces to most of the storage pool functions provided by the Work with System Status (WRKSYSSTS) and Work with Shared Pools (WRKSHRPOOL) commands.

This component is installed through either Client Access Express Full or Custom installation. If this component is not installed on your workstation you can install it by running Selective Setup as discussed in “Selective setup” on page 60.

In V5R1, the Work Management component tasks are geared toward the day-to-day routine of the System Operator in managing jobs and monitoring the system. The highlight of the Work Management subcomponents (folders) is they integrate the interfaces and functions from the several OS/400 commands listed above listed into a single place to more easily take advantage of the OS/400 work management capabilities. And, starting with V5R1, for jobs that need extra managing, you can link to the new Job monitor support (described in Chapter 6, “Management Central and Monitors” on page 181) by simply right-clicking the job name shown in a window.

You get to the Work Management component folders through My Connections -> system -> Work Management. The navigation tree of Work Management consists of five main folders as shown with their first level context menus in Figure 5-1.
Before going into more detail on the functions available with each of these Work Management folders, we note a change in the job management through Operations Navigator starting with V5R1. Prior to V5R1 of Operations Navigator, there was a Job Management folder in the tree under each iSeries server. In V5R1, the name Job Management has been changed to Work Management and functions enhanced. Along with this change, the Jobs function has been moved to Basic Operations and the Server Jobs function is under the Work Management folder along with new functions through the Active Jobs, Job Queues, Subsystems and Memory Pools folders.

See 4.5, “Jobs” on page 132 for job management capabilities under the Basic Operations component.

- **Active Jobs**: You can view all jobs on the system or use menu bar Options -> Include to subset the view by job name prefix, job user name, job number, or within a specific OS/400 Work Management subsystem that is currently active. Jobs (and any associated threads of a job) have “attributes” such as status, run priority and opened files. You can view and, when necessary, manage job activity through this interface.

  These functions provide a way of working with active jobs on the system similar to using the WRKACTJOB command.

- **Server Jobs**: You can view jobs determined by the system to be “server jobs”. As previously discussed, Server jobs was part of the Basic Operations -> Job Management folder in releases prior to V5R1. When your V5R1 Operations Navigator PC workstation is connected to an iSeries server running V5R1 OS/400, the Serve Jobs folder appears under the Work Management component folder. When connected to an iSeries server running V4R5, Server Jobs appears as a folder under Basic Operations.

  This view is a subset of the jobs that could be included in the Active Jobs folder. Examples of IBM-supplied servers (jobs) include Directory Services (Lightweight Directory Architecture Protocol), NetServer, database servers for ODBC and SQL Call Level Interfaces (CLI), Web servers, Management Central itself, Domino, and more. When using this folder you do not see 5250 workstation jobs or “traditional” batch jobs.
Your can further subset the views using menu bar Options -> Include similar to Active Jobs and also include jobs not yet run but on job queues and jobs already completed but with spooled output still on the system.

This "server job" classification support under this component gives a different view than "Servers" under the Network Component folder, which has been available in releases prior to V5R1. We discuss Network -> Servers functions in 7.3, “Servers” on page 313.

- **Job Queues**: Job queues are one of the means to submitting work to an OS/400 subsystem. You can view jobs on active job queues (assigned to an active subsystem) or all job queues. For jobs on a job queue, you can hold or release the job or move a job from one queue to another job queue.

  A job queue must be created and deleted using OS/400 commands

- **Subsystems**: Any iSeries server contains several subsystems running independently of each other that manage work (jobs and threads) according to a run priority and storage (memory pools) assigned to that subsystem.

  You can view jobs by Subsystem name. For example, you could view the active jobs only in the IBM-provided QBATCH subsystem or in a subsystem you created through OS/400 5250-based commands. For each subsystem defined on the system, you can start an inactive subsystem or end an active subsystem and access job queues for that subsystem.

  You must use OS/400 commands to create or delete a subsystem description and define other aspects of a subsystem, such as adding a routing entry or adding an autostart job entry.

- **Memory Pools**: The logical division of main or auxiliary storage (memory) is called a memory pool. OS/400 provides "named pools" that are assigned to subsystems or the Licensed Internal Code - the “Machine Pool”. Named, “shared memory pools” and user defined (private) storage pools, can also be used by a subsystem. OS/400 provides an optionally activated “automatic performance adjusting job” (QPFRADJ) for OS/400 shared pools. This management includes memory pool utilization and reallocation according to a default set of values (which can be modified by a sophisticated user).

### 5.1.1 Work Management folder context sensitive menus

The following is a general description of the possible actions for each Work Management folder, as shown in Figure 5-1:

- **Explore**: Displays the contents of the folder in the right pane
- **Open**: Displays the contents of the folder in a new window
- **Create Shortcut**: Creates a shortcut to the folder
- **Include**: Allows you to edit the selection criteria for the folder
- **Reset Statistics**: Refreshes list information and sets elapsed time to 00:00:00
- **Start Subsystem**: Starts a subsystem
- **Performance System Values**: Displays system values for memory pool performance
- **Properties**: Displays the automatic refresh properties of the folder

Each Work Management folder has its own subset of these context menu items. Any unique considerations are included in the folder detail topics that follow.
You can access jobs from each of the Work Management folders. The context menu items for managing the jobs is the same. We discuss the job specific menu items for all Work Management folders under the Active Jobs folder topic in 5.2, “Active Jobs folder” on page 143.

Note, that General Operations Navigator general navigation facilities such as the menu bar Options -> Include, Sort, or Columns functions can be used by you to customize your views for each of the Work Management folders.

Consider also using the manual refresh or automated refresh options when displaying information with these folders, as changes are not automatically reflected in the details pane.

**Note:** Through each of the Work Management folders, you should consider OS/400 security implications as shown by the following examples:

- From all of the folders you can get to a list view of jobs and job-related objects, based upon that folders interface. However, to perform certain actions on the jobs, the signed on Operations Navigator session’s user must have the appropriate OS/400 “permissions” (authorities) to perform a function. For example to hold, release, or delete/end a job that user must have system privilege Job control to perform these actions. If the user does not have Job control permission, an error message window will result.

- For each job there is the capability to view a job’s printed output. If the signed on Operations Navigator user’s profile is not authorized to view the output queue containing that printed output an error message window will result.

The Work Management online Help information is very robust. We recommend using it when ever doing a Work Management task the first few times. The primary help interfaces we recommend are:

**Menu bar Help -> What can I do with.....** Expand the help tree structure for overview level information.

From any job’s Properties window select the ? field level help to get column heading help information. To get access to all of the Work Management online Help information select the Help button on that window.

### 5.2 Active Jobs folder

The functions of this folder enable you to view and manage all jobs active on the system. In addition to getting a general overview of system activity you can use this folder to identify possible performance issues, why certain output is not being produced when it should be or perform other problem determination activities.

Examples in this area include:

- Jobs (or a job) are consuming more CPU utilization over a time period than they should be
- A job is in held status
- A job is waiting on a message reply that no one expected

For an active job you can:

- Hold and release the job
- Delete (end) the job
View the job’s job log and any spooled printer output

Reply to a message the job is waiting on

View the job’s properties, including printer output parameters, run priority, job log logging level, international values (date and time format, and more)

View the job’s call stack, library list, open files, locked objects, elapsed performance statistics

Monitor the job

What is an active job? It is easier to say what an active job is not, rather than list all the different “status” values for an “active job”. An active job is one that is not:

- Waiting on a job queue to be accepted by a subsystem
- A job that has completed running that produced spooled files that are available to be printed

Figure 5-2 shows the default Details pane for Active Jobs.

The default is to display all active jobs on the system under the managing subsystem according to the alphabetic order of the subsystem name - similar to the OS/400 WRKACTJOB command. A unique icon distinguishes a subsystem job from the other jobs in the list. Subsystem jobs include QBATCH, QCMN, QCTL, QINTER and QSERVER, QSYSWRK, and CHAINBCH is a user defined subsystem.

The system jobs (SCPF, QSYSARB, QLUS, and so on) are alphabetized by job name, have a specific icon, and are listed following all the subsystem jobs.
In this example we have already used the column width mouse technique to show as much of the default columns of information as possible in this figure. We also have already used the Refresh function to get average CPU% utilization and average Database CPU% utilization over a period of 1 minute and 6 seconds.

If you need to reset statistics for all jobs listed back to 0, you can use the tool bar Reset button shown at 1 in Figure 5-2. Alternatively you could use the context menu for the Active Jobs folder as shown in Figure 5-1 on page 141 and select Reset Statistics.

A single Operations Navigator Active Jobs window can show much more information than a single WRKACTJOB 5250 workstation screen where you have to toggle between screens. As you can see this example shows several different values for Detailed Status, Job Type, and a job’s Run Priority value, as well as contrasting a job’s total CPU Utilization relative to that same job’s CPU utilization while performing database functions (CPU DB% column).

With Active Jobs menu bar Options -> Columns you can add, remove, and reorder columns of information being displayed in the Details pane. You can also use menu bar Edit -> Find to find jobs based upon a character sequence in the job name or user profile.

The Find and Sort by column capabilities are powerful, generally corresponding the WRKACTJOB functions keys for controlling the work station’s view of active jobs.

In our example, jobs As01j0325 and As0320job are mostly doing database functions. Based upon your understanding of your production mode environment, this much database activity may be normal or warrant further investigation.

Although not shown in this book, we investigated the “Waiting for reply to message” status for jobs As0321job and Bo0301job and found:

- Job As0321job was waiting for a resource that was being exclusively used by another job
- Job As0301job had opened a database file with a member name that does not exist

You can view and respond to the message for each job through either Operations Navigator interfaces (Basic Operations -> Messages, the job’s context menu, a Message monitor) or an OS/400 command based interface such as the 5250 Display Message (DSPMSG) command. We discuss several “message handling methods” in 6.7.1, “Message monitors” on page 242.

We discuss the job context menu capabilities (hold, reply, display job details, opened files, and more) under the next topic.

### 5.2.1 Active Jobs: job management

The job context menu can be accessed under each of the Work Management folders. The list of menu actions provides powerful job management capabilities. Using the windows in Figure 5-3, we discuss the context menu capabilities for a job.

---

**Important:** There may be times, depending on your operating environment, when displaying all active jobs on your system could impact performance. If you notice this, use the menu bar Options -> Include function to subset the number of jobs displayed.

---
In the window at 1 we have scrolled down the default Details pane to show 5250 workstation-based jobs running under the IBM-provided subsystem Qinter. You can see jobs in suspended status (no workstation input for a time period specified in system value QINACTITV), waiting for workstation I/O and other “conditions” (signal, dequeue, time interval, and more).

In the window at 2 we have clicked on the column heading CPU% to get the jobs listed in descending order of average CPU utilization over the Elapsed Time Period of 2 minutes and 30 seconds.

Right-clicking any of the jobs brings up a context menu similar to the one shown at 1 in the middle of this figure. We have selected the Details menu item to show the menu at 2 with Call Stack as the top item. These menus offer a large subset of the functions available for a job using the WRKACTJOB command interface.

The Operations Navigator interface to the functions is easier to use, and offers the interface to defining a Job monitor (described in 6.7.2, “Job monitors” on page 249).

In our example we have selected job Qzdasoinit, which is one of the Client Access Express Database server jobs that performs ODBC (Open Database Connectivity) and JDBC (Java Database Connectivity) functions with a client workstation. In our example, this job was running a complex SQL statement under the Operations Navigator Database folder Run SQL Scripts function.
Note that the Current User of this job is shown as As0309 - the Operations Navigator session user. If we were using any of the 5250 job related commands, including WRKACTJOB, their screen output would show the user as QUSER for this same job. This is the IBM-provided user profile, which was used to prestart the QZDASOINIT job.

The Work Management folder field “User” (not shown by default) corresponds to the QUSER field shown by WRKACTJOB.

For a multi threaded job, the Current User name shown is the user under which the primary thread is running.

The following is a short summary of what each context menu item does. In some cases, you may select more than one job and have the menu item apply to all of them. For example, you could select multiple jobs and hold, release, or delete them all at the same time.

- **Reset statistics**: Resets any collected job statistics back to zero. The refresh function can be used to extend the time over which elapsed times statistics are calculated. This is useful if you decide to monitor a specific job. At some time you may want to “start back at 0”. We show an example of using the Elapsed Performance Statistics from the job Details context menu later in this chapter.

- **Printer Output**: This opens a new window and displays any spooled files associated with the selected job. This is equivalent to choosing option 4 (Work with spooled files) from the Work with Job menu in a 5250 screen.

  Figure 5-4 shows an example.

  ![Figure 5-4 Job's Printer Output example](image)

  Note the powerful context menu when selecting one of the spooled files. You can display the spooled file contents in a separate window by selecting Open. See **Basic Operations -> Printer Output** in 4.3, “Printer Output functions” on page 124 for details on the spooled file context menu items.

- **Job Log**: This action opens a new window which displays the job log of the selected job. The messages within the job log can then be viewed in detail. This is equivalent to choosing option 10 (Display job log, if active or on job queue) from the Work with Job menu, in a 5250 screen.

- **Reply**: Enables you to view and reply to any unanswered inquiry messages associated with the selected job.

- **Hold**: You can hold the selected job, and if necessary, any associated printer output. This is equivalent to the Hold Job (HLDJOB) OS/400 command or taking option 42 (Hold job) from the Work with Job menu, in a 5250 screen.
- **Release**: If in held status, you can release the selected job. This is equivalent to taking option 43 (Release job) from the Work with Job menu, or using the Release Job (RLSJOB) OS/400 command.

- **Move**: If the selected job is on a job queue, you can move it to a different job queue. This function corresponds to an OS/400 Work with a Job Queue (WRKJOBQ) function.

- **Delete/End**: This enables you to delete (end) the selected job from the system. When this action is chosen, you are presented with a confirmation dialog which gives you the chance to specify further options such as, *How to end* (controlled or immediately) and what to do with Printer output and the Job Log. This is equivalent to the End Job (ENDJOB) OS/400 command or choosing option 41 (End job) from the Work with Job menu, in a 5250 screen.

- **Monitor**: This links you to the Job monitor functions available with V5R1. The job or jobs selected here and are already “entered” into the Job Monitor definition. See 6.7.2, “Job monitors” on page 249.

- **Properties**: This opens a page displaying the general properties of the selected job. There are several property pages of information, including:
  - General: Displays fully qualified job name, job start time and date, subsystem the job is running in, and more.
  - Performance: Displays run priority, its time slice and the memory pool it uses. Some performance statistics are described and you are provided with the Elapsed Performance Statistics Button to further analyze the job’s performance behavior.
  - Printer Output: Displays printing device choices and the priority of printed output on the output queue.
  - Messages: Displays how messages for the job are handled.
  - Job Log: Displays what will happen when the maximum job log size is reached and logging levels
  - Server: For a server job only, displays the signed on user ID and IP address of the PC workstation actively in session with this server job.
  - Security: Displays the current user and a new with V5R1 job user identity field. This field is used for authorization checks when other jobs in the system attempt to operate on this job or when a thread in this job attempts to perform a thread-related function on another thread in the same job.
  - International: Displays date, time, coded character set ID, country (or region) and language characteristics
  - Threads: Displays whether the job can run with multiple user threads and the number of active threads
  - Other: Displays other characteristics such as job accounting number, DDM conversation persistence, and job switch settings.

Depending on the status and type of job, some of the properties can be changed. This is equivalent to using the Display Job (DSPJOB) and Change Job (CHGJOB) OS/400 commands or taking a combination of options from the Work with Job menu, in a 5250 screen.

On a Properties pane use the? field level help function to get a description of the field. On that same window use the Help button to get access to an extensive set of help information.

Figure 5-5 shows examples of General (1), Performance (2), and Server (shown at 3) properties for a database server job running **Database -> Run SQL Scripts** functions.
Server properties are shown only for server jobs. See 5.3, “Server Jobs folder” on page 155 for more information.
The white fields indicate job properties (parameters) that can be changed - by someone with the proper authority, who is also familiar with the current operating environment and any inter job dependencies.

The Server properties shows the IP address of the client workstation connected to the server job.

In Figure 5-6, we show an example of using the? field level help for “Detailed status” on the General properties page.

![Figure 5-6 Job properties and field level help example](image)

We selected and dragged the question mark symbol to the Detailed status fields, which brought up the initial Details status window.
Details: Starting with V5R1 you can do the following job detail actions from Operations Navigator:

- **Call stack:** You can view, print, and refresh the list of programs and procedures currently being used by the job. This can be useful when doing detailed problem determination. This function corresponds to option 11 on the Work with Job menu through the 5250 workstation interface to a job.

  Figure 5-7 shows a simple example using a 5250 workstation job.

  ![Call stack example](image)

  By selecting an item under the Call Level column you can alternately sort the items in ascending or descending order. You can also display properties, such as what library the program was called from and the full procedure name.

- **Library List:** You can view, print, and refresh the library list currently being used by the job in a new window. You can search the library list for a named object and object type.

  These library list functions can be useful when doing detailed problem determination, such as trying to find out which version of a program or file is being used (stored in different libraries). The system searches for an object according to the order of the job’s library list.

  The name, type, and description of each library are shown. The libraries are grouped by type and displayed in the following search order for the library list:

  - System libraries (1 to 15)
  - Product libraries (up to 2)
  - Current user library (1)
  - User libraries (up to 250)

  For each library in the list you can also display the objects in the library (Open) and display the library properties.

  When you open a library you invoke the Integrated File Systems component of Operations Navigator. Once the library is displayed you can use the menu bar Options -> Include or Columns functions and re display different information for the objects in that library.

  Figure 5-8 shows an example where we searched two libraries that we already knew would possibly contain the object - database file CSTFIL and found the file in library PFREXP.
We could have selected all the libraries in the library list to be searched, but we knew the other libraries would not contain this object.

Option 13 on the Work with Job (WRKJOB) menu shows the job's library list, but that option does not have the search library list function.

- Locked Objects: View, print, and refresh the objects locked by the job. For each object you can view all jobs having a lock of some kind on that object. This can be helpful in problem determination when trying to find why a job is not actively using CPU or if a job's performance could be slowed by other jobs holding exclusive locks on the same object for periods of time.

Figure 5-9 shows an example the job we were interested was in a “wait state” and we wanted to find out why. You are where two jobs are accessing the same database files/tables and one job is waiting for a lock before it can do further processing, as shown at 1.
If the waiting for lock status remains for several seconds or longer there may be an application design problem.

This corresponds to option 12 on the Work with Job menu.

This Work Management Details - Locks function shows all jobs having a lock on an object. The Work with Job Menu has no such function.

**Note:** Operations Navigator My Connections -> system -> Database -> Libraries -> file/table name can display jobs with locked rows in that table.

- Open files: You can view the files (database file/table, display, printer, and so forth) the job currently has open. Use this option when you think the job may not be processing the correct data, such as is the case for a database file with multiple members of data. Perhaps a program passed the wrong member name to a program doing the Override Database File (OVRDBF) command.

This corresponds to option 14 on the Work with Job menu.

Figure 5-10 shows an example for an interactive 5250 update file program job with two database files opened (along with system and application display files opened to the workstation).
In this window you can see the actual database member name opened for files Cstfil and Itmfil as As0319 and which record (row) is currently being processed under the Relative Record Number column. To understand the meaning of all column headings, especially for the Activation Group-related headings, use the Properties window Help button or field ? help.

- Elapsed Performance Statistics: You can view and monitor a job’s performance statistics over an elapsed period of time. This is important when you are investigating a job for a potential performance problem and attempting to see if the problem is in CPU utilization or disk I/O activity.

Figure 5-11 shows an example of batch job 069485 with two different elapsed performance statistics windows. You can see the various CPU and disk I/O and page fault rates (and for 5250 jobs, interactive transaction counts and average response time).
Note that when the Elapsed Performance Statistics window is initially shown all statistics values are set to zero. You must use a Refresh Now or Timed Refresh button to get the first set of values. Then wait several minutes and refresh the information to get a good representation of the job’s consistent use of system resources.

The values are more meaningful over several time periods to ensure you are not taking action based upon some momentary spike in activity. You can set all statistics back to zero with the Reset Statistics button.

5.3 Server Jobs folder

You would typically use the Server Jobs folder to view the jobs that are doing work of a particular “server type” - server functions you are using. You may already suspect a problem with some “server function” and are not sure what jobs actually perform the server functions. This folder lets you look only at server jobs without having to “sort them out” from other types of jobs (interactive, batch, pre-started, and so on) as would be displayed with the Active Jobs folder on a very busy system.

With this folder you can view and manage jobs determined by the system to be “server jobs”. This view includes all the IBM-supplied servers such as Directory Services (Lightweight Directory Architecture Protocol), NetServer (AS/400 Support for Windows Network Neighborhood), for database servers for ODBC/JDBC (QZDASOINIT) and SQL Call Level Interfaces (QSQSRVR...), Web servers (such as HTTP Server - Admin), Management Central itself, Domino, and more. When using this folder you do not see 5250 jobs or “traditional” batch jobs.
You can do all the job management functions described under the Active Jobs folder, as described in 5.2, “Active Jobs folder” on page 143, including:

- Hold and release the job
- Delete (end) the job
- View the job’s job log and any spooled printer output
- Reply to a message the job is waiting on
- View the job’s properties, including printer output parameters, run priority, job log logging level, international values (date and time format, and more), and, for server jobs - the IP address of any workstation connected to a specific server job.
- View the job’s call stack, library list, opened files, locked objects, elapsed performance statistics
- Monitor the job

In general, a “server job” is one that waits for some kind of request for work to be received, does its work and then waits for another request. This Work Management -> Server Jobs interface to these kinds of jobs is significantly easier to use than the Work with Active Jobs (WRKACTJOB) or Work with Subsystem Jobs (WRKSBSJOB) OS/400 commands to find the server jobs you want to view, manage, or monitor resource utilization for.

With the OS/400 command interface you generally have to know the job name or server type acronym (such as *NETSVR or *MGTC) or even what subsystem the server jobs run in to view and manage these server jobs.

This “server job” classification support under the Work Management component gives a different view than “Servers” under the Network Component, available in releases prior to V5R1. We discuss Network -> Servers functions in Chapter 7, “TCP/IP network” on page 289.

Figure 5-12 we have scrolled down bar to show two windows of server jobs when all active servers are being displayed. You can use menu bar Options -> Sort or Include or Columns to specify what servers are displayed and the order in which the information is displayed. For Server Jobs, the Include criteria includes 3 part job names, jobs on queues and completed jobs with spooled output, and server jobs user profile names.
Chapter 5. Work Management

5.3.1 Managing server jobs

In Figure 5-12 we also show the context menu for a server job. The menu items are essentially the same as for the Active Jobs component as described in 5.2.1, “Active Jobs: job management” on page 145.

Some comments worth noting regarding the selected set of server jobs shown in this example are:

- Unless you have done setting up of HTTP servers yourself, you are prohibited from doing many browser based configuration functions on iSeries unless the IBM-provided HTTP Server - Admin server jobs (shown at 1) are active.

- You cannot perform any of the Management Central functions of Operations Navigator if the two Management Central servers (shown at 2) are not active.
You cannot perform any iSeries file server and file share based functions if the Netserver jobs are not active.

The Work Management -> Server Jobs view of these IBM servers is suited more for monitoring specific server jobs than starting and stopping a server (all jobs doing the server functions). For starting and stopping these servers we recommend the Network -> Servers -> TCP/IP or Client Access folder interface functions as discussed in Chapter 7, “TCP/IP network” on page 289. Their initial display of servers rolls up all the individual server jobs into a single server for each server type. The jobs shown Figure 5-12, would appear in the Network -> Servers -> TCP/IP window as a single server - AS/400 NetServer, that can be stopped and started.

5.4 Job queues

Use this component to view and manage job queues and jobs on the job queues.

Job queues are an important element in the OS/400 Work Management capabilities. Most jobs are either explicitly (for example, through the OS/400 Submit Job (SBMJOB) command) or implicitly (by IBM or application implementation) submitted to a job queue.

Jobs scheduled through the OS/400 system job scheduler support (Work with Job Scheduler Entries (WRKJOBSCDE) command and other commands to add a job scheduler entry, remove a job scheduler entry and change a job scheduler entry) are submitted to a job queue. This includes Management Central scheduled tasks, which implicitly does the add job scheduler entry function with default parameter values.

Job queue parameters and the associated subsystem parameters are used to manage the number of jobs allowed into the subsystem at any given time and the order they are allowed into the subsystem. Each job has a job queue priority that can be managed when the job is on the job queue through job properties.

OS/400 job queue-oriented commands include Work with Job Queues (WRKJOBQ), Create/Delete a job queue (CRTJOBQ/DLTJOBQ), Clear Job Queue (CLRJOBQ), Add/Remove Job Queue Entry (ADDJOBQE/RMVJOBQE) to a subsystem, and Change Job Queue Entry (CHGJOBQE). The Display Subsystem Description (DSPSBSD) command can be used to view several subsystem configuration entities, including the job queues currently assigned to the subsystem.

V5R1 Work Management -> Job Queues provides a graphical interface to OS/400 job queue management (not creation/deletion, changes to a job queue, or changes to a subsystem via two folders as illustrated in Figure 5-13:

- Active Job Queues (assigned to an active (started) subsystem)
- All Job Queues

Functions you can do include:

- Hold and Release Job Queues
- Clear all jobs from a queue
- Change the priority of a job on a queue
- Move jobs between queues
- Display all job queues defined to a subsystem
- View and change the waiting job's run time properties
Chapter 5. Work Management

Figure 5-13 Active Job queues with context menu example

In this example you can see the many job queues that may be active on any system running a variety of work. Chainbch, Chainbch2, and Qbatchtwo are user-created job queues. The other job queues are supplied by IBM. This function corresponds to the DSPJOBQ JOB(*ALL) or WRKJOBQ JOB(*ALL) command function. but shows you much more information on a single window than do these commands.

You can use menu bar Options -> Columns to add columns of information to the default ones listed here.

For the All Job Queues folder you can also use menu bar Options -> Include to subset the job queues shown by job queue name and library name.

5.4.1 Managing job queues

The context menu shown in Figure 5-13 provides the following functions:

- **Explore**: Displays the jobs on the job queues in the right pane
- **Open**: Displays the jobs on the job queues in a new window
- **Create Shortcut**: Creates a shortcut on your desktop for the selected queue
- **Hold**: Holds the job queue - no job queue entries can enter a subsystem
- **Release**: Releases the job queue. This enables waiting jobs on the queue to now enter a subsystem, provided:
  - The waiting job itself is not held
  - Other job queue properties enable the job to enter a subsystem
  - The subsystem is not already at its maximum number of jobs
- **Clear**: Deletes all waiting jobs on the queue
- **Properties**: Displays the properties of the queue. This includes much of the information already shown in Figure 5-13 and additionally, authority values required to manage the queue, and the number of maximum job queue entries.
5.4.2 Managing waiting jobs on the job queue

Jobs are listed on a job queue in order of (Detailed) status and priority on the queue. For jobs with the same status and priority, the order is time of day the job was initially placed on a job queue.

In Figure 5-14 we have opened job queue Qbatchtwo, which is in Held status. This shows two submitted jobs. We have already used menu bar Options -> Columns to add columns (job) Number and (job) Type to the default pane information.

![Figure 5-14 Managing jobs on a job queue](image)

You can see the job name, user profile name, and priority on the job queue for each job. One of the jobs is ready to be run (Waiting on job queue status) and one is Held on the job queue, which means that it cannot run even when the job queue is in released status.

The context menu shown in Figure 5-14 provides the following functions. Depending on the menu item you wish to use, you can select multiple waiting jobs and perform the function on all selected jobs (such as hold, release, delete/end, and move):

- **Printer Output**: There is no printer output for a job on a job queue
- **Job Log**: Displays the initial message to a job log as it would appear when the job actually becomes active
- **Reply**: Reply is greyed out as there can be no inquiry message for a job on a job queue.
- **Details**: The Details sub menu (not shown) has all menu items greyed out as the information does not apply to a job on a job queue
- **Hold**: Holds the job on the queue - the job will not be accepted by the subsystem, even when the job queue is in Released status
- **Release**: Releases a held job. The job can enter a subsystem when:
  - The job queue is in Released status
  - Other job queue properties enable the job to enter a subsystem
  - The subsystem is not already at its maximum number of jobs
- **Move**: Moves the job from one job queue to another job queue. The prompt window can be used to display a list of job queues to select from. The job appears on the target job queue within any already existing jobs according first to status (for example, “waiting on job queue” ahead of “held on job queue”), and then within status according to job priority. The job’s priority and status and other properties are preserved on the target queue.

  *Ensure the results of the move are what you want on the target job queue after the move.*
• **Delete/End:** Deletes the job from the job queue - the job will never run.

• **Monitor:** You can set up to monitor a job before it runs! By selecting Monitor for a job you are presented with a define New Monitor window. The job or jobs selected are already “entered” into the Job Monitor definition. See 6.7.2, “Job monitors” on page 249.

• **Properties:** Displays the properties of the waiting job (some of the information already shown in Figure 5-13 on page 159 plus job run parameters), many of which can be changed before the job runs. These properties include:
  - Job queue (move to another queue) and priority on job queue
  - Print parameters including default output queue, printer device, spooled file priority on the output queue, page footer
  - What to do with inquiry messages the job may issue
  - International values, such as date and time format and numeric decimal point character, and more
  - Accounting code, DDM conversation activity, and job “switch settings” (used by the job during run time). You can view or change the accounting code independent of whether job accounting is active or not.

Many of these actions have corresponding buttons in the Toolbar, such as holding and releasing a job on the job queue.

### Using the mouse to manage job queue examples

The following are several examples using mouse drag-and-drop to manage jobs on job queues, instead of context menu actions or changes to job Properties.

**Moving a waiting job to another job queue using drag, drop**

On the same iSeries server you can use the waiting job’s context menu or the job’s Properties -> Job Queue window to move the job to another job queue.

When you use these techniques to move the job, the job’s properties, such as Priority on Job Queue and Detailed Status are preserved on the target queue.

You can also do the move function by selecting one or more jobs and dragging them to another job queue. You can use either the right mouse button or left mouse button to perform the drag/drop. The left button drag/drop performs a “move after” the selected target. The right button drag/drop prompts with a menu of move actions. The right button Move After or Move Before choices are dependent on the two different ways you specify the target of the move:

• Drag to the target job queue folder: The selected job(s) original job queue detailed status and job priority on the source job queue are preserved on the target queue and the new job is placed after any existing jobs on the target queue having the same detailed status and job queue priority.

  Both the left mouse and right mouse techniques do a “move after”. If you use the right mouse you get a menu with Move and Cancel actions.

• Select the target job queue and Open it. This brings up a separate window showing the current contents of the target job queue. Move the target job queue window so that you can see the jobs on that job queue while still viewing the original job queue jobs.

  Select the job(s) on the source job queue and using the left mouse, drag and position the mouse on one of the current jobs on the target job queue. Release the mouse and the moved job takes on the Detailed status and Priority on the job queue of the *existing job*. The moved job is placed after that existing job.
To get the Move After (same as left mouse drag/drop) or Mover Before menu, use the right mouse to drag the source jobs to the selected existing job on the target job queue. Release the mouse and you get the menu with the Move Before and Move After actions. The moved job is positioned, depending on the Move After or Move Before you select. The moved job could also have changed Detailed status or job priority on the target job queue.

**Tips:**

1. We suggest you experiment with the job queue mouse drag-and-drop Move Before and Move After techniques to determine which work best for you.

2. Before moving a job on a job queue, consider holding the receiving job queue (or move to an inactive job queue). This ensures the moved jobs will not immediately enter the subsystem associated with the queue or be run out of sequence. This way you can review the results of the move to ensure all jobs now on that job queue are what you want them to be. Release the job queue when you have verified the jobs will run in the correct order.

Figure 5-15 shows an example of right-clicking to move two selected jobs from job queue Chainbch2 to job queue Qbatchtwo - after a current job already on Qbatchtwo.

In the window at 1 we have selected two jobs To01c0407 and Prtdski by left-clicking. Using the right mouse, we dragged these jobs to job Rtvdski in the job queue Qbatchtwo shown in window 2. This window was previously opened from the context menu for queue Qbatchtwo.

Note, if we wanted to move these jobs and place them on the queue and preserve their job queue properties, we would have used the left button and dragged them directly to the job queue Qbatchtwo shown in the left hierarchy tree (shown at 3).
Figure 5-15 Drag, drop a job to another job queue using the right mouse example

The window at 3 shows the menu with the Move Before or Move After options.

We selected Move After Rtvdski, which has Detailed Status of Waiting on job queue and Priority on Job Queue of 3. In the window at 4, note the placement of these jobs on the job queue according to their new Detailed Status and Priority on Job Queue values (assuming the values for Rtvdski).

**Changing job priority within a job queue using the mouse**

Instead of using the Properties window to change a job’s Priority on Job Queue value, you can select the job to “move” (change priority). You can use either the left mouse button to drag the job on top of the job you want to “be next lower than” (move after) or the right mouse button for the Move After or Move Before choice.

In Figure 5-16 in the window at 1 we used the left mouse button to select the Prtdski job with Held on job queue status and priority 5. We used the right mouse button to drag the job to the Rtvdski job with Waiting on job queue status and priority 3. In the window at 2 you can see a menu appears that enables us to place the selected job either before or after the target job.
5.5 Subsystems

Use this folder to start and stop subsystems and manage jobs running within an active subsystem.

An OS/400 subsystem is where work (jobs) are managed. All jobs (and any associated threads), except for the subsystems themselves and certain "system jobs", run within an active subsystem.

A subsystem is a single predefined operating environment through which the system coordinates work flow and resource utilization according to:

- One or more memory pools used by the subsystem ("shared pools" can be shared with other subsystems).
- The maximum number of jobs the subsystem can manage at the same time.
- Subsystem "entries" that control the type of work that can be "given to" the subsystem. Entries include job queues, autostart job, pre-started job, workstation, and communications. A unique entry type is a *routing entry* which is used by the subsystem to
assign a run priority (through a class description object, the first program to run in a job, and a memory pool to a job.

The intent of a subsystem is to manage related kinds of work in the same subsystem, though that is not a requirement. OS/400 comes with some IBM-supplied subsystems for ease in getting started. Users can use these subsystems and, optionally, create and use their own subsystems.

In a less complex environment there may be only a few of the IBM-supplied subsystems active, such as QBASE and QSPL. In an environment doing a complex mix of different work (applications) there may be many other active subsystems, such as IBM-supplied QCTL, QBATCH, QINTER, QSERVER, QSYSWRK, QUSRWRK, QHTTPSVR, and more. QSYSWRK and QUSRWRK are always started by default.

Some applications also require their own subsystems, such as Domino for iSeries, or WebSphere Application Server, and more.

OS/400 has commands to create and manage subsystems, including:

- Create, change, delete a subsystem description (CRTSBSD, CHGSBSD, DLDTSBSD)
- Display, print, work with a subsystem description (DSPSBSD, WRKSBSD)
- Start, end, work with subsystems (STRSBS, ENDSBS, WRKBSBS)
- Work with subsystem jobs (WRKSBJSBS)
- Commands that add, change, or remove subsystem configuration “entries” that control the work accepted by the subsystem, including job queue, routing, communications, autostart job, prestart job, and workstation (5250) entries

V5R1 My Connections -> system name -> Work Management -> Subsystems provides a graphical interface for managing all subsystems or a specific subsystem activity, its job queues, and jobs running in that subsystem. The Operations Navigator interface does not support the creation, deletion or configuration related functions available through the OS/400 command interface.

Essentially the Operation Navigator interface integrates the STRSBS, ENDSBS, WRKBSBS, and WRKBSBSJOB command functions. From the Subsystems folder you can not only manage jobs running within a subsystem but also access Job Queues folder management functions.

This graphical interface makes working with active subsystems or starting/stopping a subsystem easier than having to use the various OS/400 commands.

Figure 5-17 shows the Subsystems -> Active Subsystems folder context menu at 1. In the right details pane you see the active (started) subsystems on a system performing several different kinds of work, and a context menu for a selected subsystem at 2 in the right pane.
In the Details pane of Figure 5-17 you can see a description of each active subsystem (text from the Create/Change Subsystem (CRTSBSD/CHGSBSD) command) and the number of currently active jobs in each subsystem. Remember to use the refresh options to refresh the window contents, as this window is not automatically updated by the system.

The following topics give additional information when selecting the Active Subsystems folder and a specific active subsystem.

5.5.1 Active Subsystem folder functions

The context menu for the Active Subsystems (and Subsystems folder) as shown in Figure 5-17 at 1, provides the following functions:

- **Explore**: Displays the subsystem in the right pane
- **Open**: Displays the subsystems in a new window
- **Create Shortcut**: Creates a shortcut on your desktop for the subsystems older
- **Start Subsystem**: Brings up a subsystem selection window, where you specify a subsystem name and library name where the subsystem description object is stored. A Browse button can be used that will show all subsystem descriptions in the specified library. You can select a subsystem from that list to be started.
- **Properties**: Displays in a window in which you can specify the automatic refresh options.

5.5.2 Selected subsystem functions

The context menu for a selected subsystem, as shown in Figure 5-17 at 2, provides the following functions:

- **Explore**: Displays the active jobs running in the subsystem in the right pane
- **Open**: Displays the active jobs running in the subsystem in a new window
> **Create Shortcut**: Creates a shortcut on your desktop that will display all the active jobs running in that subsystem.

> **Job Queues**: Brings up the Job Queue window showing the job queues assigned to that subsystem and displays job queue information. From this window, you have access to functions as described under 5.4, “Job queues” on page 158, including holding/clearing the jobs queue and viewing and managing jobs on the job queue.

> **Stop**: Brings up a Stop Subsystem window for this subsystem, where you can end the subsystem controlled or immediate and specify what to do with jobs logs and active jobs in the subsystem performance attributes. These parameters correspond to parameters on the End Subsystem (ENDSBS) command.

Use the online Help button or field level ? help for assistance.

> **Reset Statistics**: When activated, this resets elapsed time performance statistics back to zero for the jobs in the subsystem.

> **Properties**: Displays subsystem properties in a window.

**Selected subsystem and jobs running in the subsystem**
The Explore/Open actions display the active jobs running in that subsystem. From that Details pane (Explore) or a separate window (Open) you have full job management functions on these jobs as described in 5.2, “Active Jobs folder” on page 143, including menu bar Options -> Sort or Column functions and a selected job context menu.

Refer to Figure 5-18 for an example window.

![Figure 5-18 Subsystems - active jobs example](image)

In this example we have already performed a refresh function to get non-zero values in the CPU utilization column. The context menu at 1 is one for any job within the subsystem. The context menu at 2 is for the subsystem “job” itself.

Go to 5.2, “Active Jobs folder” on page 143 for more information on the menu items shown here in either of the context menus.

Note the greyed out actions, based upon job status and a job versus the subsystem itself.
We describe here only specific context menu action items that are unique because you have selected the subsystem itself, rather than a job in the subsystem:

- Selected subsystem **Printed Output, Job Log, Details** (Call Stack, and so forth): In rare cases of problem determination, it may be necessary to view this subsystem information, such as its job log messages.

- Selected subsystem **Monitor**: Selecting to monitor a subsystem links you to the new with V5R1 Job monitor functions where you can define a new Job monitor. “All jobs running in this subsystem” is already entered into the Selected Jobs input area of the New Monitor window. See 6.7.2, “Job monitors” on page 249.

## 5.6 Memory pools

On the iSeries, all main storage can be divided into logical allocations called **memory pools**. A memory pool can be reserved for processing a job or group of jobs. A subsystem description specifies which memory pool or pools (more than one pool is possible) it uses for jobs managed by that subsystem.

By default, the system (job QFPRADJ) automatically monitors job/thread transitions (switching between using CPU or waiting for a resource or event to occur) and the frequency of times a part of object (program or data) not already in main memory is needed (a “page fault”). In many cases all of this is normal. However, the QPFRADJ job monitors this and makes adjustment automatically as needed.

Though not frequently required, iSeries work management experts can override parameters used by QPFRADJ, turn off the QPFRADJ job’s activity, and do their own memory management. They also may create their own subsystems or modify IBM-provided subsystems where they allocate portions of main memory to their own “private pools” under OS/400 commands.

The Memory Pools folder provides the graphical interface for viewing and optionally managing memory pools. Use the Memory Pools functions when you suspect:

- There may be a main memory utilization imbalance - a subsystem’s pool has an insufficient amount of storage that may be causing performance degradation or a memory pool is much larger than it needs to be for the amount of work being done in it.

- The activity level value used by a subsystem may be set incorrectly when there are a large number of jobs (and threads in a multi-threaded environment, such as a busy Domino server) attempting to use the CPU processor at the same time.

  **Note:** The Operations Navigator term **Maximum eligible threads** corresponds to the Maximum Activity Level term used by OS/400 memory pool related command interfaces.

In addition to viewing activity within the memory pools, you can do the following with this folder:

- Increase or decrease the size of the pool. Note, any amount of storage you manually remove from a pool is immediately placed into the IBM-provided Base pool. Any increase in pool size reduces the Base pool size by that amount.

- Change the **Maximum eligible threads** (activity level) of the pool (number of threads the subsystem attempts to give CPU processor time to at the same time).

- Link to a subsystem window that gives you access to all the functions available with the Subsystems folder.
Link to a jobs window for all jobs using the memory pool (these jobs may be managed by more than one subsystem). This gives you access to all the job management functions as described under the Active Jobs folder in 5.2, “Active Jobs folder” on page 143.

**Note:** In many OS/400 environments, the system’s “automatic tuning” capabilities are sufficient to monitor and manage memory pool storage sizes and activity level values. This folder should be used only by those well versed in how iSeries manages memory pools and give jobs/threads access to the CPU processors. Also, use this interface only if there actually is a performance problem on the system. This folder’s functions can help determine if the problem is due to insufficient main memory allocations or job/threads management (for example, not a high enough activity level to manage all the jobs/threads ready to use the CPU processor).

**Starting with V5R1,** Operations Navigator **Work Management -> Memory Pools** interfaces they can do this more easily with the graphical interface.

The following provides overview information that should be sufficient background information to understand the **Work Management -> Memory Pools** functions and windows shown in this redbook.

OS/400 ships with IBM-supplied shared storage pools with specific names that are, by default, used by the IBM-supplied subsystems. These pools include:

- **Machine Pool** (*MACHINE in the OS/400 command interface): This pool is used by the System Licensed Internal Code. This pool is not used by OS/400 subsystems.
- **Base Pool** (*BASE in the OS/400 command interface): This is the default memory pool used by most IBM-supplied subsystems for non-5250 work.
- **Interactive Pools** (*INTERACT in the OS/400 command interface): This pool is the default pool used by the IBM-supplied subsystem QINTER that, by default, handles all 5250 workstation jobs.
- **Spool** (*SPOOL in the OS/400 command interface): This pool is used by the IBM-supplied subsystem QSPL for spooled input and output).
- **General set of Shared pools** - Shared 01 through Shared 60 (*SHRPOOL1 through *SHRPOOL60 in the OS/400 command interface): These pools are shipped with 0 memory and Maximum eligible threads of 0. They are available to be assigned to any subsystem anyone properly authorized to create or change a subsystem description).

The term *shared* pool is used because any one of these memory pools can be used by more than one subsystem.

A properly authorized user can define a “private pool” to a subsystem. That pool is defined only for used by that subsystem. By default the name of a private pool is the subsystem name as a prefix with a number assigned by the subsystem.

With the **Work Management -> Memory Pools** folder you can view and manage these pools through two primary folders as shown in Figure 5-19.

- **Active Pools:** This include IBM-supplied shared pools and any user-defined pools that are being used by active subsystems and the Machine Pool used by the System Licensed Internal Code: The pools viewed and managed under this folder correspond to the pools shown in the lower half of the Work with System Status (WRKSYSSTS) command screen.
- **Shared Pools:** This includes IBM-supplied shared pools that are active and other IBM-supplied shared pools that are available but not assigned to an active subsystem. The
pools viewed and managed under this folder correspond to the pools shown in the Work with Shared Pools (WRKSHRPOOL) command.

![Figure 5-19 Memory Pools folders and context menus](image)

With Figure 5-19 you can see the memory pool folders in the left pane, and the Active Pools in the Details pane.

We show the context menus for both Active and Shared Pools to illustrate the various menu items, depending on the Memory Pools folder selected. In the right pane you see all active pools including a private pool Chainbch1, which is assigned to a user-defined subsystem Chainbch.

Before discussing specific functions for the Active Pools folder and the Shared Pools folder note the following:

- The values shown were current the last time the Details pane was refreshed.
- The column heading Current Threads includes the sum of jobs with only 1 thread (all jobs by default have at least 1 thread) and jobs with multiple threads (which includes HTTP servers, Domino servers, and other multi-threaded implementations of an application).
- The Maximum Eligible Threads column shows the maximum allowed activity level for each pool. You cannot specify any Maximum Eligible Thread value for the Machine pool.
- The Total Faults column shows the current number of database and non-database (for example program code) page faults per second since the last Details pane refresh.
- Some of the context menu items are unique depending on the folder or subsystem type you have selected. We discuss these item in the following topics.
- Consider using menu bar Options -> Columns for adding information displayed in the Details pane. There are a significant number of columns of information that are not shown by default.
Use the Refresh functions or automatic refresh to see the latest information in these windows.

All information displayed and functions supported by the WRKSYSSTS and WRKSHRPOOL OS/400 commands are available through the Active Pools and Shared Pools interfaces, with the exception of the top portion of the WRKSYSSTS display, which contains overall system level performance information. However, you can view some of that information (e.g., %CPU used and % System ASP* used) by creating and starting a System Monitor in Management Central. The System Monitor contains metrics such as CPU Utilization and Disk Storage that you can monitor on a single system or group of systems. For more information on Monitors refer to 6.7, “Monitors” on page 240.

From within the Active Pools and Shared Pools folders, a trusted operator can change pool size and maximum eligible threads and work with specific jobs running in a pool and subsystems using a pool. The next topics discuss managing work through the primary Memory Pools folders Active Pools and Shared Pools.

5.6.1 Managing Active Pools

This topic describes Active Pools folder capabilities.

**Active Pools folder**

With the Active Pools folder you can:

- **Explore**: Work with the active memory pools on the system in the right Details pane
- **Open**: Work with the active memory pools on the system in a new window
- **Create Shortcut**: Creates a shortcut on your desktop that will display all the active memory pools on the system in a window
- **Performance System Values**: Opens a window in which you can view and change some system performance-related OS/400 system values. The system values include dynamically adjusting job run priorities, setting the QPFRADJ job’s tuning parameters, allowing parallel processing for queries, and more.
  
  Only an iSeries performance skilled person should make any changes.

  Use the online Help button or field level ? help for assistance.

- **Reset Statistics**: Sets the Active Pools page fault and job transition column values back to zero.

- **Properties**: Allows you to view and change the automatic Refresh options

You can use menu bar -> Options -> Columns to add and reorder columns of information. In Figure 5-20 we use menu bar -> Options -> Columns to show some of the additional columns of information you can display for Active Pools.
These columns have meaning to iSeries performance experts, so they would add some of these columns to see their values in the Active Pools Details pane or window.

**Managing an active memory pool**

With the active memory pool information you can periodically refresh the information being shown to observe, over time, activity statistics for page fault values and job transitions (counts in the Active -> Ineligible, Active -> Wait, and Wait -> Ineligible columns).

Figure 5-21 shows a series of Details pane refreshes of the active pools and a context menu for the Base pool showing the link to subsystems using this Base memory pool.
In this example (where there is no problem on the system), the windows at 1 and 2 show pool statistics over two time intervals. We have already used menu bar Options -> Columns to add the Defined Size (MB) column to the Details pane.

We have selected the context menu item Subsystems to get the window shown at 3. Note how many IBM-supplied subsystems active on the system are all sharing the Base pool.

As seen at context menu B, you have all the Work Management -> Subsystems functions as described in 5.5, “Subsystems” on page 164.

The context menu at A has the following actions for a selected memory pool:

- **Jobs**: Displays a window that lists all the jobs active under the subsystems using that pool. This window (not shown) looks and has functions similar to the right Details pane for Work Management -> Active Jobs, as shown in Figure 5-2 on page 144 (except subsystem Chainbch is not shown because it does not use the Base shared pool).

- **Subsystems**: Displays a window that lists all the subsystems using a pool (as shown here in Figure 5-21 at 3). As just stated you have access to the Work Management -> Subsystems folder functions.

- **Properties**: Displays a window that enables you to view and change several memory pool values including some of the pools performance statistics and pool values used by the
QPFRADJ job such as pool minimum and maximum sizes, and other pool size values such as defined and current sizes, page fault values, and more.

Figure 5-22 shows an example of most of the memory pool properties for the Base pool.

In Figure 5-22 we show the Base memory pool General (1), Configuration (2), and Tuning (3) properties.

On Configuration page you can view and specify minimum storage size of the pool and the Maximum eligible threads (activity level) used by this pool. At A you can see the Paging option. Those knowledgeable about iSeries “Expert Cache” function for caching database data should recognize the “Calculated” value (*CALC in Work with Shared Pools command screen) as turning on the Expert Cache function for this pool.
In the Tuning page window you can view and change values used by the QPFRADJ job.

**Notes:**

1. The Work with Shared Storage Pools (WRKSHRPOOL) OS/400 command also enables viewing and changing all the pool performance and tuning values.

2. The OS/400 system value commands (Work with System Values (WRKSYSVAL) and Change System Values (CHGSYSVAL)) have access to all system values, including those accessed via the System Performance Values context menu item.

3. The Operations Navigator **My Connection -> system -> Configuration and Service -> System Values** folder interface provides the graphical interface to all system values, including those accessed via the System Performance Values context menu item.

4. The Properties for pools other than Base may have different parameters that you can view and change. For example, for other shared pools you can view and specify the actual pool size rather than a minimum size.

5. This is another reminder not to change system values or memory pool values unless you are very knowledgeable about OS/400 work management and the particular operating environment you are working with.

### 5.6.2 Managing Shared Pools

The functions and context menus under the Shared Pool folder and a specific shared pool are so similar to the corresponding function and context menus for the Active Pools and specific active pool that we refer you to the entire Managing Active Pools topic starting at 5.6.1, “Managing Active Pools” on page 171.

In this topic we do show a Details pane for shared pools here that represents what you would see on a typical iSeries server in Figure 5-23. We show this because the default set of columns shown contains several more columns of information than the Active Pools folder shows by default.
In this example it takes two windows to show the entire set of columns of information displayed by default for explore/open of the Shared Pools folder. In 1 you see the left half of column information and in 2 we have scrolled to the right to show all the remaining columns shown by default. There are still additional columns of information that can be selected (and other columns could be removed) using the menu bar Option-> Columns function.

We call your attention to the following:

▶ You can see that a shared pool is active or inactive.
▶ For an active shared pool you cannot deallocate (storage and activity level not changed to zero).
▶ For an inactive pool you can deallocate storage and activity level. (If never made active, there should be no storage allocated to the pool).
▶ The Paging Option column shows if Expert Cache (Calculated) is enabled for the pool or not (Fixed).
▶ In the window at 2 you can see many of the tuning values used by the QPFRADJ job if it is active.
▶ You can click on any of the column headings to alternately sort the list in ascending or descending order of that column.
▶ The Properties pages can be used to change certain parameter values, similar to the Active Pools folder Properties pages. You can specify “calculated” for Paging option on the Properties Configuration page.
5.7 Operations Navigator Work Management tips

This section summarizes Operations Navigator Work Management usage tips. Some of these appear throughout this chapter while others are mentioned for the first time in this topic.

5.7.1 Use the menu bar cues Edit -> Find, Options -> Sort, Columns, Include

These menu bar functions can greatly assist you viewing and managing only the jobs you are interested in and viewing the columns of information most important to you:

► **Edit -> Find**: If you have a long list of jobs to use find to selectively look at the jobs you want to.

► **Options -> Sort** (or column heading click sort): Sort the jobs according to the columns of information most important to you, such as Current User, CPU% utilized, or Detailed Status. Sort criteria are maintained for your session but not used the next time you start Operations Navigator.

► **Options -> Columns**: Columns of information can be added (or removed) for most lists and can be rearranged to an order that suits your needs. The column selection and ordering are saved and reused the next time you start Operations Navigator - for all connections.

► **Options -> Include**: Include can greatly reduce the number of jobs you are looking at. You can select based upon elements of a job name, a Current User, or Job Type, or Subsystem. The Include criteria are saved and reused the next time you start Operations Navigator - for connections.

The following is an example showing Include. On a system running thousands of jobs at the same time, using the 5250 command Work with Active Jobs (WRKACTJOB) to display and refresh the screens takes significant additional system resources considering the system is already very busy. While the **Work Management -> Active Jobs** and **Work Management -> Server Jobs** functions are more efficient than WRKACTJOB, you should still consider subsetting the number of jobs displayed.

Figure 5-24 shows two examples using **Include** from the Active Jobs folder to subset the number of jobs you see.
In the window showing 1, we have subset the jobs shown by a prefix user name - AS03*. In the window showing 2, we have subset using the current user field as As0321. With the current user field we can see jobs started with user profile As0321 as well as server jobs (ODBC/JDBC database server in this case) that are now being used by As0321 as shown in the window at 3.

5.7.2 Use desktop shortcuts for frequently used active jobs, memory pools

Operations Navigator provides Desktop shortcuts to frequently accessed folders to minimize the number of point and clicks to get to the lowest level folder you want to work with. You click the desktop icon and get right to the associated folder. You do have to sign on or already be signed on to access the window for the associated folder.

In the Work Management area consider shortcuts for working with subsystems, memory pools, and more.
**Note:** Shortcuts are very useful. However, if you have too many shortcuts active on your PC workstation you could use up a larger amount of workstation resources than is desirable. This is dependent upon any other work your workstation may be doing at the same time.

### 5.7.3 Use the Server property of a server job to find the attached workstation

The Active Jobs, Server Jobs, Subsystem, and Memory Pools folders all can be used to link to a job list, that identifies a job as a “server”. Consider the case when there are several PC workstations signed on to the system with the same user profile and one of them is experiencing a function or performance problem that requires you to look at the job (or jobs) they are using.

Have the PC user do something like issuing “ipconfig” on their workstation command window to get the IP address they are using.

Then you use other Operations Navigator work management functions to find the jobs running under their user ID. Selectively look at the Server properties for a server job running under their profile. The IP address can be correlated with the “ipconfig” address to ensure you are examining the correct job (or jobs).

An example showing the Server properties is shown in Figure 5-5 on page 149.

### 5.7.4 Set target job queue to hold status when moving jobs to that job queue

When moving a job on a job queue it has two important properties - Detailed status and Priority on Job Queue that need to be considered. Consider corresponding properties of jobs already on the target job queue.

So Hold the target job queue and after the move to that job queue, examine the moved job Detailed status and Priority on the job queue. Review the target job queue before release it to ensure the moved jobs are in the order you want.

### 5.7.5 Consider using the system, job, and message monitors

This chapter shows several context menus that have a Monitor action. If you decide one or more jobs should be monitored for job status, performance metrics, or messages, go to 6.7, “Monitors” on page 240 to set up an appropriate monitor.
Chapter 6. Management Central and Monitors

This chapter describes the general Management Central set up and functions related to managing one or more iSeries servers. These include:

- Setting up the central system and endpoint systems
- Central system task scheduling and activity monitoring
- Inventory collection and related processing
- Managing software products (including fixes), users and groups, and system values on multiple systems
- Managing “packages of objects” on multiple systems
- Collecting performance data with Collection Services
- Monitoring system performance, jobs, messages, and B2B (iSeries Connect, licensed program) transaction logs
- Complete examples showing Run command and Send and Install a package

An overview and summary of the Management Central functions and setup are given first in these sections:

- 6.1, “Management Central overview” on page 183
- 6.2, “Management Central V5R1 function and setup summary” on page 183

The Management Central setup begins in section:

- 6.3, “Management Central setup” on page 189

Other volumes in this Operations Navigator redbook set

The following topics are covered in more detail in other volumes of the Operations Navigator redbook set:

- Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227:
  Viewing, managing and search functions for security related system values, authorization lists, and managing users and groups
Managing OS/400 with Operations Navigator V5R1, Volume 3: Configuration and Service, SG24-5951: Viewing, managing, and search functions for hardware, software products, fixes inventory, and system values

Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products, SG24-6564: Defining and distributing Integrated File System objects and IBM and user-defined software products.

Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565: Defining and using system monitors, Collection Services, and Graph History

Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566: Operations Navigator Network function details

Other Management Central interfaces

The following functions can also be invoked from the Management Central interfaces. They are overviewed in Chapter 2, “Operations Navigator introduction” on page 11. However, they are not covered in detail in this chapter or by other volumes in the set of V5R1 Operations Navigator redbooks:

- Logical Partitioning configuration and management. See these other sources of information:
  - Information Center, either CD-ROM SK3T-4091 or Web site: http://www.ibm.com/eserver/iseries/infocenter
    Select System Management -> Logical Partitions.
  - Redbook: LPAR Configuration and Management: Working with iSeries Logical Partitions, SG24-6251.

- Clustering (“switched disk”) configuration and management. See these other sources of information:
  - Information Center, either CD-ROM SK3T-4091 or Web site: http://www.ibm.com/eserver/iseries/infocenter
    Select System Management -> Clusters.
  - For details on V5R1 simple clustering support refer to Clustering and iASPs for Higher Availability on the IBM iSeries Server, SG24-5194.

- Extreme Support (connecting to an IBM Web site) and accessing the suite of iSeries service offerings. See these other sources of information:
  - IBM @server iSeries Universal Connection for Electronic Support and Services, SG24-6168.
  - For current service and support capabilities, go to http://www.ibm.com/servers/support and select iSeries.

Attention: This chapter presumes you are familiar with the information described in Chapter 2, “Operations Navigator introduction” on page 11 and Chapter 3, “Installation and general navigation” on page 53.
6.1 Management Central overview

Management Central is an integral part of overall management of many specific functions of Operations Navigator which may be defined or “run” on one or multiple iSeries servers.

Starting with V5R1 Management Central is not explicitly installed as part of Operations Navigator installation, as it was in previous releases. Rather, the Management Central basic functions are included in the basic Operations Navigator installation. Specific Operations Navigator components such as Configuration and Service, when installed, include additional Management Central based functions.

For example, Inventory is part of base Management Central. Inventory for hardware, software, fixes, users and groups and system values can be collected and searched. However, if the Configuration and Service component is not installed you cannot do other operations on hardware, software, fixes, system values, or Connection Services (collect performance data).

See Chapter 3, “Installation and general navigation” on page 53 information on the initial installation on your PC workstation of V5R1 Client Access Express Custom or Full installation, or later installation via Client Access Express Selective Setup. See that chapter also for general navigation capabilities, such as context menus, window refresh options, Explore (Details pane on same window), Open (separate window) and column based functions such as sort, adding columns to be displayed and varying column width.

In 6.2, “Management Central V5R1 function and setup summary” on page 183, we include summaries from Chapter 2, “Operations Navigator introduction” on page 11 of the primary Management Central functions plus some additional information including Management Central setup considerations. All Management Central functions are controlled through the primary Management Central server jobs and require a Management Central central system be defined and signed onto.

In 6.4, “Management Central navigation” on page 210, we describe how you define a function or initiate a task and track that task using Management Central interfaces.

6.2 Management Central V5R1 function and setup summary

The following summarizes all Management Central-based functions and setup considerations through V5R1. The remainder of this chapter provides additional information on the following:

- **Management Central general operation settings**: You control “environmental settings” for all Management Central functions, such as:
  - Specify what system is your central system.
  - Specify security-based functions, such as passwords and Secure Sockets Layer (SSL) security used when exchanging Management Central data.
  - Control which Operations Navigator functions are administered (restricted) through Applications Administration (Applications Administration component must be installed).
  - Specify if a check for newly available plug-ins should be done.
  - And more.

- **Configure and manage endpoint systems and system groups**: The Management Central central system initiates functions to one or more endpoint systems. That is, when you specify a Management Central function or task (such as run a command or collect
inventory) to be performed on a system, that system must be defined as an endpoint system to the central system for that function or task to be performed successfully.

A **system group** is a named collection of a list of endpoint system names. A system group can be used to simplify the interface when you want to perform a Management Central function on multiple systems.

- **Collect inventory:** You can collect inventory information for hardware, software products, fixes, system values, and users and groups (profiles). You can perform management functions based on that inventory data. Inventory functions for system values and users and groups (profiles) is new for V5R1 and provide powerful assistance for managing system values and user profiles on multiple systems.

  The collection information is stored on the central system.

- **Manage fixes:** Based upon inventory information, you can install, clean up, search for fixes on a system, send and install fixes on remote iSeries servers, and identify missing and extra fixes, based on a model system. Identifying extra fixes is new for V5R1.

- **Manage software products:** You can display and install software products, search for installed and supported software, send and install products on remote iSeries servers. Starting with V5R1 you can view the current status of licensing information for a product when software inventory has been collected.

- **Create and manage a user-defined software product:** New for V5R1 you can create, install, and manage your own software product as part of the manage software products support for IBM products. A user-defined product is a collection of programs which you have developed on a source system and intend to install on other iSeries servers. A wizard is available to help you create and install your product. You can distribute and install your applications and fixes to that product to multiple systems. This support has functions that correspond to functions available through the SystemView System Manager product, 5769SM1.

  Details on this function are included in *Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products*, SG24-6564.

- **Manage packages of objects:** You can define a package of related objects such as programs and files, and send and install (restore) that package on multiple iSeries servers. The objects can be from any of the supported Integrated File System file systems, including QSYS.LIB.

  This chapter provides additional details but more complete information is contained in *Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products*, SG24-6564.

- **Manage user and group profiles:** You can create, delete, view, edit, and send user and group profiles on one or more iSeries servers. You can also scan for owned objects. On collected users and groups inventory information (stored on the central system) you can scan for owned objects on the system you collected inventory from. You can also search for users, groups, profile attributes, user profile actions (such a previous sign on date and sign on attempts not valid), and other “attributes” on multiple systems.

  The V5R1 level of function is superior to that on previous releases, giving you full control of user and group profiles on multiple systems managed by the Management Central central system. This chapter provides additional details but more complete information is contained in *Managing OS/400 with Operations Navigator V5R1, Volume 2: Security*, SG24-6227.

- **Manage system values:** All new for V5R1. You can view and change system values on your local system as part of the Configuration and Services component (described in more detail in *Managing OS/400 with Operations Navigator V5R1, Volume 3: Configuration and Service*, SG24-5951). Using Management Central collected system values inventory
information (stored on the central system), you can compare system values inventory information based upon a model system. Based on that comparison you can update system values on multiple iSeries servers. This enables you to more fully control system values on multiple systems from the Management Central central system.

- **Run commands**: You can define repetitively run commands and “run once commands” and run them on the local system or on multiple iSeries servers. As described in 2.2.11, “Commands” on page 33, there is full command prompt support in V5R1.

- **Collect performance data**: You can run Collection Services on one or multiple iSeries servers to collect system-wide performance data. The performance data is placed into a collection object. The collection object can be used to generate performance database files used by:
  - The Performance Management/400 (PM/400) licensed program and service offering for trend analysis
  - The Performance tools for iSeries, 5722-PT1 product for viewing or print performance reports. 5722PT1 can also use the performance database file information for capacity planning tasks
  - *New with V5R1* Graph History support

There is only one IBM system job on a system performing Collection Services regardless of how many users start Collection Services or start a system monitor.

This chapter provides additional details on Collection Services and Graph History. However, more complete information on Collection Services capabilities is contained in *Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management*, SG24-6565.

- **Manage your iSeries from remote browsers or wireless hand-held Personal Digital Assistant (PDA) devices**: Through the optionally installed and activated java servlet-based Management Central - Pervasive tool (provide by an IBM fix) you can use one of these devices to run a command and on a V5R1 system you can view and manage:
  - Active system, job, and message monitors
  - Inventoried Integrated xSeries Servers for iSeries

This chapter provides additional details but more complete information on Management Central - Pervasive can be found at:

  - Redbook *Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management*, SG24-6565

- **Monitor jobs and servers**: You can monitor jobs to stay on top of job activity by monitoring a job or a list of jobs based on job name, job user, job type, subsystem, or server type. Certain jobs are characterized as “server jobs” and can be referred to collectively as servers or as a group of related server jobs for a particular “server type”. Management Central, an HTTP server, database, NetServer are examples of server types that have multiple server jobs performing their functions. Monitoring application jobs and iSeries servers (jobs) supports running a command when a threshold has been triggered or reset.

- **Monitor message queues**: You can monitor your message queues for the information you need to manage your servers. For example, you could monitor a message queue to determine whether an application completed successfully, or you could monitor the system operator message queue or another message queue for a specific message that indicates when a critical storage condition exists. Monitoring message queues supports running a command when a threshold has been triggered or reset.
Monitor system performance: You can monitor one or more system-wide performance metrics (such as average total CPU utilization, interactive (5250 jobs) response time, and more) to track overall resource utilizations. Available since V4R3, this monitor support has been enhanced and is renamed as a system monitor with V5R1. These monitored performance metrics can be displayed in real-time graphically on a PC workstation and you can run a command when a threshold has been triggered or reset.

New in V5R1, Graph History enables you to graphically view performance metrics over extended periods of time. Since V5R1 system monitors use the same job as Collection Services, Graph History uses the historical performance data regardless of whether started performance data collection with a system monitor or Collection Services.


With V5R1 Client Access Express service pack SI02795 (available February 2002) the Operations Navigator Monitor component/folder has the “B2B Activity Monitor” folder. Information is collected from Connect for iSeries and presented by this monitor. Problem detection, analysis and avoidance can be enhanced through the following capabilities of this monitor:

- Graphical view of the active request count over time (updated in real-time)
- Drill-down to the details for each request
- Graphical view of the step execution (order and duration) of any request
- Automatic notification/action when the quantity of active requests exceeds a user specified limit
- Automatic notification/action when any request is active longer than a user specified limit
- Search, sort and export capabilities

Details on this monitor support are not included in this redbook. You are referred to the following Web sites for additional information:

http://www.ibm.com/eserver/iseries/btob/connect

This contains general information about Connect for iSeries. You can follow the What is New link from the right navigation bar to information on the B2B monitor support or go there directly with the following URL:


Create and manage Definitions: You can define a command, package, product, or user profile with the intent of later sending that definition to one or more iSeries systems. The user profile and product definition support is new or has major enhancements in V5R1.

This redbook volume contains examples of command and packages functions. Additional details are in Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products, SG24-6564.

Schedule a task and track its activity: Management Central supports tasks for managing running commands, sending and installing packages and products, collecting inventory, users and groups, fixes, Collection Services, logical partitions, and system values. The task related functions can be run immediately or scheduled to run later on one or multiple iSeries servers. This support uses the OS/400 standard job scheduler support. Optionally, you may install the Advanced Job Scheduler licensed program, 5722-JS1, on the central system as a plug-in to Operations Navigator. If you do this Management Central uses the Advanced Job Scheduler functions.
New for V5R1 the Scheduled Tasks and Task Activity folders now separate the tasks types (inventory, commands, and so forth) into sub folders, based upon the function they are doing. For example, under the Scheduled Tasks folder there are sub folders for Commands, Packages and Products, Inventory, Fixes, and so forth.

**Configure and manage logical partitions:** Configure partitions, view partition configuration and move resources (processor, main memory, I/O components) between partitions, optionally using the Management Central scheduling functions for resource movement.

As stated previously on the cover page of this chapter, we do not provide additional details in this redbook.

**Configure and manage simple clustering:** Configure independent disk (auxiliary) storage pools and 2 iSeries server cluster nodes and switch the independent auxiliary storage pool between systems or partitions on the same system.

As stated previously on the cover page of this chapter, we do not provide additional details in this redbook.

**Configuring and managing Extreme Support:** Configure and connect your iSeries server to the IBM iSeries services Web site. When you use Extreme Support, iSeries delivers secure, personalized service and electronic support that is designed to help you keep your business running at peak performance. Through automated support, online tracking of service, and proactive maintenance, iSeries offers support that is customized to your unique system environment.

As stated previously on the cover page of this chapter, we do not provide additional details in this redbook.

### 6.2.1 Management Central network terminology

Table 6-1 provides Management Central networking terminology for the iSeries servers in your network.

**Table 6-1 Management Central network systems terminology**

<table>
<thead>
<tr>
<th>System role</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central system</td>
<td>Any iSeries server or AS/400 system that you use to manage the other systems in your network. Although it is common to have the same iSeries server as the central system for all functions or tasks performed on other endpoint systems, it is not a requirement. For example you could have one central system contain all inventory information and have another system be the central system when running a system (performance) monitor on multiple endpoint systems. The central system automatically includes itself as an endpoint system, which enables it to manage itself.</td>
</tr>
<tr>
<td>Endpoint system</td>
<td>Any iSeries server or AS/400 system in your TCP/IP network that you choose to manage through your central system using Management Central. A system must be defined to the central system as an endpoint system for any functions managed by the central system to run successfully on that system. It is not required that an endpoint system also be listed under My Connections. However, if you have a system under My Connections and it is not also included as an endpoint system, any Management Central function, such as Run command on that My Connections system will fail. You must explicitly add a system as an endpoint system,</td>
</tr>
</tbody>
</table>
You need an operational TCP/IP-based network to perform Management Central functions. When you have only a single system to "manage", Operations Navigator handles the My Connections system - endpoint system - central system setup.

You can use IP addresses to identify each system in the network.

Most users, however, typically use either a local host table entry or a network Domain Name Systems (DNS) server to map a host name (for example As80) to IP address that is actually used at the communication protocol level.

It is very important to have the correct IP address for the Management Central central system and each endpoint system. Operations Navigator My Connections -> Network -> TCP/IP Configuration -> Utilities and OS/400 commands corresponding to the Utilities provide tools for validating IP address and mapped host names.

The simplest tool is the IP industry-wide "Ping" utility. We discuss this tool and others in 7.4, "TCP/IP Configuration utilities" on page 318. You can Ping, specifying either the host name or the IP address you want to use for the central system and each endpoint system. If this does not work either the system TCP/IP support is not active on the system, the IP address is wrong or the mapping of an IP address to a host name is not set correctly either on your PC workstation or on the iSeries server, or the DNS server in your network has a problem.

If a DNS server is in the network to resolve host name to IP address requests, all iSeries servers and AS/400 systems participating as a Management Central central system or endpoint system, must be known to the DNS server. Depending on your network topology, the DNS server could be the local iSeries, another iSeries, or some other product that supports DNS server functions.

<table>
<thead>
<tr>
<th>System role</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>System group</td>
<td>A named logical collection of endpoint systems. You can setup and perform Management Central functions by specifying the system group name, instead of each system in the group. An endpoint may be included in multiple system groups.</td>
</tr>
<tr>
<td>Model system</td>
<td>One of the iSeries servers or AS/400 systems in your network that is to be used for a &quot;comparison function&quot;. Using the compare for missing and extra fixes function as an example, you install and verify the fixes on one of your systems. After collecting software and fix inventory for your model system and target systems, perform the compare and update function. You can then send the fixes from any system that contains the save files for the fixes you want to send. For the new V5R1 system value compare and update function you also collect system value inventory. You define a model system that contains the values for the system values you want on the target systems. Perform the compare and update function. Send (update) the model system values to the target systems. A central system or any endpoint system can be a model system.</td>
</tr>
<tr>
<td>Source system</td>
<td>An iSeries server or AS/400 system on which you store objects to be sent to other systems. The objects include software products, programs, files, folders, save files, fixes, user and group profiles, and more. Either a central system or an endpoint system can be the source system.</td>
</tr>
<tr>
<td>Target system</td>
<td>An iSeries server or AS/400 system that is the recipient of objects or commands received from the source system. The target system can be the central system.</td>
</tr>
</tbody>
</table>

You need an operational TCP/IP-based network to perform Management Central functions. When you have only a single system to “manage”, Operations Navigator handles the My Connections system - endpoint system - central system setup.

You can use IP addresses to identify each system in the network.

Most users, however, typically use either a local host table entry or a network Domain Name Systems (DNS) server to map a host name (for example As80) to IP address that is actually used at the communication protocol level.

It is very important to have the correct IP address for the Management Central central system and each endpoint system. Operations Navigator My Connections -> Network -> TCP/IP Configuration -> Utilities and OS/400 commands corresponding to the Utilities provide tools for validating IP address and mapped host names.

The simplest tool is the IP industry-wide “Ping” utility. We discuss this tool and others in 7.4, “TCP/IP Configuration utilities” on page 318. You can Ping, specifying either the host name or the IP address you want to use for the central system and each endpoint system. If this does not work either the system TCP/IP support is not active on the system, the IP address is wrong or the mapping of an IP address to a host name is not set correctly either on your PC workstation or on the iSeries server, or the DNS server in your network has a problem.

If a DNS server is in the network to resolve host name to IP address requests, all iSeries servers and AS/400 systems participating as a Management Central central system or endpoint system, must be known to the DNS server. Depending on your network topology, the DNS server could be the local iSeries, another iSeries, or some other product that supports DNS server functions.
In 6.3, “Management Central setup” on page 189, we provide additional host table entry and DNS information.

The central system in the Management Central network serves as a repository for the inventory data and monitor information of the endpoint systems as well as the repository of scheduled tasks (not yet run) task activity (running or already completed) information.

For Collection Services, you can start, stop, and monitor a collection on multiple systems. The actual collection object that contains performance data remains stored on the endpoint system.

Figure 6-1 shows a typical Management Central network with a central system, endpoint systems, a graphical client workstation, and mobile pervasive computing devices (central system has Management Central - Pervasive installed and defined monitors active).

The client workstation is being used to specify and manage Management Central functions. In later sections, we use other system roles, such as a model system and a source system. The graphical client workstation is attached to a central iSeries system and, optionally connected to all iSeries servers or AS/400 systems under My Connections.

The central system then broadcasts requests, collects data, receives response information, and provides the central data repository of management information.

![Figure 6-1 View of Management Central network](image)

Note that in general, any central or endpoint system can be the source, target, or model system.

### 6.3 Management Central setup

The following sections describe setting up the Management Central central system and endpoint systems and creating system groups.
The central system and all endpoint systems must have the following setup and, where applicable, active:

- TCP/IP started
- All systems defined either by IP address, an entry in a local host table or an entry in an active Domain Name Services (DNS) server
- The Management Central server active
- The same user profile on the central system and endpoint systems. Requiring Identical passwords is optional.

**Important:** The Management Central server must be active on the central system and each endpoint system for functions to work successfully.

The Management Central server is actually two OS/400 multi-threaded jobs that may invoke other Management Central jobs to accomplish a function. The QYPSSRV server job is the original server job and is implemented in C++. New with V5R1 is a second server job QYPSJSVR, which is implemented in Java. This Java server primarily supports System Value, Job Monitor and Message Monitor functions.

Knowledge of these two server jobs can assist you in use of online Help functions and in problem determination situations. The C++ related help functions and Java related help functions each have their own help file and help file index and different interfaces to the user. See 3.5.1, “Help information and sources” on page 113 for general information on help information for Operations Navigator.

For additional problem determination information, see Appendix E, “Management Central problem determination traces” on page 501.

Read the following information carefully to ensure the Management Central server can be started successfully.

The central system handles all of the communication to endpoint systems. You only need to sign on from your PC to the system that will play the role of your central system. Each managed endpoint system sends task results back to the central system so that one workstation session can show status and summary information for all endpoint systems.

In normal operation you need not be signed on to each endpoint system when performing a Management Central task.

The Operations Navigator left pane tree hierarchy integrates Management Central functions and supporting task information and definitions. As shown in Figure 6-2, all Operations Navigator components have been installed on the PC workstation used to capture this window. We have expanded many, but not all of the primary Management Central folders.

The right pane has good summary descriptions of the Management Central primary folders.
6.3.1 Central system

At 1 in Figure 6-2 you see the central system is system As80. At 2 you see where the **Endpoint Systems** folder appears in the tree. At 3 you see the helpful Management Central taskpad functions.

Under the **Task Activity** and **Scheduled Tasks** folders you see the expanded V5R1 task categories. Under the **Definitions** folder you can see the new with V5R1 **Product** and **User** sub folders. Under the **new for V5R1 Monitors** folder you can see the four monitors supported through Client Access Express service pack level SI02795.

(We highlighted the Systems with Partitions folder at 4 to serve as a reminder that the central system (As80 in our example) does not have to be one of the partitions on partitioned systems (As01 and As05 in our example).

**Validating your central system’s DNS settings**

On the iSeries you must have specified as a minimum the local system’s Host name and Domain name.
All TCP/IP systems support a host table or a DNS server to resolve host names to IP addresses for successful connections to other hosts. To communicate with other hosts in a network you can explicitly specify an IP address to identify the system or use a host name. A host name is most typically used and we use host names instead of IP addresses throughout this redbook. The host name to IP address mapping resolution can be performed either through a local system host table entry or by using a DNS server to perform an equivalent mapping function.

If your PC workstation cannot connect to the central system via My Connections -> system, your PC workstation has a problem with its own host table or DNS settings (typically domain name spelling error or wrong IP address of the DNS server). If you are not using a DNS server, the PC host table must have an IP address - host name entry that matches that of the iSeries.

If the PC workstation connects to the Operations Navigator My Connections -> system, but cannot connect to that same system as a Management Central central system because Management Central fails to start itself (we discuss the Management Central servers later in this chapter), there is probably a host table entry or DNS settings problem on the iSeries system - similar to the previous description for the PC workstation.

Describing the details of DNS serving support and other details on TCP/IP networking is beyond the scope of this redbook, though we do include some additional information on this in 7.2, “TCP/IP Configuration folder” on page 294.

**Important:** In this topic we show you ways to view and update, if necessary, either your system’s local host table or DNS information as a first step in setting up your Management Central network successfully. The information presented here is similar to corresponding information in Chapter 7, “TCP/IP network” on page 289.

*You should not make changes without understanding your current network topology.*

The OS/400 command interface provides Configure TCP (CFGTCP) command menu options, including 10 - Work with TCP/IP host table entries and 12 - Change TCP/IP domain information to view and change entries.

The corresponding Operations Navigator interface to host table and DNS properties is My Connections -> system name -> Network -> TCP/IP Configuration -> context menu Properties windows shown in Figure 6-3.
Figure 6-3  TCP/IP configuration host domain and host table properties example

In this figure we have an example that works in the Rochester ITSO domain. In the window at 1 we have specified the local system’s host name and domain at A. In the other areas of this window we have specified, when attempting to resolve a host name - IP address mapping, to look in the local host table first and then, if no host - IP address match is found go to the external DNS servers (B) with their IP addressees listed in search order. In the lower portion of this window (at C) we have listed 2 possible domains to be used.

In the window at 2 you see we have no entries in the local host table because we want to use only the DNS servers to map the name-IP address.

See 7.2.1, “TCP/IP properties” on page 296 for additional TCP/IP Configuration properties information.

Tip: If you read this host table and DNS server information and the additional information starting in 7.2, “TCP/IP Configuration folder” on page 294 and continue to have connection problems you can also check the FAQ (Frequently Asked Questions) link at the Management Central Web site: 
Specifying or changing your central system

Using Figure 6-4 as a reference, you can specify or change your central system from several places:

- The central system context menu
- The central system Properties - General window (as shown in this example)
- The taskpad action

You may find times you need an alternate central system, such as in the event your primary central system requires downtime for maintenance.

If the system you want to change to is not in the drop down list (at A, but list not shown), you need first to add that system under My Connections. Once you connect the new system to your network, you can begin to use it immediately as your central system. Changing the central system ends the connection, if any, to the current central system and closes other opened Management Central windows.

Setting up the central system Connection properties

In almost all Management Central networks you do not need to change any of the default central system Connection properties shown in the window at 1 in Figure 6-5. We show you this window and suggest using the online Help functions if you need to know more information.
Management Central security and central system security properties

If you are signed onto a system via My Connections -> system and start a function on that system that requires Management Central, you must sign on to the central system (if not already signed on). If you get the sign on window to the central system, enter your user ID and password.

(Note: In a single system environment (My Connections -> system and Management Central central system are the same), only one sign on is required.)

You may sign on with any user ID and password valid on the central system, but remember that user ID and optionally, a password, will be used on any endpoint system you specify a Management Central function to be performed on. Based on the user profile used, you may have insufficient permissions (authorities) to perform some Management Central functions.

Management Central uses the same sign on procedures you chose for Operations Navigator for each iSeries connection (My Connections -> system) as described in 3.3.2, “Setting up connections” on page 74. The selections for user validation are:

- Use the Windows user name and password (no prompting). The user name and password of the Windows logon is used, and therefore, no additional logon to the iSeries server has to be done. This is the easiest method to use, but may be too generalized to use if you have various security permissions that require different user profiles from the same client workstation.
- Use the default user ID (prompt as needed). A default user ID is prompted every time the user wants to sign on.
Prompt for the user ID and password every time. The user ID and password has to be typed every time the user needs to signon to the system (as determined by the Management Central function being performed).

Management Central has security properties considerations in addition to the ones used for Operations Navigator connections and functions. We discuss them in the following topics.

**Passwords on managed systems**

Management central uses the user ID specified during the sign-on procedure when communicating to endpoint systems. The Management Central Properties - Security properties window as shown at 2 in Figure 6-5, shows the password requirement parameter. That is, should only the user ID exist on all systems or must both the user ID and password be the same on all systems performing the function.

A change to this setting takes effect the next time the Management Central servers are restarted.

*Selecting this box sets only the value for the central system.* If you want to exchange passwords, each endpoint system must be explicitly configured to require the password for Management Central functions.

If there is a mismatch between the central system and the endpoint system the password is validated or not, based upon this setting on the endpoint system.

To set the Management Central properties appropriately for both the central system and the endpoint systems, you can do one of the following:

- Alternately make each one of the Endpoint systems your central system. Signon and change the corresponding Properties windows for that Management Central central system. Then change your central system to the one you want as the central system.
- Collect at least the System Values inventory from all the endpoint systems. After the collection has completed, for each endpoint system or for a system group:
  - Right-click to get the context menu. From the context menu select **Compare and Update**
  - Set your central system as the model system
  - Select the Management Central system values category you wish to compare and update

You need a valid user profile and the same password on the central system and endpoint system for this function. Note, there is no Management Central system values category through the OS/400 Work with System Values (WRKSYSVAL) or Display System Value (DSPSYSVAL) commands or the Operations Navigator Configuration and Services interface to system values.

When sure of your selections select **OK** to send the system value settings to the endpoint system or systems in the system group. You can also select **Schedule** to have this update run at a later date and time. For additional information, see the online Help for the Security Properties window.

**Use Secure Sockets Layer**

This parameter as shown in window 2 of Figure 6-5 is used to specify you want to use Secure Sockets Layer (SSL) cryptography between the central system and endpoint systems.
Do not check this parameter until you have completed all SSL setup steps. If you check this parameter without completing all the other processes and restart your Management Central server, the Management Central server will fail to start. You will probably have to contact IBM support to refresh your configuration.

**Important:** You *must* follow the setup SSL process steps in the sequence documented in the Web based Information Center article that can be viewed with a browser accessed and downloaded to your PC workstation as a PDF file. This file includes SSL setup information for all iSeries applications supporting SSL, which are summarized following this important information box. You can access this document as follows:


2. From the left navigation bar select Networking -> Networking Security -> Securing applications with SSL -> Print this topic. In this document there are specific topics for Operations Navigator folders, including Management Central.

There is also very good online (?) field level help for the Management Central central system Properties -> Security. Use Secure Sockets Layer (SSL) (?) field level help.

The Information Center article is improved more than the online Help description and should be followed exactly. This article also lists service pack level (SI01907 or later) and additional fixes you need on your system in the Securing Management Central chapter.

If you select Use Secure Sockets Layer (SSL) either on the Management Central central system Security properties window or a My Connections -> system names -> Properties - Secure Sockets page, you are presented with a window that cautions against selecting this parameter if you have not completed other Secure Sockets Layer setup processes. If you are unsure you have completed all processes, select **Cancel**.

The set of SSL setup processes include:

- Using a browser interface to the OS/400 Digital Certificate Manager on each system to “prepare” a Certificate Authority, a Certificate Authority's digital certificate, and a digital certificate for the central system and a digital certificate for each endpoint system. You must also assign each system certificate to the Management Central server (jobs) on each system through the Digital Certificate Manager interface.

- Building a “Management Central validation list” (contains central system and endpoint system certificate information for additional security) and distributing this object (QYPSVLDL.VLDL) to each endpoint system.

7.1.1, “Secure Sockets Layer (SSL) considerations” on page 292 contains this set of considerations and a list of the iSeries software that must be installed before you can set up SSL for any iSeries application.

### Management Central Application Administration

With the Operations Navigator Application Administration component installed on your workstation, you can selectively administer the signed on workstation user's ability access to Management Central function folders, as well as folder functions under My Connections -> system.

Chapter 12, “Application Administration component” on page 433 provides details and examples of general Application Administration functions. With Application Administration you can allow or deny a user ID the ability to even see a Management Central folder on their workstation.
In this topic we show in Figure 6-6 the Management Central central system sub folder functions that can be “access allowed” or “access denied”, depending on the Application Administration options chosen.

You can select a Management Central sub folder, such as Commands, and then use the Customize button to specifically list user profiles or group profiles who do not have All Object Access authority to be “access allowed” or “access denied”. You can specify this for each of the Management Central folders shown in Figure 6-5.

**Management Central user preferences**
Management Central has a set of user preference settings that address several topics, as shown in Figure 6-7. You can use the default values or change them to suit your needs.
Monitor Colors
This user preference (window 1 in Figure 6-7) shows the default colors and line type attributes used for the System (performance) monitor graphs for each system that is monitored. Color, line width, and style (solid, dotted, and so forth) are defaulted for each endpoint system defined to the Management Central central system.

You can change these defaults and have the color and line attributes applied immediately when viewing the system monitor graphs.

Task Sharing (and object sharing)
This user preference (window 2 in Figure 6-7) applies to tasks, such as collecting inventory or sending and installing software and fixes, and running a command.

Management Central Definitions (user, command, package, product) and other Management Central “objects”, such as monitors and system groups, have their own “sharing property” that are similar to Task Sharing values, but not exactly the same. These object sharing values are not specified here under Management Central Task Sharing, but rather when you are defining the Management Central object.

In this topic we describe sharing “properties” for both Management Central tasks and objects as we feel the information needs to be together. When actually starting a task or adding a new definition, monitor, or system use the online help information for sharing to be sure to select the sharing value you want to use.
Setting the sharing value is very important for viewing and managing a Management Central task or object. If the “creator” of the task or object specifies “None” then only the creator can see the task or object and do any task or object management functions. If someone in addition to the owner (“creator”) needs to view and do other actions, such as track the status of a task or start a monitor or task, the owner must specify a sharing value other than None.

At the Management Central folder context menu User Preferences level you can set the following “default task sharing” values:

- **None**: Users other than the task creator will not be able to view any aspect of the task. This is a good option for tasks that set security values or passwords.
- **Read-Only**: Other users may view the task and any task results, but cannot change any of the run time properties.
- **Controlled**: Other users can start and stop the task or use the task for a “new, based on” function. Only the owner (creator) of the task can change the sharing value or delete the item.

For Management Central objects you can set the sharing value when defining the object or later by changing its properties.

Sharing values supported by Management objects -all definitions (see “Definitions” on page 275), all system groups, and monitors are as follows:

- **None**: Users other than the object creator will not be able to view or manage the object.
- **Read-Only**: Other users may view the object, but cannot change any of the run time properties. Other users cannot stop or start a monitor.
- **Controlled**: Other users can view, start and stop a monitor and define a new monitor based upon the selected monitor. Only the owner (creator) of the monitor can change the monitor (including its sharing value) or delete the monitor.
- **Full**: The owner and other users can view, change, and delete this object. Full applies to all Definition objects and system groups.

**Note**: System monitors are not shareable. They can be viewed and managed only by the creator.

**Automatic detection of plug-ins**

This parameter (shown in window 3 in Figure 6-7) applies to whenever you initially connect to an iSeries server. When selected, this parameter causes the system to be scanned to determine if new plug-ins are available for you to optionally install on your PC. A plug-in is an application registered to the system as a plug-in that, when installed as a plug-in on your workstation, will have one of its folders integrated into the hierarchical tree structure with standard Operations Navigator and Management Central folders.

For more information, see Chapter 11, “Plug-in support” on page 385.

**Setting the correct time value for Management Central**

Many Management Central and Operations Navigator functions use a time stamp on windows and Management Central schedules according to a time value, including the following Management Central functions:

- **Job scheduling**
- **Job, message, and system monitors “started” and “last changed” timestamps**
- **Management Central Pervasive displays**
If you do not set the iSeries “time” and “time zone” variables appropriately you will not see times that reflect your local time on windows or scheduled tasks may not be started at the intended time.

Appendix D, “Setting the time values for Management Central functions” on page 479, provides a complete description of how to set the appropriate time variables, based on your international time zone. In this topic we summarize the following “time variables” that need to be set correctly:

- **System time**: OS/400 system value QTIME.
- **System time value offset from Greenwich Mean Time (GMT)**: OS/400 system value QUTCOFFSET (coordinated universal time offset). This value must contain the number of hours and minutes your system is ahead or behind Greenwich Mean Time (GMT).
- **Correct time zone for your system**: The time zone value must be set to correspond to the time zone your system is in. The time zone values are acronyms listed in Appendix D, “Setting the time values for Management Central functions” on page 479.

On the iSeries the time zone value can be specified either in the locale object accessed by OS/400 system value QLOCALE or a Java Development Kit (JDK) “default properties” file.

You can view and change the system values QTIME, QUTCOFFSET, and QLOCALE through either:

- OS/400 commands Work with System Values (WRKSYSVAL) or Display and Change System Values (DSPSYSVAL, CHGSYSVAL).
- Operations Navigator My Connections -> system -> Configuration and Service -> System Values. Select the Date and Time category, then Time.

On an iSeries the system values QTIME and QUTCOFFSET must be changed when there is any change between standard time and daylight savings time. For example, in the North America and Latin America “Central Time Zone” the time of 2:00 AM during standard time should have a corresponding QUTCOFFSET value of - 6:00 (6 hours behind GMT). When daylight savings goes into effect, you must explicitly change QTIME to 3:00 AM and QUTCOFFSET to - 5:00 (now only 5 hours behind GMT).

The time zone value needs to be set correctly once as it uses QTIME and QUTCOFFSET values. If your time zone does not support daylight savings then QTIME and QUTCOFFSET need to be set only once.

Any time you change QTIME, QUTCOFFSET, QLOCALE and the JDK default properties file, you need to stop and then start the Management Central servers (refer to “Starting TCP/IP and the Management Central server” on page 202).
Starting TCP/IP and the Management Central server

You can manually start (and end/stop) TCP/IP and the Management Central server on your system through either OS/400 commands or Operations Navigator settings (provided you have an active Operations Navigator session). You can specify to start the TCP/IP-based servers whenever TCP/IP starts, which is recommended for most environments.

The following gives a summary of the easiest way to start TCP/IP and the Management Central server. A more complete discussion of multiple ways to achieve the same results is contained in Chapter 7, “TCP/IP network” on page 289 under “Servers to Start window” on page 300.

- **Starting TCP/IP**

  The system IPL Attributes have a new with V5R1 *Start TCP/IP at IPL* (system restart) parameter. As shipped with the V5R1 this value is set to *YES. This parameter can be accessed from OS/400 commands Display IPL Attributes (DSPIPLA) and Change IPL Attributes (CHGIPLA).

  This is the easiest technique to use. Other techniques are discussed in 7.2.6, “Starting and stopping TCP/IP” on page 311.

- **Starting TCP/IP applications (TCP/IP must be active first)**

  *Starting with V5R1*, we recommend you use Operations Navigator My Connection -> system -> Network -> TCP/IP Configuration Properties - the “Servers to Start” window. This window lets you to selectively specify the complete list of TCP/IP-based servers and servers classified as Host Servers to start when TCP/IP starts.

  This is the easiest way to have your TCP/IP servers (including Management Central) and Host servers started every time TCP/IP is started under OS/400. For additional techniques refer to 7.3.2, “TCP/IP servers” on page 315 and 7.3.3, “Client Access servers” on page 316.

- **Starting the Management Central server**

  For normal operation, we recommend “checking” the Management Central server as described above for TCP/IP Configuration Properties as previously described here - in 7.3.2, “TCP/IP servers” on page 315.

**Tip:** We recommend you set the QTIME, QUTCOFFSET, and time zone in the locale object (referenced by system value QLOCALE) or time zone in the JDK default properties file correctly on each system in your network. These values, however, are more important on your central system as that is the time values used to schedule tasks and update timestamps on various Operations Navigator windows.

If you are performing tasks on endpoint systems in different time zones and want to ensure the times the task runs on those endpoint systems, a simple, but effective approach is to define on your central system a system group containing endpoint systems all in the same time zone. For example, assume the central system and system group SG_TZ1 endpoint systems are in the same time zone and system group SG_TZ2 endpoint systems are in a time zone 1 hour ahead of the central system.

To run the task at 01:00 AM on system group SG_TZ1 you schedule the task to run at 01:00 AM on the central system. To run the task at 01:00 AM on system group SG_TZ2, you schedule the task to run at 12:00 AM (midnight) on the central system.
You can also use Operations Navigator My Connection -> system -> Network -> Servers -> TCP/IP, and select Properties for the Management Central server as shown at 3 in Figure 6-8.

For special cases, such as stopping and then starting Management Central outside of the End or Stop TCP/IP process, you can use the ENDTCPSVR SERVERS(*MGTC) and STRTCPSVR SERVERS(*MGTC) commands or use My Connection -> system -> Network -> Servers -> TCP/IP Management Central server context menu as shown at 1 in Figure 6-8 to start or stop the Management Central server.

Figure 6-8   Management Central servers

In the upper window context menu for the Management Central server (shown at 1), you see the Start, Stop actions, as well as Server Jobs, and Properties.

Remember that if you change values for time or the time zone, you must stop and start Management Central to use the new values.

With Figure 6-8, in window 2 we show the primary Management Central server jobs that are the initiators and work flow managers of Management Central functions.
6.3.2 Endpoint systems

All systems to be managed by Management Central need to be defined as an endpoint system. The Management Central central system must have V5R1 installed to potentially use all the V5R1 functions. The release on each endpoint determines which of the V5R1 Management Central functions can be performed on that system. For example, you can use a System monitor on a V4R5 endpoint system, but not a Job monitor as that function is new with V5R1.

If your central system is at a release earlier than V5R1, you not be able to us the V5R1 Management Central functions on a V5R1 endpoint system.

If you specify endpoint systems in a system group and specify a V5R1 central system function that is not supported on some of the endpoint systems, you can see this in task status fields, such as “Failed on 2 of 5 systems” at a summary level and for a specific endpoint system a status such as “Failed - release not supported”.

An endpoint system is any system in your TCP/IP network that you choose to be managed through your central system with Management Central. You can let the Management Central discover and add endpoint systems, or you may manually define the endpoint systems.

Except for the central system itself you must take action to get a system to be included as an endpoint system. This is described in topics following Table 6-2.

The endpoint system must have V4R3 OS/400 or later installed. V4R4 and higher versions of OS/400 provide significantly improved support for Operations Navigator functionality as shown in Table 6-2.

<table>
<thead>
<tr>
<th>Release level on endpoint system</th>
<th>Function available</th>
</tr>
</thead>
<tbody>
<tr>
<td>V5R1M0</td>
<td>All functions</td>
</tr>
<tr>
<td>V4R5M0</td>
<td>Performance (called System monitors starting with V5R1) monitors (not Job or Message monitors), event log, fixes management, Collection Services, remote commands, package (not product) distribution, inventory. Management Central - Pervasive is also supported.</td>
</tr>
</tbody>
</table>

Note: In some networks an endpoint may have its IP address changed. If this happens after you have added an endpoint system, you must delete the endpoint system and manually add it again or run Discover Systems as described in “Adding endpoint systems through discovery” on page 205 and “Adding endpoint systems manually” on page 207.
Adding endpoint systems through discovery
To automatically discover endpoint systems, from within Management Central, right-click **Endpoint Systems** and select **Discover Systems** from the context menu.

The **Discover Systems** dialog enables you to search the selected TCP/IP subnets for iSeries systems. You can elect to perform this search every time the Management Central server starts. The iSeries systems found during discovery are added as endpoint systems on the central system. If the iSeries system is already defined as an endpoint system, the IP address is verified and updated if it has changed.

As shown in Figure 6-9, you can specify which TCP/IP subnets to search and indicate whether to use File Transfer Protocol (FTP) or Simple Network Management Protocol (SNMP) to locate candidate iSeries systems. You may limit the search to include only iSeries systems operating at a selected level of OS/400 or higher.

**Discovery logic**
When using Automatic Discovery, if you select only FTP (as shown in Figure 6-9), only those iSeries systems that are running an FTP server are discovered. If you select only SNMP, only those iSeries systems that are running an SNMP server (agent) are discovered. If you select both FTP and SNMP, FTP is used first. If no iSeries FTP server is located for a system, then an attempt is made using an SNMP server. Please refer to Chapter 7, “TCP/IP network” on page 289, for more information on starting TCP/IP servers.

<table>
<thead>
<tr>
<th>Release level on endpoint system</th>
<th>Function available</th>
</tr>
</thead>
<tbody>
<tr>
<td>V4R4M0</td>
<td>Performance (called System monitors starting with V5R1) monitors (not Job or Message monitors), event log, fixes management, Collection Services, remote commands, package (not product) distribution, inventory</td>
</tr>
<tr>
<td>V4R3M0</td>
<td>Performance (called System monitors starting with V5R1) monitors (not Job or Message monitors), event log</td>
</tr>
</tbody>
</table>

**Note:** For releases prior to V4R3M0, you need the IBM Performance Investigator PRPQ for the OS/400 version installed on your system. This PRPQ is no longer supported but it should work. The System (performance) monitor function is not available on endpoint systems running a release of OS/400 earlier than V3R1M0.
Figure 6-9  How to verify iSeries systems

Note: A change to the option (for example, to find the system on another subnets) in the the Discover Systems dialog does not take effect until the Management Central server is restarted.

Consider the following points when using the discovery method:

- If your network frequently changes an IP addresses for a system, use the option to automatically discover addresses. Be aware that discovery uses significant system resources as it examines each IP address in the range.
- If you are defining your endpoint systems for the first time and you have a large number of systems to add, Automatic Discovery will reduce the effort involved with adding the systems.
- If you have a number IP-connected iSeries systems, Discovery will add all located systems as endpoints. If you only require a limited selection of these systems to be defined as endpoints, you may find it more efficient to manually add the required endpoint systems, or use the Discovery technique and manually remove (delete) an endpoint system from the Endpoint Systems folder you are not going to use.
- You should be aware of the Management Central property IP address lookup frequency under the Connections tab as seen in Figure 6-10. This specifies how often the IP addresses are refreshed from a DNS server. The choices for this property are Always or Never. If you select Always, connecting to an endpoint system may take longer as a DNS lookup is performed prior to connecting. If you select Never, Management Central uses previously stored IP addresses. You can run Discover Systems at any time to update the list of IP addresses stored in Management Central. To access this property value, right-click Management Central, and select Properties. Then select the Connection tab as shown in Figure 6-10.
Adding endpoint systems manually
You can manually add endpoint systems to your Management Central network. To add an endpoint system to Management Central, complete these tasks:

1. Right-click **Endpoint Systems**, and select **New Endpoint System**.

2. Type the host name of an iSeries system that meets the version requirements. Your DNS server or host table entry will be referenced to determine the IP address of the endpoint system.

You can delete an endpoint system simply by right-clicking it and selecting **Delete** from the context menu. Any endpoint system except for the central system may be removed from your Management Central configuration.

**Attention:** When you delete an endpoint system under Endpoint Systems you delete the endpoint system from all system groups in which it was included. Any collected inventory information for the deleted endpoint system will be discarded as well. Operations Navigator will prevent you from deleting the central system from the list of Endpoint Systems.

### 6.3.3 System groups
A system group is a named collection of endpoint systems that share common attributes or typically have the same Management Central function/task performed on them. Endpoint systems can belong to several system groups as suits your needs. Once you create a system group, you can manage the entire group from your central system as a single entity.

Having the ability to group systems makes systems management more convenient and Management Central tracks the task activity on each endpoint system in the system group.

**Creating a new system group and adding endpoint systems**
To create a system group, use Figure 6-11 and follow these steps:

1. Right-click **System Groups**, and select **New System Group**.
2. On the New System Group dialog box, specify a unique name for the new system group. You can type a brief description that will help you later identify this group in a list of system groups.

3. From the Available systems list, select the endpoint systems that you want to include in this new system group. Click Add to add the endpoint systems to the Selected systems list as shown in Figure 6-11.

4. Before completing the new system group definition, click the Sharing tab to ensure you have the sharing option specified the way you want.

As shown in Figure 6-11 the default when defining a new system group is Sharing - None. This means only the owner (user As0301) will be able to see this system group and later right-click on it to perform actions from the resulting context menu.

5. Click OK when satisfied with the endpoint systems in the system group and the system group sharing option.

The system group you create includes all the endpoint systems you just added as shown in the lower left window with context menu at 1. You can see the many menu actions possible for all the systems in the system group, some of which we expand on in this chapter. Note that you can add or remove endpoint systems from your system group or change the sharing option through the Properties action.

You can also delete the system group or create a New Based On system group by right-clicking the system group.

**Attention:**

1. When you remove an endpoint from a system group, you do not delete the endpoint system from Endpoint Systems list. When you remove a system from Endpoint Systems, that system is automatically removed from any system group.

2. In V5R1 if you are using the new to Operations Navigator Systems with Partitions support or Clusters support, you may see a system group that you did not create using the support described in this topic.

You cannot use such a system group for Management Central functions such as sending software products or collecting inventory. You cannot edit, or delete these system groups except under Logical Partitioning and Clustering interfaces.
Figure 6-11 Configuring a system group example
6.4 Management Central navigation

Management central activities are managed as tasks or definitions or monitors. Some activities can be initiated from a single folder, while others can be initiated from more than one folder or menu bar or tool bar icon.

Figure 6-12 is good for discussing an overview of Management Central navigation.

In the upper window left pane of Figure 6-12 we show the Management Central central system hierarchy tree folders with the Task Activity, Scheduled Tasks, and System Groups folders expanded.

In the right pane at 1 we have Explored the Scheduled Tasks for Fixes. You can see two Fixes tasks have been scheduled - one to Send and Install Fixes and one to simply Send fixes (because the fix cover letters have special install instructions).

At 2 we show the context menu for a system group (SG_TimeZone1 in our example).
At 3 we show the context menu for a system (As01) under My Connections.

On the right hand side of Figure 6-12 we show the second level context menus for Management Central-based functions and tasks that have second level menus. This gives you a general idea of how to interface to the Management Central functions summarized in 6.2, “Management Central V5R1 function and setup summary” on page 183.

As you can see the context menus 2 and 3 have many actions in common. These are the actions on either context menu that use the Management Central central system to manage and perform the associated functions/tasks:

- Users and Groups
- Inventory
- Monitors
- Fixes
- Collection Services
- Run Command
- System Values

Each one of these actions, except Monitors, support a scheduling option.

In Figure 6-13 we show an expanded list of endpoint systems and expanded one endpoint system to show the primary folders under each endpoint system. We also show the context menu for a specific Endpoint system.

The functions available for a selected endpoint system are similar to those functions available from either a Management Central system group or a My Connections system.

![Context Menu Diagram](image)

**Figure 6-13** Endpoint system navigation example

The context menu for an endpoint system, shown at 1 is very similar to the context menu for a system group. The context menu shown at 2 for the Collection Services folder shows full function access to managing Collection Services capabilities.
The **Configuration and Service** sub folders for an endpoint system are a subset of those available for that same system under **My Connections**. The **Users and Groups** sub folders are a subset of those available for that same system under **My Connections**.

Note for the subfolders grouped under **A**, the word “Inventory”. An Inventory must have been collected for that system for functions associated with those folders to be available. If you select the folder and no inventory exists, you get an error window indicating inventory has not been collected.

**6.4.1 Task scheduling and activity**

Management Central introduces the concept of a *task* when you perform an action. For example, you create a Management Central task each time you run a command or collect inventory.

The central system handles all Management Central tasks. Tasks are needed to track activities, which may run for an extended time, run across multiple endpoint systems, or be scheduled to run at a later time. Some activities, such as automatically installing fixes, simply take longer to complete than the time interactive users are willing to tie up their desktop. As a result, Management Central handles long-running and scheduled functions by using tasks.

These functions can be run and left unattended by PC workstation users. The central system performs all work in the background so your session with the central system can be ended and your workstation powered off and the work continues to be performed.

Later you can start up an Operations Navigator Management Central session and view the status of the task.

Management Central tasks are managed in V5R1 according to the following task categories:

- Commands
- Packages and Products
- Inventory
- Fixes
- Collection Services
- Users and Groups
- System Values

Not all Management Central “activities” are considered a task. Under the Definition folder you can create a new definition (such as a package of objects or a command definition), but there is no task at that time. When you select to send a definition (or **Run** a command) a Management Central task is created.

When you create a new monitor (system, job, message, and B2B) there is no task at that time. When you start a monitor, that monitor becomes active but is not considered a Management Central task.

You can follow the activity for a particular task when you choose to run it immediately, or you can oversee its activity when you schedule the task for a later time and then when it runs. The task activity is updated immediately when a status changes. There is no need to perform a manual refresh.

At **A** in Figure 6-14 we show the expanded hierarchy tree for Task Activity and Scheduled Tasks. We also show the context menu that applies to the entire Task Activity folder at **B**.

If you specify a task to run “immediately” (do not use a Schedule button) the task appears only under the Task Activity folder - never appearing in the Scheduled Tasks folder.
The following section goes into more details on overall task management.

Figure 6-14 Viewing tasks scheduled and run activity

At 1 in Figure 6-14 we show the two scheduled Fixes tasks we used in an earlier figure in this chapter. At 2, we show the corresponding Task Activity window for these same Fixes tasks after they have run. In this example they both show Completed. This means the completed successfully.

Because we scheduled these Fixes tasks to run only once, the task entries in the window at 1 would be automatically removed when they start to run.

You can use the menu bar Options -> Include function to subset the tasks shown in the window.

The context menu at C applies to the selected Fixes task in the window.
Note that all Scheduled Tasks and Task Activity tasks support a **Start Based On** action. This is an easy way to schedule or run the same task on different systems based on each target system’s time of day requirements.

At a you see the context menu for the entire Task activity folder. The **Delete Tasks** for this menu is a convenient way to remove a large number of tasks you are no longer interested in.

**Tips:**

1. A scheduled task that has not yet been started appears under the Scheduled Tasks folder. It does not appear under Task Activity. It continues to be displayed under Scheduled Tasks until it starts to run. You have some change and delete capabilities of that task while it remains scheduled. If a task is scheduled to run only once, that task no longer appears under Scheduled Tasks once it starts to run. If the scheduled task is to be run repetitively (such as once a week) its entry also remains visible under Scheduled Tasks. You can review the task’s run activity under Task Activity.

2. If you are interested in viewing up to the second status of tasks, but want to do other work on your PC workstation at the same time, consider right-clicking the appropriate task category (Command, Packages and Products, and so forth) select **Open**. You now have a separate window on you desktop that you can watch for changes to appear.

3. A task scheduled through Management Central can also be viewed through the OS/400 Work with Job Scheduler Entry (WRKJOBSCDE) command screen. The entry will have a Qccc “job name”, such as Q3F12. Knowing this can assist, for example, in resolving a situation where a task runs repetitively and no one can see this Schedule Task through the Management Central interface. For example, assume user ID ITSCID19 originally scheduled the task to run weekly, the corresponding employee has taken an extended home leave, and you are wondering why this task is running as scheduled.

   If user ID ITSCID19 specified None for task sharing, no other users can see this task through Management Central windows. Using WRKJOBSCDE you can tell this scheduled Qcccc entry was entered through Management Central. By examining other entry information such as scheduled job user profile or time of day to run or command to run, you can determine to either delete this entry or hold it until further investigation.

4. Management Central scheduling functions will use the scheduling functions of the licensed program Advanced Job Scheduler for AS/400, 5769-JS1, if it is installed as an Operations Navigator plug-in. Once installed, each place where scheduling is supported, Advanced Job Scheduler parameters are available to do things such as full calendaring support, job dependencies, and conditioning across a vast number of system and job attributes. We generally address Advanced Job Scheduler capabilities in Chapter 11, “Plug-in support” on page 385.

---

**6.5 Task management**

In the following topics, we use examples to show you how to start, view, stop, and delete tasks in the Management Central environment.

**6.5.1 Creating a new task**

Tasks can be created from various folders and associated menus, as illustrated in Figure 6-12 on page 210, depending upon whether you want a task to run on a single system or multiple systems:
Chapter 6. Management Central and Monitors

Single system:
- My Connections -> system name -> context menu
- Management Central -> Endpoint Systems -> system -> context menu

Multiple systems:
- Management Central -> System Groups -> group -> context menu
- Management Central -> Endpoint Systems -> select multiple systems -> context menu

Since Inventory has a powerful set of capabilities for hardware, software products, fixes, system values, and users and groups functions, we use the inventory-based functions to illustrate task management. Inventory-based functions require an inventory to be collected, even when you are in a single system environment. In our example we collect inventory for the central system itself and one endpoint by using a system group.

In our example, our system group is named **AS80_AS25B**, to represent central system As80 and secondary partition As25B in another system.

From the context sensitive menu of **AS80_AS25B** shown in Figure 6-15, select **Inventory** -> **Collect**.

![Figure 6-15 Inventory collection](image)

The inventory collection panel is presented as shown at 1 in Figure 6-16. We select to collect inventory for all five supported sets of information.

Clicking **OK** would immediately start the collection process. Instead we select **Schedule** to bring up the window at 2.
6.5.2 Scheduling tasks

Management Central functions that support scheduling, by default interface to the standard OS/400 job scheduler functions. You have the option of choosing to perform a task immediately or choosing a later time.

When you schedule a task, the time at which the scheduler starts the task is based on the system time and date of the central system. For example, if you collect inventory on systems in California, and the central system is located in New York, the collection happens on New York time. See “Setting the correct time value for Management Central” on page 200 for systems in multiple time zone considerations.

In our inventory example, we click the Schedule button to get the Management Central Scheduler window as shown at 1 in Figure 6-16. We schedule this task to ensure that this collection is performed at the end of a day (5:00 PM).

Figure 6-16   Inventory selection and scheduling

We schedule this to run once because we intend to view the just inventoried values and take some immediate actions as soon as we view these values. You could schedule one or more inventory collections to be repeated without manual intervention as shown under the “When to run” area. When doing inventory analysis you need to make sure you understand how old the inventory information is.

After clicking OK on the scheduler window, a task is generated which can be accessed in the Scheduled Tasks panel of Management Central. A “Collect Inventory scheduled” window (at 2 in Figure 6-16) appears that provides information to help identify this task from other scheduled tasks when you view scheduled, running, or already completed tasks.

In our example you see “Collect Inventory (2)” as the name of the scheduled task. (We had earlier scheduled other inventory collections.)

Note, once a task has been scheduled using the standard OS/400 job scheduler you can access all currently scheduled tasks by expanding the Scheduled Task folder under the Management Central server, as shown at 3 Figure 6-17. On a scheduled task you can:
View the schedule information.
Start another task based on this one (uses the existing task as a base definition that you can change).
Delete the scheduled task to prevent it from being run.
View the properties of the scheduled task.

**Important:** Management Central scheduling defaults to using the standard OS/400 job scheduler. When using this support you can change the Sharing option value after a task has been scheduled, but cannot change any other scheduling properties.

As discussed in the Plug-ins chapter in *Managing OS/400 with Operations Navigator V5R1, Volume 2: Security*, SG24-6227, you could have additional job scheduling capabilities by installing the Advanced Job Scheduler for iSeries, 5722-JS1, licensed program and including it as a plug-in to Operations Navigator on a specific PC workstation.

When a job that has been scheduled to run only once starts running, its entry under Scheduled Tasks is automatically removed. You can only view its activity while running or after it has completed through the Task Activity component.

**Viewing task properties**
A scheduled task may be viewed, or deleted and a new task can be defined based upon the existing task. You can view the existing task's properties and change the sharing parameter previously specified.

You can view the properties of an active or completed task as described in the next topic.

![Scheduled task properties](image)

**6.5.3 Viewing task status activity**
You can view task status when the task is running or already completed under Task Activity for the central system. In our example in Figure 6-18 we show the activity status for recent inventory collections.
At 1 in Figure 6-18, you can see that one inventory collection had a failure on one of the two endpoint systems we collected inventory from.

We selected Status from the context menu for the collection with a failed status. At window 2 we show the detailed status for the system (As80) where inventory collection was completely successful. At window 3 you can see the “failure information” for system (As25B.)

The task failed on As25B because the user profile used by the Management Central central system was disabled.

We corrected that problem and ran the collection shown at the top of the list, which you can see completed successfully.

Note, if As25B had been a V4R5 system and the user ID had been enabled, Hardware, Software, and Fixes inventory would have shown Successful. System values and Users and Groups would have shown Failed - release not supported.

6.5.4 Viewing task output

Task status information is stored on the central system. Some tasks may produce printed output or generate an OS/400 job log on the endpoint system.
The Inventory functions do not produce printed output. However, the Run Command task is an example of a task that could produce printed output. In our example, shown in Figure 6-19, we ran the Display Library (DSPLIB) OS/400 command - DSPLIB LIB(PFREXP) OUTPUT(*PRINT), which produced a listing of the library objects contained in library PFREXP.

We used a different central system and system group than the inventory example, but windows 1 and 2 showing high level task activity status are similar to the inventory example.

![Figure 6-19 Task printer output example](image)

By right-clicking one of the systems in the window at 2, you can see if the task produced any printed output, as shown at 3. Task Output will be grayed out if no output exists.

Selecting **Task Output** brings up the window shown at 4. Note that this printed output (spooled file Qpdsplib) is on an endpoint system - As25 (which happens to be a V4R5 system) - not the central system (As01c).
Selecting the spooled file (context menu Open) brings up the window shown at 5.

Depending on your My Connections -> system context menu Properties -> Connection settings you may need to sign on to the system again before seeing the AFP Viewer window shown in 5.

Management Central uses the AFP Viewer (provided with IBM Client Access Express) to view output. For general information on viewing printed output for an OS/400 job, refer to 4.3, “Printer Output functions” on page 124.

Note, from the context menu shown for the spooled file, you can select other actions to work with the spooled file. You could use the menu bar -> File options to close the file, create a page overlay, create a page segment, or print the file.

While working with this task activity information, do not forget if you need additional help with the status information, select Help from the toolbar, and select Task Status Help.

**Stopping a task**

If a task is shown as running (Started status, for example) and you want to try to stop it:
1. Right-click the task and select Stop from the context menu.
2. Select Stop when you are asked to confirm, or Cancel if you decide not to stop the task.

**Note:** When you stop a task, all activity for the selected task ends immediately. However, there may be cases where you may want to sign on to the target systems to verify you are satisfied with the results of the stop function.

**Deleting a task**

After you have completed or started running several tasks, the task results list may become quite long. As the list gets longer, you may determine that some task results are no longer meaningful to you. You can delete one or multiple of these task results within a task category by performing the following:
1. Select one task entry or using the Ctrl or Shift keys and left-clicking the selection.
2. Select Delete.
3. Select Delete when you are asked to confirm, or Cancel if you decide not to delete the selected tasks.

**Note:** We have just described deleting a task within a task category. You can delete at a higher level across all task categories by selecting the Task Activity folder context menu item Delete Tasks as shown in Figure 6-14 on page 213.

### 6.6 Inventory management

Inventory management provides powerful view, search, and other change management facilities across the five inventory categories - hardware, software products, fixes, system values, and users and groups.

This topic assumes you have reviewed the summary of capabilities under 6.2, “Management Central V5R1 function and setup summary” on page 183. In this topic we show examples of some of the important inventory management functions to get you comfortable in using all of the inventory management capabilities. For additional details you are referred to:
Before describing inventory management under Management Central, we first summarize what you can do without collecting inventory information for the corresponding inventory categories:

- **My Connections -> system -> Configuration and Service.** Expand Configuration and Service:
  - System Values: You can view and change system values, assuming your user profile has sufficient user authorities. (Use online Help when using the System Values folder). There is no search or compare function.
  - Hardware: Shows current system (or logical partition) hardware in specific hardware categories. There is no search facility.
  - Software: Shows current software products in Installed and Supported categories. Supported is for software not installed on the system, but contained on this system for support on another system. There are no search or send and install, or uninstall functions.

You cannot do any Fixes folder functions without collecting inventory.

- **My Connections -> system -> Users and Groups.** Expand Users and Groups. Three folders are shown - All Users, Groups, and Users Not in a Group. With this interface:
  - You can view, create, edit, and delete user profiles and group profiles.
  - You can send a message to users, copy user profiles to another system and view objects related to the selected user such printed output, active jobs, owned objects, and more.

There is no search function.

Inventory collection and associated functions are supported for the following five categories:

- **Hardware features installed:** view, search across multiple systems. You can export hardware information to PC workstation file formats.

Note, without a collected inventory on the Management Central central system, you can view the hardware installed on a My Connections -> system. You cannot search for a hardware feature on the system or export the hardware information.

- **Software products installed and supported:** view, search send, send and install, uninstall, on multiple systems. You can export software information to PC workstation file formats.
Note that without a collected inventory on the Management Central central system, you can view your installed software products or supported (but not installed) software products on a My Connections -> system. You can view basic product properties information. You cannot search for a software product on the system or export the software product information.

- **Fixes (per software product):** copy from media, view, send, send and install, uninstall, compare to a model system for missing or extra fixes, update other systems that are missing fixes, cleanup fixes (cover letters and save files), and export software information to PC workstation file formats.

Note that fixes are accessed through the Fixes Inventory folder. All fixes functions require that software products and fixes information be collected and stored on the central system.

- **System values (new with V5R1):** view, change, compare to a model system and update other systems, and export software information to PC workstation file formats.

Note that without a collected inventory on the Management Central central system, you can view and change your system values on a My Connections -> system. You cannot perform any search, update on other systems, or export function.

- **Users and Groups (new with V5R1):** create/delete, edit, view, send new or changed user and group profiles to other systems, search for profile and profile attributes, scan for owned objects, and export user and group information to PC workstation file formats.

Note that without a collected inventory on the Management Central central system, you can create/delete, edit, view user profiles and group profiles on a My Connections -> system. You can also manage user objects, send a message to that user, copy the user profile to a remote system, and more, including scan for owned objects for a user on that system. You cannot search for user profiles nor use the advanced search functions.

### Notes:

1. In summary, you can view and perform other management functions on the hardware, software products, fixes, systems values, and users and groups only for that system, when you access these folders and associated context menus through any of the following:
   - My Connections -> system (without a collected inventory)
   - Management Central -> Endpoint Systems -> system
   - Management Central -> System Groups -> system

2. When you access these inventory-based folders and associated context menus using a system group name you can perform the supported function for all endpoint systems in the system group.

3. When viewing inventoried information consider using menu bar Options -> Columns as there is often several columns of information not included in the default columns of information.

4. In this chapter we have chosen to show extended examples for some of the inventory category functions that we wished to highlight in this volume without requiring you to refer to another redbook volume. You may find the information and examples in this chapter sufficient to start using these functions productively.

The inventory export function includes the following PC workstation file formats:

- ASCII Tab Delimited Text (.txt)
6.6.1 Collecting inventory

In Section 6.5, “Task management” on page 214, Figure 6-15 on page 215 through Figure 6-18 on page 218, we used inventory collection to illustrate several aspects of Management Central task management.

In this topic we assume all five inventory categories have been successfully collected from two systems - As80 (central system) and As01. We also assume that we have very recently collected the inventory as we do not want to make decisions based on “old data”.

When you do some compare (to a model system) functions, note that those Management Central windows include the time stamp of the most recently collected inventory data.

Note also, you can use Management Central scheduling to regularly collect inventory and do it at some “quiet” time of day for the systems involved.

**Tip:** Management Central inventory is collected by job QYPGETINV on each endpoint system. If you have problems with inventory collection, look in the job log of this job on each endpoint system.

6.6.2 Accessing the inventory information

There are several left pane tree hierarchy “folders” from which you can access the inventory information and perform a function on that information. The context menus for the My Connection system inventory categories have several actions in the menu.

Use Figure 6-20 as a reference for accessing inventory information and performing inventory-based functions.
The general inventory context menu at A includes the Collect action which, as we described earlier. From that menu you can search the inventories for hardware, software, fixes, and users and groups with search criteria unique for each inventory category.

At A we show the context menu actions for Users and Groups. We highlighted the capability to scan for owned objects for specific inventoried users and groups across multiple systems, if the context menu was for a system group. (Scan for owned objects works on a single system for a user under My Connections -> Users and Groups without inventory collection.)

At B we show the context menu actions for Fixes Inventory. We summarize these capabilities later in this topic under “Fixes Inventory” on page 226.

At C we show the context menu actions for System Values inventory. Similar to Fixes inventory you can compare system values on based upon a model system and update other systems with system values from the model system.

At D we highlight the Inventories that can be accessed under and endpoint system when inventory has been collected for that system. Many of these actions also apply to the context menu selected for a My Connections -> system for that same system.

In some cases there are multiple “point and click” paths to the same function or information. You should experiment with the various inventory based folders and context menu items to see which works best for you. We do not show all of them in this redbook. Online Help information is available to assist you in the various ways to perform an inventory function.

In most cases, if you attempt a function that is dependent on an inventory collection and no inventory exists for that category for a system, an error window appears indicating “no inventory collected for system xxxxx”. In some cases, for example, the search function, the search results area is blank and you must note the “last collected” parameter shows Never.

In this redbook we give examples of some of the inventory functions. We assume you have collected inventory for all five V5R1 categories.
Hardware inventory
You can view, search and export the hardware inventory for a system or for multiple systems using a system group.

We show a simple example showing hardware inventory for system As01 in Figure 6-21.

![Figure 6-21 Hardware Inventory example for an endpoint system](image)

Software inventory
You can view, search and export the software inventory for a system or for multiple systems using a system group.

This can be a very useful way to install an application or licensed product to test your use of it on one system. When testing has completed satisfactorily, you can send and install that product on multiple systems, perhaps at an off peak activity time for those systems.

To start the send and install process you start with displaying the collected Software products inventory stored on the central system for an endpoint system as shown in Figure 6-22. We selected a product - the Advanced Job Scheduler, 5722JS1, to show a product context menu.

![Figure 6-22 Software Inventory example for an endpoint system](image)
The Send and Install function has a wizard that assists you in selecting the target systems, scheduling the send and install and optionally adding a command to be run after the installation has completed. The send task is status is tracked with Management Central Scheduled Tasks and Task Activity under the Packages and Products folder.

See the example in “Inventory Search examples” on page 235 for a more complete Send and Install example.

Note that Properties information includes current licensing information.

**Fixes Inventory**
The Fixes inventory functions provide significant assistance toward keeping a local system up to date and managing the fixes inventory on other systems in your network.

The complete list of fixes inventory functions include:

- View fixes on a single system.
- Search for specific fixes on a single system or all inventoried systems.
- Install fixes on a single system or target systems.
- Perform advanced functions on a single system or target systems, such as uninstall a fix, install a fix permanently, and cancel an action for selected fixes that have restart actions specified. Restart actions includes install or uninstall at the next system restart (IPL).
- Send fixes or send and install fixes on target systems.
- Clean up fixes (removing PTF save files and cover letters) on a single system or target systems. You can cleanup individual fixes, a set of fixes, fixes for a product, and fixes for all products on a system.

You normally clean up fixes on your target systems after installing fixes when you have sent the fixes separately from installing them. It is not necessary when you send and install them in a single operation. If possible, you should avoid cleaning up fixes on your source system until the fixes have been installed permanently on the appropriate systems in your network. This is important because you will need the save file if the temporarily installed fix ever becomes damaged and you want to uninstall it.

This is important also because sending fixes requires the associated save file. If you remove a save file, and want to send it you need to reorder the fix to get the save file. The cover letters are important because they must be reviewed to ensure any special instructions - in addition to applying the fix, are performed in the correct sequence.

- Compare and update fixes based upon a model system. You can compare for missing and extra fixes. A missing fix is one that the model system has but another system does not. An extra fix is a fix the other system has, but the model system does not.

Based on the comparison results, you can send only or send and install the missing fixes on target systems you specify.
We show you a Compare and Update example, which shows some of the alternatives to automate sending and installing fixes on target systems. We use a system group (SGAS01_AS02all) of two systems and do the compare and update for two installed products - the Advanced Job Scheduler (5722JS1) and TCP/IP Connectivity Utilities (5722TC1).

In our example we had recently received and installed fixes for these two products. These products are installed on all the systems listed in our system group. We knew the 5722TC1 fixes were brand new, but no one was sure if we had earlier installed the fixes for 5722JS1 manually on each of the endpoint systems. In our example, we use system As01 as a model system based upon inventory collected from As01 and As02.

We show most, but not all of the windows in the sequence to compare fixes and then send missing fixes.

**Tips:**

1. You must study the cover letter before applying a fix to understand any special handling required. This is especially important when sending fixes to a target system and using a model system for the compare and update function. This way you can note any special instructions that require special handling on the model system. Then you need to plan how to handle those same special instructions on the target system when you use the compare and update function.

   The compare and update function enables you to send only or send and install the fixes identified as missing. The send and install option has additional options for installing immediately or at the next system restart.

2. If you have installed a group fix (PTF), the associated product fixes and their save files can be treated just as any other product and associated fixes. The cover letter identifies a data area and a value that indicates the group PTF has been installed on a system. Verify the system with the group PTF (and associated fixes) has the appropriate data area value and use that system as the model system.
In Figure 6-23 the upper window shows selecting the Compare and Update function for the system group SGAS01_AS02all (contains endpoint systems As01 and As02).

The lower window shows we have selected system As01 as our model system.
In the upper window of Figure 6-24 we show the list box with 5722js1 selected. We had already selected 5722tc1. In the lower window we show selecting to compare for both missing and extra (new for V5R1) fixes.

In the window at 1 in Figure 6-25 we show the summary window just before selecting Finish to begin the compare. Here you can see that we selected the two products and to compare results only (in a window not shown).

We selected Finish to begin the compare, with results shown in the window 2.
Figure 6-25  Fixes Inventory - Compare and Update example 3 of 4
In window 2 we show the compare results for system As02 — three fixes are missing compared to model system As01. No extra fixes were found.

We had previously read the cover letters for these fixes and learned that some of these fixes require some specific TCP servers to be restarted to be able to use the fixes after they have been installed. Based upon the cover letter instructions and your operating environment, there are some alternative fix installation steps to choose from that affect how we respond to the wizard parameter prompts once we begin the update process by selecting the toolbar Update button.

These alternatives include:

- **Just sending the fixes.** Then, based upon the target system’s operating environment, use either Operations Navigator interfaces or 5250 workstation interfaces to manually install the fixes and end and start the TCP servers in the appropriate order.

- **Just sending the fixes.** Then use Management Central package support to send a package containing a program with control language commands to, as the cover letters describe, end specific TCP/IP servers, apply the fix, and start the TCP servers.

  There are alternatives to sending and running the install fixes program including the use of Management Central Command and Package definitions. The intent of the program is to apply the fixes successfully without requiring a target system restart.

  See 6.10, “Management Central examples” on page 276 for examples of running a command and sending a package.

- **Send and install the fixes specifying to install the next time the system restarts.** We know in our operating environment these fixes are applied during restart of the system. During restart and after the fixes have been applied, the system starts TCP and then starts the TCP servers specified to start when TCP starts.

  This is the process we chose for the example in this book.

  See “Servers to Start window” on page 300 for more details on starting TCP/IP servers.

The dotted line to the window at 3 in Figure 6-25 indicates several window steps are not shown, where you can select to send only or send and install. In the example steps that follow we have chosen to send and install fixes the next time the system restarts.

A summary window in Figure 6-26 shows the install options we selected.

In this window we specify the system on which the corresponding fix save files to be sent reside. The corresponding save file is required to send a fix.

Figure 6-26 is the last in our example. The upper window 1 is again a summary of our update (send) request. Note we specified to Install fixes the next time the system is restarted.
In our example we selected Finish which immediately starts the sending of the selected fixes.

The window at 2 shows an example of several of our most recent “send fixes” tasks, including our just completed example.

Not shown in this example is Management Central Command Definition and Run command process to restart the target systems at a time when there are no active applications.

**Users and Groups Inventory**

From **Management Central -> Endpoint Systems -> system -> Users and Groups Inventory** (as shown in Figure 6-27) you can:

- Create a new user or group on the inventoried system, based upon an inventoried user.
- Edit a user profile (or group profile) for the collected system (updates the edited profile on that system).
- Delete a user or group profile on the inventoried system.
- Send any selected user profile (or group profile) to target systems.
- View the properties of the selected user profile or group profile.
As shown in the menu at 1 in Figure 6-28, you can perform the create, edit, and delete functions for users and groups on multiple systems “immediately” or as scheduled.

You can also scan for owned objects by the users on the systems in the system group for which you collected inventory.

The search (2) function for Users and Groups has additional search criteria than for the other inventories.

**Important:**

1. You can send a selected user or group profile to other systems as shown here in Figure 6-27. As online Help for the Send function states, the following “user profile information” is included when sending a user profile or group profile: user profiles, private authorities, and passwords (includes any LAN server password). Also, any system distribution directory information for that profile is also sent or updated on the target system.

2. When sending or editing (or deleting!) user profiles on target systems we recommend you not be signed on to the central system with one of those user profiles. If you are signed on as one of these profiles, you may or may not be completely successful with the task.
A more complete discussion of users and groups functions is included in *Managing OS/400 with Operations Navigator V5R1, Volume 2: Security*, SG24-6227.

**System Values**

From inventoried system values you can:

- Compare and optionally update values for multiple systems based upon a model system.
- Export inventoried system values for a system or systems in a system group.

Note: Without collecting inventory, under *My Connections -> system -> Configuration and Service -> system values* you can view and update system values on that system.

Figure 6-29 shows the compare portion of the compare and update function for system group of endpoint systems As01, AS05, As25B and A80.

![Figure 6-29 System Value inventory compare and update example](image-url)
There are many functions available using the Compare and Update System Values window shown in Figure 6-29. We discuss several of them in this topic, but we recommend using the online Help for complete coverage.

In this example we use system AS25B as the model system (shown at 1). Note the text “Model systems settings - 0 minutes old” under the model system. The Compare and Update System Values function always uses the latest content of the system values of the model system. To retrieve the content of these system values you must be signed on to the model system. If you are not currently signed on to that system, you are presented with a sign on window.

At 2 we have selected to show the Jobs category of system values which are displayed in the “Items to compare” area of this window. By selecting one of these values (maximum jobs allowed on the system in this example), the contents of that system value for each system in our system group are shown in the target system area of this window.

Note the “Target Systems - Last Collected” date just above the target systems. This tells us the last time the inventory for system values was collected. Although we included the model system in our inventoried system group, it is not required, since, as described above, the model system’s system values are retrieved real-time as part of the compare.

Under the Update column at 3 you can check which system values you want updated - based on the model system content for that system value.

You can remove a system from the list of target systems by selecting that system and clicking the “x box” icon shown at 4. A removed target system would not be updated later when you select OK or Schedule. In our example we would remove target system As25b since it is our model system.

You can add an endpoint system to the target system list by selecting the “system” icon shown at 5 and then selecting a system from the list of endpoint systems (not shown in this example). If you select to add another system and inventory has not already been collected onto the central system for that endpoint system, you get text in the target system area that states “value not collected”. This target system can be updated.

When you are satisfied you have checked all the system values you want updated and have listed all the target systems you want updated, click OK to immediately start the update task or click Schedule to run the update for a later time.

Inventory Search examples
We have grouped examples of the powerful inventory search functions into this topic. You can search hardware, software, fixes, users and groups inventory.

Inventory Search can be initiated from the general inventory menu shown at 6 in Figure 6-20 on page 224. The search applies to hardware, software, fixes, and users and groups categories as shown Figure 6-30 for system group AS80_AS25B.
Depending on the category, you have specific Basic search criteria you can search with.

You can use an asterisk (*) as a wild card to search for all items containing a specified string. We show an example of this in “Searching Users and Groups inventory” on page 239.

For Users and Groups you can combine Basic search criteria with Advanced search criteria. Use the online Help button or field ? help to determine the valid search values for each category. The following are selected examples.

**Searching Software inventory**
In this example we searched for the Performance Tools for iSeries, 5722PT1, product.
All options of 5722PT1 (as shown at 2) are installed on all systems in the system group - 5722PT1 has a base option, a Manager Feature option 1 (reporting and capacity planning functions), and an Agent Feature option 2 (no reporting functions).

In the window at 3 we have selected all 3 options and show the context menu which enables you to send and install the product on other systems, with the help of a wizard as shown in Figure 6-32.

You can also view the product Properties which includes information on the library installed in, primary language, and (new with V5R1) licensing information and statistics.

**Important:** You can view basic Properties information: *Under My Connections -> system -> Configuration and Service -> Software -> Installed products -> specific product.*

However, you cannot see licensing properties and you cannot Send and Install on another system.
In this example, we show some, but not all of the wizard windows you see when selecting to send and install an inventoried product.

The window at 1 is the first wizard window you see. The window at 2 shows an example of the optional command to run after installation on a remote system. The window at 3 shows we had earlier selected to send 5722PT1 to another system Newsys. You can also see a summary of the send options we had specified to verify this is what you want to do.

You can go back, cancel, send and install “now” (Finish button) or schedule for a later time (Schedule button).

Note, though not shown in this example, you would typically send and install a product that is found on one of the systems you inventoried but missing on one of the other inventoried systems. But this is not a requirement.
**Searching Users and Groups inventory**

Searching inventoried users and groups information is new for V5R1 and provides powerful capabilities for not only viewing the user and group profile names on all managed systems but also tracking their activity based upon various user profile "capabilities", such as privilege class (OS/400 command interface User class parameter) and system privileges (OS/400 command interface special authority parameter).

In the Figure 6-33 example, we search for all user profiles starting with the prefix AS03 (wild card) and the Advanced search criteria of users signed on after February 10, 2002, and who have the privilege class of Security Officer.

In windows 1 through 3 we specified the Users and Group advanced search criteria, by selecting “Previous sign-on date” and “Privilege class” of Security officer.

In the window at 4 you see the users that satisfied the search criteria. The context menu for a selected user shows all the user profile-based actions you can do for each user on each of the inventoried systems!
6.7 Monitors

Monitors allow you to introduce a high degree of automation into your operation. You may centrally monitor selected endpoint systems and system groups, receiving notification when monitored events occur on those systems which meet your pre-defined threshold limits. You must have installed the Monitors component to have these functions available on your PC workstations. The supported monitors are:
Starting with V5R1 you can monitor any message queue on the system for any of a set of IBM-supplied messages, other OS/400 messages or application-issued messages. You can merely record the occurrence of a message in a message monitor event log or define an automatic message response or run a command based upon a message or a message queue threshold value. Certain monitor attributes have a threshold trigger and reset capability. A message monitor has an event log for recording triggers and reset occurrences.

Message monitors are discussed in 6.7.1, “Message monitors” on page 242.

Starting with V5R1 you can monitor specific jobs, job types, and jobs running within a subsystem. You can also monitor a group of jobs under a “server” type categorization (described later in this topic). You can merely record the occurrence of a job monitor event in a job monitor event log or define an automated OS/400 command to be run, based upon a job performance metric threshold trigger, threshold reset, job status change, or job log messages. A job monitor has an event log for recording triggers and reset occurrences.

Job monitors are discussed in 6.7.2, “Job monitors” on page 249.

System monitors enable you to monitor performance metrics on each of your endpoint systems using real time graphing. You may define threshold triggers and resets that cause colors to change in the displayed line graphs or run a command to take some automated action. You can record the threshold trigger and reset events in a system monitor event log. Graph History (new in V5R1) may also be displayed allowing you to contrast performance metric values over days, weeks and months.

System monitors are discussed in 6.7.4, “System monitors” on page 254.

As described in 6.1, “Management Central overview” on page 183, these monitors are for the Connect for iSeries product transaction processing. These monitors are not covered in this redbook.

Each monitor has its unique “trigger” and “reset” conditions. All monitors support a manual reset action that can occur when a reset is selected from a menu. For example, you can use menu bar File -> Reset Triggers or the detail display of a specific monitor by right-clicking a system name that is being monitored.

Certain metrics also support an automatic reset condition that supports an automatic reset action. For example, a Job monitor using a job CPU utilization metric or a System monitor using the system-wide CPU utilization metric supports can have a trigger at 70% CPU utilization and a reset at less than 10 CPU utilization. Either or both the trigger and the reset condition can be specified to automatically run an OS/400 command.

All monitors can be started from a workstation. The user of that workstation can end his Operations Navigator session or also power off the workstation and the monitor will continue to be active.

All active monitors with the appropriate sharing option specified can be used by the Management Central - Pervasive java servlet-based tool available for use by remote browsers or hand-held Personal Digital Assistant (PDA) devices. For more information refer to http://www.ibm.com/servers/eserver/iseries/sftsol/pervasive.htm
6.7.1 Message monitors

A message monitor is intended for tracking the occurrence of important messages or taking an automated action, based upon that message. Automated actions could include:

- Sending an automated response to the message
- Automatically deleting the message
Running a command that starts another job, based upon the message content

Running a command that takes some management action on the job issuing the message. For example, you could specify to run a command that would delete objects that you know are no longer needed from the disk pool. The command could be a Call Program to a program that runs the system commands Retrieve Disk Information (RTVDSKINF), followed by Print Disk Information (PRTDSKINF) and send a message to a system administrator to review the printed report to determine an action to be taken.

Calling an application, such as a paging application, that “pages” the appropriate support personnel to take some action based

You can define a message monitor to monitor any combination of specific message IDs, message types, or message severities. In a list box, IBM provides a pre-defined set of message descriptions that you can select from. This results in an actual message ID being monitored. One example of these IBM-supplied message descriptions is “auxiliary storage threshold reached” (message ID CPI0953).

You can specify any message queue on the system, including the system operator message queue to be monitored.

The message monitor event log remains available across multiple stop and start time periods for your historical review of trigger and reset occurrences. You should periodically remove entries no longer needed.

Operations Navigator automatically creates a sample Message monitor on your workstation, called Sample DASD Message. You can use it as an aid in defining your own message monitor.

**Important:** A Message monitor is one of the ways OS/400 provides for automating message handling. It has the added advantage over other ways to automate message handling by being able to be defined and managed on multiple systems from a central system.

Other ways to automate message handling include:

- Many OS/400 messages have a default reply that can be automatically taken if the message queue they are sent to is set to “default mode” through the OS/400 command Change Message Queue (CHGMSGQ).

- OS/400 has a System Reply List where a default response can be specified based upon the Add Reply List Entry (ADDRPYLE) command message ID, compare value, and message reply parameter values.

Our suggestion is to become familiar with all capabilities and choose the ones that work best for you.

The quickest way to find out about the System Reply List support is to use the search word ADDRPYLE with iSeries Information Center. The Web address is:

http://www.ibm.com/eserver/iseries/infocenter

**Creating a new message monitor**

There are three ways of creating a message monitor:

- Expand **Basic Operations -> Messages**. Select **Explore/Open**, right-click a message, and select **Monitor**.
Expand **Management Central -> Monitors**. Right-click **Message**, and then select **New Monitor**.

Expand **Management Central -> Monitors -> Message**. Select **Open**, right-click a message monitor and select **New Based On** from the context menu (which can save steps in defining a similar monitor from the beginning).

In the following example, we use **Management Central -> Monitors -> Message**, and then select **New Monitor**.

In Figure 6-34 we show the new monitor General and Messages parameter windows. In window 1 we assign a meaningful name and description to the monitor.

![Figure 6-34](image)

The Messages window has several message monitoring parameters to help tailor the message monitor to your needs. Note that two message sets can be defined for each monitor, enabling several monitoring capabilities with a single Message monitor.
At 2 we define a user application message queue. For that queue, we specify one message set to monitor all messages of all types that appear on this queue (3). At 2 we have selected that once 3 messages matching this set of message criteria have arrived on the message queue, a trigger occurs that runs the CALL program command. Note, the message count corresponds to the number of such messages occurring on the queue since the last start of the message monitor or the last trigger reset. The Collection Interval time period specifies how often the system checks the message queue for new messages.

In our example we call a program that displays a library that we know has been created by the application sending messages to our monitored message queue.

Looking closely at the command you see an &FRMJOBNAME variable. This is one of the message monitor variables available that can be passed to your command. See Table 6-3 for a complete list of Message monitor variables. To see this list online and get additional details, use the (?) field level help for the “OS/400 trigger command” and “OS/400 reset command” Prompts.

**Note:** If a new monitor is started via an existing message (as from Basic Operations -> Messages) then message information has been automatically inserted into the selected message ID window, but can be removed or added to if required.

Note also, that since System and Job monitors are discussed more fully in Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565, their monitor variables are not discussed in detail in this redbook.

<table>
<thead>
<tr>
<th>Replacement variable</th>
<th>Data substituted</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATE</td>
<td>Date message event occurred as MMDDYYYY</td>
</tr>
<tr>
<td>&amp;ENDPOINT</td>
<td>Endpoint system incurring the message event</td>
</tr>
<tr>
<td>&amp;EVENTYPE</td>
<td>Event type</td>
</tr>
<tr>
<td>&amp;FROMJOBNAME</td>
<td>From job's name</td>
</tr>
<tr>
<td>&amp;FROMJOBNUMBER</td>
<td>From job's Number</td>
</tr>
<tr>
<td>&amp;FROMJOBUSER</td>
<td>From job's user name</td>
</tr>
<tr>
<td>&amp;INTVL</td>
<td>Collection interval in seconds</td>
</tr>
<tr>
<td>&amp;MON</td>
<td>Message monitor name</td>
</tr>
<tr>
<td>&amp;MSGCOUNT</td>
<td>Message count</td>
</tr>
<tr>
<td>&amp;MSGID</td>
<td>Message ID</td>
</tr>
<tr>
<td>&amp;MSGKEY</td>
<td>Message key</td>
</tr>
<tr>
<td>&amp;MSGSEV</td>
<td>Message severity</td>
</tr>
<tr>
<td>&amp;MSGTYPE</td>
<td>Message type</td>
</tr>
<tr>
<td>&amp;OWNER</td>
<td>User profile of the monitor owner</td>
</tr>
<tr>
<td>&amp;THRESHOLD</td>
<td>Threshold number</td>
</tr>
<tr>
<td>&amp;TIME</td>
<td>Time as HHMMSS</td>
</tr>
</tbody>
</table>
In Figure 6-35 we show two more of the new definition windows.

In the Actions window you see the many “actions to be taken” options you select. Some items are pre-checked for you. We have checked to log events and to automatically open the event log window when a trigger occurs, if the window is not currently being displayed.

Note that you can specify different times of day to apply the thresholds and actions.
We do not show the Sharing window options but we selected Controlled as described in “Task Sharing (and object sharing)” on page 199. (Monitor sharing is similar to, but specified differently than, task sharing.

**Using a message monitor example**

In our example we defined the message monitor and then at a later time manually started it when we wanted it to be active. From the context menu at [1] we open the monitor to see its current activity details.

From that detail monitor you can do several functions from the tool bar, including stopping/starting the monitor from the tool bar, viewing the event log, viewing (and changing real-time) the monitor’s properties.

In the window at [2] you see a log of each occurrence of a message on our monitored message queue that matches the message criteria set for both message sets in the message monitor definition. Valid messages are messages occurring since the most recent start of the monitor or since the last reset. You can also identify the message that triggered our action (Call a program) In this window we selected to show the Event Log from the tool bar as shown by the arrow between windows [2] and [3].

We selected one of the triggers that brings up the Message Event Properties window. In the window at [4] we show the Trigger properties - which happens to show actual message monitor parameter value passed to our program!
Figure 6-36  Active message monitor example
6.7.2 Job monitors

A Job monitor can be used to:

- Identify increases in hardware resource utilization or I/O activity beyond your expectation for a job that may require further investigation.
- Take normal application automated action when some monitored condition occurs, such as when a job completes or starts to use a lower amount of CPU utilization. For example, start a dependent application when a preceding job completes.

You can monitor for job log messages, or job status (for example, running, held while running, end of job, completed - printer output available, and more), and, optionally, take an automated action, such running a command that starts a related job when the monitored job “ends”. Additionally you can monitor some job performance metrics, such job CPU utilization or batch logical database I/O counts.

You can define a monitor for one or more jobs based on job selection criteria that can include job name, job user, subsystem, and job type (batch, interactive, and so forth). You can also define a job monitor to monitor for IBM-defined “server types” (without needing to understand the specific job names or subsystem they run in. You can also monitor your own server type, See “Server Jobs folder” on page 155 for more information on Server jobs.

The term metric is applied to the items that can be monitored for a job.

Criteria for metric thresholds can be specified, that, when triggered cause an event to be logged and an indicator to appear on the job monitor’s open window. You can run an OS/400 command when a threshold is triggered or reset.

A job monitor event log remains available across multiple stop and start time periods for your historical review of trigger and reset occurrences. If the event entry is for a job currently running you can “drill down”, select the job, and take some actions on the active job, such as holding it.

You should periodically remove entries no longer needed.

A Job monitor event log can be saved and viewed to take job actions from (for example, end the job or respond to a message), as well as provide you with historical information.

6.7.3 Creating a new job monitor

You can define a new job monitor in one of the following methods:

- Select Basic Operations -> Jobs. Select Explore/Open. Right-click a job and select Monitor from the context menu.
- Select Management Central -> Monitors -> Jobs. Select Explore/Open. Right-click a job monitor and select New Based On from the context menu (which can save steps in defining a similar monitor from the beginning).
- Expand Work Management. Select Explore/Open the appropriate job grouping (Active Jobs, Server Jobs, Job Queues, or Subsystems) to view a list of jobs in the right pane. Right-click on a job and select Monitor from the context menu.

In the following example, we used Management Central -> Monitors -> Jobs, and then selected New Monitor from the context menu.
Figure 6-37 shows the General definition window.

![New Monitor Definition Window]

Figure 6-37  New Monitor definition example: monitor all jobs in subsystem CHAINBCH

We entered a monitor name and description. At 1 you see you can monitor jobs based on name, user (profile), subsystem in which they run and job type.

You can specify generic (wild card) values for subsystem name, job name (for example JOBAS*), and user profile (for example AS03*).

You can also specify jobs to monitor according to a Servers to monitor category (the tab at 2 in Figure 6-37).

In this example we are monitoring all the jobs running in started subsystem CHAINBCH. At the end of this Job monitors topic we show an example window of the list of "server job types" you could select from.

Figure 6-38 shows an example of the Metrics page for a New Monitor.
In this example we selected two metrics to monitor for each job in subsystem CHAINBCH. We have then clicked the CPU Percent Utilization metric in the Metrics to monitor area in the window and, for that metric, specified a CPU utilization percent value as both a trigger and a reset condition at 1.

At 2 we specified that a job must average at least 33% CPU utilization over 1 (Duration) interval. The Collection Interval window (not shown, we specified an interval of 15 minutes. This means that for a trigger or reset to occur, a job must average more than 33% CPU utilization over 15 minute time period. The reset duration works in a similar fashion. Durations specifying more than one interval means consecutive intervals.

At 3 we have specified the OS/400 Hold Job command (for the job that triggers this threshold) and the OS/400 Release Job command when the reset condition occurs. Note the Job monitor parameters we used to hold and release the “offending job”. We used the (?) field level help to identify the monitor’s parameters we wanted to use.

Though not shown in this example we have the performed the following for this monitor.

- Started the monitor
- Specified a system group with two endpoint systems to run the monitor on
- Specified Actions that included logging events and opening the Event Log when a new entry is logged.
- Specified the sharing option as Controlled. The owner and other users can start, stop, and view the monitor. Only the owner can change the monitor properties.
After the monitor was running we selected to view the monitor’s Properties and changed its Collection Interval value to 5 minutes.

There are several Job monitor metrics that can be selected, depending on what you plan on doing with the monitor. We list them in this topic to save you the time finding them in Information Center:

- **Job Count**: Monitor for a specific number of active jobs matching the job selection criteria specified under the General tab for the set of jobs being monitored.
- **Job Status**: Monitor for jobs in any selected status, such as Completed, Disconnected, Ending, Held while running, or Initial thread held. For Job Status we recommend not monitoring more than 40 jobs at a time.
- **Job Log Message**: Monitor for messages based on any combination of Message ID, Type, and Minimum severity within job logs of the jobs being monitored. For Job Log Message we recommend not monitoring more than 40 jobs at a time.
- **Job numeric values** (applies individually to each job) and **Summary numeric values** (applies in total to all jobs being monitored). These values apply to each job that matches the selection criteria specified on the monitor’s General tab page. Using Summary numeric values as an example, if 3 jobs match the selection criteria then the total CPU utilization of all 3 jobs much average the specified trigger value.
  - **CPU utilization**: The percentage of available processing unit time used by each job that is being monitored on this system.
  - **Logical I/O rate**: The number of logical I/O actions, per second, by each job that is being monitored on this system.
  - **Disk I/O rate**: The average number of I/O operations, per second, performed by each job that is being monitored on this system. The value in this column is the sum of the asynchronous and synchronous disk I/O operations.
  - **Communications I/O rate**: The number of communications I/O (read and write) actions, per second, by each job that is being monitored on this system.
  - **Transaction rate**: The number of transactions per second by each job that is being monitored on this system. This is meaningful only for 5250 workstation jobs.
  - **Transaction time**: The total transaction time for each job that is being monitored on this system. This is meaningful only for 5250 workstation jobs.
  - **Thread count**: The number of active threads in each job that is being monitored on this system.
  - **Page fault rate**: The average number of times, per second, that an active program in each job that is being monitored on this system refers to an address that is not in main storage.

**Using a job monitor example**

In our example we defined the job monitor. We then manually started it when we wanted it to be active. In this example we assume you are familiar with ways to start, end, and view the high level monitor status. If needed, refer to “Using a message monitor example” on page 247.

In Figure 6-39 we show the event log after 2 triggers and 1 resets have occurred in window 1.
In the window at 2 you see each endpoint system and its current status. For the selected system you see the context menu actions.

By selecting system As80 at 2, we see the active jobs being monitored for that system (remember we specified the subsystem name itself. For job As80job01(at 3) you see the context menus actions available to you for that job.

See 5.2.1, “Active Jobs: job management” on page 145 for more details on these menu actions.

Note, the Hold/Release job commands we used in our example guarantee the cycling of trigger followed by reset until the monitor is stopped or all subsystem jobs are ended.

**Servers to monitor example**

As mentioned at the start of 6.7.3, “Creating a new job monitor” on page 249 you can select in the New job monitor General window the tab - Servers to Monitor.

This topic provides a short example of how to use the capability.

When you select Servers to monitor you get the window shown in Figure 6-40.
You can specify the server names from the list of Available servers. This means all jobs performing that server’s functions will be monitored. Other job monitor definitions and capabilities are the same as for “specific jobs” to be monitored.

You can also specify that your application jobs be treated as a “server.” To activate this, select the Add custom server button and follow the instructions. To create a custom server, use the Change Job (QWTCHGJB) API.

Attention to reader: Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565, contains additional examples of Job monitors.

6.7.4 System monitors

A system monitor is intended for you to:

- Identify up to the minute significant increases or decreases in hardware resource utilization or I/O activity that may require further investigation or indicate some action should be taken.
- Take some automated action based upon a selected “system-wide performance metric” threshold being triggered or reset.

You can define a monitor to graphically show the utilization of one or more hardware resources or the count of I/O activity over a defined time interval.
Criteria for metric thresholds can be specified that, when triggered, cause a graph line to appear “highlighted” to indicate the threshold change and optionally run a command. While viewing the real-time graph data most metrics support identifying the “top 20 items” with highest utilization of that metric. For many metrics this means the top 20 jobs consuming a resource. For disk arms utilization, this means the top 20 disk arms with the highest utilization (“percent busy”).

The system monitor event log remains available across multiple stop and start time periods for your historical review of trigger and reset occurrences. You should periodically remove entries no longer needed.

New for V5R1, you can hold, release, delete (end), and see job details similar to the Display Job (DSPJOB) OS/400 command and also through the Operations Navigator Work Management component.

**Starting with V5R1**, new Graph History can graphically display historical values for specific performance metrics monitored by a System monitor (and Collection Services).

**Starting with V5R1**, a system monitor uses Collection Services. Starting a system monitor when Collection Services is not active will automatically start Collection Services. If Collection Services is already active a system monitor accesses the Collection Services performance data already being collected. You can have more than one system monitor active at the same time. They are all using Collections Services.

Metrics that can be monitored include average system CPU utilization, average interactive feature utilization, interactive transaction rate, disk hardware “busy” utilization, LAN line utilization, batch database logical I/O counts, and more.

As with job or message monitors, you can start a system monitor, and then turn to other tasks on your server, in Operations Navigator, or on your PC. In fact, you could even turn your PC off! Management Central will continue to monitor and perform any threshold commands or actions you specified. Your monitor will run until you decide to stop it.

A System monitor is typically displayed real-time in a graphical display window, but this is not required.

System monitor support has been available since V4R3 under Management Central. New metrics to be monitored became available with V4R5. Prior to V5R1, these were known simply as “monitors” but are called System Monitors **starting with V5R1** to distinguish their functions from the Message and Job monitor functions.

A sample System monitor is provided by Operations Navigator on your workstation with V5R1, Sample CPU Monitor. It is provided to assist you in getting started with system monitoring.

**Attention**: This chapter overviews the capabilities under system-wide performance metric monitoring. It does not go into details of how to use one of these monitors in an actual performance management implementation. Complete performance management is beyond the intent of these Operations Navigator redbooks. Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565, when available will contain additional System monitor (as well as Collection Services) details.

The following system wide performance metrics can be specified for a single monitor. Multiple metrics can be assigned to a single System monitor.
The following is taken from the online (?) field level help text for the “Available Metrics” lustiest shown in Figure 6-42 on page 259. We include it here so you do not have to actually define a monitor to consider the metrics you may want to monitor.

- **CPU Utilization (Average):** This includes the cumulative percent of CPU utilization for all jobs, threads of a job, and Licensed Internal Code tasks. Second level information shows any jobs or tasks having the highest CPU utilization.

- **CPU Utilization (Interactive Jobs):** This includes the cumulative percent of CPU utilization for all jobs started from a 5250 workstation (twinax attached, remote and LAN line SNA (including SNA display station pass-through) attached, all Telnet sessions (LAN, IBM PCOMM, Client Access PC5250) and other SNA or Telnet emulators. Second level information shows the 5250 jobs having the highest CPU utilization.

- **CPU Utilization (Interactive Feature):** This measures the cumulative percent of the “Interactive Feature” performance rating on all AS/400 and iSeries server models consumed by the same jobs included under the CPU Utilization (Interactive jobs) metric. The value range should be approximately equal to or less than 70 percent to ensure good interactive (5250 jobs) performance. Second level information shows the jobs having the highest interactive feature utilization.

  This information can be used to help determine if you need a more powerful Interactive Feature.

- **CPU Utilization (Database Capability):** This includes the cumulative percent of CPU utilization consumed for OS/400 database functions (File I/O, SQL, and general query functions) by all jobs running on the system. Value range should be approximately equal to or less than CPU Utilization (Average). Second level information shows the jobs having the highest Database function CPU utilization.

- **CPU Utilization (Secondary Workloads):** Through V5R1 this is valid only on a Dedicated Server for Domino model. This includes the cumulative percent of CPU utilization for all jobs not considered doing Domino or “complementary to Domino work”. Starting with V5R1 September 28, 2001, microcode level “complimentary to Domino work” includes WebSphere Java and general Java servlets running as Domino applications.

- **CPU Utilization Basic (Average):** This includes the same work as CPU Utilization (Average), but does not include active job details.

- **Interactive Response Time (Average):** This includes the average response time for interactive (5250) jobs on the system. Second level information shows the jobs having the highest average response time.

- **Interactive Response Time (Maximum):** This includes the highest response time for interactive (5250) jobs on the system while the monitor is active. Second level information shows the jobs having the highest response time.

- **Transaction Rate (Average):** This includes the average number of transactions per second completed by all jobs active on the system. Second level information shows the jobs having the highest rate.

- **Transaction Rate (Interactive):** This includes the average number of transactions per second completed by 5250 jobs active on the system. Second level information shows the jobs having the highest rate.

- **Batch Logical Database I/O:** The average number of logical database input/output (I/O) operations currently performed by all non-5250 (“batch”) jobs on the system. Second level information shows the jobs performing the highest I/Os.

- **Disk Arm Utilization (Average):** The average percentage of disk arm “busy” doing I/O operations for all disks on the system. Second level information shows information for each disk arm.
- **Disk Arm Utilization (Maximum):** The maximum percentage of disk arm “busy” doing I/O operations for all disks on the system. Second level information shows information for each disk arm.

- **Disk Storage (Average):** The average percentage of disk arm storage that is full on your system during the time you collect the data. Second level information shows information for each disk arm.

- **Disk Storage (Maximum):** The highest percentage of disk arm storage that is full on your system during the time you collect the data. Second level information shows information for each disk arm.

- **Disk IOP Utilization (Average):** The average percent busy the disk input/output processors (IOPs) are on your system during the time you collect the data. Second level information shows information for each IOP.

- **Disk IOP Utilization (Maximum):** The maximum percent busy the disk input/output processors (IOPs) are on your system during the time you collect the data. Second level information shows information for each IOP.

- **Communication IOP Utilization (Average):** The average percent busy the communication (LAN, WAN, ...) communication input/output processors (IOPs) are on your system during the time you collect the data. Second level information shows information for each IOP.

- **Communication IOP Utilization (Maximum):** The maximum percent busy the communication (LAN, WAN, ...) input/output processors (IOPs) are on your system during the time you collect the data. Second level information shows information for each IOP.

- **Machine Pool Faults (Average):** The average number of faults per second occurring in the machine pool of the system during the time you collect the data. Only Licensed Internal Code runs in the Machine pool.

- **User Pool Faults (Average):** The average number of faults per second occurring in all of the user pools on the system during the time you collect the data. Second level information shows information for each pool.

- **User Pool Faults (Maximum):** The maximum number of faults per second occurring in all of the user pools on the system during the time you collect the data. Second level information shows information for each pool.

- **Communication Line Utilization (Average):** The average percentage of line utilization for all non-LAN lines active during the time you collect the data. Line utilization is an approximation of the actual amount of data transmitted compared to the theoretical maximum line speed configured on the line description object. Second level information shows information for each non-LAN line. A non-LAN line is one supporting binary synchronous, asynchronous, IDLC, X.25, LAPD, or SDLC protocols.

- **Communication Line Utilization (Maximum):** The maximum percentage of line utilization for all non-LAN lines active during the time you collect the data. Second level information shows information for each non-LAN line.

- **LAN Utilization (Average):** The average percentage of line utilization for all LAN (token ring and Ethernet) lines active during the time you collect the data. Line utilization is an approximation of the actual amount of data transmitted compared to the theoretical maximum line speed configured on the line description object. Second level information shows information for each LAN line.

- **LAN Utilization (Maximum):** The maximum percentage of line utilization for all LAN lines active during the time you collect the data. Second level information shows information for each LAN line.

Note that these metrics are also collected by Collection Services.
6.7.5 Creating a new system monitor

You can define a new job monitor in one of the following methods:

- Expand Management Central -> select Monitors -> right-click System, and then select New Monitor from the context menu.
- Right-click a system under My Connections. Select Monitors from the context menu and select System.
- Expand Endpoint Systems under Management Central. Select a system, select Monitors from the context menu, and select System.
- Expand System Groups under Management Central. Select a system group, select Monitors from the context menu, and select System.

Each of these methods activates the New Monitor window shown in Figure 6-41. In our example we used Management Central. Select Monitors. Right-click System, and then select New Monitor from the context menu.

![New Monitor window](image)

We entered a monitor name and description.

Note the absence of a Sharing tab that is supported for Message and Job monitors. System Monitors can be viewed and managed only by the creator of the System monitor. Since all system monitors use the same Collection Services implementation, several system monitors can be active at the same time with only one set of data being collected.

The Metrics window parameters are similar to the Job monitor Metrics tab window, containing metrics to be selected and input areas to define trigger and reset thresholds.

However, there are more performance metrics in a System monitor rand you are monitoring system-wide, not subsetting by specific job name, job type, job user name, subsystem name, and so forth.

You can set up to two thresholds for each metric that the System monitor is collecting. Thresholds are triggered and reset based on the value at the time the metric collection is made. Specifying a higher number of collection intervals for duration helps to avoid unnecessary threshold activity due to frequent spiking of values.

In our example we select two metrics for the same monitor - CPU Utilization (Average), for all jobs active on the system and Batch Logical Database I/O for all non-5250 jobs active on the system. You can use the (?) field level help for the Available Metrics “ to get an explanation for each metric.
In our example in Figure 6-42, we show at window 1 the General set of parameters for the CPU utilization metric.

In the window 2, we set the Threshold1 parameter values for a trigger at 70% CPU utilization over 1 time interval and to send a message to a user-defined message queue (not shown in the Send Message command input area at B) when the threshold is triggered. We also have already specified a threshold reset at 20% CPU utilization.
The Duration value of 1 means 1 times the value shown at \( A \) in window \( A \) or one minute. We use this small period of time to capture graphs for this redbook. In a real environment you would probably specify a longer time period to determine threshold trigger or reset conditions.

As discussed under Job monitors a reset condition is optional and can be specified only after a threshold trigger condition has been specified.

70% CPU utilization is a good starting point for monitoring overall CPU utilization, but your environment should determine the value used here. For example your network is almost all interactive (5250 jobs) work then 70% to 80% is a good values to select, dependent on the number of full processors you have on your system or logical partition. as the number of full processors increases above 4 the threshold value can be 80% or higher and you can still have good 5250 workstation performance.

If your environment has a lot of non-interactive work - primarily background “batch” or long running high CPU “transactions”, then 90% utilization may work fine for you.

You need to experiment with your environment to set appropriate values that you think are “abnormally high”. Remember not all system monitor metrics need to be used to track possible problems. You can use a Reset value to normally call a job that requires significant CPU processor capacity.

In Figure 6-43, we have already added the Batch Logical Database I/O metric to the monitor, so both the logical I/O and CPU average metrics appear in the Metrics to monitor list box.

![System monitor metrics tab example - batch logical I/O and average CPU utilization](image)

Before specifying General tab or Threshold tab information, ensure you have selected the appropriate metric within the Metrics to monitor list box.
In Figure 6-43, we do not show the corresponding “General” settings for Batch Logical I/Os, but values used were 1 minute for Collection interval and 5000 for Maximum graphing level. You can update the maximum graphing value because if you set it too low, especially for logical I/Os you will not see any line graph within your window.

Maximum graphing value of up to 1 million (1000000) I/Os per second is supported. Note, the default is 50, which is typically too low.

Figure 6-44 shows both the Actions window and the Systems and Groups window for our System monitor definition.

![Figure 6-44 Creating a system monitor - actions and systems and groups](image)

With the Actions window you specify event logging and monitoring options.

Use the Systems and Groups wind to view, select or change the endpoint systems and system groups you want the System monitor to run on.
When you start the monitor the default system(s) to start on will be those specified here. If the activity has already been started, changes made on this page will be effective when you click OK. The activity will be stopped on endpoint systems that are no longer in the list. The activity will be started on systems that you added to the list. The activity will be restarted on any systems where it failed to start on the previous attempt.

Each time the monitor is started you can change the systems you want to run on or simply accept the ones already specified. Click OK when done selecting the systems. In the example shown in Figure 6-45, we selected system As80, which is listed under Endpoint systems and have not yet clicked the Add button.

In contrast to the Job monitor support there are no day of the week and time of day selection options on when to apply the thresholds or actions. The default here is the Actions always apply.

**Using a system monitor example**

As with the other monitors after your system monitor has been defined, it appears in Management Central under its specific System monitor type. As shown in the background window in the top of Figure 6-45, right-click on the named monitor and select Start (1) from the context menu. (Note the Event Log and Graph History actions.)

You may also start the monitor from a window displaying the monitor and clicking the green Start icon at 2 in the lower window of Figure 6-45.

To get the lower window selected Open from the context menu shown at 3.
Figure 6-45 Starting a system monitor

Figure 6-45 is used to describe the general capabilities while displaying the monitor. In the following pages we show an example of the active CPU and Logical I/O System monitor.

At 4 you see the trigger and reset values as indicated in upper and lower ends of the vertical red bars. With your mouse you can select either end of the vertical bar to “instantly” change your threshold trigger and reset threshold values.

After a metric has been above the threshold trigger value for its specified duration for a system, its system uniquely colored line becomes solid red for all points until the metric value reaches a threshold reset value. If reset occurs the system unique color returns to the line in the graph.

The metric title bar shown at 5 alternates between grey, dark blue, and red. The red color is coordinated with and changes with a threshold trigger and reset event. By left clicking the metric bar you make that metric the “active metric” on the screen for displaying second level information (if supported by that metric) in the right pane at 8. The “active metric” title bar becomes dark blue unless it is has a threshold triggered in which case the title bar is red.
You can change the default line type (solid, broken, and so forth) and color for each system by selecting menu bar Options -> User preferences from the menu bar shown at A.

At 6 in Figure 6-45, you can use the “pull up” triangle symbol to list the systems being monitored and display the monitor status for that system. As01 and As80 are both stopped in this example. If you attempt to monitor a metric on a system or release that does not support that metric, you would see “not supported” text in this area. One example would be the CPU Utilization (Interactive Feature) metric on an older 5xx or 6xx system.

At 7, you see the magnifying glass icons for zooming in and out on areas of the metric graph lines being displayed while the monitor is active.

The upper window within the right pane (8) is used to display any second level detail information for a metric. The lower window within the right pane (9) is used to display any third level detail from second level information.

For example, for either CPU Utilization (Average) or Batch Logical database I/O the second level information shows the top 20 jobs (and any licensed internal code tasks) consuming CPU or doing batch database logical I/O. You can click on one of these jobs and the third level information for the job appears in the lower window within the right pane.

If you have more metric information than can be displayed horizontally within a pane within the window, you can use the scroll right or left bar as shown at B. If there is more metric information than can be displayed vertically within a pane within the window, you can use the scroll up or down bar as shown at C.

We start the monitor and wait a few seconds to see status information indicating the monitor successfully started on each system and a colored graph line for each metric for each system to appear.

When the monitor has just been started it may take 60 seconds before the first graph point (grey square) appears.

If you have defined a threshold and an Action to automatically display the monitor window you may wait for the window to appear when a threshold is triggered or manually view the monitor window. Thus topic describes viewing the monitor by manually invoking the window display.

Figure 6-46 shows an active monitor.
Figure 6-46  Active system monitor - CPU utilization (average)

The icon to the left of the monitor name pointed to by 1 is green when no threshold had been triggered and becomes yellow when at least one metric threshold has been triggered. When the background window (A) was copied, the batch logical database I/O was the only metric threshold triggered. Its metric title bar was red.

System As01 is represented by the light grey (green color) line and system As80 is represented by the bold (violet color) line.

The foreground window (B) shows lots of information. First, notice the system-wide count of database I/Os per second fluctuates repeatedly every 2 minutes and is frequently above the threshold trigger value as shown at 2 for system As01, while system As80 is doing almost no database I/O, as indicated by 3. The line for As01 is bright red.

In this example (Figure 6-46), we selected the graph point at the time stamp 11:26 to show the second level information for the CPU utilization (average) metric job information at 4 in the right pane.
Note that total CPU utilization was averaging approximately 26 percent and a single 5250 workstation job was consuming almost all of that utilization, as shown at 5. Unless this is a very special job, a 5250 job taking 20 percent of available CPU utilization should be examined for possible performance improvements.

We left clicked on telnet job Qpadev0003 to get the job details partially shown in the lower pane area at 6. For a selected job, the colored bar turns black.

In Figure 6-47, we have selected the database I/Os per second metric to show some additional possibilities when using the System monitor capabilities.

![Figure 6-47  Active system monitor - batch logical database I/Os per second](image)

We clicked the Batch Logical Database I/Os metric title bar to make it the active monitor being displayed. Since the threshold trigger had occurred and no reset condition had occurred, the title bar and the line graph remained red.

Note the following:

- The time line (11:32 - 11:36) is not the same time line shown for CPU utilization (11:25 - 11:30). It is your responsibility to be aware of the time line period being shown.

- The I/Os per second show a high degree of fluctuation for system As01 while the CPU utilization for system As01 remained consistent as shown at 1 and 2. It is worth investigating the reason for high I/O activity on system As01 in contrast to investigating high CPU utilization for interactive work on system As80.

- We displayed the second level (highest I/Os per second jobs and tasks) at 11:36 for system As01.
We right-clicked the Ca01job01 at 11:40 to get the context menu and actions list shown at ④, that includes showing job details (Show Properties) and the new for V5R1 Jobs actions, including job printed output, job log, holding and later releasing the job, replying to any job message, deleting (ending) the job or starting a Job monitor for the job.

**Viewing a system monitor event log**

Like the job and message monitors, a system monitor records events in an event log. The Event Log can be automatically displayed when a threshold is triggered if that was specified in the Actions tab when creating the monitor or changing the monitor properties. You can also explicitly display the event log in several ways.

We show two ways to manually display the event log. You can either use the menu bar File pull-down actions list or while displaying a monitor, select Event Log icon (a check mark within a yellow box (log list), as shown at ③ in Figure 6-48.

![Figure 6-48  System monitor - opening the Event Log](image)

A sample System monitor event log is shown in Figure 6-49. The background window includes trigger and reset events. The foreground window shows the Trigger tab properties for the highlighted trigger event shown in the foreground window after we right-clicked and selected Properties.
Similar to Job monitor event log, there are three possible icons for each event:

- Red circle with white X character: This indicates the event was triggered and there was no command to be run specified for the threshold.
- Yellow circle with red X character: This indicates the event was triggered and an associated command was run per the monitor definition.
- White circle with black check character: This indicates the monitor threshold was reset.

As seen in this example the event log continues to contain entries for the same monitor, even over multiple monitor start and stop sequences. You can delete entries by selecting them and either deleting them in a context menu or use the Delete icon in the tool bar.

Note the Trigger tab properties shown include the actual metric value that triggered the event (at 70 percent busy).

Attention to reader: Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565, n contains additional examples of System monitors.

6.7.6 Graph History

The Graph History functions are new for V5R1. You can use Graph History when you have had an active System monitor (system monitor uses Collection Services) or Collection Services is active. Graph History enables you to view specific performance metrics over a longer time period (for example, up to 1 year) than you can with a system monitor (up to the most recent 60 minutes).
Consider Graph History as a near-real time view of a performance metric, with a system monitor a real-time view of that same performance metric.

However, Graph History enables you to look at a wide range of performance metrics, whereas the System monitor enables you to view only the metrics you have specified for that monitor.

V5R1 Collection Services set up includes how long to save “graph data” up to 30 days (default of 1 hour) and “summary data” for several years (not recommended). The summary data default is one month. Both sets of data are available to Graph History.

If you do not run either Collection Services (remember it is started by a system monitor, if necessary) for certain periods of time, then there will be “blanks areas” in any graph line shown by Graph History data.

A more complete description of Graph History capabilities is contained in Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565. However, this topic provides good overview information.

The system monitor performance data is displayed real time - within seconds of actual time. You can scroll backwards to the left across the time line of the window area for up to the last 60 minutes, starting from the “current time”. If you have previously run the system monitor or have run the system monitor for longer than 60 minutes, you cannot see time periods older than 60 minutes graphically through the system monitor window.

You can, however use Graph History to review those system monitor metrics that you are interested in for several different time periods, such as for a day, a week, a month, or a year, depending on how long Collections Services has specified to keep graph history and summary performance data. See 6.8, “Collection Services overview” on page 271 for more information.

You can display one metric graph at a time. However, you can display multiple Graph History windows to make comparisons, if needed.

There are several ways to start (open) a Graph History history window, including:

- Select Management Central -> Monitors -> System to see a system monitor. Right-click a monitor and select Graph History from the context menu.
- From a System monitor window (active or stopped) use the select menu bar File and select Graph History from the context menu.
- Select Management Central -> Endpoint Systems -> System -> Configuration and Service -> Collection Services. Select Explore/Open. Right-click a collection object and select Graph History from the context menu.

In Figure 6-50, we have selected Graph History for an active System monitor that has been running for several hours. By default no graph is displayed in the graph window in the lower right pane at A.

We have already specified the start and stop dates and times in the From and To boxes at 1, and clicked Refresh to get the graphic shown for CPU Utilization (Average).
Note, at 2 you select the metric to display, the time interval to show on the graph and the maximum graphing value.

Dependent on the performance metric being shown and the age of the graph history data you may or not be able to display second level information in the pane at 3 or third level information in the pane at 4.

There are symbols used at the graph points within the graphing pane at A that indicate if any additional detail information is available:

- A square symbol (xxxxx) is used when the data includes both second and third level information. This is similar to the information available when viewing the data real-time with a System monitor.
- A triangle symbol (xxxxx) is used to represent summarized data that has second level information. This information is performance metric dependent. For example the second level information would be the top 20 jobs for CPU utilization average or batch logical I/Os. This symbol is used in Figure 6-50.
- A circle symbol (xxxx) is used to represent data that contains no drill down information.

There are several additional functions and viewing options that are not described in this book. Use the help functions for additional information.

Attention to reader: Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565,n contains additional examples of Graph History.
6.8 Collection Services overview

This topic gives a quick look at using Collection Services. Collection Services is one of the tools you can use for performance management of one or more iSeries systems.

Complete discussion of the primary iSeries performance management tools is beyond the scope of this redbook. While Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565, provides more details on the use of Collection Services, system performance monitors, and graph history, it is not a compete treatment of how to do performance management on an iSeries.

The best V5R1 document addressing overall iSeries performance management is entitled Performance Overview. This document can be obtained from the Information Center Web site at:

http://www.ibm.com/eserver/iseries/infocenter

From the left navigation bar select System Management -> Performance -> Print this topic.

This document contains information on when to use the various iSeries performance tools - system monitors, Graph History, Collection Services, the Performance Tools for iSeries, 5722PT1 product, PM/400, and additional tools are covered in this document.

Starting in V5R1 Collection Services is the only OS/400 tool for collecting system-wide performance data that can be used by:

- PM/400 licensed program and service offering,
- Performance Tools licensed program, 5722PT1
- Management Central Graph History

When active, Collection Services places encoded performance metric data into a collection object (*MGTCOL type) that can be viewed (not the contents) with OS/400 commands and through the Operations Navigator interface. An active collection can be stopped and “cycled” (active performance collection data stops being placed into the currently active collection object and a new collection is started and a new collection object created).

Your system can be set up to have the data based on this object be automatically processed by the Performance Management/400 (PM/400) licensed program shipped with every iSeries server. PM/400 can be configured to send a summary of this performance data to IBM for trend analysis on hardware resource utilization and transaction-based metrics, without you having to do any of the analysis yourself! Depending on your chosen level of PM/400 performance analysis, the PM/400 service offering enables you to receive various reports or view your secured performance trend information with a browser connected to the IBM PM/400 Web site.

Someone in your enterprise can also use the performance data from the collection object for their own analysis, perhaps for detailed job level performance analysis. When you want to do this you must first create a set of performance database files from the collection object and either write your own queries on these files or use these files as input to the Performance Tools for iSeries, 5722PT1, product.

Performance database files can be specified to be generated for any time periods within a collection object's start and stop time. These database files all have a QAPMcccccc prefix, which is familiar to those using the Performance Tools licensed program in previous releases. 5722PT1 uses these files as input to its reporting and capacity planning functions.
6.8.1 Starting Collection Services

Collection Services can be started by any of the following techniques:

- PM/400 is active on your system. PM/400 will start Collection Services if it detects there is no active collection.
- The Performance Tools licensed program 5722-PT1, menu option 2 - Collect Performance Data. To get this menu on a 5250 workstation, enter either GO PERFORM or STRPFRT.
- Select **My Connections -> system -> Configuration and Service -> Collection Services** -> select **Start** from the context menu
- Select **Management Central -> system group -> Collection Services** -> select **Start** from the context menu
- Select **Management Central -> Endpoint Systems -> system -> select Collection Services** from the context menu -> select **Start** from the next context menu
- Select **Management Central -> Endpoint Systems -> system -> Configuration and Service -> Collection Services** -> select **Start** from the context menu
- Starting a system monitor when Collection Services is not active
- Calling a user program at the appropriate time that calls QYPSSTRC (Start Collector API). For example:
  - In the program specified in system value QSTRUPPGM (program called as soon as OS/400 restart is complete)
  - In an autostart job specified for IBM-supplied subsystem QSYSWRK
  - In a Management Central Run command or Command Definition that is scheduled to run at a certain time.

Search Information Center with search words Collection AND Services AND API to find out more about Collection Services APIs.

There is only one IBM system job on a system performing Collection Services regardless of how many users start Collection Services or start a system monitor.

Collection objects on the system can be accessed and managed by any of the following techniques:

- Select **Management Central -> Endpoint Systems -> system -> Configuration and Service -> Collection Services** -> select **Explore/Open** from the context menu
- Select **My Connections -> system -> Configuration and Service -> Collection Services** -> select **Explore/Open** from the context menu

In 2.2.3, “Configuration and Service” on page 16 there is an excellent overview of Collection Services. However that topic does not show an example of starting your own collections where you can specify important parameters that, if a collection is currently active can be cycled and new parameters used for the collection

In this topic we show the context menus for a Collection Services and an example of starting your own collection.

Figure 6-51 shows the Collection Services context menu actions.
Figure 6-51  Collection Services context menus

Figure 6-52 shows an example of a Start Collection Services where we have explicitly specified some non default values for specific parameters.

Figure 6-52  V5R1 Start Collection Services window example
At 1 we can override the default values to run collection services approximately, for example, 12 hours and recycle (“close the current collection object and start a new one”). The default is 24 hours and a cycle time approximately midnight.

At 2 we you see values keeping the Detailed (job level) performance data to 20 days (up to 30 days is supported), the Graph data to six days and summary data for one year.

For graph data, if you do not start Performance Management/400 (PM/400), you can specify one to seven days. If you do start PM/400, you can specify one to thirty days. The default is one hour.

For summary data you must start PM/400 to enable the summary data field to be edited. You can specify up to 99 years! One year would be reasonable for most enterprises. The default is one month.

The Graph data and Summary data parameters are not available to central systems or endpoint systems that do not have V5R1 or later installed.

At 3 we have checked to have the performance database files while the collection is running (not necessary, as you can “Create Performance Data” from a collection object context menu), and create the Graph and summary data when the collection is cycled. Graph and summary data can be generated “on the fly” when you use a context menu function that requires it.

In this example, we use the default set of performance metrics (essentially the same ones used for a system monitor). The collection object defaults to Q, followed by the start collection time stamp in the form of Qdddhhmmss, where:

- $ddd$ is the numbered day of the year the collection started
- $hh$ is started hour
- $mm$ is started minutes
- $ss$ is started seconds
6.9 Definitions

In this topic we provide an overview of Management Central Definitions support as a lead in to the next major topic; using the Management Central Run command and Package support.

The Management Central -> Definitions folder supports specific definition “types” on which you can perform tasks. The definitions supported by Management Central include:

- **Commands:** OS/400 commands or user-written commands can be defined with the intention of “running them” repeatedly on one or more systems according to some schedule.

We have successfully used these definitions to run programs on endpoint systems to perform unattended fix installation for fixes requiring special actions.
Packages: Packages are typically lists of paths to programs or files or other objects within the same file system to be sent to one or more iSeries systems. Packages can be set up to run an OS/400 command after the distribution of the package has completed on each endpoint system. Packages are an effective way to do one time or repetitive file exchanges among iSeries systems. Packaging and product support are discussed in detail in Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products, SG24-6564.

Products: Products (new with V5R1) enable a user to create programs and associated objects into a product that can be distributed and installed similar to the processes available for IBM software products. With this support you can also create, distribute, and install fixes to the product.

User: User definitions (new with V5R1) enable you to create a “base template” of user profile parameter values that can be used later when creating a user profile on an endpoint system. More information regarding managing user profiles through Management Central is provided in Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227.

6.10 Management Central examples

Management Central provides a wide variety of function to help you manage the iSeries systems in your network. This topic provides simple examples that illustrate a number of Management Central concepts. We have two sets of examples:

- Running commands using Management Central
- Defining and sending a Package

6.10.1 Running commands using Management Central

Management Central allows you to submit and run commands on multiple systems. Any OS/400 control language (CL) command that you can run in batch can also be submitted from the central system to multiple endpoint systems at the same time. A command can be run immediately, or it can be stored as a definition, allowing you to share commonly used or complex commands with other users that can be run repeatedly.

When a command is run, a Management Central task is created on the central system. The task can then be watched by you from the Management Central Task Activity details pane. You can view the status, job log, and printer output, you can also handle inquiry messages.

Command processing

For a run command task the command is transmitted to the endpoint system through Management Central. The command must exist on the endpoint system and you must have authority to that command.

When you schedule to run a command, the task is scheduled on the central system to be run at a later time according to the central system’s time. When the date and time arrive, the command is processed the same way as a normal run command process.
Running an “ad hoc” command
This method allows you to run a command without creating a command definition. You can use this method for one time commands, or a command that is only run occasionally. Once the run command has started, a task is listed in Task Activity under Management Central. All commands run using this method have the task name of Run Command. If you run a command multiple times during your Operations Navigator session each Run Command task will have a number appended to the end of the task name constructed by Management Central. For example, Run command, Run command (2), Run command (3), and so forth.

Here is a sequence of steps to running an “ad hoc” command on multiple endpoint systems.

1. Select Management Central -> Endpoint Systems or System Group
2. Select the endpoint system(s) or group on which you want to run the command.
3. Right-click the selected endpoint system(s) or system group(s), and select Run Command from the context menu. Notice that the window that you see does not display the fields for a name or description as shown in Figure 6-53.
   Note: See “Task Sharing (and object sharing)” on page 199 to see about “default or “global” sharing.

4. Enter the command to be run or the first several characters followed by the * (wild card) and select the Prompt button or PF4. If you use the wild card, select the command from the listed presented to you.
5. Select Prompt to bring up the Operations Navigator prompt window. You can click Previous Commands to select from a list of commands that you previously ran from your PC.
   To specify options concerning the job log or inquiry messages, click the Options tab.
6. Select OK to run the command immediately or Schedule to run the command at a later date or time.
Creating a command definition

There are several methods you can use to create command definitions. We show two examples in this section. The first method (described in the following section) creates a new definition. The second method (see “Creating a definition based on an existing definition” on page 279) creates a definition based on the definition which already exists. Using the existing definitions helps you create the same command with different run attributes.

Creating a new command definition

Use this method to create a new definition:

2. Right-click Command, and select New Definition. The New Command Definition window appears as shown in Figure 6-54.

3. Specify a name for the definition and a brief description. You can type a command to be run in the Command field or again enter a partial command followed by an *. Select Prompt to invoke the Operations Navigator command prompt facility. Enter the entire command in the Command field of the Command Definition window as if entering from the command line on the iSeries system.

In this example, the command we are using is a user-defined command (SBMCHAINUC) in library PFREXP on the system on which we are creating this command definition. When this command runs it submits a job to job queue CHAINBCH on the target system. As written, the command, its command processing program, all programs called by the command processing program, and a message queue used by the job must all reside in library PFREXP on the target system.

You can use a Package definition to send all the necessary objects to run this command to the target systems. We implemented this application before the V5R1 Product definition support was available.

We show a simple Package example (not this application) in “Defining and sending a package” on page 282.

4. You have the option to use the Previous Commands button to select from a list of commands that were previously run from your PC workstation. This history is retained on
your local PC, so the list does not include commands that were run from other PCs, even by the same user.

5. To specify options concerning the job log or inquiry messages, select the **Options** tab. Use the Options page to specify how you want to handle the job log and inquiry messages when this command definition is run.

Figure 6-55 shows the Options tab. If you uncheck the *Automatically reply to inquiry messages if they occur* box and the command needs a reply, it waits for your response. You have to access the system to reply to the message.

This can be done by using a 5250 workstation session and entering the Display Message (DSPMSG) command for message queue QSYSOPR. You can also reply using Operations Navigator **My Connections -> system -> Basic Operations - > Messages** for “System operator”.

![Figure 6-55 Options tab for a new command definition](image)

6. Select the **Sharing** tab to specify whether you want to share this command definition with other users. Refer to “Task Sharing (and object sharing)” on page 199 for information regarding definition (object) sharing selections.

7. Select **OK** to finish the definition. The new command definition is placed in the right panel of Command folder. The command does not run until you tell it to.

**Creating a definition based on an existing definition**

Use this method to create a definition based on an existing definition. You can change the properties needed for the new command. Figure 6-56 shows a sample command definition window.

1. Select **Management Central -> Definitions**. Expand **Definitions**.
2. Select **Command** to see the commands already created. Remember the task sharing option. You will not see commands defined by other users if they specified “None”.
3. Right-click on any command that you wish to use as a base. Select **New Based On**. You may then use the existing command to create a new one.
You can change any of the properties necessary to suit your needs. For example, you can choose the Options tab to change the options to reply differently to an inquiry message, you can run a different command with all the same options, or you can run a different command with the same options, but not allow other users access to the command if a security issue is involved.

**Submitting a command**

When a command is run, a task is created. You can select the task in the Management Central Task Activity pane and view the status of the task on any system or system group. If the task is scheduled, the task will appear under Scheduled Tasks. Only those tasks that the user has created and those that the user has been given authority are shown.

There are several methods you can use to submit your commands. Two examples are given in this section. The first method submits the command from a command definition list. The second method runs the command without creating a command definition.

**Submit command from list**

This method allows you to run a command from a list of existing command definitions. You can run a command without having to create a command definition each time you want to run it. Re-use the command as often as necessary. You may want to run the same command on different endpoint systems or at different times.

1. Select **Management Central -> Definitions**. Expand **Definitions**.
2. Select **Commands**. The right-hand panel displays the command list.
3. Right-click on a command definition, and select **Run**.
4. Select the endpoint systems or system groups to which you want to send the command definition, and click **Add** for each selection. See Figure 6-57 for an example.
5. Select OK to start the command task immediately or Schedule to specify how often you want to run this task and when you want the task to start. Figure 6-58 shows an example window to schedule the command.

![Figure 6-58  Management Central scheduler](image)

Here are some examples of usage of a command definition.

Run a program that applies a fix that was sent using Fixes inventory, but could not be installed in the same task because the fix required special action, such as End a TCP server, apply (install the fix) and Start the TCP server.

You need to change the system values QTIME and QUTC_OFFSET when a change between standard and daylight savings time occurs. For example you could uses two command definitions:

```plaintext
CHGSYSVAL SYSVAL(QUTC_OFFSET) VALUE('-0500')
CHGSYSVAL SYSVAL(QTIME) VALUE('03:00')
```

You could use the Run action several times for this same command to schedule the commands to run on a list of endpoint systems in one time zone and then on a different list of endpoint systems in another time zone.

You can use the Run action to notify interactive users on all endpoint systems of a pending action, such as the need to power down the system. An example is:

```plaintext
SNDBRKMSG MSG('Please sign off. The system will be powered off in 10 minutes.')
TOMSGQ(*ALLWS)
```
You can use the command definition to save this command and run it whenever you need to later.

**Running multiple commands**

Multiple linked commands may be submitted from Operations Navigator simply by creating a CL program and installing that program on each endpoint system. Use the Package Definition support or simply select the program and specify Send while using My Connections -> system -> File Systems -> Integrated File Systems -> QSYS.LIB -> library -> program to send the program to the target system.

To run the program on the remote system here two options:

- After the program has been installed on a target stem, create a Command definition that CALLs the program and run that command on the target system.
- Create a Package definition for the program and use the Actions function of a package to CALL the program after the package has been installed on the target system.

### 6.10.2 Defining and sending a package

Management Central -> Definitions -> Packages supports defining a package that consists of objects stored on one iSeries system for the purpose of sending that package and installing the objects on other iSeries systems.

A package can consist of a wide variety of object types, but they must all be from the same file system for that package.

Objects can include:

- Any PC file type stored in the Integrated File System
- Any OS/400 object stored within the QSYS.LIB file system, including programs, database objects (physical files, logical files, SQL objects including tables, and indexes), message queues, data queue, and spool output queues.

Message queues, data queues, and output queues can be sent but only the object definition is restored on the target system. Any “entries”, such as messages, or spooled file output on these queues are not sent.

Management Central selects the appropriate save function (SAV, SAVDLO, SAVOBJ) based on the file system containing the objects. SAV and SAVOBJ are both “save object” commands. SAVDLO represents save document library objects. The objects are placed into an OS/400 QSYS.LIB save file object. That save file is sent to the target iSeries system and restored.

When creating the package you can specify save options, such as what to do if an object being saved is in use (“save while active”) and restore options on the target system (such as what to do if the object already exists on the target system).

You can also specify if a “snapshot” of the listed objects should be created when you complete your definition. This way the content of the objects sent is “frozen” at the time the package was defined. You can send that saved version of the objects or have the save performed when the send function begins to send the package.

If the target system does not contain the source system directory or QSYS.LIB library, it will be created on the target system.
The following example shows sending some files containing SQL statements that can be selectively used by Operations Navigator -> Database Run SQL Scripts workstation users. We also show some windows for some QSYS.LIB objects in library PFREXP.

We do not show all package-related windows nor all options that are supported for packages, such as New Based On. Use the context menus and online Help to review all capabilities.

Creating a package definition
You can explicitly create a package definition and then later send the package. You can update the package before sending it. You can also implicitly create an “ad hoc” package by selecting objects while using the Integrated File System interface and selecting the Send function.

We explicitly create a package definition in our example. Follow these steps:
2. Select Packages and select New Definition from the context menu. This brings up the windows shown in Figure 6-59.
3. In the General window, enter a package name and description and source system as shown at 1.

4. Select the Add button to get the window at 2, from which you scan scroll through the entire Integrated File System directory tree structure to find the directory or library you want to send objects from and expand the directory/library.

In our example we have selected three PC workstation type files to include in the package.
5. Select **OK**, which returns to the General window which has been updated with selected files as shown above at 3.

Note that the Source Path and Target Path data can be edited by you. For example,

6. Under 6 you can see we have selected Create snapshot. Operations Navigator has filled in a default OS/400 library name (Qusrsy) and save file name that will contain the snapshot (saved) data.

Before clicking OK we select **Options** and **Actions** tabs.

7. In the basic **Options** window at 4 we have selected to include subdirectories (if any) and to restore the sent version of an object if it already exists on the target system.

In the **Advanced Options** window at 5 you can specify parameters such the current or previous Target release and save actions and whether to allow a restore if the object is already on the target system and the one being restored have object differences.

8. In the **Actions** window at 6 we have entered a command to run after the objects have been restored.

In a more sophisticated example our package could have contained OS/400 programs and we could have used the Call OS/400 command to run the "just restored" program!

9. Select **OK** and the "create snapshot" function runs which is indicated by a "create snapshot in progress" window, not shown in our example.

When the snapshot has completed, you are returned to the Details pane, which shows your new package definition. Now or later you can right-click this definition and perform several actions from the context menu, including send the package, which we describe in the next topic.

Note that we do not show the window where we specified our definition sharing as Controlled.

In this example we used files from a file system other than QSYS.LIB.

We now show a subset of the windows used to create a new package definition for a QSYS.LIB program and associated message queue to illustrate calling a program that was specified in the package.

Our package uses the **Action** window to run that program as part of the send package task.
Once the package of program TCPSVRS and message queue (no message queue data sent) was restored on the target system, program TCPSVRS was called which stopped and then started selected TCP servers with the ENDTCPVR and STRTCPVR commands.

Program TCPSVRS performs the special fix actions required for fixes to 5722TC1 (TCP/IP Connectivity Utilities) that we used in our fixes inventory example in “Fixes Inventory” on page 226.

Sending a package

We use the three SQL statement files package shown in Figure 6-59 to illustrate the steps in sending a package. Figure 6-61 shows some of the windows used to send the package, views its Task Activity and the Details of the completed task. In this example we:

1. Right-click the package and selected Send from the context menu as shown at 1.

   Note that you can select to have the package snapshot updated if you wish.

   We do not show the windows we used to schedule the send (at 3:40: PM) nor to select the system group AS01_As25B to receive our package.
2. In the window at 2 we selected the completed task, which brought up the window at 3.

3. We selected system As01 to view the detailed status for each object restored on that system.

**Tip:** If the completion status in window 2 shows a failure of some kind, select **Status** from the context menu as the first step in problem determination. In the next window, take the **Task Output** context menu action for a system that has “failed” status.

Following this path takes you to the Management Central server job log on the target system for the job that performed the receive of the package function. You can view the job log messages to determine the cause for the failure. The target system job name is constructed as job number/Management Central user ID/QYPSPRC.

Depending how you have configured your default sign on procedure (use Windows user ID and password, used default user ID and prompt as needed, or prompt every time), you maybe required to sign on to the target system to view the job log.
Chapter 7. TCP/IP network

This chapter provides an overview of the V5R1 Operations Navigator Network component TCP/IP-based functions and focuses on a subset of those major functions that are required for basic management of Operations Navigator functions.

The topics covered in this chapter include:
- Overview of the network
- TCP/IP configuration (basic configuration and utilities — Ping, Trace route, Lookup host)
- Servers - TCP/IP and Client Access
- AS/400 NetServer Example
- FTP and Telnet server Examples

The Network component provides an easy to use graphical interface to both simple and complex TCP/IP capabilities. Describing details of configuration parameters and problem determination techniques is beyond the scope of an Operations Navigator redbook. Similar to how we suggest other documentation for iSeries Database, Logical Partitioning, and Cluster management, for more TCP/IP details we refer you to other documentation at the end of this chapter in 7.6, “Additional information” on page 334.

More advanced Networking component capabilities are described in Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566; capabilities such as:
- IP address filtering, Virtual Private Networking
- Dynamic Host Configuration Protocol (DHCP)
- Domain Name Services (DNS) servers
- Quality of Service (QoS)
- Windows Administration (managing Windows operating systems on an Integrated xSeries Server for iSeries)
- Use of SSL authentication and encryption for Operations Navigator and Management Central functions
7.1 Network overview

The Network component of AS/400 Operations Navigator first appeared in V3R1M3 of Client Access and has been further enhanced up through the OS/400 and Client Access Express release V5R1.

Functionality is dependent on the Client Access and the operating system levels of your iSeries server. Please refer to Appendix C, “Operations Navigator functions by release” on page 473, for an outline of network functions available by operating system release.

This component is installed through either Client Access Express Full or Custom installation. If this component is not installed on your workstation you can install it by running Selective Setup as discussed in “Selective setup” on page 60.

The Network component consists of several primary level folders, each of which may have several lower level folders. The preliminary level folders include:

- IP Policies
- Remote Access Services
- Servers
- Windows Administration
- Internet
- IBM Network Stations
- TCP/IP Configuration

Figure 7-1 shows these primary folders and the lower level folders in the left pane hierarchy tree at 1. Note the important Taskpad items in this example.
We overview the functions in each of the primary folders as follows:

- **IP Policies**: Allows you to define advanced security parameters for your TCP/IP network, including Packet Rules (IP filtering, Network Address Translation and more), Virtual Private Network configuration and management, and starting with V5R1 Quality of Service configuration and management, which enables prioritized processing and routing of certain application data.

  This is considered an advanced topic and not covered in this chapter.

- **Remote Access Services**: Remote Access Servers were formerly configured and managed as point-to-point connects, and allow you to configure remote connections to your iSeries server through connection profiles and modem selection.

- **Servers**: Provides views, configuration options and management for TCP/IP and other servers (and associated server jobs) running on your iSeries server. Domino servers are also supported, provided you have the Domino plug-in configured. We discuss managing servers in 7.3, “Servers” on page 313.

  Note: This is a very key component for managing important functions such as OS/400 NetServer, remote database access through ODBC and JDBC interfaces, Domain Name Services server, Management Central, and more.

- **Windows Administration**: You may manage your Integrated xSeries servers, including new for V5R1 Disk configuration and OS/400 user profile enrollment support. This is considered an advanced topic and not covered in this chapter. We refer you to:


  Select Networking -> Windows servers on iSeries

  - The redbook Consolidating Windows 2000 Servers in iSeries, SG24-6056
  - The redbook Direct Attach xSeries for the IBM @server iSeries Server, SG24-6222
  - The redbook Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566

- **Internet**: Provides a connection to several iSeries applications configured through a Web browser. These applications include:

  - The IBM-provided HTTP *ADMIN server Tasks page, which, depending on what you have installed on your system, includes configuring or changing other HTTP Web servers to run under OS/400.
  - Digital Certificate Manager (creating and maintaining digital certificates for use with applications using Secure Sockets Layer (SSL) functions)
  - New with V5R1 IBM IPP (Internet Printer Protocol)
  - 4758 Cryptographic Coprocessor functions

From the Internet folder you can use the new for V5R1 Internet Setup Wizard which links to an extensive set of wizards available for configuring your system's connection to the Internet with these capabilities:

- Three connection methods: (1) through a private network and (2) through a protected network, each of which can connect through a firewall or router and (3) through a direct dial-up to an ISP or through a router.

- Depending on the connection method selected, wizards are provided for configuring the following services: Web serving, Proxy serving, Use of Net.Data, FTP access, packet filtering rules, VPN setup, and use of a Virtual IP interface.
These functions are described in more detail in *Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking*, SG24-6566.

- **IBM Network Stations:** This also provides a connection to the Web browser to allow you to set up and manage IBM Network Stations, if the product IBM Network Station Manager for AS/400, 5733-A07, is installed on the iSeries server.

- **TCP/IP Configuration:** As discussed in 7.2, “TCP/IP Configuration folder” on page 294, all aspects of basic configuration and management of your TCP/IP network can be addressed from within this menu selection. This includes creating, viewing and managing IP interface and routes, connections and physical interface activity (such as send and transfer rates). For V5R1 there is a graphical view of the commonly available NETSTAT functions and you can access additional information, such as the jobs associated with a connection.

Starting with V5R1 there are “connection test” utilities for well-known TCP/IP functions, including:

- Ping
- Trace route
- Host lookup

**Note:** With V5R1 of Operations Navigator, the TCP/IP Configuration folder and next level Interfaces folder is shown when connected to OS/400 V4R5 and earlier releases. All other lower level folders are supported in OS/400 V5R1 release and later.

### 7.1.1 Secure Sockets Layer (SSL) considerations

SSL support enables you to use digital certificates to authenticate connections and encrypt data exchanged between iSeries systems and other hosts and between an iSeries server and the PC workstation running Client Access Express and Operations Navigator.

Describing how to set up SSL is beyond the scope of this volume. In this topic we summarize the software requirements to use SSL between a V5R1 iSeries server and the PC workstation and between an iSeries Management Central central system and iSeries endpoint systems. We also overview the steps required to set up SSL.

To set up and use SSL for Operations Navigator, Management Central, and Client Access Express insure the following are installed:

- Ensure you have all the prerequisite products installed on your iSeries server:
  - OS/400 option 34 - Digital Certificate Manager.
  - 5722DG1 IBM HTTP Server for iSeries.
  - 6722TC1 TCP/IP Connectivity Utilities.
  - One or both 5722AC2 Cryptographic Access Provider 56-bit for AS/400 or 5722AC3 Cryptographic Access Provider 128-bit for AS/400.
  - For SSL use between your PC workstation and the iSeries using Client Access Express functions, including Operations Navigator you need one or both 5722CE2 Client Encryption 56-bit or 5722CE3 Client Encryption 128-bit.

- On your PC workstation you must have installed the Secure Sockets Layer (SSL) component from Client Access Express to perform the SSL setup. You must have 5722CE2 or 5722CE3 on an iSeries system to be presented with the option to install SSL on your PC workstation. Installing this component can be done during initial installation of Client Access Express on your workstation or later by using Selective Setup as described.
in “Selective setup” on page 60. You select either or both 5722CE2 Client Encryption 56-bit or 5722CE3 Client Encryption 128-bit support.

You must have installed this component on your PC workstation to see the **Secure Sockets** tab for a **My Connections -> system Properties** page or the **Security** tab for a Management Central central system **Properties** page.

For reference purposes, the following lists all iSeries applications that support SSL for V5R1:

- IBM HTTP Server for iSeries (original)
- IBM HTTP Server for iSeries (powered by Apache)
- FTP server
- Telnet server
- Distributed relational database architecture (DRDA) and distributed data management (DDM) server
- Management Central
- Directory Services Server (LDAP)
- Client Access Express applications, including Operations Navigator, Data Transfer, PC5250
- Applications that are written to the Client Access Express set of application programming interfaces (APIs)
- Programs developed with Developer Kit for Java and client applications that use IBM Toolkit for Java
- Programs developed with Secure Sockets Layer (SSL) Application Programmable Interfaces (APIs) or Global Secure Toolkit (GSKit) APIs which can be used to SSL enable applications. See the Secure Sockets Layer (SSL) APIs for information on both SSL and GSKit APIs.
The TCP/IP Configuration folder allows you to manage and configure TCP/IP interfaces, monitor the status of routes and connections, and monitor the activity of physical interfaces.

7.2 TCP/IP Configuration folder

The TCP/IP Configuration folder allows you to manage and configure TCP/IP interfaces, monitor the status of routes and connections, and monitor the activity of physical interfaces.
Prior to V5R1 of Operations Navigator, there was a “Protocols” folder (folder) that contained TCP/IP and resided under the primary Network folder. “Protocols” no longer appears starting in V5R1. A new TCP/IP Configuration folders, now resides under the Network folder. When TCP/IP Configuration is selected in the tree view (as shown at 2 in Figure 7-1 on page 290), the list shows the following new folders:

- **Interfaces**: Allows you to manage and configure TCP/IP interfaces, view, change, and add the interfaces associated routes and packet rules, and manage the ARP cache
- **Routes**: Allows you to monitor the status of routes
- **Connections**: Allows you to monitor the status of connections, connection jobs, and job logs
- **Physical Interfaces Activity**: Allows you to monitor the activity of physical interfaces

Figure 7-2 shows the context menus for these lower level TCP/IP Configuration folders.

In Figure 7-2, you see for the TCP/IP Configuration component all the context menus have the standard actions:

- **Explore**: Displays the contents of the function items in the right pane
  - For the TCP/IP Configuration folder the right pane represents the Explore action.
- **Open**: Displays the contents of the function items in a new window
- **Create Shortcut**: Creates a shortcut to the function item on your desktop

We discuss the other menu actions for each folder later in this chapter. Before doing that we discuss the Properties from the TCP/IP Configuration folder menu.

You can use the **menu bar Options -> Sort** or the Details pane alternately selecting a column heading to sort the information displayed. Most of the folders have a significant number of columns of information not shown by default. Consider also using **menu bar Options -> Columns** to select the information that best suits your needs.
7.2.1 TCP/IP properties

TCP/IP properties are used to configure the local system to be able to communicate with other hosts on a TCP/IP network. When Properties is selected from the context menu of TCP/IP configuration (as shown in Figure 7-3), the following property windows are shown:

- Host Domain information
- Host Table
- Settings
- Quality of Service
- Port Restrictions
- Servers to Start
- Socks

These are generic TCP/IP settings that affect TCP/IP as a whole on the iSeries server rather than specific interfaces.

To enable TCP/IP communication with your iSeries server, you must define Host Domain Information at a minimum for your system. Other properties are defined based upon your network configuration, and are described in detail using the specific Properties windows online Help functions or general searches through documentation under iSeries Information Center.

All TCP/IP systems support a Host Table or a DNS server to resolve host names to IP addresses for successful connections to other hosts. To communicate with other hosts in a network you can explicitly specify an IP address to identify the system or use a host name. The host name to IP address mapping resolution can be performed either through a local system Host Table entry or by using a DNS server to perform an equivalent mapping function.

If your PC workstation cannot connect to the central system via My Connections -> system, your PC workstation probably has a problem with its own Host Table or DNS settings (typically domain name spelling error or wrong IP address of the DSN server). If you are not using a DNS server, the PC Host Table must have an IP address - host name entry that matches that of the iSeries server.

Use the online Help functions, for example the Help button on the Properties windows for the TCP/IP sub folders (Interfaces, Routes, Connections, Physical Interface Activity) for the specific properties field descriptions as well.

In “Host Domain Information window” on page 296 and “Host Table window” on page 298 we give some examples that help ensure your host name - IP address mappings are correct both for your My Connections -> system and Management Central (system) connections to be successful.

You can use the TCP/IP Configuration -> context menu Utilities to do some connection tests to help you resolve host name to IP address mapping problems.

Note: Only someone with TCP/IP expertise and knowledge of your network environment should make any changes to the contents of the following properties windows.

Host Domain Information window

The first window you see within the TCP/IP Properties window is the Host Domain Information page. This page is shown in Figure 7-3. The functions of this window for working with Host Domain Information correspond to the Change TCP/IP Domain (CHGTCPDMN) OS/400 command, or using the TCP/IP configuration menu (CFGTCP) option 12.
The Host name and Domain name fields allow you to specify the local system name, and domain in which the system is located, as shown at A. Combined, the host name and domain name make a fully qualified name. The host name you specify is added automatically to the system’s Host Table entries as both the short and fully qualified name.

Domain Name Services (DNS) servers are optional, but commonly used in networks of more than a few systems (“hosts”). A DNS server places the responsibility for mapping an IP address and Host name on that server, rather than requiring every host in a network to have a Host Table entry for every host in the network they will communicate with.

The iSeries supports up to three domain server IP addresses. The system uses the domain name servers in the order they are listed. You can also specify the search order in resolving a DNS name. You can have the iSeries server search its local host table first, or the network Domain Name Servers specified.

Starting with V5R1 you have a new option Domain suffix search order (shown at B in Figure 7-3). This allows you to specify up to three domains to search for a host name. Click Add to specify the domain suffix. To remove a domain from the list, select the domain and click Remove.

In this example, we have a “local domain” (DOMAIN.IBM.COM) that has its own DNS server (another iSeries server) that is located at 19.25.92.47 (as shown at C). Our system is known as As01 in DOMAIN.IBM.COM and as a different name outside of this “internal” domain. Therefore we must specify the 19.25.92.47 address first in the list of domain name servers.

Clicking the Advanced button also gives you other options including specifying the listening port of the Domain Name Server, the protocol to use, retry settings and the domain name.
**Important:** You must have your iSeries server Host Domain information or the Host Table information set correctly for Management Central to work efficiently between iSeries servers.

**Host Table window**
Within TCP/IP properties you can also work with your local Host Table if you are using it on the system (as opposed to a Domain Name Server). This window is shown in Figure 7-4. It provides similar functionality to working with the iSeries server host table through the Add TCP/IP Host Table Entry (ADDTCPHTE) OS/400 command or the TCP/IP menu (CFGTCP option 10).

![Host Table window](image)

*Figure 7-4  TCP/IP properties: host table*

**Settings window**
From the TCP/IP Settings dialog you can set overall TCP/IP system attributes as seen in Figure 7-5. These attributes include those for the Transmission Control Protocol (TCP), User Datagram Protocol (UDP), Internet Protocol (IP), and Address Resolution Protocol (ARP) protocol layers.
You simply select relevant options, or enter numeric data into fields where appropriate. This display is the same as performing the Change TCP/IP Attributes (CHGTCPA) OS/400 command from the command line, or from the TCP/IP menu (CFGTCP option 3).

Only someone with TCP/IP expertise and knowledge of your network environment should change the values on this window.

**Quality of Service window**

Quality of Service is a new function starting with V5R1. QoS enables you to define preferential treatment for some forms of data versus other forms of data. For example, you may assign voice data a lower priority than image data or FTP data a higher priority of Telnet data. Setting this up requires corresponding support on routers and other nodes in a network or you will have network problems.

This is an advanced function with additional information provided in the *Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking*, SG24-6566.

**Port Restrictions window**

Operations Navigator also provides you with the ability to work with Port Restrictions on the system. This is shown in Figure 7-6.
When you click the Add button, you are presented with a separate window which allows you to enter the user-name, the starting and ending port for the restriction (if it is one port you have to specify it as the starting and ending port), and the protocol.

The functionality of Port Restrictions within Operations Navigator is virtually identical to the configuration accessible using the Add TCP/IP Port Restriction (ADDTCPPORT) OS/400 command or using the Configure TCP/IP (CFGTCP) command menu option 4).

**Servers to Start window**

Servers to start (as illustrated with Figure 7-7) when TCP/IP is started is very important to becoming operational as soon as the iSeries TCP/IP support itself is started, for example after a system restart (IPL) or after you have changed some important TCP/IP-based support that requires the TCP/IP support to be stopped and started outside of the restart processing.

![Figure 7-6  TCP/IP properties: port restrictions](image-url)
From this Servers to Start Properties window, you can select the currently installed TCP/IP servers that you want to start automatically when TCP/IP starts. This includes TCP/IP and Client Access servers. A subset of the possible servers to start is shown in Figure 7-7.

**Figure 7-7  TCP/IP properties: servers to start**
On an OS/400 command line you have the ability to set autostart for most of the TCP/IP servers, but not the Client Access servers. The OS/400 Start Host Servers (STRHOSTSVR) command is required for Client Access servers. This Servers to Start function of Operations Navigator gives you control of more servers through a single interface.

**SOCKS window**

SOCKS allows you to configure sockets (SOCKS) support on the system. SOCKS is a client/server architecture that transports TCP/IP traffic through a secure gateway. Operations Navigator is the only interface for configuring the iSeries server as a SOCKS client. Figure 7-8 shows the configuration page for SOCKS under TCP/IP properties.

![TCP/IP Configuration Properties](image)

On this page, you can define the necessary SOCKS server settings such as defining the direct network, the network that requires the use of a SOCKS server, and the SOCKS server to use to access the network.

**7.2.2 TCP/IP Configuration interfaces**

Within TCP/IP Configuration (shown at 2 in Figure 7-1 on page 290), you have the ability to both create a new TCP/IP interface, work with existing TCP/IP interfaces, and add a route to an inactive interface. The interface functionality provided within Operations Navigator is similar to Work with TCP/IP Interfaces (CFGTCPIP option 1) menu and Work with TCP/IP Interface Status (NETSTAT option 1) OS/400 command. In another words, the Interfaces folder allows you to manage the logical TCP/IP interfaces on the iSeries server.
A logical interface is usually known by its IP address, and a physical interface by its line description. Here, when we talk about interface, we refer only to a logical interface. The Interface folder from previous Operations Navigator releases has been relocated and enhanced in V5R1 Operations Navigator. Prior to V5R1, the interface existed in **Network -> Protocol**, when you right-clicked TCP/IP. This structure is now changed and it is part of the left pane tree view below the TCP/IP Configuration folder.

Functions performed by the Interface folder include:
- Create/Delete interfaces
- Start/Stop and view the status of interfaces
- Work with ARP Cache
- Display (line) Statistics
- Packet Rules
- Add new routes

### Working with existing interfaces

Existing Interfaces can be viewed by going into **Network -> TCP/IP Configuration -> Interface**. This brings up the view as seen in Figure 7-9. This lists all the TCP/IP interfaces that are currently defined on the local system. The status column tells you whether the line is currently active or inactive.

From this window, you can stop and start TCP/IP interfaces (again, be cautious when stopping interfaces) as well as delete individual interfaces. The delete function is only available for interfaces not currently active.

Note the active and inactive (greyed) out context menu actions, depending on the status of Active or Inactive. We overview some of the context menu items and Properties values in this redbook, but going into details about each action and each of the properties values is beyond the scope of this redbook.

Note, however, that for an interface in Active status, the properties interface is essentially a “view only” set of values. For an interface with Inactive status, you can view and change some property values. This includes being able to add a new route.
You can access the properties for each interface by either double-clicking on it or right-clicking on the interface and then selecting **Properties**. The properties window is context sensitive to the type of Interface with which you are working and its status. As an example, the properties window for the Ethernet LAN TCP/IP Interface is shown in Figure 7-10.

![TCP/IP interface properties example](image)

You have the ability to view and alter certain parameters of the interface. For information on each of the parameters for the various interface types, you can click Help on any of the pages.

With all TCP/IP Interfaces, you have the option to select if the interface is to automatically start when TCP/IP starts. This is done simply by selecting the check box on the general page of the properties window. For those familiar with the OS/400 command line, this check box manipulates the Autostart parameter when performing a Change TCP/IP interface (CHGTCPIFC) OS/400 command, or CFGTCP menu option 1.

### Configuring a new interface

Operations Navigator also gives you the functionality to configure new TCP/IP interfaces. You are provided with user-friendly wizards to help guide you through the new interface configuration. However, we advise that you understand TCP/IP and the iSeries server when configuring TCP/IP.

You can configure three types of interfaces:

- Local Area Network (LAN)
- Wide Area Network (WAN)
- Virtual IP

Depending on your operating system level, some of these options may not be available. To configure a new TCP/IP interface, you can select one of the following, depending on your OS/400 release level:

- Right-click Interfaces in the left hierarchy pane and select New Interface.
- Select Interfaces in the left pane and then **menu bar File —> New Interfaces** (shown in Figure 7-10).
- Select Interfaces in the left pane and the New Interfaces toolbar icon as shown at ![image](image) in Figure 7-9.
The configuration wizards takes you step by step through configuring the new Interface, through a series of questions and responses. The wizards are selection sensitive. In our example, we chose Ethernet as our connection type for a LAN interface. This brings up the next page for the wizard which requests which resource or physical line is to be used for the new interface. The wizard then follows on for information of the new line description and then at what speed the line will communicate. In our case because the line is Ethernet we were given a choice of either 10 Mb or 100 Mb/second (If the right hardware is available then the option of 1 Gbs/second is also available). If we would have chosen Token Ring then we may have been presented with 4 or 16 Mb/second, depending on the hardware feature installed.

As an example, Figure 7-11 shows the initial displays of the wizard for creating a new LAN interface.

**Note:** Selecting New Interface using the toolbar button does not give you choices for creating the interface. Instead, it defaults to a new LAN connection (Ethernet, Token-ring, DDI, Wireless, or Opticonnect).

In brief, after the connection type is defined, the wizard continues with various other user selections for the interface. These include associating a hardware resource with the interface, specifying a line name and description, line speed, TCP/IP address, interface name, routing information, servers to start when TCP/IP is started and so on. Please note also the Help button is available on each window of the wizard should you require assistance with particular steps or parameters.
**ARP cache**

With V5R1 of Operations Navigator we are able to work with Address Resolution Protocol (ARP) cache table. The ARP cache can now be viewed and managed. The window does not allow you to select and work on multiple entries at a time, you can either delete one entry or all the entries at a time. It also allows deletion of only Dynamic entries. This function is also exclusive to the Operations Navigator and not available through OS/400 commands.

One example where you may need to clear the cache is when a system you have been communicating with using DNS now receives an "unable to contact" message. Someone may have changed the subnet address of that system your local subnet DNS server was not made aware of the change.

Your local iSeries server’s ARP cache may need to be immediately cleared using the procedure described in this topic.

OS/400 automatically clears the ARP cache based on a time specified in the TCP/IP attributes, ARP cache time-out (the default is 15 minutes). This can be accessed from the Settings page of TCP/IP properties or through the Change TCP Attributes (CHGTCPI) OS/400 command.

It is important to note that, even though you navigate to the ARP cache via a list of logical TCP/IP interfaces, only one ARP cache on each physical line is kept. This means that, when you clear the ARP cache on the physical line, all the ARP cache entries for all the logical IP addresses are cleared.

To manage ARP cache follow these steps:

1. In the **TCP/IP Configuration -> Interface** Details pane, right-click the interface whose ARP cache needs to be managed.
2. Select **ARP**. A window similar to Figure 7-12 is seen.
3. Select the cache entry you want to delete and use the Delete button. You can delete all cache entries by using the Delete All button.

**Statistics**

This display contains information about physical interface statistics. The properties page from this window is identical to the Physical Interface Statistics page when using the tree structure. Refer to 7.2.5, “Physical interfaces activity” on page 310.
Packet rules
To display the current packet rules for an interface to use:

1. In the **TCP/IP Configuration -> Interface** Details pane, right-click the interface whose Packet Rules you want to view.

2. Select **Packet Rules**. A window similar to Figure 7-13 is seen.

You can view what packet rules have been defined using the IP Security policies. It also shows Network Address Translation (NAT) rules if defined on the system. If the Rules column is added in the main Interface window it will show if NAT or IP rules have been implemented for this interface.

Associated routes
To display the current associated routes for an interface use:

1. In the **TCP/IP Configuration -> Interface** Details pane, right-click the interface whose Associated Routes you want to view.

2. Select **Associated Routes**. A window similar to Figure 7-14 is seen.

In V5R1 of Operations Navigator, associated routes allows you to view routes associated to a particular interface. The address of the interface the routes use appears at the top of the display. Only the routes that use this interface are displayed in the list.

Figure 7-14 shows associated routes to one of the system interfaces on system AS80. The Interface IP address can be seen on the Window header, and routes in the tabular form.
7.2.3 TCP/IP Configuration routes

In the TCP/IP Configuration -> Routes Details pane you can monitor the status of all routes known to the system, as shown in Figure 7-15.

By right-clicking an active route you can delete the route and view its properties. Properties include much of the information shown in the Details pane, including local binding information.

7.2.4 TCP/IP Configuration connections

Operations Navigator Connections functions correspond to the OS/400 Work with Network Status (NETSTAT) command. These functions allow you to monitor all TCP/IP connections to your iSeries server. You can view statistics summarized for all currently established sessions (as shown in window 2 in Figure 7-16).
Chapter 7. TCP/IP network

Figure 7-16  TCP/IP connections

By default all connections are displayed. Many systems will have one thousand or more connections in either the Listen or Established status (shown at 1). In the background Details pane in Figure 7-16, we have already sorted the connection into ascending Remote IP address by clicking that column.

In addition to the menu bar Options -> Columns or Sort, or column click sort functions, consider the menu bar Options -> Include function to “filter” connections shown by Remote or Local IP addresses or port numbers.

Remember also to use the Refresh functions or automatic refresh to observe changes in status and statistics shown.

Managing specific connections
The Details pane and context menu for a specific connection enable you to

- **Stop**: Stop the connection
- **Jobs**: Display the iSeries jobs using the connection
- **Properties**: Display the connection properties. This information includes much of the information that can be shown in the Details pane, including IP address information, IP data send and receive information and low level sockets information.

Using Figure 7-17 as an example, for remote IP address xxxx.186, note the four established connections. Those familiar with TCP/IP Telnet know that the default local port is 23, so you can tell that from PC workstation address xxxx.186, a Telnet session has been established.

We also know from Information Center documentation the Client Access Express Host servers (Database, Remote Command, and others) use local ports in the 84xx range.
In Figure 7-17 we right-clicked the connection shown and selected Jobs from the context menu to get the window shown at 1. In that window you can see the QZDASOINIT job, which is a Client Access Express Database host server job. We used the Job Log button to get the job log window at 2. In the job log you can see the message that indicates this job is doing work for user profile As0301.

The “PRT01 messages” do not indicate a problem.

7.2.5 Physical interfaces activity

To obtain a list of the physical interfaces (line descriptions) available for TCP/IP communication, select TCP/IP Configuration -> Physical Interfaces Activity as shown in Figure 7-18.
Figure 7-18  Physical interface activity

Physical Interface Activity information includes send and receive data statistics. By selecting Properties, you get additional statistics, including the current results of any packet filtering actions, as shown in Figure 7-18, at window 1.

Note the Percentage and More Details buttons for additional ways to look at packet statistics.

7.2.6 Starting and stopping TCP/IP

Within Operations Navigator, you have the ability to start and stop TCP/IP on your iSeries server.
Starting or stopping all TCP/IP on the system can be performed either using the toolbar Start and Stop buttons that become active when TCP/IP Configuration is highlighted, or by using the context menu when you right-click TCP/IP Configuration. As seen in Figure 7-19, you have the ability to stop TCP/IP in an immediate or controlled function, the same as you would on the OS/400 command line.

**Important:** You should have either a system restart (IPL) program to start TCP/IP or use the V5R1 Network Attributes Start TCP/IP parameter set to *YES in almost all normal operating environments.

For special situations OS/400 provides the Start and End TCP/IP commands (STRTCP, ENDTCP) as well as the Operations Navigator interface to start and stop TCP/IP discussed in this topic.

Since almost all connections to the system are dependent on TCP/IP being active (Client Access Express, 5250 Telnet, FTP, and more), you need to be very careful not to inadvertently end TCP/IP while using the TCP/IP Configuration menus.

If you stop TCP/IP during your normal runtime environment, unless you are using Operations Navigator from the Operations Console, you need to end or start TCP/IP from the master console or a batch job program with the ENDTCP and STRTCP commands), or a non-TCP/IP connected workstation, such as a twinaxial attached workstation.

We also discuss starting TCP/IP in “Servers to Start window” on page 300.

Starting and stopping TCP/IP on an interface is discussed in 7.2.2, “TCP/IP Configuration interfaces” on page 302.

Starting or stopping all TCP/IP on the system can be performed either using the toolbar Start and Stop buttons that become active when TCP/IP Configuration is highlighted, or by using the context menu when you right-click TCP/IP Configuration. As seen in Figure 7-19, you have the ability to stop TCP/IP in an immediate or controlled function, the same as you would on the OS/400 command line.

**Important:** You should have either a system restart (IPL) program to start TCP/IP or use the V5R1 Network Attributes Start TCP/IP parameter set to *YES in almost all normal operating environments.

For special situations OS/400 provides the Start and End TCP/IP commands (STRTCP, ENDTCP) as well as the Operations Navigator interface to start and stop TCP/IP discussed in this topic.

Since almost all connections to the system are dependent on TCP/IP being active (Client Access Express, 5250 Telnet, FTP, and more), you need to be very careful not to inadvertently end TCP/IP while using the TCP/IP Configuration menus.

If you stop TCP/IP during your normal runtime environment, unless you are using Operations Navigator from the Operations Console, you need to end or start TCP/IP from the master console or a batch job program with the ENDTCP and STRTCP commands), or a non-TCP/IP connected workstation, such as a twinaxial attached workstation.

We also discuss starting TCP/IP in “Servers to Start window” on page 300.

Starting and stopping TCP/IP on an interface is discussed in 7.2.2, “TCP/IP Configuration interfaces” on page 302.
As discussed elsewhere in this chapter, starting in V5R1, IPL attributes has a Start TCP/IP - STRTCP (*YES or *NO) parameter. Use Display (DSPILPA) IPL Attributes or Change IPL Attributes (CHGIPLA) OS/400 commands to view or change these attributes.

This IPL attribute specifies whether the Start TCP/IP (STRTCP) OS/400 command function is implicitly submitted at the completion of IPL and when the controlling subsystem is restarted from the restricted state. In versions of OS/400 prior to V5R1, it was necessary to change the startup program to include the STRTCP command.

### 7.3 Servers

The **Network -> Servers** folder enables you to manage server functions. In general you can start, stop, view and manage their associated jobs. You can also view server Properties. For some servers you can configure them or change properties and use the new properties.

The Servers folder has these primary sub folder groupings:

- TCP/IP folder
- Client Access folder
- DNS folder
- If you have the Domino plug-in installed on your PC workstation, you will also notice Domino appears under your servers tree.

Server management has been available since V4R2 of the operating system and been enhanced each new OS/400 release.

The menu bar Help has good summary level information for all of the left hierarchy pane navigation tree folders, including summary descriptions for the servers that appear in the left pane. For example:

- **TCP/IP Servers - DHCP**: Configure the DHCP server, add subnets to an existing DHCP configuration and modify an existing subnet. New in V5R1 are dynamic updates to DNS servers when DHCP assigns an IP address to a host.

- **DNS Servers**: Configure a primary, secondary, or cache-only server using DNS. New for V5R1 are BIND features that support additional security.

A full explanation of each server and its functionality is beyond the scope of this book. In this chapter we provide some general discussion of the **Network -> Servers** common functions and then some details on managing the NetServer, Client Access host servers, FTP, and Telnet servers. The TCP/IP Management Central server is discussed in more detail in Chapter 6, “Management Central and Monitors” on page 181.

### 7.3.1 Common functions

While the iSeries servers are grouped into separate branches of the Operations Navigator hierarchy tree, working with servers provides similar capabilities across the different servers.

When working with Servers, in the details pane of Operations Navigator, you are given a listing of the server names, the *status* of each server, and a short description of each server. We show an example in Figure 7-20.
Common capabilities when working with servers include:

- **Start, Stop**: Servers can easily be stopped and started (providing you have the correct authority) by highlighting the desired server and selecting stop or start from either a toolbar button or from a menu.

- **Server Jobs**: You have the ability to view the actual jobs on the iSeries server that correspond to each server listed within the Details pane. Most servers actually use multiple OS/400 jobs to perform their functions. These jobs can be seen by selecting Server Jobs from the context menu. A list of common server jobs is provided in Appendix B, “Operations Navigator server jobs” on page 469.

**Note:** The Network -> Servers folder first displays general status of each specific Server, such as TCP/IP TELNET, Management Central, NetServer servers and the Client Access Database server. This makes starting and stopping all the jobs running under each of these servers very simple. If you want to look at all the specific jobs running under this server, you select the Server Jobs menu item.

Contrast this to the Work Management component’s Server Jobs folder (Work Management -> Server Jobs), which initially displays all server jobs for each server classification. See 5.3, “Server Jobs folder” on page 155 for related information.

- **Properties**: Most of the servers listed under both TCP/IP and Client Access Servers have active properties windows that allow you to view and change various options for that server. To see the properties for a server, click Properties after selecting the specific server. In this redbook, we do not go into detail about each server. You can view the help text within the properties window for information. However, one option that is common to most servers is the Start When TCP/IP is Started parameter, which we discuss in “Servers to Start window” on page 300.
Along with these common capabilities just described, you may find different servers have unique functionality and properties. As stated previously, Operations Navigator is context sensitive. Therefore, as you select different servers, you will notice menus, toolbars, or properties windows unique for the current selection. We provide examples of this context sensitive functionality in our NetServer, FTP, and Telnet examples in 7.5, “TCP/IP servers: examples” on page 322.

### 7.3.2 TCP/IP servers

When you select TCP/IP Servers, you are presented with a list of all TCP/IP servers available on the iSeries server, and their current status (either stopped or started). Figure 7-21 shows in the Details pane a large number of the TCP/IP servers that may be installed on your system. Please note that the list of TCP/IP servers presented is dependent on the operating system version and specific OS/400 (5733SS1) installed options, and, in some cases, which licensed program products are installed on your iSeries server.

![TCP/IP network server example](image)

Almost all the servers shown in our example are either shipped standard with OS/400 or are included with a no charge licensed iSeries program. Of course to take advantage of some of these servers may require some setup in addition to what we discuss in this chapter.

We have placed the A character next to servers we want to call your attention to:

- **NetServer (AS/400 Netserver)** This must be active for the iSeries server to participate in file and print serving functions in a Windows Network Neighborhood. We discuss NetServer in more detail in 7.5.1, “NetServer” on page 322.

- **Management Central**: This must be active for any Operations Navigator function that uses Management Central functions, including functions being done on a single system, such as Run a command, define and run Message, Job, or System monitors, or any Configuration and Service component functions.

We discuss more about Management Central functions in Chapter 6, “Management Central and Monitors” on page 181.
FTP, LPD, ... TELNET: These servers must be active for the corresponding TCP/IP applications to function correctly. LPD is required for network printing functions and the Basic Operations -> Printers function to copy a spooled file from one iSeries server to a Printer device on another iSeries server.

HTTP Administration and Directory: HTTP Administration must be active for browser-based functions such as setting up your own HTTP server or using Digital Certificate Manager support. Directory must be active to do Directory (LDAP-based) publishing of information.

The basic functionality available through Operations Navigator when working with TCP/IP servers was outlined in the previous topics. The properties window is the primary tool for working with settings specific to each server. If you are familiar with 5250 emulation, you may notice, as you view the properties, some similarities to OS/400 commands to work with some of these servers. The examples in Figure 7-37 on page 331 and Figure 7-38 on page 332 show a comparison of the FTP attributes available through a 5250 emulation session and the properties windows available in Operations Navigator.

For help on the properties of each server, you can select the Help button on any Properties page. We also provide additional details on TCP/IP servers in Managing OS/400 with Operations Navigator V5R1, Volume 6: Networking, SG24-6566.

7.3.3 Client Access servers

Selecting Client Access under the Servers branch of the hierarchy tree gives you a list of all the Client Access Host Servers on your iSeries server as well as their current status. The typical view of the Client Access Servers branch is shown in window A in Figure 7-22.
The window context menu actions shown here for starting and stopping Client Access servers correspond to servers supported in the OS/400 Start Host Server (STRHOSTSVR) and End Host Server (ENDHOSTSVR) commands, such as *DATABASE, *FILE, *RMTCMD, and so forth. These are the only commands available for working specifically with Client Access servers on the iSeries server.

In Figure 7-22, we show the Server Jobs window at 1. Note all the Qzasoinit jobs with actual signed on users (user profiles other than Quser). At 2 we show the context menu for one of these jobs which has full job management capabilities as discussed under Work Management -> Active Jobs in “Active Jobs folder” on page 143.

Important: You should never Stop the Database, Central, Sign on, Server Mapper servers during normal system operation while running Operations Navigator. This make many Operations Navigator functions unusable. In those cases, you cannot use Operations Navigator to start up these servers! If this happens, you can use the OS/400 STRHOSTSVR command for these servers from either a console device or a batch OS/400 job.

In general Operations Navigator provides more flexibility than OS/400 commands when working with Client Access servers. The most notable flexibility functions are:

- You can see all the Client Access servers in a single panel interface. Since Client Access servers run in multiple OS/400 subsystems, to view all the Client Access jobs through the 5250 command interface you must use multiple Work with Subsystem Jobs (WRKSBSJOB) commands for each subsystem to view all the Client Access server jobs.

- You can select whether you want a particular Client Access server to automatically start when TCP/IP is started (as described in “Servers to Start window” on page 300). This functionality is not provided within an OS/400 command. We recommend that you start all Client Access Servers when TCP/IP is started.

For the servers running out of the QUSRWRK subsystem, you can also change the subsystem in which the jobs run. The Subsystem properties window is shown in Figure 7-23.

Figure 7-23  Server properties: subsystems
Use Server Defaults means that it is taking the subsystem default that is defined within the properties window of the Servers branch of the hierarchy tree. You can however tailor these servers to have all clients jobs run under a subsystem you specify. Similarly, you can specify the jobs of particular clients to run in certain subsystems.

For more information on Client Access servers, refer to Client Access Express Host Servers, SC41-5740.

7.4 TCP/IP Configuration utilities

With V5R1, new utilities have been added when you right-click TCP/IP Configuration. As shown in Figure 7-24, the following utilities are included:

- Ping
- Trace Route
- Look Up Host

Each of the above Utilities executes on the iSeries server, even though it is invoked from your Operations Navigator workstation. These utilities provide the easy interface to the commonly available “connection verification” functions available on most products supporting basic TCP/IP support.

TCP/IP must be started on your iSeries server to use these functions.

7.4.1 Ping

Verifying that a network connection is working is an important part of finding problems in your network. Use the Ping function to verify your TCP/IP connection. Ping sends an Internet Control Message Protocol (ICMP) echo-request packet to a gateway, router, or host with the expectation of receiving a reply. A successful reply means that you have a working network connection.

OS/400 supports the Ping function through the OS/400 command and the Operations Navigator TCP/IP Configuration Utilities interfaces. Figure 7-25 shows an example using the Operations Navigator interface.
Figure 7-25 Ping utility

You can enter either an IP address or remote host name in the area at A. Use Ping Now to start the function. Results of the function are displayed real time in the Results area at B.

This Operations Navigator interface to the Ping function uses only defaults to Ping function parameters supported on the OS/400 Verify TCP/IP Connection (VFYTCPCNN and PING) commands. The parameters include length of test packets (256 character default) and number of test packets to send (5 is the default). Remember, the Ping function is testing the iSeries server connection to the IP address/host name, not your workstation’s connectivity.

Note: A successful PING indicates network connectivity to the target system. An unsuccessful PING doesn’t necessarily mean there is no connectivity. Filter rules in the path may be dropping the PING ICMP echo request packets.

7.4.2 TCPIP Trace Route function

In a TCP/IP network there are typically “hops” (products that route your data) between your system and another system or PC workstation.

There are times when you need to know the “number of hops” in the path between your iSeries server and a remote host or workstation. Typically this is needed to help find a problem somewhere in the routing or to investigate if the number of hops may be a reason for poorer than required performance.

The Trace Route function is available to trace the route. You can trace all hops from your iSeries server along the route or specify the starting and ending hops to be traced. The route is traced by sending packets (called probes) to the destination system. Each probe contains an upper limit (called Time To Live or TTL) on the number of hop systems the probe can pass through. A route is traced by successively incrementing the TTL of the probe packets by one hop. The trace ends when either a probe response is received from the destination system or when the probe Time To Live value equals the number specified (255 maximum).

OS/400 supports the Trace route function through OS/400 command and the Operations Navigator TCP/IP Configuration Utilities interface. Figure 7-26 shows an example using the Operations Navigator interface.
At A you can enter an IP address or a host name. In this example we entered the final destination host name and clicked Trace to start the trace. The Routes to host window in B shows each hop along the way and the average response time back to the iSeries for each hop, along with the IP address and full name of each hop.

Note the 11 hops and slow average response times for hops 6 through 11 are indications that slow performance should be expected. If performance is critical for functions to Opnav01, you need to contact your network administrator.

At C you can see the default values for several parameters that control the trace functions. The Advanced Tab allows you to configure additional parameters. Use the online Help button or field level iSeries server help for description of the information shown in this window.

Figure 7-26  Trace route
The OS/400 Trace TCP/IP route commands (TRACEROUTE or TRCTCPRTE) also perform the trace route functions. However, viewing the result requires you to scroll through messages at the bottom of the 5250 screen or look at your workstation job's job log.

The Operations Navigator interface is much easier to use.

7.4.3 Look up host

At certain times you may need to understand the IP address - host name assignments in your network. A typical use is when a new node is introduced into your network or for some reason the IP address of a node you have been communicating with has changed and you are getting error messages.

The IP address - host name relationship is frequently maintained by one or more Domain Name Services (DNS) servers in your network. Sometimes one or more of them may not have the updated IP address - host name assignment.

The TCP/IP Name Server Lookup service is provided on OS/400 through OS/400 command and starting with V5R1 the Operations Navigator (Look up host) interfaces. Figure 7-27 shows an example using the Operations Navigator interface.

![Figure 7-27   Look up hosts](image)

At A you can enter either an IP address to be resolved to a host name or a host name to be resolved to an IP address. In this example we entered yahoo.com and received the IP address as shown at B.

Figure 7-27   Look up hosts
This Operations Navigator interface to the Name Server lookup function shows only basic information in the results of the lookup. It also uses only the DNS lookup Domain name search order as specified in “Host Domain Information window” on page 296, one of the TCP/IP Configuration Properties windows.

The Start DNS Query OS/400 commands (NSLOOKUP or STRDNSQRY) provide the corresponding lookup function, but have the following additional parameter:

- **Domain Name Server**: In addition to defaulting to the TCP/IP Configuration Properties Host Domain Name Information window sequence of domains, you can enter a specific DNS server name or IP address. This could be used when you want to see which DNS server does or does not have the resolved IP address - host name assignment.

### 7.5 TCP/IP servers: examples

Though we cannot provide details on all the various OS/400 Server Job in an Operations Navigator redbook, in this chapter we do provide some additional configuration and management information on the following commonly used TCP/IP servers under the Network -> Servers -> TCP/IP folder:

- OS/400 NetServer servers
- FTP
- Telnet

### 7.5.1 NetServer

The NetServer server must be active for such tasks as file, directory and print sharing, and mapping network drives and functions that depend on these interfaces being active in a Windows Network Neighborhood.

There are some NetServer configuration considerations that affect the iSeries’ participation in this network.

**NetServer configuration overview**

NetServer (formally called AS/400 Support for Windows Network Neighborhood on the Operations Navigator windows) enables an iSeries server to provide file and print serving in a Windows network without the need to install additional hardware or software on the iSeries server. The NetServer server jobs need to be active to.

NetServer uses the Server Message Block (SMB) protocol to communicate with the network. Using this protocol, PC workstations access the NetServer with Windows networking functions without requiring additional software to be installed.

NetServer has been available since V4R2 of the Operating System. It is integrated into the base of OS/400 and is not a part of Client Access Express for Windows. Client Access for Windows 95/NT provides access to iSeries directories and printers with a function called Network Drives and Network Printers. This function was removed in Client Access Express for Windows because the iSeries server provides these functions “naturally” with NetServer.

NetServer offers the following advantages:

- NetServer eliminates the cost of administering multiple servers in your network because the iSeries becomes a single point for software maintenance.
- NetServer reduces the cost of PC software and maintenance because there is no additional software needed on client PCs and no retraining required because it uses standard Windows interfaces.

- No special hardware is needed, NetServer uses iSeries processor, disk and LAN adapters. Using NetServer as a network print server takes advantage of iSeries disk space to spool print jobs to a shared output queue configured for a network attached printer.

- Because NetServer is managed with Operations Navigator, there is a simple, graphical way to administer iSeries file and print shares.

- NetServer simplifies network backup and recovery procedures, because all save/restore is done on the iSeries server. There is no need to back up individual PCs in the network.

- NetServer uses iSeries user profiles and security. There is no need to learn an additional operating system to take advantage of native file and print serving capabilities on the iSeries server.

- NetServer supports clients that use different language code pages, but need to share the same text file. In V4R4 and later, NetServer allows you to do file data text conversion on the fly.

**NetServer and Operations Navigator**

We recommend that you have NetServer running for proper Operations Navigator functionality. Operations Navigator also provides the interface for working with NetServer. There is no command line interface for NetServer on the iSeries server, with one exception. Beginning with OS/400 Version 4 Release 4, NetServer can be started with the OS/400 command:

```
STRTCPSVR SERVER(*NETSVR)
```

You can stop NetServer with the command:

```
ENDTCPSVR SERVER(*NETSVR)
```

It is possible to do some of the configuration and administration by calling the OS/400 APIs for NetServer. This is cumbersome and not described in this book. The Operations Navigator Network->Servers->TCP/IP folder provides access to the NetServer server as shown in Figure 7-28).
As shown in the context menu, you are provided with several menu actions:

- **Open**: Shows the currently active sessions to NetServer in two sub folder groups - Shared Objects and Sessions
- **Start**: Start the NetServer and associated server jobs
- **Stop**: Stop the NetServer and associated server jobs
- **Reset and Start**: Reset configuration parameters and start the NetServer and associated server jobs
- **Server Jobs**: View and manage the associated NetServer jobs
- **Status**: View activity statistics at the NetServer server level
- **Disabled User Ids**: View and re-enable user IDs that become disabled during normal operation
- **Create a Short Cut**: Creates a shortcut on your desktop to the NetServer folder
- **Properties**: View and change some of the NetServer properties

We discuss the significant Netserver specific context menu actions in the next several topics.

**Open**

Selecting **Open** from the context menu, or simply double-clicking NetServer, a window similar to the one shown in Figure 7-29 appears.
The initial window shows the compressed left pane hierarchy tree with just the two Shared Objects and Sessions folders. In this example we have expanded each folder so you can see in the left pane, files that are shared, printers that are shared, and currently active sessions to NetServer. We also show the context menus for a printer share (1), a file share (2), and an active session (3).

We do not describe every context menu action item shown in Figure 7-29 as there are many lower level context menus, depending on which actions you take from the menus shown in Figure 7-29. There are several context menu action item paths to the same information or function under NetServer. We generally summarize the functions available under the two primary NetServer folders:

- **Shared Objects:** Allows you to work with both file and printer shares on your iSeries server. Folder functions include:
  - Viewing all current file and printer shares on your iSeries server
  - Creating new printer or file shares
  - Viewing an existing shares properties, such as its name, description, access type and maximum number of users
  - Stopping file and printer shares
  - Viewing computers and corresponding user IDs using a particular share as well as the status of this connection (such as time connected)
  - For file shares view and change its permissions

- **Sessions:** Allows you to view a list of all computers connected to the NetServer, the user name, and the type of logon. In Figure 7-30 we have selected Sessions in the left pane to show the right pane of information for all the active sessions showing signed on user ID and session type.

For one of the sessions we show the Explore window at 1 and the Properties window at 2.
In the window at 1 you can see the share being used by this session.

Window 2 information includes the current number of sessions from this workstation and number of files opened.

There are other sequences that display the same information shown in our examples.

**Tip:** You can also access the NetServer configuration window through the File Systems branch of Operations Navigator by selecting **File Systems -> File Shares-> Open NetServer**. Chapter 8, “File Systems component” on page 335, further discusses file sharing using OS/400 NetServer support.

**Configuration**

Selecting **Configure** starts the NetServer Configuration Wizard, which leads you through a series of screens to define the parameters of your NetServer shares. The selections on the panels presented are used to define values in Properties windows we discuss later in this topic.
We show one wizard window in Figure 7-31 that highlights a new for V5R1 NetServer function. Starting with V5R1 an iSeries administrator can configure NetServer so that it can be the log on server for multiple Windows Network Neighborhood clients in the network. When configured to be the log on server, the iSeries can used to authenticate logging onto Windows which can provide home directory and log on scripts to the Windows user. Additionally Windows user profiles can be stored and retrieved from the iSeries server.

With this support, a Windows NT or Windows 2000 server is not required in the network to provide these functions.

**Status**

Selecting **Status** from the NetServer context menu, you see the display shown in Figure 7-32. This status window displays the current statistics for all NetServer activity, with options to refresh the Statistics, set up a timed refresh, or reset all the statistics back to zero.
**Disabled User IDs**

Selecting **Disabled User IDs** from the context menu lets you view OS/400 user IDs that may be disabled from NetServer access due to excessive invalid signon attempts. These IDs will be disabled only for NetServer resource access — they will still be able to access the iSeries server through 5250 screens, Operations Navigator, or other application interfaces. Starting in V5R1 you may obtain a list of IDs which have been revoked from NetServer through the selection of this function as shown in Figure 7-33.

![Figure 7-33 Disabled IDs for NetServer](image)

Select the user ID and re-enable this ID for use with NetServer. The makes managing NetServer user IDs much easier than in previous OS/400 releases.

**Properties**

If you select **Properties** from the context menu shown in Figure 7-28 on page 324, you can view the current NetServer settings. A NetServer administrator can change some of the NetServer properties if they need to be different from the original configuration setup.

There are three windows for General and Advanced properties, and WINS Configuration. Each page also has a Next Start button to change the current settings after the NetServer is stopped and started.

- General properties, shown in Figure 7-34 define how your NetServer is represented to your windows network, including your server name and domain information.
- Advanced properties (Figure 7-35) define your connection control parameters. A guest user profile may be specified to allow windows users to access shared resources without requiring an iSeries user profile and password.
- WINS configuration allows the iSeries to reference a primary and secondary WINS server, defined in the panel shown in Figure 7-36 on page 330.

General NetServer properties include NetServer name, domain, and network log on role. By using the Next Start button you get the window shown at 1 in Figure 7-34.
Chapter 7. TCP/IP network

Figure 7-34  NetServer properties

Note the Start when TCP/IP starts parameter and the Server name and related check box to set the NetServer names that will be recognized on this iSeries server. The Q in front of the system name is a good idea. The NetServer name being different than your iSeries server “host name” is sometimes required. See the tip at the end of this topic for more information.

The Advanced properties window lets you see the current NetServer Guest user ID, if one exists. By using Next Start you get a window shown at 1 in Figure 7-35.

Figure 7-35  Advanced properties

In the Advanced Next Start window you can specify a guest user ID (for PC workstations with IDs that do not have corresponding OS/400 user ID). You can also override defaults for Coded character set ID and some “idle time” actions.

Note also the Reset to Current button. Use this if you start changing various values and then decide not to make the changes.

The WINS properties windows shown in Figure 7-36, enables viewing and optionally changing WINS servers.
NetServer configuration tips

The following are simple, but important tips for running Netserver on an iSeries server:

1. NetServer must be restarted in order for any property changes to take effect.

2. Consider keeping the iSeries host server name and its NetServer name different from each other. In most cases, a client workstation can easily find and access NetServer functions. We recommend the iSeries server itself and the NetServer have similar, but separate names. This minimizes possible conflicts different client applications may have in resolving to the iSeries itself or to NetServer.

In Figure 7-34 we show a typical naming convention, naming the NetServer Qas25 on the system named As25. You can choose any meaningful name. In networks using Domain Name Service name resolution, ensure both names are in the network DNS database.

In some networks, you may need to use some support independent of DNS. This support is typically Microsoft’s Windows Internet Name Service (WINS) or you may need to specifically enter the NetServer name into a client workstation’s configuration file, such as LMHOSTS.

For additional NetServer information refer to:

- The AS/400 NetServer Advantage, SG24-5196, for detailed NetServer configuration information, if your client workstations have trouble finding the NetServer


7.5.2 Configuring the FTP server

As can be done with most TCP/IP Servers, select Properties from the context sensitive menu of the FTP server. The General, Mappings and Initial Formats panels are presented, allowing you to tailor your FTP server parameters. We show these panels in Figure 7-37, and the corresponding OS/400 Change FTP Attributes (CHGFTPNA) command parameters in Figure 7-38 on page 332.
Figure 7-37  FTP server properties

In the General properties window you view and specify “Start when TCP/IP starts”, the number of FTP servers to initially start, which subsystem the FTP functions should run in (defaults to subsystem QSYSWRK), and if Secure Sockets Layer (SSL) is to be used.

**Important:** Do not check this SSL option without first reading the **Important** box on page 294.
In the Mappings properties window you can view and specify the ASCII character code set to use and the EBDIC character code values to use for new database files received onto this iSeries server.

In the Initial Formats properties window you can view and specify the file naming format, and directory format the FTP session uses by default for every FTP session. These defaults can be temporarily overridden with FTP commands entered during the session.

Figure 7-38 which shows the OS/400 Change FTP Attributes (CHGFTPA) command parameters that correspond to the Operations Navigator property windows parameters.

<table>
<thead>
<tr>
<th>Change FTP Attributes (CHGFTPA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type choices, press Enter.</td>
</tr>
<tr>
<td>Autostart servers ............ *YES *YES, *NO, *SAME</td>
</tr>
<tr>
<td>Number of initial servers ...... 3 1-20, *SAME, *DFT</td>
</tr>
<tr>
<td>Inactivity timeout ............ 300 0-2147483647, *SAME, *DFT</td>
</tr>
<tr>
<td>Coded character set identifier 00819 1-65533, *SAME, *DFT</td>
</tr>
<tr>
<td>Server mapping tables:</td>
</tr>
<tr>
<td>Library ..................</td>
</tr>
<tr>
<td>Name, *LIBL, *CURLIB</td>
</tr>
<tr>
<td>Library ..................    Name, *LIBL, *CURLIB</td>
</tr>
<tr>
<td>Initial name format ........... *LIB *LIB, *SAME, *PATH</td>
</tr>
<tr>
<td>Initial directory ............ *CURLIB *CURLIB, *SAME, *HOMEDIR</td>
</tr>
<tr>
<td>Initial list format ........... *DFT *DFT, *SAME, *UNIX</td>
</tr>
<tr>
<td>New file CCSID ............... *CALC 1-65533, *SAME, *CALC...</td>
</tr>
<tr>
<td>Subsystem description ......... QSYSWRK Name, *SAME, *DFT</td>
</tr>
<tr>
<td>Library ..................    QSYS Name</td>
</tr>
<tr>
<td>Allow secure sockets layer ... *YES *SAME, *YES, *NO, *ONLY</td>
</tr>
<tr>
<td>F3=Exit  F4=Prompt  F5=Refresh F12=Cancel  F13=How to use this display</td>
</tr>
<tr>
<td>F24=More keys</td>
</tr>
</tbody>
</table>

Figure 7-38   CHGFTPA parameters

### 7.5.3 Configuring the Telnet server

As can be done with most TCP/IP Servers, select **Properties** from the context sensitive menu of the Telnet server. The General, Mappings and Initial Formats panels are presented, allowing you to tailor your Telnet server run time environment.
Some of the parameters are similar to those shown for the FTP server in 7.5.2, “Configuring the FTP server” on page 330.

**Important:** Do not check this SSL option without first reading the **Important** box on page 294.

Other parameters on the System Sign-On and Time-Out windows affect not only the 5250 Telnet sessions but all 5250 sessions on the system. These parameter values shown are from the value in a corresponding OS/400 system value.
Attention: The example Properties windows shown are for an Operations Navigator session signed on user with Privilege class Security officer or Security Administration. These classes correspond to the OS/400 user profile command interface User Class *SECOFR or *SECADM values respectively. If you change one of these 5250 session values on these Telnet server Properties windows, the corresponding OS/400 system value is changed immediately after clicking OK.

If you have insufficient authority, the 5250 session values are shown “greyed out” and you cannot change them.

The Telnet Properties windows have corresponding parameters on the OS/400 Configure Telnet Server (CFGTCPTELN) command, which is not shown in this chapter.

7.6 Additional information

For specific network topics, we provide references to additional documentation. Refer to following sources for overall iSeries networking support documentation:

- Information Center: http://www.ibm.com/eserver/iseries/infocenter
  - Select Networking-> list of topics to choose, including:
    - Windows Server on iSeries
  - Select iSeries Supplemental Manuals -> Communications, TCP/IP, Networking -> list of manuals, including:
    - OS/400 TCP/IP Configuration and Reference, SC41-5420
    - Client Access Express for Windows - Setup, SC41-5507

- Redbooks at http://www.ibm.com/redbooks
  - Select Redbooks Online -> iSeries and AS/400 -> Redbooks -> list of books to choose, including:
    - TCP/IP Tutorial and Technical Overview
    - IBM @server iSeries Wired Network Security: OS/400 V5R1 DCM and Cryptographic Enhancements, SG24-6168
    - V4R4 TCP/IP for AS/400: More Cool Things Than Ever, SG24-5190
    - The AS/400 NetServer Advantage, SG24-5196
    - AS/400 TCP/IP Auto configuration: DNS and DHCP Support, SG24-5147
    - AS/400 Internet Security: IBM Firewall for AS/400, SG24-2162
    - AS/400 Internet Security: Implementing AS/400 Virtual Private Networks, SG24-5404
    - AS/400 Internet Security: Developing a Digital Certificate Infrastructure, SG24-5659
    - Direct Attach xSeries for the IBM @server iSeries Server, SG24-6222

File Systems component

This chapter describes the functions of the File Systems component of Operations Navigator and covers the following features:

- Operations within the Integrated File System
- Enhanced QSYS.LIB support
- Java Integration
- Journalling from within Operations Navigator
- File Shares
- Integrated File System and File Shares examples
8.1 General File System operations

The File Systems component of Operations Navigator allows you to view and manage files systems and file system objects supported by the OS/400 Integrated File System and supports Windows operating system-like file shares.

This component is installed through either Client Access Express Full or Custom installation. If this component is not installed on your workstation you can install it by running Selective Setup as discussed in “Selective setup” on page 60.

Expand the File Systems component in the left hierarchical tree as shown in Figure 8-1 to get the two primary File Systems folders:

- **Integrated File System**: The Integrated File System folder enables you to work with the various file systems under the IFS and the objects within each file system. You can create or change NetServer file shares, and manage security of the integrated file system objects.

- **File Shares**: The File Shares folder enables you to work with existing NetServer file shares and also provides a quick way of mapping network drives to them.

![Figure 8-1  The File Systems component of Operations Navigator](image)

Throughout this chapter, we assume that you are familiar with the basic concepts of the Integrated File System. If this is not the case, good sources of Integrated File System information are:


- *Integrated File System Introduction*, SC41-5711
8.1.1 Integrated File System

The Integrated File System (IFS) folder provides a Windows Explorer style view of file supported file systems on the iSeries server. You can use Operations Navigator to manage the contents of each file system in the same way that you can manage the files on your PC using Windows Explorer. For example, you can create, delete, and rename directories or folders, and move files to and from your PC and within the system using drag-and-drop.

Many of the tasks you can perform here are equivalent to taking actions within the OS/400 Work with Object Links (WRKLNK) command through a 5250 session. However, the Operations Navigator graphical user interface (GUI) makes these tasks much quicker and easier to perform.

In Figure 8-2 we have expanded the Integrated File System folder in the left pane to show the supported file systems in the left pane and selected the Integrated File System folder to get corresponding information in the right details pane.

This list of file systems may vary between iSeries servers depending on the licensed programs installed. You can see the standard OS/400 file systems - QSYS.LIB and the Document Library System QDLS. Some of the file systems may be shown with a hand symbol under them (Root in our example) indicating that they are being shared on the network using AS/400 NetServer (we use “NetServer” in this chapter).

![Figure 8-2 The Integrated File System view](image)

As shown in Figure 8-2, we right-clicked the Root directory to show an example of the context menu for that directory.

**Note:** The context menu presents the same actions, regardless of the file system you select. The success of the action you choose depends on the rules governing the specific file system. For example, if you try to *paste* a file into the QOPT file system, it fails because QOPT is a read-only file system. The QOPT file system represents the CD ROM (OPTical) device on the server. Detailed information on the rules governing each file system can be found in the *Database and File Systems* section of the Information Center.
The actions available form the context menu are listed as follows:

- **Explore**: This displays the contents of the selected file system in the right hand (details) pane. This is the default option, and is the same as selecting (left-clicking) on the file system in the hierarchy tree or double-clicking on the file system in the details pane.

**Note**: To access the QDLS file system, the current user must be enrolled in the system distribution directory. To enrol a user, use the **ADDDIRE** command from the Run Command function or a 5250 screen.

- **Open**: This option is the same as Explore except the contents of the file system are displayed in a new window.

- **Create Shortcut**: This creates a shortcut icon for this file system on the Windows desktop. Refer to “Shortcuts and desktop icons” on page 97 for more details.

- **Include**: This option allows you to only show items in the details pane that match certain criteria. For more information, see 8.1.4, “Using the Integrated File System Include option” on page 345.

- **New Folder**: Selecting New Folder allows you to create a new folder (an OS/400 library in QSYS.LIB) in the selected file system. The folder name must conform to the file system standards - for example, in QSYS.LIB the folder name must end in.LIB and in QDLS the folder name must be eight characters or less.

- **Paste**: The paste option allows you to place the contents of the Windows clipboard into the selected file system. Items are placed into the Windows clipboard by performing a copy or cut option within the workstation session. If the paste option is unavailable (greyed out), this means the Windows clipboard is empty or contains non-file system data (for example a graphic image).

- **Permissions**: This opens a dialog box enabling you to view and define security permissions for the file system. This chapter gives some overview information on using the Integrated File System interface to assign permissions to iSeries files and other objects. At 8.3.8, “Using the Integrated File Systems interface to assign object permissions” on page 360, we show an example of assigning permissions to an Integrated File System object.

*Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227*, discusses object permissions in the context of total iSeries security capabilities.

- **Sharing**: The Sharing option allows you to create new or modify existing NetServer shares for this file system. More information on NetServer can be found at “NetServer configuration overview” on page 322. This option is not selectable if the user does not have System privilege “System configuration” (*IOSYSCFG special authority).

- **NFS Export**: This enables you to define the selected file system as a new Network File System (NFS) Export. If the file system has already been exported, you can view or change the properties, or remove it altogether from the list of NFS exports. This option is not selectable if the current user does not have System privilege System configuration (*IOSYSCFG special authority). For more information on NFS, refer to the redbook *Exploring NFS on AS/400*, SG24-2158, or use Information Center, with search word NFS.

- **Properties**: The properties option will display information regarding the selected file system including the disk pool it is stored in, the number of objects, the space allocated and other information. There is significantly more information available in V5R1 than has been available in previous releases.
8.1.2 Directories, folders and libraries

You can review the contents of a file system by either expanding the folder in the left pane or selecting the file system to get the contents displayed in the right details pane.

The information is displayed in a hierarchical manner. In Figure 8-3, we show in the left pane a portion of the tree structure for all the file systems with the Root file system expanded. In the left pane we have scrolled down to show the last of many directories within the Root directory and the other file systems on As01, including the QSYS.LIB file system.

We had earlier selected the Root file system directory to also list the folders within the right pane. We have already scrolled down the right pane list to show some of the same Root directory folders in both the left and right panes, for example folders ONLabSQL_830 and porteri.

In this example we also show the context menu for a directory within the Root file system. The description for files within the IFS is obtained from the Windows details for the file extension. The description for files within QSYS.LIB is obtained from the OS/400 file type.

As Figure 8-3 shows, you can perform the same actions on a directory, library or folder within a file system as you can on the file system itself. There are also additional options, as follows:

- **Delete**: As the name implies, this option will delete the selected item from the system.
- **Rename**: This enables you to rename the selected item.
- **Cut**: This option will place the item into the Windows clipboard. When you paste the item elsewhere, it will be deleted from its original location.
- **Copy**: This option will place a copy of the item into the Windows clipboard. The item will remain in its original location even when pasted elsewhere.
- **Send**: Selecting send will allow you to send the selected item(s) to another system using Management Centrals packages and products functions. We overview Packaging support in 2.2.12, “Packages and Products” on page 35. In 8.3.7, “Sending file system objects to..."
another iSeries server” on page 358, we show an example of sending QSYS.LIB objects. For more information on packages and products refer to Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products, SG24-6564.

- **Journaling:** Starting in V5R1 you can now configure journaling from within Operations Navigator for files and folders within certain file systems and QSYS.LIB. For more information refer to “Journaling” on page 344.

### 8.1.3 Files

When working with stream files in the Integrated File System or physical file members in the QSYS.LIB file system, the options available are identical to those available at the folder level, with the addition of the Edit option. See Figure 8-4 for an example. The Edit option is only available for those files that have their extensions registered within Windows with an associated file type of Text Document. Such documents are usually associated with Notepad by default. An example of how to register members of database files - MBR files is shown in Figure 8-5. You do not need to register MBR files, this is only shown as an example.

![Figure 8-4   Working with a stream file in the Integrated File System](image-url)
You can enable editing for all files within the IFS if you wish, by changing the properties from the context menu for the Integrated File System component (shown in Figure 8-6). Within this properties window there are two options to allow you to work with text files. The bottom section for the window allows you to choose between being able to edit only text files within the IFS or being able to edit all files within the IFS. In the top section of the window you can specify file extensions to allow automatic conversion between EBCDIC and ASCII when transferring or copying the files between the iSeries server and your PC workstation. New starting in V5R1, you can perform mixed Coded Character Set Identifier (CCSID) for EBCDIC to ASCII file data conversions.
When using the Edit option, a window is displayed with the contents of the stream file or file member for editing as shown in Figure 8-7. From here you can edit the text and save the file or member back to the IFS.

![Figure 8-7 Editing the contents of a file member](image)

**QSYS.LIB support**

While the File Systems component interface to QSYS.LIB libraries and objects is very similar to the interface with other file systems there are some differences worth noting.

**Working with objects in an OS/400 library**

You can work with an OS/400 libraries objects from either the left pane or right pane.

When expanding an OS/400 library in the left pane, the list contains only database object types, including tables (files), views, logical files, SQL indexes, and so on.

When selecting that same library, all object types are displayed in the right pane. This makes it very easy to select objects for packages and to assign permissions (authorities) to these objects through the Operations Navigator interface.

**Copy and paste, drag-and-drop**

Prior to V5R1 Operations Navigator provided limited support for accessing QSYS.LIB files and members. V5R1 Operations Navigator provides increased QSYS.LIB support and lifts a number of previous restrictions. You can now copy/paste, and drag / drop objects within QSYS.LIB libraries You can also copy selected objects, such as physical files, to the IFS. These operations can be performed even on iSeries servers with previous releases of OS/400.
Table 8-1 summarizes the copy and paste (under the Integrated File System interface this is same as drag-and-drop) of objects between OS/400 libraries on the same iSeries using the V5R1 level Integrated File Systems interface to QSYS.LIB objects.

<table>
<thead>
<tr>
<th>Source Library Object Type</th>
<th>Target Library Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program, display file, printer file, subsystem job description, and more.</td>
<td>Object in library. Signed on Operations Navigator session user is owner. Source library owner has full access rights. The object remains unchanged in the source library.</td>
</tr>
<tr>
<td>Database file/table a</td>
<td>Object in library. No data copied. Signed on Operations Navigator session user is owner. Source library owner has full access rights. The object remains unchanged in the source library.</td>
</tr>
<tr>
<td>Database file member a</td>
<td>Member in library. File/table must already exist in target library. The object remains unchanged in the source library.</td>
</tr>
<tr>
<td>Job queue</td>
<td>Object in library. Any jobs on source library queue not copied. Signed on Operations Navigator session user is owner. Source library owner has full access rights. The object remains unchanged in the source library.</td>
</tr>
<tr>
<td>Message queue</td>
<td>Object in library. Any message on source library queue not copied. Signed on Operations Navigator session user is owner. Source library owner has full access rights. The object remains unchanged in the source library.</td>
</tr>
<tr>
<td>Data queue</td>
<td>Copy not supported - error message</td>
</tr>
</tbody>
</table>

a. Database only objects can be copy/pasted, drag/dropped, and cut/pasted between QSYS.LIB libraries via the Database -> Libraries folder interface. When using this Database component the results are slightly different than when using similar copy/paste and drag/drop functions under the IFS interface:

- **Copy/paste**: The target library contains the object and for a table contains the member and data. The Operations Navigator session user is the owner of the object in the target library. Source library object owner retains full authority.
- **Cut/paste**: This is essentially a “move operation”. The source library object is deleted and the object and data copied to the target system. The Operations Navigator session user is the owner of the object in the target library. Source library object owner retains full authority.
- **Drag/drop**: This is essentially a “move operation” with the object removed from the source library and placed into the target library containing the object. The Operations Navigator session user is the owner of the object in the target library. Source library object owner retains full authority.

**Restriction**: You cannot copy or move objects from QSYS.LIB between iSeries servers using the Integrated File Systems components.

For any IFS object, you can copy these objects between systems by defining a package and sending that package to another iSeries server. We overview Packaging support in 2.2.12, “Packages and Products” on page 35. In we show an example of sending files to another iSeries from the Integrated File Systems interface to packaging support. For more complete packaging support details, refer to Managing OS/400 with Operations Navigator V5R1, Volume 4: Packages and Products, SG24-6564.
Java integration

New starting in V5R1 is the ability to work with java files from the IFS. When displaying the context menu for a java file (*.jar, *.zip, *.class, *.java), a number of additional options appear, as shown in Figure 8-8. There are also additional tabs in the properties window relating to java files as shown at in Figure 8-8.

Figure 8-8   Working with Java files in the Integrated File System

The additional options displayed in the context menu for java files are as follows:

- **New Java Program:** The New Java Program option allows you to create a Java program based on the Java class file, JAR or ZIP file. This resulting program object will be associated with the file you have selected and will contain an optimized version of the code. If you do not take this option, the first run of the Java code will run more slowly due to the optimization being performed at runtime. Subsequent runs will use the optimized code and run more quickly.

- **Change Java Program:** This option will allow you to change the attributes of the Java programs attached to the selected file.

- **Delete Java Program:** This option deletes the program attached to the selected file.

- **Run Java Program:** This will run the Java program associated with the file. If you have not created the program using the New Java Program option, the program is created and then run.

Additionally, if the file has a.java extension, you can:

- **Compile Java Program:** This option compiles the Java program using the Java compiler on the iSeries server. You can select a Java Development Kit version and classpath to use from the resulting dialog box.

Journaling

Starting with V5R1 Operations Navigator, you can start and stop journalling of files and folders within the Root, QOpenSys and User-Defined File Systems, and physical files within QSYS.LIB. Figure 8-9 shows an example of journalling a folder in the Root file system.
Within Root, QOpenSys and User-Defined File Systems, you can journal entire folders or individual files. The “journal before images” option is not available within these file systems. For more information regarding journaling, particularly for QSYS.LIB objects, refer to Advanced Database Functions and Administration on DB2 Universal Database for iSeries, SG24-4249. This book contains detailed examples of V5R1 Operations Navigator interfaces to iSeries database functions.

8.1.4 Using the Integrated File System Include option

The Include function from the context menu and menu bar Options -> Include should be considered when viewing large libraries and folders or to enable you to work with a particular subset of a library or folder. In the example in Figure 8-10, we are viewing objects within the Root file system that end with the letter ‘e’. The default include criteria is "*.*" (or *.lib for QSYS.LIB) which will include all files/folders. New in V5R1, the include criteria is preserved after refreshes and will remain until the filter is set back to a blank value or *.*, and the Include dialog box remembers the previous 10 Include criteria in a drop-box as shown in Figure 8-10.
8.1.5 Creating a User-Defined File System (UDFS)

User-Defined File Systems (UDFS) are file systems created by a user in the auxiliary storage pool (ASP) of their choice. They are used infrequently, but offer an alternative to the IBM-supplied file systems when the user needs unique file system attributes.

The user defines the attributes of the file system, when it is created. They also specify the systems location within the Integrated File System, when it is mounted.

Creating a UDFS using Operations Navigator is easy if you know where to look. Since a UDFS resides in an auxiliary storage pool, expand the tree view of File Systems by clicking **Integrated File System->Root->dev** (device folder). Then, right-click a QASP0n pool (where n represents the ASP number) and select **New UDFS** from the context menu. This is illustrated in Figure 8-11.

**Note:** If you are not familiar with auxiliary storage pool support, refer to **OS/400 Backup and Recovery, SC41-5304**, for a complete description.
Figure 8-11 Creating a User-Defined File System

The dialog box allows you to define a name for the UDFS, a description and an auditing value. You can also specify a default file format and decide whether or not to make the file names case sensitive. After creation, these attributes cannot be changed. When you fill out the fields and click OK, the UDFS is created. This is equivalent to using the OS/400 Create User-Defined FS (CRTUDFS) command.

To view a UDFS in an ASP, you open the appropriate QASP0x directory. By right-clicking a UDFS and selecting Mount, you can mount the selected UDFS over an existing directory in the Integrated File System. This is equivalent to using the OS/400 Add Mounted FS (MOUNT) command.

A UDFS has to be mounted before you can store files in it or retrieve files from it. When mounting a UDFS, you only need to specify the directory to mount over and whether the file system should be Read only or Read/write when mounted. An example is shown by using the context menu in Figure 8-12. Another method of mounting a UDFS is simply to drag-and-drop it over the directory that you want it mounted over, as shown in Figure 8-13.

Once a UDFS is mounted, when users display the directory that the UDFS has been mounted over, they no longer see its former contents. Instead, the directory now contains the contents of the UDFS that was mounted. It performs just like any other branch of the Integrated File System (within the limits of the attributes on the UDFS).

To unmount a UDFS, right-click it, and select Unmount from the context menu. This is equivalent to using the OS/400 Remove Mounted FS (UNMOUNT) command.
Figure 8-12  Mounting a User-Defined File System

Figure 8-13  Drag-and-drop method of mounting a User-Defined File System
8.2 File Shares subcomponent

The File Shares subcomponent of File Systems allows you to perform certain functions associated with As/400 NetServer file shares. As/400 NetServer (called NetServer in this document) is covered in “NetServer configuration overview” on page 322 and allow you to share out iSeries and AS/400 files and printers. The File Shares subcomponent of Operations Navigator only allows you to manage the file shares.

As shown in Figure 8-14, selecting File Shares shows you a list of the current NetServer file shares in the details pane. The context menu for File Systems also allows you to open the NetServer administration window.

The context menu for the listed file shares allows you to choose from the following options:

- **Open**: This displays the contents of the selected share in a window.
- **Explore**: This displays a normal Windows Explorer view of the file share.
- **Map Network Drive**: As shown in Figure 8-15, this allows you to map a Windows network drive to the file share, similar to the map network drive option from the tools menu in Windows Explorer.

**Restriction**: When using Window 95/98/Me, you can only map a network drive using the same user ID that you signed onto the PC workstation with. If this does not match the iSeries user ID, you will need to enable guest access for NetServer to allow these users to connect. For more information, refer to *The AS/400 NetServer Advantage*, SG24-5196.

- **Properties**: This displays the properties tab for the share, allowing you to specify details regarding extensions for EBCDIC to ASCII conversion, the read only or read/write attributes for the share, the number of users permitted to access the share, and simple
and complex file text conversions using different CCSID’s. Further information can be found in “NetServer configuration overview” on page 322.

Note: The AS/400 NetServer does not need to be started to view the files shares available or their properties, but to view the contents of the file shares or map a network drive, NetServer must be started. For details on starting NetServer, refer to “NetServer configuration overview” on page 322.

8.3 File system hints and tips

This section guides you through using the File Systems component of Operations Navigator to perform some simple tasks including:

- Creating a new directory in the Root file system
- Copying files and folders from a PC to an iSeries server
- Sharing a directory on the network using AS/400 NetServer
- Mapping a network drive to a NetServer file share
- Stopping a directory from being shared on the network
- Creating a library and database file in file system QSYS.LIB
- Sending file system objects to another iSeries server (This shows a simple example of the capabilities of the Operations Navigator Packages and Products component, which must be installed to perform the functions shown.)
Assigning permissions to a file system object. (This gives a snapshot view of Operations Navigator permissions support. For positioning object authorities (permissions) with other iSeries security facilities, refer to Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227.

Throughout this section, you need to be signed on to the iSeries or AS/400 system using a user profile with sufficient authority to perform each task.

### 8.3.1 Creating a new directory

Using Operations Navigator to create a new directory called "EXAMPLEDIR" within the Root file system is as easy as using Windows Explorer to create a new directory on your PC. Follow these steps:

1. Open Operations Navigator, and expand the tree view for your system. Explore the file systems by clicking the Integrated File System folder of File Systems in the tree view.
2. Right-click the Root file system, and choose New Folder from the context menu. In the dialog box that opens, enter the name of the new directory that you want to create (which is EXAMPEDIR in this case). Then, click the OK button (Figure 8-16).

![Figure 8-16 Creating a new directory in the IFS](image)

The new directory has now been created, and you can view it by exploring the Root file system.

### 8.3.2 Copying files and folders from the PC to the iSeries server

You can copy PC files or folders to the iSeries server using drag-and-drop or the copy-and-paste edit features of the Windows operating system. To do so, follow these steps:

1. Open Windows Explorer, and select the files and/or folders that you want to copy to the iSeries server. Right-click the selected files, and choose Copy from the context menu to copy them to the clipboard, as shown in Figure 8-17.
2. Right-click the destination directory (EXAMPLEDIR in this example) within Operations Navigator. Choose Paste from the context menu. The clipboard contents are copied to the iSeries server, as shown in Figure 8-18.
8.3.3 Sharing a directory on the network using AS/400 NetServer

By sharing an iSeries directory on the network using NetServer, you allow other Windows users to access the directory and its contents. Follow these steps to share a directory ("EXAMPLEDIR" in our example) on the network:

1. Right-click the directory, and choose **Sharing->New Share** from the context menu, as shown in Figure 8-19.

2. In the AS/400 NetServer File Share dialog box, enter a name for the share, a description (if desired), and whether it is going to allow **Read only** or **Read/Write** access. If you want the share to be hidden when users are browsing the network, end the share name with a $ (dollar) symbol, as shown in Figure 8-20. Then click **OK** to enable the new file share.

![Figure 8-19  Sharing a directory from the IFS on the network using NetServer](image1)

![Figure 8-20  Defining the properties of the new file share](image2)
8.3.4 Mapping a network drive to an AS/400 NetServer file share

To save PC files to a directory on the system, or even to open existing files stored on the system using your PC, you first have to map a network drive to the AS/400 NetServer file share for that directory. For example, to open the files that were copied to the EXAMPLEDIR directory in 8.3.2, “Copying files and folders from the PC to the iSeries server” on page 351, we must map a network drive to the file share created in 8.3.3, “Sharing a directory on the network using AS/400 NetServer” on page 353. This is how we can do it using Operations Navigator:

1. Click File Shares in the tree view of Operations Navigator to display the existing NetServer file shares on the system, as shown in Figure 8-21.

![Figure 8-21 The list of NetServer file shares](image)

2. Right-click the relevant file share in the list view (EXAMPLEDIR) in our case), and choose Map Network Drive from the context menu, as shown in Figure 8-22.

3. Choose which available drive letter you want mapped to the file share. Also, decide whether you want the drive to Reconnect at logon the next time the PC reboots, as shown in Figure 8-22. Then click OK to map the drive.

Tip: If you are using Microsoft Window NT or 2000, you can specify the user name and password that you wish to use to connect the mapped drive. Windows 95/98/Me do not offer this capability.
You can now open or explore the mapped drive and access the directory as if it was local to the PC, as shown in Figure 8-23.

8.3.5 Stopping a directory from being shared on the network

If you no longer want a particular directory to be shared on the network using NetServer, you can remove the file share in one of two ways as follows:
Stopping file shares using NetServer

1. Right-click the File Shares folder of File Systems, and choose Open AS/400 NetServer from the context menu, as shown in Figure 8-24.

![Figure 8-24 Opening AS/400 NetServer from within File Shares](image)

2. Within the NetServer configuration window, right-click the relevant Shared Object (EXAMPLEDIR$ in this case), and choose Stop Sharing from the context menu, as shown in Figure 8-25.

![Figure 8-25 Using NetServer to stop sharing a directory](image)

Stopping file shares from the shared folder

1. From within the IFS, locate the directory/folder that you wish to stop sharing. In this case, it is EXAMPLEDIR in the Root file system. Right-click on the folder to display the context menu, and select Sharing, then click Stop Sharing as shown in Figure 8-26.
2. You will now see a dialog box prompting you to select the shares to stop sharing for the
folder, as shown in Figure 8-27. If you have multiple shares over the same folder, you can
choose between them. Highlight the folder you wish to stop sharing (in this case
EXAMPLEDIRS) and click OK.

8.3.6 Creating a library and file in the QSYS.LIB file system

With Operations Navigator, you can easily create a library or a database file within a library
using the File Systems component. Simply follow these steps:

1. Expand the Integrated File System folder of File Systems to list all file systems on your
system.

2. Right-click the QSYS.LIB file system, and select New Folder from the context menu of
actions. The New Folder dialog box opens and prompts you to enter a name for your new
library.

3. Enter the library name (devstuff.lib, in our example), and click OK to create the library as
shown in Figure 8-28.
Note: The .lib extension must be included to signify that the new object being created is a library. Similarly, if you were creating a new database file, you must specify the .file extension.

Figure 8-28 Creating a library in QSYS.LIB

4. The new library should now be listed under the QSYS.LIB file system when you either double-click QSYS.LIB or click on the adjacent + (plus) sign to expand the tree view. You may need to refresh the screen by pressing the F5 function key.

Note: When creating a library or a file using the Integrated File System folder of File Systems, the object is created with only a basic set of default attributes and authorities (permissions). Because of this, we recommend that you use one of the following methods to create a library, database file, or SQL table:

- OS/400 Create Library (CRTLIB) command
- OS/400 Create Physical File (CRTPF) command
- SQL CREATE TABLE statement

The Operations Navigator Database component, overviewed in 2.2.7, “Database” on page 28 also has a create library function. However, this support does not provide the functional equivalence of the OS/400 CRTLIB command.

8.3.7 Sending file system objects to another iSeries server

You can select any object ("file") within the same file system to send to one or more iSeries servers. You can define the contents of a package through a Management Central -> Definitions -> Packages interface or implicitly through the My Connections -> system name -> Integrated File Systems -> directory name interface. This Integrated File Systems interface has slightly less function than the Management Central Definitions interface.

In Figure 8-29 we show some of the important windows in the sequence of steps to select QSYS.LIB objects to be sent (shown at 1), to select the target iSeries servers (2), and specify save and restore actions (3). In this example we stop at the step where you can elect to send the package “now” or use the Management Central scheduler function (shown at 4).
As you can see in the window at 1, we have selected a variety of objects to be sent (as a package). In the window at 2 you can see we are sending the objects we selected from system As01 to the systems represented by the Management Central system group AS25B_As80.

We show the send options windows, starting at 3, which show the default settings for all parameters. Note the Target release and “save while active” options in the Advanced window.
After ensuring the correct files have been selected and the correct save and restore options have been selected, we can either select **OK** to “save and send now” or **Schedule** to “save and send” at a later time.

You would use **Management Central -> Task Activity -> Packages and Products** and optionally **Management Central -> Scheduled Tasks -> Packages and Products** to determine the success of the send function.

### 8.3.8 Using the Integrated File Systems interface to assign object permissions

You can assign permissions (authorities) at any level of the hierarchy of a file system supported by iSeries - directory, folder, sub folder, file, specific object. The permissions values may be unique for certain file systems or have special considerations, based upon the object type.

As we have previously said, refer to *Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227*, a more complete picture of these security considerations.

Using Figure 8-30, as a reference, we use a folder (ONRBSQL) in the Root directory. This folder contains files of type .sql, each of which contains SQL statements created, tested, and saved through the Operations Navigator Database component's Run SQL Scripts function.

The creator (and owner) of file Pfrm_jtype_qapm is user profile As0301 who also is the currently signed on Operations Navigator user. As0301 wants certain users (but not the general public) to be able to view and run the SQL statements in this file.
Figure 8-30 Assigning permissions to an SQL statements file example

In the Properties window for the SQL file (shown at 1) you can see the owner As0301 has a complete set of permissions, including Write (add statements) and Existence (delete). The general public is Excluded from any use of this file.
We selected Add to add new users. The window shown at 2 is the result of selecting a Users and Groups -> All Users folder and scrolling down to get to the selected Ca20-Ca25 user profiles.

The updated Permissions window at 3 shows the updated list of users explicitly authorized to Read and Execute the SQL statements within the file.

Use the Apply or Cancel buttons to cause the changes just made to take affect or cancel them.

Note the various buttons for additional functions not described in this example, including using an authorization list to secure this object.

**Tips:**

1. The security-based online Help available while you are assigning permissions offers significant assistance in reviewing iSeries security terminology and how different parameter values fit together.

   Considering the online Help and the Integrated File Systems component's graphical interface for object permissions, managing object level security is much easier through Operations Navigator than compared to the OS/400 5250-based command level interface. The Integrated File System interface to database objects supports all levels of permissions to database objects, except column level permissions.

2. The OS/400 DB2 Universal Database for iSeries supports QSYS.LIB file system file (table) and other database object authority (permissions) as well as data access permissions (read, write, execute, and so forth). Column (field) level permissions are also supported.

   You can access column level permissions as well as other database object permissions through the Operations Navigator My Connections -> system name -> Database -> Libraries -> library -> object interface.
Backup component

This chapter describes the functions of the Backup component in Operations Navigator. The following areas are discussed:

- Selecting iSeries components to backup
- Scheduling backup activities
- Managing backup media
9.1 Backup

The Backup component of AS/400 Operations Navigator provides a simple to use graphical interface to the OS/400 Operational Assistant (OA) backup functions. These functions are suitable for simple to moderately complex backup requirements. These functions include scheduling backups (saves) of portions of your AS/400 libraries, database files, and directories on to simple tape device media. Backups can be scheduled daily, weekly, or monthly. Restoring the saved objects is not included because this often requires customer-unique decisions based on the current operating environment.

**Important:** For Restore functions you have to use the 5250 command interface. Refer to *iSeries Backup and Recovery, Version 5, SC41-5304*.

This component is installed through either Client Access Express Full or Custom installation. If this component is not installed on your workstation you can install it by running Selective Setup as discussed in “Selective setup” on page 60.

The target users of the AS/400 Operations Navigator Backup function are customers that today typically use relatively basic backup functions through either or both of the following 5250 interfaces:

- Operational Assistant (GO ASSIST) Backup under “Manage your system, users, and devices”
- The Save and Restore commands: Save and Restore Library (SAVLIB/RSTLIB), Save and Restore Object (SAVOBJ/RSTOBJ), Save Changed Objects (SAVCHGOBJ) command, and Save and Restore Integrated File System Objects (SAV/RST) commands

This function is not intended to replace using Backup Recovery and Media Services/400 (BRMS/400), 5722-BR1, or a similar installed product. It is also not intended for customers that use other complex save strategies.

**Important:** The Backup component will be removed on the PC where the BRMS Plug-in will be installed.

For more Information about the BRMS Plug-in refer to *Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227*.

Selecting the Policies branch of Backup in the tree view of AS/400 Operations Navigator reveals the three IBM-supplied system backup policies in the list view, as shown in Figure 9-1. The policies are provided to help you quickly define and make operational your specific backup requirements.

9.2 Backup policies

To review or change a backup policy, either double-click to select it, or right-click and choose Properties from the context menu. This brings up the backup policies Properties panel shown in Figure 9-2, which contains four pages: General, What, When, and Where.
Information about each of the backup policies (Daily, Weekly, and Monthly) is displayed in the list view, including:

- When the backup is scheduled to run
- Which tape set is to be used the next time the backup is run
- When the backup was last run
- The last tape set used for the backup

**Note:** The AS/400 Operations Navigator Backup component does not provide an option to backup the entire system. The Licensed Internal Code and the QSYS is not saved. You have to enter the `savsys` command on a 5250 command interface to save this.
9.2.1 Properties general page

The General settings page, shown in Figure 9-3, affects all three backup policies (Daily, Weekly, and Monthly) when changes are made to it. On this page, you can:

- Activate or deactivate the backup policy schedule.
- Determine if and when the system operator should be notified prior to the start of a backup. This option can be used, for example, to remind the system operator to insert a tape before leaving the system unattended.

Authority requirement: To activate, deactivate, or modify backup policies, the current user must have System privilege Job control (*JOBCTL) and System privilege Save/restore (*SAVSYS) special authorities.

9.2.2 Policy properties: what to backup

On the What settings page (shown in Figure 9-3), you can define what data to backup. The options are:

- All, None, or Selected User libraries
- All, None, or Selected Folders
- None or All User directories
- OV/400 mail and calendars:
  Note: The OV/400 options are only present if you are reviewing backup policies on an AS/400 system with V4R5 or earlier OS/400 and has OfficeVision for AS/400 licensed program installed.
- Security data
- Configuration data
- All selected data or Changed data only
Settings on the panel shown in Figure 9-4 can be set for each of the three backup policies individually. For example, if you do not want to back up the User directories during the daily backup, check the None radio button on the Daily backup policy, but check the All radio button on the Weekly and Monthly backup policy properties to make sure that these directories are backed up every week.

Libraries and folders can be selected from a list by clicking on the corresponding Browse button and making the appropriate selections on the panels shown in Figure 9-4.
9.2.3 Advanced options

The Advanced Option button shown on the panel in Figure 9-3, allows you to define a user exit program that is called before the backup begins and again after the backup is complete. You can use this, for example, to notify users about the start and end of the backup, or to vary off your Integrated xSeries server for iSeries before the backup begins and vary it back on after the backup completes. This option does not exist in the OS/400 Operational Assistant backup function.

See Figure 9-6 for an example of an exit program that ends and starts the QINTER subsystem. For more information on writing exit programs in CL refer to CL Programming, Version 5, SC41-5721.
Select the Print detailed reports after backup check box (3 in Figure 9-3) if you want a summary printout of your backup. We recommend that you do this when you have implemented a new or significantly changed backup process.

### 9.2.4 Backup policies: when to backup

The When page shown in Figure 9-7, provides check boxes to specify the backup schedule. This schedule affects all three backup policies so only one backup policy has to be changed. Reasonable default settings for the backup schedule are provided. In many cases, these may be sufficient for your needs.

The Operational Assistant rules apply of when the three backup policies can be run. For example, daily backups are automatically deselected on any day of the week that is selected for weekly and monthly backups.

For the Monthly backup, you can specify:
- Day of the week
- Time of the day
- First, second, third, fourth, or last day of the month (this means that if you selected Saturday, the backup runs on the first, second, third, fourth, or last Saturday of the month)

For the Weekly and Daily backups, you can specify:
- Day (or days) of the week
- Time of the day
9.2.5 Backup policies: where to backup

The Where page of a backup policy's properties (Figure 9-8) has to be changed for each of the three backup policies. Here, you can specify where your data is backed up. Tape drives are the only supported devices for the backup function. All available tape drives in your AS/400 system are automatically displayed, and you can choose up to four drives to be used from this list.
If you are using different tape sets for the daily, weekly, and monthly backup, and you want them to be used rather than the mounted tape, you can define them here. You can use up to seven tape sets in rotation. These sets are used in the specified order. The Target tape information radio buttons determine whether the mounted tape or one of the tape sets is used.

To add a tape set to the Tape sets to rotate list, type a four-character name for the tape volume set in the Add tape set box. Then click Add. The system generates the tape volume IDs for the backup by using the four-character name you specified followed by a sequential number beginning with 01.

To remove a tape set from the Tape sets to rotate list, select one or more tape sets you want to remove and then click Remove.

**Tip:** Select the Erase tape before backup option 1 in Figure 9-8 if you want the tape to be initialized before it is used.

For more information about backup and recovery of your system, refer to these sources:

- iSeries Information Center (http://www.as400.ibm.com/infocenter). Select **Systems Management -> Backup, Recovery, and Availability**
- **iSeries Backup and Recovery V5R1**, SC41-5304
Advanced Function Printing (AFP) Manager

This chapter provides information on the Advanced Function Printing (AFP) Manager. We discuss the following topics:

- Overview
- Resources
  - Code pages
  - Coded fonts
  - Font character sets
  - Form definitions
  - Overlays
  - Page definitions
  - Page segments
- PSF configurations
- Font mapping tables
  - System tables
  - User tables
10.1 AFP overview

The Advanced Function Printing (APF) Manager is a component of Operations Navigator that became available with V5R1. This component provides the ability to manage AFP objects between a PC and an iSeries serve plus has the ability to create some iSeries objects.

This component is installed through either Client Access Express Full or Custom installation. If this component is not installed on your workstation you can install it by running Selective Setup as discussed in “Selective setup” on page 60.

An AFP object can be either an AFP resource, Print Services Function (PSF) configuration object, or a font mapping table. All AFP objects can be deleted and renamed. Some objects AFP resources can be imported or opened.

This unit will only provide an overview of the capabilities of this product. For detailed information on using AFP Manager, see iSeries Printing VI: Delivering the output of e-business, SG24-6250.

Note: Client Access Express includes the Advanced Function Printing Workbench Viewer as an installable option. The AFP Workbench Viewer is used to view and print iSeries Advanced Function Printing (AFP) and SNA character set (SCS) spooled files. It also supports many popular PC file formats such as ASCII, TIFF and GIF. The AFP Manager is not an enhancement to the AFP Viewer Workbench. It is an entirely separate product. For more information using the AFP Workbench Viewer refer to: AS/400 Client Express for Windows: Implementing V4R4M0, SG24-5191.

The AFP Manager allows you to work with:

- AFP resources including code pages, coded fonts, font character sets, form definitions, overlays, page definitions, and page segments,
- Print Services Facility (PSF) configuration objects
- System and user font mapping tables

Figure 10-1 shows the various components of the AFP Manager.
Chapter 10. Advanced Function Printing (AFP) Manager

The remainder of this chapter is devoted to reviewing these AFP objects: resources, PSF configuration objects, and font mapping tables. Figure 10-1 shows the taskpad functions available for AFP Manager. These are available for direct access without using the initial right-click, pull down menu, or context sensitive menu actions. The topics in this chapter assume you are not using the taskpad functions.

10.2 AFP resources

An AFP resource contains printing instructions and data that can be used in a print job. This is a special kind of AFP object that can be stored in a library and can be shared by different printer files and pages within a printer file. Resources include such objects as coded fonts, code pages, font character sets, form definitions, overlays, page definitions and page segments. All resources can be imported, deleted and renamed. Coded fonts can also be opened.

Figure 10-2 displays how the AFP resources are shown under the Operations Navigator interface.
**Code pages**
A group of characters with a unique hexadecimal identifier, known as a code point, assigned to each character. As text is entered, each character is translated into the code point. When the text is printed, each code point is matched to an image of the character you specified. You can delete, rename, and import code pages.

**Coded fonts**
A family or assortment of characters of a given size and style and is created by associating a code page with a font character set. The AFP Manager allows saving a coded fonts from a PC to the iSeries server as an AFP resource. You can open, delete, rename and import coded fonts.

**Font character set**
A collection of characters that share a style. For example, Sonoran Serif, Roman medium normal, 10-point is a font character set.

**Form definitions**
A definition of the characteristics of a form including any overlays, text suppression, data positioning, number of pages and modifications to a page.

**Overlays**
An object that can contain text, images, graphics, and bar code data. An overlay is created electronically in the host processor, stored in a library, and can be merged with variable data when printed or viewed.

**Page definitions**
A definition used to format line data into logical pages. A page definition includes the number of pages per printed sheet, font selection, print direction, and mapping individual fields in the data to positions on the printed sheet.

**Page segments**
An object that contains composed text and images, prepared before formatting, and is included during printing. Page segments can be printed anywhere on a page or at the same place on every
Examples of page segments include logos, signatures, bar charts, and engineering drawings.

**Importing resources**

You can save a source file from your personal computer as an AFP resource on your server. This is called importing. To import a resource, follow these steps:

1. Create the resource on your PC. This is done in normal case by printing through your AFP Printer Driver to a File by selecting the right Output Format.

Note: For detailed information about creating AFP Resources on your PC refer to IBM AS/400 Printing V, SG24-2160.

2. Select My Connections -> system -> AFP Manager.
3. Expand the Resources folder.
4. Right-click the folder for the type of resource you wish to import and select Import as shown in Figure 10-1.

For this example, we selected to import a Font Character Set.

5. The Import Font Character Set windows will appear as shown in Figure 10-3. The following fields are available:

   ![Figure 10-3 Import Page Segment Dialog Box](image)

   **Source file:** Specify the name of the file you wish to import. Click **Browse** to search for the file.

   **Resource name:** Specify a name for the resource you wish to create. The name cannot be more than eight characters long and must meet iSeries naming requirements.

   **Library:** Specify the library where the new resource will be located. By default, the current library is selected. To specify a different library, enter the name or click **Browse**. The library must already exist.

   **Description:** Enter a description for the resource you wish to create. The description cannot be longer than 50 characters.

   **Object Authority:** Specify the authority you want to give to users that do not have specific authority to the object; are not on an authorization list; and whose group profile does not have specific authority to the object. You can specify: **Change**, **Library create**, **All**, **Use** or **Exclude**. For overview of Operations Navigator interfaces into iSeries
security, refer to: 2.2.5, “Security” on page 23.
For the most complete documentation on OS/400 security, refer to: iSeries Security Reference for V5R1, SC41-5302, available on iSeries V5R1 Information Center.
The redbook Managing OS/400 with Operations Navigator V5R1, Volume 2: Security, SG24-6227, provides more detailed information on Operations Navigator interfaces into iSeries security capabilities.

Eligible for capture:
Specifying whether the code page or font character set is capturable. Capturing is a process used when a particular font is used in a document but the font is not resident on the specified printer; the printer is capable of capturing fonts; and font capturing is implemented on the specified printer. The captured font is stored on the printer and appears as a printer-resident font as long as there is space for it. The available options include:
- Use source file (use the font capture information stored in the source file)
- Yes (capture the font)
- No (do not capture the font)

6. Click OK. You can now see the import listed in the right pane.

10.3 Print Services Facility (PSF) configurations
PSF configuration objects are AFP resources used to specify parameters for AFP printers that are not definable with the Create Printer Device Description (CRTDEVPRT) command. These objects may be created using iSeries 5250 commands or the AFP Manager. We discuss the use of the AFP Manager in managing PSF configuration objects.

AFP Manager provides the ability to create PSF configuration objects on the iSeries server and include parameters for such capabilities as:
- Use of resources
- Font substitution
- Printer sharing
- Error recovery
- Data transformation

Figure 10-4 illustrates how to locate the PSF configuration objects under AFP Manager.
The AFP Manager - PSF Configuration interface includes the ability to create, change, rename, and delete configuration objects.

To create a new PSF configuration object, right-click **PSF Configuration** and select **New** from the context menu.

**Note:** System configuration authority is required to create PSF configuration objects.

The New PSF configuration window appears as depicted in Figure 10-5.
Note the various tabs included on this panel. This is where the configuration objects capabilities are defined.

**General**
Set the general characteristics of the configuration object such as its name, description, authority level and where it is stored.

**Resources**
Specifies how this PSF configuration object will use PSF resources.

**Sharing**
Controls printer sharing capabilities such as releasing the printer, reconnecting it, and the number of times to attempt to make a connection to the printer.

**Recovery**
Specified error recovery parameters

**PDF Transform**
Sets the configuration values for transforming PSF/400 and IPDS to PDF files

**Advanced**
Specified advanced functions such as inserting blank pages, output rotation, and so on.

Once the configuration object is created, users can create, change, rename and delete PSF configuration objects. To manage the PSF configuration objects, right-click on the selected PSF configuration object and select the applicable option on the context menu. Figure 10-6 illustrates the available options.

![AG/400 Operations Navigator](image)

*Figure 10-6 Managing PSF configuration objects*

Most PSF configuration object parameters are changeable via the Configure option of the context menu, once the object has been created However, the name, library and authority level of a PSF configuration object cannot be changed once it has been created.

### 10.4 Font mapping tables

AFP Manager provides the ability to manage font mapping tables. Font mapping tables are a type of AFP object that specifies a font substitution to be used whenever a requested character set or code page is unavailable and a similar character set or code page is available.
Table 10-1 shows there are five types of font mapping tables.

### Table 10-1  Font mapping tables type

<table>
<thead>
<tr>
<th>Font name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHFCS</td>
<td>Printer resident to host resident font character set font mapping table</td>
</tr>
<tr>
<td>HPFCS</td>
<td>Host resident to printer resident font character set font mapping table</td>
</tr>
<tr>
<td>PHCPP</td>
<td>Printer resident to host resident font character set font mapping table</td>
</tr>
<tr>
<td>HCP</td>
<td>Host resident to printer resident font character set font mapping table</td>
</tr>
<tr>
<td>PPFCS</td>
<td>Printer resident to printer resident font character set font mapping table</td>
</tr>
</tbody>
</table>

**Note:** The first four font mapping tables are installed only if PSF/400 is on the system.

There are two types of font mapping tables: system and user. System font mapping tables are supplied with your system and cannot be changed. Figure 10-7 represents a listing of default system font mapping tables.

*Figure 10-7  System font mapping tables*

System font mapping tables cannot be changed, deleted or renamed. You can only view a font mapping table by double clicking on one system table. See Figure 10-8 QSYSPHFCS for an example.
User font mapping tables are created by the user and can be changed, deleted, imported, opened and renamed. To create a new font mapping table, right-click AFP Manager -> Font Mapping Tables -> User Tables and select New from the context menu as illustrated by Figure 10-9.

The New Font Mapping Table window will appear as illustrated by Figure 10-10 below.
To create a new font mapping table:
1. Select the font mapping table type.
2. Specify a name for the new table. The name cannot exceed 10 characters and must meet iSeries naming conventions.
3. Specify the library. The library must already exist on the system. By default, PPFCS font mapping tables will be created in the QGPL library.

**Note:** The ability to specify a name and library for the new font mapping table is only available if creating a PPFCS font mapping table. In all other cases, PSF/400 will automatically name the font mapping table and create it in the QUSRKEY library.

4. Enter a description (not more than 50 characters).
5. Specify the object authority.
6. Click OK when finished to create the new font mapping table.

The user font mapping table can now be opened, renamed, or deleted. Figure 10-11 illustrates the functions available: adding (add) a new entry in the font mapping table; changing (edit) an entry in the font mapping table; or deleting (remove) an entry in the font mapping table and the resulting windows from selecting the Add button.
For additional details, review *iSeries Printing VI: Delivering the output of e-business*, SG24-6250.
Chapter 11. Plug-in support

This chapter describes the Operations Navigator support of plug-ins to enable the application to be accessed through the Operations Navigator interfaces. In the case of two of the plug-ins, BRMS and Advanced Job Scheduler, these plug-ins replace the standard Operations Navigators functions for the Backup component and the Management Central task scheduling functions.

This chapter discusses the viewing of plug-ins that are installed, and installing and uninstalling plug-ins. These following products are discussed as plug-in examples.

- **BRMS**
  - Availability of functions
  - Prerequisites
  - Operations Navigator Hierarchy Integration (Operations Navigator Backup component uses this product's backup functions in place of the default basic backup support)
  - Using BRMS Wizards

- **Advanced Job Scheduler**
  - Advanced Job Scheduler Integration
  - Using the Advanced Job Scheduler (Management Central uses this product's scheduling functions in place of the default use of the standard OS/400 job scheduling functions when installed as an Operations Navigator plug-in)

- **OnDemand**
  - Spool File Archive Administration
  - Media Administration
  - Common Server Administration

- **Lotus Domino**
  - Function
  - Installing Domino using the Domino EZ-Setup Wizard

- **Third-party**
  - Plug-in developing requirements
11.1 Introduction

Plug-in support provides the capability to plug-in custom tools and applications by adding new folders and objects, or context menu items, to existing folders and objects to the Operations Navigator hierarchy. This enables programmers to create new dialogs for an object or launch applications from existing folders in the Operations Navigator. For example, when you right-click on an object, Operations Navigator calls the plug-in to obtain the context menu items for the object and displays it.

This chapter looks at how to use, install and view plug-ins.

Some plug-ins can be restricted in their access and functions by using the Application Administration function in Operations Navigator. For more information using Application Administration refer to Chapter 12, “Application Administration component” on page 433.

For more Information about Operations Navigator Plug-ins refer to:

11.1.1 Viewing installed plug-ins

To view the plug-ins that are currently installed on your PC, right-click the iSeries server under My Connections in the left pane of the main Operations Navigator window (My Connections -> system). Select Properties. Select the Plug-ins properties tab as shown in Figure 11-1.

The list that appears in the top panel shows the plug-ins currently installed in the PC. The plug-ins supported by the iSeries server are shown in the lower list. The Rescan button performs a scan operation on the AS/400 installed plug-ins. We recommend that you perform a scan each time the iSeries server is upgraded. Doing this obtains an updated list of plug-ins supported by the iSeries server.

Figure 11-1  Viewing plug-ins installed
In the list of Plug-ins Installed on PC, notice that the Service Directory is included in each of the plug-ins. By default, the Service Directory is set to the path from where the plug-in was installed. You can change the Service Directory of a plug-in by highlighting it from the list and clicking the **Details** button.

### 11.1.2 Installing and uninstalling the plug-ins

You can deliver your plug-in code to Operations Navigator users by including it with your OS/400 applications. The installation program for the application writes the plug-in's code binaries, registry file, and translatable resources to the `/QIBM/UserData/OpNavPlugins` folder in the iSeries Integrated File System (iSeries IFS). Once this process is completed, users can obtain the plug-in from the iSeries IFS (with the help of an iSeries NetServer mapped network drive) by invoking the Plug-in install program or the Client Access Selective Setup program. The setup program copies your plug-in code to the user’s machine, downloads the appropriate translatable resources based on the language settings on the user's PC, and runs the registry file to write your plug-in's registry information to the Windows registry. All you need is a setup file, which identifies the files to be installed. If you provide a Windows policy template with your plug-in, you can also take advantage of Windows system policies to control which network users can install your plug-in.

**Installation process of plug-ins**

*Note*: Client Access Express, Operations Navigator, must all be installed on the PC before you can install additional plug-ins.

To install plug-in, follow this procedure:

From the iSeries server, use the Restore Licensed Program (RSTLICPGM) command or **GO LICPGM**, or option **11** to install the specific licensed program.

1. After starting the Operations Navigator and connecting to the iSeries, the **Autodetection of Plug-ins** starts and a window appears and lists the plug-ins found, as in Figure 11-2.

   **Note**: The Autodetection Function can be turned off by unchecking box 1 in Figure 11-2 or with menu bar Options -> User Preferences -> Plug-ins Tab as shown in Figure 11-3

   ![Figure 11-2](image)

   *Figure 11-2  New plug-ins found on the system*
2. Click **Yes**. This ends your Operations Navigator and starts the selective install for plug-ins

**Note:** If you want to manually start the selective setup for plug-ins go to **menu bar File** and select **Install Plug-ins** from the Pull-down menu.

3. Sign on to the iSeries Netserver with the correct User ID and password and click **OK** (Figure 11-4).

4. Select the plug-ins check box for the plug-ins you want to install. We selected all those displayed in our example as shown in Figure 11-5.
After the installation has completed, Operations Navigator is restarted. During restart processing a window appears indicating a new component has been detected (Figure 11-6). Click **Scan Now**. You may see this window again when you access systems from My Connections.

This window appears for every new connection you create.

You should see the new Plug-ins folder appear under the Management Central or My Connections for system AS01C. The plug-in implementation determine under which Operations Navigator component it will appear.

### Uninstall process of plug-ins

To uninstall the plug-ins, follow these steps:

1. **Double-click** the Selective Setup icon in the Client Access Express folder.
2. Click **Next** on the Selective Setup panel.
3. Select **Ignore, I’m going to uninstall components** as shown in Figure 11-7, on the Selective Setup Options panel.
4. Click **Next** on the Selective Setup Options panel.

5. Click the plus sign (+) next to Operations Navigator to expand the installed components on the Component Selection panel (Figure 11-8).

6. Find the Plug-in you want to Uninstall.

7. Deselect the Plug-ins check box. In our example, we have unchecked Advanced Job Scheduler and OnDemand.

8. Click **Next**. The plug-ins are deleted from your PC and not available for all iSeries connections anymore.

### 11.1.3 How the plug-in support works

This topic and “How Operations Navigator learns about a plug-in” on page 391, discuss how the plug-in support works and is primarily provided for those application developers considering providing a plug-in interface to their application. It is not required that the user of a plug-in understand this processing.
With Client Access Express, your plug-in may be written C++, Visual Basic (VB), or Java. You implement a set of predefined classes and methods that are invoked by Operations Navigator in response to a particular user action. Here is a high-level overview example of how to create a Java plug-in. You can use the plug-in support to add a new folder (function) to the Operations Navigator tree. When the user clicks the folder, the plug-in's Java code is called to obtain the folder's contents, which in this case is a list of messages on the user's default message queue. Operations Navigator communicates with the Java plug-in by invoking methods defined on a special Java interface, known as the List Manager interface.

The javadocs for these Java interfaces are available at the iSeries Information Center Web site at: http://www.as400.ibm.com/infocenter

The .jar file, jopnav.jar, resides in the ClientAccess/Classes folder. The plug-in support defines this interface specifically for the purpose of letting Java applications supply list data to the Operations Navigator tree and list views. To integrate your application into Operations Navigator, you create a new Java class that implements this interface. The methods on the new class call into your existing Java application to obtain the list data.

What a user wants to perform an action on one of a plug-in's objects, the user right-clicks a message object to display its context menu. Operations Navigator then calls a predefined method on another Java interface, Actions Manager, to obtain the list of menu items supported for message objects.

Once again, you create a new Java class that implements this interface. This is how you make your application's specialized functions available to your users through Operations Navigator.

When the user selects the menu item, Operations Navigator calls another Actions Manager method to perform the action. Your Actions-Manager implementation calls your existing Java application. Then, it displays a confirmation dialog or another, more-sophisticated user interface panel that lets the user perform a specialized task. The plug-in feature allows you to define actions on any of the base objects supplied with Operations Navigator, as well as on new object types that your plug-in introduces into the hierarchy. Based on its current status, you can "gray out" actions that aren't appropriate for an object and supply status bar help for each action. You can also refresh portions of the main Operations Navigator window after an action is performed. The Operations Navigator user interface is designed to let users work with lists of iSeries resources and to perform actions on them. The architecture of the plug-in feature reflects this user interface design by defining interfaces for working with lists of objects in a hierarchy and for defining actions on those objects. A third interface, DropTarget Manager, is defined to allow plug-in folders to handle drag-and-drop operations.

11.1.4 How Operations Navigator learns about a plug-in

Operations Navigator needs to be able to detect that a plug-in exists. Plug-ins must identify themselves to Operations Navigator by supplying information in the Windows registry when the plug-in software is installed on the Windows desktops of your users. The registry entries specify the location of the plug-in code and identify the classes that implement the special Operations Navigator interfaces.

You can supply additional registry information that lets Operations Navigator determine whether the plug-in's function should be activated for a particular iSeries server. For example, a plug-in may require a certain minimum release of OS/400, or it may specify that a certain product needs to be installed on the iSeries for it to function. When a user clicks on an iSeries server in the Operations Navigator tree after installing a plug-in, the iSeries server is...
examined to determine whether it is capable of supporting the new plug-in. The software prerequisites (specified in the plug-in’s registry entries) are compared with the software installed on the iSeries server. If the plug-in’s requirements are satisfied, the new function is displayed in the Operations Navigator tree.

If the requirements are not met, the plug-in function does not appear in the Operations Navigator tree hierarchy for that iSeries server. However, the plug-in may participate in the decision of whether to be included in the hierarchy by implementing a special function, which can be called by Operations Navigator during this scanning process.

11.2 BRMS plug-in

This topic overviews the Operations Navigator Graphical User Interface (GUI) to the Backup Recovery and Media Services 5722-BR1. Backup Recovery and Media Services can be installed on any iSeries server and run independently of Operations Navigator and Management Central.

This graphical interface described in this topic is provided with Backup Recovery and Media Services (BRMS) product as a plug-in to V5R1 Operations Navigator.

This BRMS graphical interface for iSeries provides functions similar to those available under Windows operating systems for backing up and recovering files on PCs running those operating systems.

**Note:** V5R1 offers an impressive list of GUIs to BRMS users, especially those getting started with BRMS. However, V5R1 support should be viewed as a “stage 1” of a multi-stage rollout of a GUI to a complete set of BRMS functions - interfaces to more BRMS functions are planned in the next OS/400 release. BRMS has been available to OS/400 users for several releases prior to V5R1 and contains a very complete set of backup and recovery options an automation. With V5R1 you still need to use the 5250 BRMS command interface to see all backup and recovery capabilities.

**Availability of functions**

BRMS is IBM’s strategic, full function backup and recovery tool for AS/400 and iSeries servers. With BRMS you define policies that identify what should be backed up and on which media the backup (saved) information is to be placed. BRMS records backup activity history information in reports and step by step documentation for using the back up media to perform recovery - a recovery log. BRMS comes with functions packaged into three separately priced components:

- **BRMS Standard Product:** Backup Recovery Media Management, and AS/400 Application Client to ADSTAR Distributed Storage Management (ADSM). This includes scheduled backups, media management and parallel (at the same time) backups to separate media devices. Media devices include OS/400 save files and tape devices that may also include “tape library servers” (such as IBM 3570 and 3590 products) that greatly automate large backup and recovery processes. The ADSM client support enables the AS/400 and iSeries backups to be included in an overall backup process that is used by customers using ADSM server support to backup workstation operating systems.
  
  Backup of Lotus server directories and files is included.
  
  To facilitate usage of BRMS pre-configured backup policies are provided such as *SYSTEM (back up the entire system) and *BKUGRP (backup all user data). V5R1 has some ease of use enhancements.
Chapter 11. Plug-in support

- **BRMS Advanced Functions Feature**: Hierarchical Storage Management Archiving and Dynamic Retrieval. This support includes, for example, aging of saved data to transfer it from frequently used media to less frequently used media. Dynamic retrieval enables scheduling the reloading of saved data onto the system when it is about to be processed by an application.

- **BRMS Networking Feature**: This enables multiple AS/400 systems and iSeries servers in a defined network to share a common BRMS backup and recovery database.

Note that when BRMS is installed as a plug-in, all Operations Navigator backup functions link directly to BRMS. That is, there is no link to the default basic backup capabilities described in Chapter 9, “Backup component” on page 363. A complete presentation of BRMS is beyond the scope of this redbook. Rather this topic gives an overview of the BRMS capabilities available through Operations Navigator plug-in support.

For a more complete description of all BRMS Plug-in capabilities and using the wizards you can download the BRMS Plug-in Student Trainings Guide as a WordPro document at: http://www.ibm.com/eserver/iseries/service/brms/pluginguide.htm

**Functions available through the GUI plug-in**

- **Backup Policy Wizard** to create Backup Policies and simple lists
- **Add Media Wizard** to add tape volumes to the media inventory
- **Restore Wizard** to help locate backed up items for automatic recovery. These Wizards are explained in 11.2.3, “Using BRMS Wizards” on page 398.
- **A task pad** providing a quick access to many highly used BRMS functions
- **Views of the Backup Policy** properties with changeable attributes
- **Include filtered views of the Backup History** with selectable columns and click sort capability
- **Include filtered views of the Tape Volume Inventory** with selectable columns and click sort capability
- **Include filtered views of the Backup and Recovery Log**
- **Help panels indexed by task and subject** offering additional guidance and definition of terms
- **Integration into the iSeries Navigator hierarchy**
- **Integration with Management Central** for task scheduling
- **Additional Functions in the GUI:**
  - Ending Integrated xSeries Servers (Integrated Netfinity servers) before backup
  - Unmounting of user-defined file systems (UDFSs) before backup
  - Starting Integrated xSeries Servers after backup

**Differences between plug-in and the BRMS 5250 command terminology**

- The plug-in term **Backup Policy** refers to the combined attributes of a 5250 command backup control group and a **media policy**.

- The plug-in term **Changes Only backup** is the same as a Cumulative backup in the 5250 command interface.

- The plug-in term **Media pool** is the same as a **Media Class** in the 5250 command interface.

- The plug-in term **Disk pool** is the same as an **Auxiliary storage pool** in the 5250 command interface.
Restrictions

- Backup Policies Properties not yet available in the V5R1 plug-in
  - Job queues to process
  - Subsystems to process
  - Minimum/maximum parallel devices
  - Backup item exits
  - Save while active
  - Target release
  - Type of changes only backup (cumulative versus incremental)

- Media Types not yet available in the V5R1 plug-in
  - Media libraries
  - Save files
  - Tivoli Storage Manager (TSM) servers

11.2.1 Prerequisites

The BRMS Graphical User Interface requires the following V5R1 Software on the iSeries:

- IBM Backup Recovery and Media Services for iSeries
- IBM Operating System/400
- Option 18 - Media and Storage Extensions
- IBM Client Access Express for iSeries

Note: Backup Recovery and Media Services for iSeries V5R1 is not required on the Operations Navigator Management Central central system if you do not intend to perform BRMS operations to that system. This does not prevent scheduling of BRMS operations to other Connections through the central system.

11.2.2 Operations Navigator hierarchy integration

This section explores many of the BRMS GUI elements which are integrated into the iSeries Operations Navigator hierarchy after the plug-in is installed. The BRMS functions can be found in different components and subcomponents and also in context menus. The following topics describe the integration in different places.

Main integration

The BRMS plug-in installs as a new component under your iSeries where BRMS is installed. To explore the functions do the following steps:

1. Open the Operations Navigator hierarchy for a system from which you installed the BRMS plug-in by clicking on the + sign. The Backup, Recovery and Media Services folder should be visible at the bottom of the hierarchy. See Figure 11-9 for an example.
2. The Backup Policies folder and Media folder are contained within the Backup, Recovery and Media Services folder. These folders provide context menus that include the functions you use to manage BRMS from Operations Navigator.

3. Right-clicking on the Components or Subcomponents folder brings up various context menus. Explore the functions that are available in each folder:
   - Backup Policies folder and Media folder
     - Back Up System - Backs up the selected system
     - Back Up System - Backs up the selected system
     - Print Recovery Report - Print AS/400 disaster recovery report
     - Backup and Recovery Log - Displays the backup and recovery log
     - Run Maintenance - Runs maintenance and cleanup activities related to backup
   - Backup Policies folder
     - New Policy - Creates a new backup policy.
     - Backup History - Displays backed up items contained in the backup history
   - Media folder
     - Backup History - Displays backed up items contained in the backup history
   - Tape folder
     - Backup History - Displays backed up items contained in the backup history

System integration - full backup
You can use BRMS to do a full backup of an iSeries server from the Operations Navigator main window. To back up an entire system, follow these steps:

1. For My Connections -> system, right-click the system that you want to perform back up functions on and select Back Up System from the context menu as shown at in Figure 11-10. (This system must have Backup, Recovery and Media Services installed on it for you to use this option.) When you perform a backup this way, you back up the system using the "System backup policy. We use system As01c in our example.
You can use BRMS to backup all of your security data from the Operations Navigator main window. To back up your configuration data, follow these steps:

1. Expand the system (My Connections -> system) whose security data you want to back up.
2. Right-click Users and Groups and select Back Up in the context menu. See Figure 11-11 for an example.

Alternatively you could select Restore for a restore wizard.

Figure 11-11  BRMS Users and Group integration

Configuration and Service integration
You can use BRMS to do backup of all your configuration data from the Operations Navigator main window. To back up your configuration data, follow these steps:
1. Expand the system (My Connections -> system) whose configuration data you want to back up.

2. Right-click Configuration and Service and select Back Up. See Figure 11-12 for an example. You also can use the Restore function to launch the Restore Wizard.

![Figure 11-12  BRMS Configuration and Service integration](image)

**IFS integration**

You can use BRMS to do backup of your IFS Data from the Operations Navigator main window. To back up, for example your QSYS.LIB, follow these steps:


2. Expand the QSYS.LIB folder/folder and right-click an OS/400 library. Select Back Up from the context menu as shown in our Figure 11-13 example.

   Alternatively you could use the Restore function to launch the Restore Wizard.

![Figure 11-13  BRMS save a QSYS.LIB library](image)
Note the wizard window prompt with regard to including this library in the BRMS disaster recovery report.

Management Central integration

In Figure 11-14 we have already expanded the Management Central folder and its primary sub folders Task Activity and Scheduled Tasks. As you can see Backup, Recovery and Media Services folders appear within the standard Management Central sub folders (Command, Packages and Products, and so forth) under Task Activity (currently running or finished) and Scheduled Tasks (schedule to run at a specific time or date).

![BRMS Management Central integration](image)

In the right Details pane we have already selected (explored) Task Activity for Backup, Recovery and Media Services. You can see a Run Maintenance has failed.

Since in this book we are not giving detailed descriptions of BRMS functions we do not go any further in this example.

Note: All BRMS scheduled, running or finished tasks are shown under the Management Central folders.

11.2.3 Using BRMS Wizards

This section explores a basic overview how the BRMS GUI Wizards can be used. No window example figures are included, but you can use the Backup Recovery and Media Services folder at A in Figure 11-11 on page 396 as a reference.

This wizard configures what media pools and volumes to add and the initialization of volumes.
The Add Media wizard enables you to add backup media to the pool of media that is already being used by Backup, Recovery and Media Services. It also enables you to prepare the media for use. Add media volumes to the BRMS media inventory means that you want BRMS to track this media.

**Add media**
To add media, follow these steps:
1. In the left hierarchy tree pane expand **My Connections -> system - > Backup Recovery and Media Services** folders.
2. Expand Backup, Recovery and Media Services
3. Expand Media.
4. Right-click Tape Volumes and select **Add**.
5. Follow the wizard's instructions to add the media to BRMS.

**New Policy Wizard**
This wizard guides the user through selecting the type of backup strategy, customizing the type of data to be backed up, allows selection of Lotus Domino servers, choosing the folders / directories / files to be backed up, what backup lists to use, backup devices to use, and retention override settings. There are also shutdown features for users with Integrated Netfinity Servers, and User Defined Files Systems.

You can create a new backup policy to control what items you back up and when. The New Backup Policy wizard enables you to create a backup policy, select the media you want to use for that policy, and then run or schedule the policy once it is created.

**Create a new backup policy**
To create a new backup policy, follow these steps:
1. In Operations Navigator, expand **My Connections** (or your active environment).
2. Expand a system with Backup, Recovery and Media Services installed on it.
4. **Right-click** Backup Policies and select **New Policy**.
5. Follow the wizard's instructions to create a new backup policy.

**Restore Wizard**
This wizard will guide the user through selecting whether to restore from a backup history log or from a device, the type of information to restore, the library / folder / directory or file path, and the version to restore.

The Restore wizard enables you to restore objects on your system either from the backup history, or from a device that you specify.

**Restore an object**
To restore an object, follow these steps:
1. In Operations Navigator, expand **My Connections** (or your active environment).
2. Expand a system with Backup, Recovery and Media Services installed on it.
3. Right-click Backup, Recovery and Media Services and select Restore.
4. Follow the wizard's instructions to restore objects on your system.
11.3 Advanced Job Scheduler plug-in

The IBM Advanced Job Scheduler is a separately purchased licensed program (5722JS1). It provides a more robust and detailed type of scheduling than the standard OS/400 job scheduler support (Work with Job Scheduler Entries (WRKJOBSCDE) command). The Advanced Job Scheduler can be installed on any iSeries server and run independently of Operations Navigator and Management Central.

This topic focuses on using the Advanced Job Scheduler through Operations Navigator on an individual system and through the Management Central schedule interface. The Advanced Job Scheduler must have been installed on your PC workstation as an Operations Navigator plug-in.

With the Operations Navigator Advanced Job Scheduler plug-in you can interface to the Advanced Job Scheduler functions in the following ways:

✓ A system under My Connections (or a user-created environment). With this interface 5722JS1 must also be installed on each system.

✓ Management Central schedule functions that can be setup to run on one or multiple endpoint systems or system groups. When installed as a plug-in, the Advanced Job Scheduler is the only scheduling interface used by Management Central - the standard OS/400 job scheduler is not used.

**Note:** When the Advanced Job Scheduler has been included as a plug-in to Operations Navigator, Management Central scheduled tasks do not require the licensed program 5722-JS1 on each endpoint system. When Advanced Job Scheduler is installed on the central server system, any jobs or tasks that are defined on that system gather any job information needed from the central system. You must set up all your job run attributes, applications, distribution lists, and other job definition information on the central system.

**Special Note:** If more than one PC in the network is using Management Central scheduling functions, each PC must have Advanced Job Scheduler plug-in installed.

The Advanced Job Scheduler graphical user interface (GUI) allows you to access many of the functions available. It allows you to:

✓ Schedule jobs
✓ Create and work with groups
✓ Job Dependencies *(New for V5R1)*
✓ Submit jobs and groups immediately
✓ Jobs can be “edited” into groups
✓ Display the status of jobs
✓ Create calendars and holiday calendars
✓ View the Activity Log

Not all Advanced Job Scheduler functions have not been integrated into the plug-in Advanced Job Scheduler functions when you are using Advanced Job Scheduler from My Connections or Management Central. These Advanced Job Scheduler functions you must perform outside of the Operations Navigator plug-in interfaces include:

✓ Commands:
  – Start the job monitor
– End the job monitor
– Reset all jobs at once
– Start the console monitor

► Display:
– Run calendar

► Updating:
– Report distribution IDs and other report distribution related items
– Job control defaults
– Some system controls
– Functional and job authorities
– Job local data area
– Fiscal calendars

These functions can be performed by OS/400 commands issued via a 5250 workstation, or by using the Run Command on the iSeries server under My Connections -> system or in Management Central -> Definitions -> Command.

Be aware that Advanced Job Scheduler uses the time on the PC workstation as the default for the scheduled time. You can specify a different time when working with scheduled jobs.

Important Note: Advanced Job Scheduler does not use the time on the central iSeries or the endpoint system. If the time on the PC is behind the iSeries time, it is possible to schedule a job that never runs. For example, if the current iSeries time is 11:30 a.m. and the current PC time is 11:25 a.m., a job scheduled to run at 11:28 a.m. will not run since the time has already passed on the iSeries server. Ensure that any job scheduled using Advanced Job Scheduler through Operations Navigator or Management Central has a run time that has not already passed on the iSeries server.

For more information about Advanced Job Scheduler and how to use it, see the Advanced Job Scheduler topic in the iSeries Information Center on the Web at:

Or see the Advanced Job Scheduler Home page at:
http://www-1.ibm.com/servers/eserver/iseries/jscheduler/

New with V5R1:

New functions have been added for V5R1:

Dependencies: You can update all types of dependencies (job, active and resource). Right-click any job and see these three dependencies have been added. You can also access job dependencies for all jobs by right-clicking the Schedule jobs folder.

Activity log: The Advanced Job Scheduler log can be displayed. Right-click a job to the log info for that job or click Activity log for all entries.

Communication tab: The user can specify communication information used within DDM when communicating with a remote system in order to submit a job.

Job controls: There are a Job control values used when the job is submitted to run. These values include the OS/400 job description object, job and spooled output queues, run priority, and more used by the job. Default values are provided by the Advanced Job Scheduler. These job controls can be specified for a new job being scheduled. They can be viewed and changed by selecting the Properties of a scheduled job. Any changes take affect the next time the job is run.
Prompt button: When entering a command in a job the user can use the *GUI Prompter* in order to see the parameters within a command.

Maximum runtime: Within a job the user can select whether to end the job after the maximum run time has been reached or just notify the system operator (*QSYSOPR*) message queue.

### 11.3.1 Advanced Job Scheduler integration

This topic focuses on interfacing to the Advanced Job Scheduler installed on each system accessed through Operations Navigator and also through the scheduling function of Management Central.

At 2 in Figure 11-15, you see the Advanced Job Scheduler functional components for system (As01) under Work Management. Using this interface you can manage jobs only on that system.

At 1 in Figure 11-15, you see the Advanced Job Scheduler functional components under the Management Central central system As80.

You can schedule tasks and view the results summary on these systems. For an example of Management Central 1 and integration with the Work Management component (shown at 2).

![Figure 11-15 Advanced Job Scheduler integration in Operations Navigator](image)

### 11.3.2 Using the Advanced Job Scheduler under Management Central

Advanced Job Scheduler can be used to schedule any task, user, command, package definition or BRMS plug-in action that has the *Schedule* button available.

Help is available for windows and fields. Press the Help button to receive additional information about the function you are performing. If the window has a (?) field level help in the upper right hand corner, you can click on the ?, move the cursor (along with the ?), and click on the field for additional help.
Example of scheduling a task in Management Central

You can use Advanced Job Scheduler to schedule an existing command to run once or multiple times based on specific criteria. For more information about Management central and creating commands refer to Chapter 6, “Management Central and Monitors” on page 181.

To schedule an existing command, complete the following steps:

1. Expand Definitions under Management Central, and select Command (1) in Figure 11-16.

Right-click on an existing command (we had created this command earlier) already shown in the Details pane and select Run as shown in Figure 11-16. A screen appears similar to the example shown in Figure 11-17.

2. Select Add for the iSeries endpoint systems or system groups to run the command. In our example we have selected one system group (JIMCSG) and one endpoint system (As80).

3. You can run the command “immediately” by selecting OK. In this example however, we select Schedule. The Schedule button links to the Advanced Job Scheduler. A dialogue box similar to the example shown in Figure 11-18 appears. Note that this screen is different than the dialogue box displayed when Management Central is using the standard OS/400 job scheduler.
4. Enter a job name meaningful to you. You must enter a job name to continue.
   You can also specify job description text and optionally select an application name from
   the pull-down menu or a report distribution list name or both. These must already be
   defined within the Advanced Job Scheduler on the central system.

5. Select the Schedule tab. A window similar to the example in Figure 11-19 appears. On
   this page you can define when your new scheduled job will run. You can set the values to:
   - Every week
   - Multiple days
   - Periodic time interval
   - Start date
   - Time Range
   - Monthly
   - Specific Time
   - Additional Calendars to use, as shown in the rightmost windows of this figure.

   **Note:** If the job is a non-scheduled job, the Schedule tab will not be active.
6. You can enter Information to the following pages, but these are not mandatory to schedule the job:

   - **Batch Information Tab**

     In this window as shown in Figure 11-20 you can specify information (job controls) that will be used when submitting a job in batch:

     - Job description for the job
     - The job and output queues
     - The user associated with the job
     - The current library for the job
     - The Advanced Job Scheduler library list associated with the job

     If you need to define more advanced information, click Advanced to go to the Advanced Batch Information display where you can define more specific informations such as job priority than presented under the Batch tab.
Figure 11-20  Batch information window example

- Notification tab

This window provides (as shown in Figure 11-21) you with a place to specify how to notify your users of the completion status of a job:

- Send a completion message to a message queue
- Send a pager message or a message to a message queue regarding the successful or unsuccessful completion of the job. (If a pager message is being sent, this requires a pager-supporting third party software product be installed.)
– Problem Recovery tab

On the Problem Recovery window shown in Figure 11-22 you can specify the actions to take in the event of a problem with job processing. Here you can specify:

• The maximum number of minutes that the job is allowed to process before Advanced Job Scheduler terminates its processing.
• Whether to use an alternate job if the current one fails
• The action to take if the job cannot start when it is scheduled
• A reply to issue to an inquiry message
Figure 11-22  Problem recovery window example

- Communication tab

The Communication window example shown in Figure 11-23 allows you to select a local device and location name, as well as a remote device and location name.

Figure 11-23  Communication window example

7. Change or review the parameters that control job information. When you have completed your selections, select OK.
8. The message as shown in Figure 11-24 appears. Be aware that the schedule confirmation display is the same when using the Standard OS/400 Job Scheduler. It says to look in Scheduled Tasks under Management Central. You see this job in the list, but you can get only the Command, System and Groups or the Sharing Information. We recommend see that you use the Scheduled Jobs under Advanced Job Scheduler instead, for more information. Click OK to get the “New Job successfully created” message.

![Figure 11-24   Job completion message]

11.3.3 Monitoring your Advanced Job Scheduler jobs

Once a job is started, use Task Activities under Management Central to monitor its progress and completion. For more information about monitoring jobs, see 6.7.2, “Job monitors” on page 249, in the Management Central chapter.

- To view or change your scheduled jobs, expand Advanced Job Scheduler and select Scheduled Jobs. You see a list of scheduled jobs. The right-hand display in Figure 11-25 shows you:
  - Job name: The name given to this job
  - Status: The status of the job
  - Next run: Next scheduled run time
  - Schedule: Type of schedule
  - Group: Name of the group job
  - Sequence: The sequence number within the group
  - Description: The description given to the job on creation

We highly recommend that you use the Scheduled Jobs under the Advanced Job Scheduler to view or change a schedule. Advanced Job Scheduler does not update information in Scheduled Tasks under Management Central. It will display no Information in the “When to Run” column.
Right-click on a task to view or change it. You can perform several functions from the pull-down menu:

- **Job Dependencies**: The Edit Job Dependency dialog allows you to change the dependencies for a particular job. You can add and remove predecessor and successor jobs, as well as view the properties of predecessor and successor jobs. See Figure 11-26 for an example.
Active Dependencies: This specifies how long a job waits for the correct dependency condition to occur before Advanced Job Scheduler runs or resets the job. For instance, if a job is scheduled to run at 11:00 that is dependent on the inactivity of another job and the wait limit is set at 60 minutes, the scheduled job will wait 60 minutes for that job not to be active. If the job is still active by 12:00, Advanced Job Scheduler resets the scheduled job for its next scheduled processing time and date. If the job is not active within the 60 minute wait limit, the scheduled job is processed. See Figure 11-27.
Resource Dependencies: The Resource Dependencies dialog, as in Figure 11-28, displays information about a specific job's resource dependencies, including a list of dependencies, the requirements needed before continuing to run a job, and the time to wait before resetting a job. You can also add, remove, or view the properties of a particular resource dependency.

Activity: Display the activity for the task, such as the completion status and start and stop times.
Activity Log: By double-clicking on a message in the Activity Log window you get the Detailed Message Information display which gives you the complete message as well as additional message text. See Figure 11-29 for an example.

Figure 11-29  Activity log

- **New Based On**: Create a new scheduled task based on the properties of the existing one
- **Copy**: Allows you to copy a job from a system and paste it into a group
- **Hold Schedule**: Hold the task
- **Release Schedule**: Release a task that is held
- **Skip Next Run**: Prevent the task from running on the next scheduled run
- **Run**: Start the task immediately or schedule it for a different time
- **Status**: Display the status of the task while running
- **Rename**: Rename the scheduled job
- **Delete**: Delete the scheduled job
- **Properties**: Display or change the properties of the scheduled task. You can change these properties:
  - General Tab
  - Schedule
  - Batch information
  - Notification
  - Problem Recovery
  - Communications
  - Las Run

Make sure the task completes after the scheduled time. Select Task Activity. Right-click on the task from the list and choose Status. To view the job log, select one of the systems from the status window and right-click to select Task Output. You can also click on the computer paper icon from the tool bar or click File -> Task Output to view the job log. You may have a job log available, based on the settings you specified when you created the job.
11.3.4 Advanced Job Scheduler properties

The Advanced Job Scheduler properties can be set only in the Advanced Job Scheduler component of **My Connection -> system -> Work Management -> Advanced Job Scheduler**. They cannot be set under Management Central -> Advanced Job Scheduler folders. These values are valid for all jobs that schedule with the Advanced Job Scheduler.

To access, right-click the Advanced Job Scheduler folder and select properties. You can see a window similar to this in Figure 11-30.

![Advanced Job Scheduler properties](image)

> **General tab:** In this Properties window you can assign general controls to the Advanced Job Scheduler like:
> - Base periodic frequency on start time
> - Log retention
> - Paging command
> - Application required for scheduled job
> - Working days
> - Activity Retention

> **Job Controls tab:** In this Properties window you can view all the existing job controls on your system.

> **Applications tab:** In this Properties window you can view all the existing Advanced Job Scheduler applications on your system:
> - Scheduling Calendars
> - Holiday Calendar
> - Library Lists
> - Command Variables
Job groups

Jobs can be collected in a group as seen in Figure 11-31. This allows you to run different jobs together in a sequence at a specific time or on demand. To create a group, right-click Job Groups and then select **New Job Group**. You can move a job to a group by copy them from the scheduled jobs to paste them in the group folder.

The sequence of jobs can be changed. You can start the begin point of a sequence at any point by right-clicking a job in the group and select **Start Group from Here**.

11.4 OnDemand plug-in

The OnDemand Archive plug-in to Operations Navigator provides a powerful graphical interface to some of the administrative functions of OnDemand for iSeries Common Server at V5R1 and later releases and also for OnDemand for iSeries Spool File Archive at V4R4 or later releases.

OnDemand for iSeries servers is an application program that provides a highly reliable, yet flexible, system to meet data archive and retrieval requirements. Key functions are described below:

- Automatic capture, archive, and management for large volumes of spooled print data
- Storage of spooled files, PC files, and scanned images to disk, tape, and optical media
- Client/server access to business-related documents through the powerful, easy-to-use OnDemand client
- Integration with mission-critical business applications to enable search, retrieval, and presentation of OnDemand stored documents
- Graphical report administration tools for fast and easy report definition

The picture displayed in Figure 11-32 shows you an overview of the OnDemand component tree when installed as a plug-in to Operations Navigator.
Since the OnDemand Administrator Client (which is separately downloaded from the Internet) is not used with the Spool File Archive feature of OnDemand, the Operations Navigator plug-in is used to create report definitions. The plug-in is also used to create migration policies and add optical and tape volumes, but not for creating output queue monitor definitions.

More detailed information about using Ondemand with the Operations Navigator can be found at:

http://www.ibm.com/software/data/ondemand/400/

### 11.4.1 Starting the OnDemand Server

For running OnDemand on your iSeries you must start the OnDemand Server jobs. You can do this in the Operations Navigator by going to **Network**, then go to **Servers**, then go to **TCP/IP**. Right-click the OnDemand server and request to start it. You can automatically start these server jobs when TCP/IP starts on the system by using the **Properties** tab and under the General tab check mark the property **Start when TCP/IP starts**.

For more information about TCP/IP server refer to the Network Chapter in *Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More*, SG24-6226

### 11.4.2 Spool File Archive Administration feature

The OnDemand Spool File Archive feature (Figure 11-33) provides report capture, segmentation, indexing, compression, storage, retrieval, and print/facsimile capabilities for print (spooled) data.

OnDemand provides Windows users with an alternative to the 5250 commands for working with Report Definitions (and many other OnDemand Administration functions) that are described in this topic. Operations Navigator provides the interface as shown in Figure 11-33.
The OnDemand Administration Graphical User Interface is one of the most powerful features of Operations Navigator since it allows report administrators to work with report definitions and spooled file data by using a graphical user interface. The iSeries spooled file data displays in a window on the workstation that the report administrator can click on to identify division criteria, report date, and key fields. You can select other definition attributes such as report type, data type, and migration policy information by using pull-down select boxes. The graphical interface is a very productive way to work with Report Definitions and perform other OnDemand administrative tasks.

Online help information is available on all the workstation panels. However, it is recommended that you become familiar with OnDemand concepts as described in this chapter before using this tool.

![OnDemand spool file archive overview](image)

**Figure 11-33  OnDemand spool file archive overview**

**Report definitions**

Every report to be archived needs a report definition. The report definition contains information about the values used to identify individual documents or logical breaks in the report (called segmentation), the report date, and the keys. It also identifies the Migration Policy that OnDemand uses to migrate the report from disk to optical or tape. You can define different report types:

- **Document Reports (DOC)**  
  A spooled file readily divided into individual documents, such as invoices or statements, is a DOC report. Each document (known as a segment) is individually indexed. Therefore, each document is individually retrievable.

- **Page Reports (PAGE)**  
  A spooled file with a single key value in sequential order from the beginning of the report to the end is a PAGE report. Each report segment contains up to 100 pages. Key1 contains the first key value from the top of the first page of the segment. Key 2 contains the last key value from the bottom of the last page of the segment. For example, general ledger reports are typically defined as PAGE reports because the report is sorted in ascending sequence by account number with multiple account numbers per page.

- **No-Index Reports (NODX)**  
  A spooled file that has no unique key values is a NODX report. Key 1 is always the segment number. Key 2 is always the report date and Key 3 is always the page number. Each report segment contains up to 100 pages.

- **Unbundled Reports (UBND)**  
  When several different reports are contained within one spooled file, use the UBND definition to automatically divide the spooled file into separate reports which will be archived.
using their own report definitions. OnDemand uses the segmentation information from the UBND report definition to detect when a new report begins.

**AnyStore Reports (ANYS)**
An ANYS report contains pieces of data stored and indexed using the OnDemandAnyStore APIs. Examples of AnyStore items are scanned images and PC files.

**Report groups**
A report group is composed of different, but related, reports. For example, you can include invoices, late payment notices, and monthly invoice summary reports in one group with the invoice number Key 1 and the customer number Key 2. Group name INVINFO. When you search INVINFO by customer number 12345678 or invoice number 876543, OnDemand lists all related items from the three different reports.

**Note:** Once a report is defined to a group, you cannot change the report to belong to a different group unless you delete ALL reports by that Report Name first, then change the Report Group named in the Report Definition.

**Report migration policies**
You must assign a report policy to each report. The report policy is used as input during the Report Management Cycle to determine which media the system stores the report on, and for what length of time. Multiple reports can use the same report policy.

Your initial estimates for Days allowed on disk, Days allowed on tape, and Days allowed on optical can be modified after OnDemand has collected historical data related to actual report usage statistics.

**Note:** If any reports have been defined to use a particular policy name, OnDemand protects you from deleting that policy; it issues a message that the policy cannot be deleted because one or more report definitions refer to it.

**Screen overlay**
You can create character-based report overlays, which combine with the spooled data when displayed. You can also include a report overlay when you print the data or send a facsimile.

You can use a report overlay to simulate a preprinted form. For example, design a box of dashes to appear around a ship-to address, and add the words Ship-To Address above the box of dashes. When the user displays the report, the spooled file data, the box of dashes around the address on the page, and the Ship-To Address appear.

It is important to understand the difference between an OnDemand character-based overlay and an AFP overlay.

- OnDemand character-based overlays are created within OnDemand. They contain character data that is combined with report data when you view the report data. (You can also print or fax character-based overlays.)
- AFP overlays are defined outside of OnDemand and can contain company logos, shading, special fonts, and others. They are associated with OnDemand reports when you name them in a printer file that you identify in the report definition.
- Screen overlays are only displayed in the 5250 screen end-user interface, not with the OnDemand Client interface. AFP overlays can be viewed, printed, and faxed from the OnDemand Client. They may also be printed and faxed from the 5250 interface.
11.4.3 Media Administration selection

You can use the selections in this group of screens to manage your tape and optical media used for archiving. With them, you choose how and where to place your archives and backups, establish capacity thresholds and space reuse policies, and work with storage groups that let you store data on one or more sets of optical volumes. See Figure 11-34 for a picture of the component.

![Figure 11-34 OnDemand media administration overview](image)

One of the benefits of using OnDemand for your data archives is that you never have to specify a particular optical volume or tape volume when storing or retrieving your data. OnDemand manages this for you. You define a policy for your reports or objects that have similar storage requirements (how long to keep and where). You assign a policy that refers to a group of optical or tape volumes that can be used for that policy. For optical volumes, this group is called a storage group. For tape, the grouping is done by media type which is a physical characteristic of the tape media itself.

For instance, when you store a report, the report's definition is checked to determine which policy to use. The report policy in turn is used to find the optical storage group and/or tape media family it should use. The actual optical volume used within the storage group is the volume that has the smallest amount of space available on it and is not yet marked full. This is done so that once OnDemand starts to use a volume, it will continue to use that volume until it is full. The actual tape volume is chosen from the volumes available of that media type, selecting the tape with the smallest number of bytes available on it that is not yet marked full.

When storing data, the media used by each OnDemand feature is determined as follows:

**Spool File Archive**  The report definition specifies a report policy which points to the optical storage group and tape media type to use.

**Object Archive**  The object control table entry specifies an object policy which points to the optical storage group and tape media type to use.

**Record Archive**  The file creation commands require you to specify the optical storage group to use.

**AnyStore**  The report definition specifies a report policy which points to the optical storage group and tape media type for use. The OnDemand administrator must ensure that there are optical volumes and tape volumes that identifies the available space in the OnDemand inventory tables. Accomplish these and other media-related functions using the menu options or commands that are described in this chapter.

Once data has been written to optical or to tape, OnDemand knows where it placed the data so you do not have to specify the volumes where the data is located.
Work with tape devices
Use this option to add, change, remove, or display a tape device.

**Note:** If you use BRMS for tape management, you do not need to add anything here; OnDemand uses information in the policy definition to link to BRMS.

Work with tapes volumes
Use this option to create new tape volumes, delete or change the properties

You must add each tape volume that you want OnDemand to use. Enter a volume ID for each initialized tape you want to use for report archives or backups.

Initialize each tape before you define it to OnDemand.

**Note:** If you use BRMS for tape management, you do not need to add any data to this table. OnDemand uses the Policy definition to link to BRMS directly.

Work with storage groups
A storage group lets you group optical volumes to store related data, such as all payroll reports or even all permanently archived reports, together on a set of optical volumes. You must define a storage group before you can add volumes to it.

Use this option to create, change, delete, or display a storage group.

Work with optical volumes
Use this screen to add, change, remove, or display optical volumes.

11.4.4 Common Server Administration feature

Using the plug-in with the *OnDemand Common Server* feature, you can:
- Create migration policies to specify how long and where archived data is to be stored
- Create definitions for output queues to be monitored to assist in automatically archiving spooled files
- Optionally define optical volumes, tape volumes, and disk pools (user auxiliary storage pools) to be used when archiving data and spooled files
- Launch the *OnDemand Administrator Client* which is used to define report indexing and end-user requirements

Refer to *IBM Content Manager OnDemand for iSeries, Common Server Administration Guide, Version 5.1, SC27-1161*, for more information.
The administrative functions in OnDemand are set up using Operations Navigator and the OnDemand Administrator (Figure 11-35), and include:

- Defining reports to the system
- Adding and maintaining OnDemand users and groups
- Adding and maintaining server printers
- Maintaining storage sets and migration policies
- Generating reports about users, groups, applications, application groups, storage sets, folders, and printers
- Adding and maintaining servers
- Setting system parameters for OnDemand servers and client programs
- Copying items from one OnDemand server to another
- Tracking changes made to the system. When you use the Operations Navigator to add or update the database, OnDemand places a document in the system log which shows the changes that you made.

The following is a list of the administrative items that are maintained directly through Operations Navigator:

- Tape devices
- Tape volumes
- Optical storage groups
- Optical volumes
- Disk pool storage groups
- Monitor definitions
- Migration policies

The items that are maintained through the OnDemand Administrator are:

- Users
- Groups
- Applications
- Application groups
- Storage sets
The **OnDemand Administrator** is launched by **right-clicking** on Common Server Administration within the OnDemand Archive section of Operations Navigator. From the resulting pop-up menu seen in Figure 11-35, **click Client Administrative Functions** to launch the OnDemand Administrator.

**Note:** The OnDemand Administrator Client must be installed as a separate product before you can use it. For more information about installing the software refer to *IBM Content Manager OnDemand for iSeries Common Server, Planning and Installation Guide, Version 5.1*, SC27-1158.

### Migration Policies

Migration policies are used if and when archived data should be moved as it ages through a hierarchy of storage media having different performance and capacity characteristics, such as disk, tape, and optical storage.

Use this dialog to create or change a migration policy that contains migration and storage media characteristics for data archived using OnDemand for iSeries. This information is used by the Archived Storage Management process (ASM), Each step in the movement of data through this storage hierarchy is referred to as a migration policy storage level, or simply, a storage level. Each policy must contain at least one storage level. Additional levels may be defined to meet your storage and retrieval requirements.

The policy also specifies:

- If separate archived files are to be aggregated, or combined, with other archived files having similar retention and migration characteristics which can increase the performance of the migration process by reducing the total number of files to be processed
- If two copies of archived data are to be kept at some or all levels in the migration sequence
- If a one-time tape backup is performed

### Monitor Definitions

Monitor definitions are used to specify what output queue will be monitored for spooled files to be processed. If defining more than one monitor job, specify a unique job name for each monitor. OnDemand will only process spooled files that are in a ready state. When the monitor job selects a spooled file from the selected output queue for archiving, it needs to determine which application group and application to associate with the spooled file so that the file can be archived correctly. Since the only data available to the monitor are the attributes of the selected spooled file, the application group name and application name must be derived from the contents of one of these attributes. Not all attributes are suitable for this purpose.

OnDemand will examine the contents of up to three of the following nine attributes, in the order specified in the Check first, Check next, Check last selections:

- Spooled file name
- Form type
- User data
- Job name
- User-defined options 1 through 4
- User-defined data
In Figure 11-36 the attribute selected from the “Check first” pull-down list is examined first. If the value of this attribute does not match the name of an existing application group, OnDemand examines the attribute selected from the “Check next” pull-down list, if specified. If the value of this attribute does not match an application group name, the attribute selected from the “Check last” pull-down list, if specified, is checked.

If a valid application group is not determined using the above method, the spooled file is moved to another output queue designated as an “error” queue which is defined in this monitor definition. If the spooled file is successfully archived, it can be moved to a “processed” queue or deleted according to the specifications in the monitor definition. The same process is followed to find a valid application name, unless you specify that the application name is the same as the application group name.

The monitor can be started manually, by a job scheduler, or started when the subsystem starts. The monitor can be ended manually, after a specified time period, after all queue entries are processed, or it can be specified when the monitor is started.

Note: Tape devices, tape volumes, optical storage groups, optical volumes can be set in different instances. Usage is the same as in Medial Administration.

Disk pool storage group
The OnDemand Disk Pool dialog enables you to identify an OS/400 Auxiliary Storage Pool (ASP) that the Archived Storage Management process may use as storage media when migrating archived data.
11.5 Lotus Domino

This topic gives you an short overview how to use Operations Navigator, together with Lotus Domino for iSeries plug-in, to set up and manage single or multiple Domino for iSeries servers on one or more iSeries servers.

Lotus Domino for iSeries can certainly run completely independent of Operations Navigator. However when installed as an Operations Navigator plug-in, can be used to administer Domino servers and it is fully integrated with the client desktop in the Windows environment.

The Lotus Domino plug-in for Operations Navigator is a separately installed sub-component of Operations Navigator that allows you to perform these tasks:

- Create (set up) Domino servers on your iSeries server.
- Access the NOTES.INI files and other Domino server properties.
- Modify the NOTES.INI files of the Domino servers on your iSeries server.
- Start and stop Domino for iSeries servers.
- Access the Domino administration client.
- Register Domino users.

The Operations Navigator for Domino plug-in is used with Operations Navigator but it comes with the Domino code.

Before you can set up a workstation to create and manage Domino for iSeries servers, you must install Domino for iSeries on your iSeries server. This can be done through the Domino EZ-setup Wizard.

Detailed Information about the functions installing Domino without the EZ-setup Wizard can be found in: Lotus Domino for AS/400 R5: Implementation, SG24-5592.

Functions availability

The Operations Navigator plug-in extension to manage Domino servers provides several functions. You must have this plug-in installed on your Domino Administrator workstation, and you must have the workstation configured to be a Domino administrator.

In this redbook, we provide an example of installing Domino with the EZ-Setup wizard.

Important: Remember, you can perform the functions described in this section only if your client PC is configured to be a Domino administrator.

11.5.1 Installing Domino using the Domino EZ-Setup Wizard

The Domino EZ-Setup wizard will poll the user for information about the Domino server that will be created, install Domino on the iSeries (if Domino is not currently installed), configure and start the Domino server.

EZ-Wizard configure

This wizard does the following:

- Installs the following Domino components on the iSeries server:
  - Domino server base
  - iSeries server Integration
  - HiTest C API
  - C API
  - C++ API
  - LotusScript Extension Toolkit
– Advanced Services

▶ Configures the following on the iSeries server:
  – Configures the Domino server
  – Sets up or connects to a Domino Domain
  – Sets up a new Domino administrator
  – Configures a Web server
  – Configures Domino mail
  – Sets up Encryption
  – Installs the Domino plug-in for Operations Navigator, the graphical interface for administering Domino Server.

The Domino wizard installs the server software, if necessary, and configures a basic server. It is ideally suited for a first server configuration, but can be run multiple times to configure multiple servers provided that a partitioning license for the Domino product has been purchased.

**Note:** The wizard cannot be used to upgrade the Domino for iSeries Server software.

### Requirements

The following conditions must be met before using the Domino EZ-Setup wizard:

▶ Version V5R1 of OS/400 must be installed on the iSeries server.
▶ Version V5R1 of Client Access Express must be installed on the PC.
▶ The Operations Navigator options of Client Access Express must be installed
▶ The Domino for iSeries server CD-ROM (release 5.0.7 or later) must be in the optical drive in order to copy files it needs to run, even if the server software has already been installed.

### Running the EZ-wizard

The EZ-Wizard can be found by right-clicking on Servers in the Network tree of an iSeries connection.

**Note:** The wizard guide you through numerous windows, not all of which are not shown here.

1. Select **Install and Configure Domino** from the context menu. See Figure 11-37 for an example of starting the EZ-Wizard and the Welcome window.
2. Insert the Domino CD (5.0.7 or later) in the iSeries CD-rom drive and click **Next**

3. Click **Next** for starting the install procedure. This will copy all necessary files to the \QIBM\ProdData\Lotus\Notes directory.

   **Note:** If you have installed the software before the wizard goes directly to the license window.

4. Answer the license question with **Yes**.
   
The software will be installed on the iSeries an takes about 15 to 30 minutes.
5. Select TCP/IP Interface you will use for Domino (Figure 11-38). A conflict can occur on Port 25 or 80 because another service is running (SMTP or Webserver) on this IP-Address.

   **Note:** Clicking on Add Another Interface will close the wizard and starts the TCP/IP Interface wizard

6. Answer the Question if this is your first server with Yes.
7. Enter organization name and click Next.
8. Select country (or region) code (this is new for Domino Release 5.0.8) and click Next.
9. Enter the domain name and click Next.
10. Enter the Domino server name and click Next.
11. Enter the Administrator Name and Password with the minimum Password length (new for Domino Release 5.0.8) which is set in the field below. Click Next.
12. Set the Webserver encryption to No. This will disable SSL-Support for Domino.
13. Select the mail options for the Domino Server. A conflict can occur when the Port used by another application. See both windows in Figure 11-39.
14. Enter the Data directory where to copy the Lotus Configuration files or take the default. The Files are copied to this directory.

15. Enter the Path to save the Notes ID-Files.

16. A Summary screen Figure 11-40 is shown after all the configuration is saved. You should save this information for future reference with the **Save** button.

17. You are now ready to manage your Domino Server with Operations Navigator. This is described in the next section.
11.5.2 Managing Domino server

Managing the Domino can be done with the plug-in. For installing the plug-in refer to “Installing and uninstalling the plug-ins” on page 387.

Figure 11-41 Lotus Domino plug-in overview

Detailed Information about managing Domino Servers with Operations Navigator on your iSeries can be found in: Lotus Domino for AS/400 R5: Implementation, SG24-5592.

Create or deleting a Domino server

You can create an additional Domino server with a right-click on the Domino icon in Figure 11-41 and select New Domino Server. When you create a Domino server using Operations Navigator, it starts the Web interface.

If you right-click a server icon and select Delete, you delete the server. This is the equivalent of executing the Configure Domino Server (CFGDOMSVR) command with the option *REMOVE. You are prompted to confirm that you mean to delete the server. This is not the case when deleting the server from the 5250 interface.

Starting and stopping Domino servers

After creating a Domino server through the graphical user interface of Operations Navigator, you can also start or stop the server with the same interface. You can click the Domino icon in the left pane, you see all your servers in the right pane of the Operations Navigator window. To the right of each icon, you can see the status of the server:

- Stopped: The server tasks are stopped and the server is not active
- Start submitted: The request to start the server tasks was submitted.
- Starting: The primary server tasks are starting.
- Started: The server is running.
- Started and active: The server is running and can be accessed from a workstation.

Add Domino application

Use the Add Application option to add an optional part of the Domino licensed application to a Domino server on your iSeries. This could be for an example the Domino Migration Engine (DME-5733DME). You have to specify the Product number and directory of this application.
Administering a Domino server
Operations Navigator allows you to perform the following administrative tasks for Domino for iSeries by right-clicking on the Domino server and select Properties. See Figure 11-42 for an example.

![Figure 11-42 Domino Server properties](image)

Basics
The Basics tab provides information about the Domino server, such as the server’s name and title.

Internet
Use the Internet tab to specify which Web features to include in the configuration of this Domino server.

Mail
Use the Mail tab to specify which Internet mail packages to include in the configuration of the Domino server. The mail packages allow the Domino server to send mail to and receive mail from the Internet. You can also use this page to specify which directory service the Domino server uses.

Services
Use the Services tab to specify what type of services to configure for this Domino server. You can also use this page to log replication and client session events.

Locale
Use the Locale tab to specify the local time zone, whether to observe daylight savings time and how the Domino server should sort characters.

Network Configuration
The Network Configuration tab shows network information for the Domino server that you have selected. The values that appear on this page are set in the Domino Directory. You can only view this dialog when the server is running. The server's Domino Directory must be available to view this dialog.

Initialization File
The Initialization File tab shows a copy of the notes.ini file that runs when you start this Domino server. You cannot change the copy. The system creates this initialization file automatically when you configure the server. An experienced Notes administrator can make changes to the Domino configuration by editing this file. Display or change the Domino initialization file (NOTES.INI).
Launch the Domino Administrator
With a right-click to Server Administration or the Toolbar-Button you start Lotus Notes with the Administrator Profile.

Registering Domino users
Operations Navigator allows you to manage many components of the iSeries server. This includes creating, changing, grouping, and deleting iSeries users (user profiles). The Operations Navigator plug-in extension to manage Domino servers also enhances your capability to manage users because you can register Domino user IDs at the same time as you create a new iSeries user profile, or you can create a Domino user based on an existing iSeries user profile.

To start the Domino User Registration go to My Connections -> systems -> Users and Groups for the iSeries server where Domino is installed. Select Users and Groups and display a list of users. Right-click a user and select Properties. Click Networks and select Domino Registration. You see the all Domino Servers listed for this iSeries server. Here you can click Add to enroll this user to a Domino server. See for Figure 11-43 an example of adding a user.

Figure 11-43 Registering Domino user

11.6 Third-party plug-ins

Operations Navigator includes a plug-in feature that provides a common framework for iSeries Business Partners and customers to add their own applications to their users Operations Navigator tree. After you have created your application plug-in, you can take advantage of the support provided by the Client Access Selective Setup program to distribute your new Operations Navigator plug-in within your organization or to outside users and customers. The following sections provide an overview of how to take advantage of this plug-in support so that an application can have the same administrative look and feel of the IBM-provided plug in support.

Originally Operations Navigator plug-in feature in the previous release of Client Access for Windows 95/NT only provided support for programs written in Windows C++. Starting with V4R4 support enables the Express Client to include plug-in support for Java and Visual Basic applications.

Figure 11-44 is an example of third-party plug-ins.

Plug-in developing requirements

An Operations Navigator plug-in stipulates different requirements according to the programming language you plan to use:

- To function as an Operations Navigator plug-in, C++ applications developed using Microsoft’s Visual C++ must be written to run on Version 4.2 or later.
- Java plug-ins run on the IBM Win32 Runtime Environment, Java Edition, Version 1.1.7 (Win32 JRE), and Sun’s Java Foundation Classes (JFC), Release 1.0.3.
- Visual Basic plug-ins run on Version 5.0 of the VB runtime environment. The plug-in feature is also provided in the Client Access for Windows 95/NT product for C++ plug-ins only, beginning in Version 3 Release 2.

For detailed information on how to create Operations Navigator plug-ins, browse the AS/400 Information Center and Technical Studio Web sites, or refer to the sources in the following section.

More detailed Information can be found on:

AS/400 Operations Navigator Plug-In Support Web page:
http://www.ibm.com/servers/eserver/iseries/oper_nav/
Chapter 12. Application Administration component

This chapter describes the functions of the Application Administration component of Operations Navigator:

- Application Administration categories with overview
- Operations Navigator Administration
- Client Applications Administration
- Host Applications Administration
12.1 Application Administration categories

The Application Administration component of Operations Navigator allows you to administer access to a set of functions grouped, under Applications Administration, into the following categories:

- Operations Navigator
- Client Applications
- Host Application

Operations Navigator Application Administration became available starting with OS/400 V4R3 and has been enhanced in V5R1. In this chapter we focus on administering Operations Navigator functions and show some examples.

This component is installed through either Client Access Express Full or Custom installation. If this component is not installed on your workstation you can install it by running Selective Setup as discussed in “Selective setup” on page 60.

**Important:** Application Administration is a simple way to control whether a specifically signed-on Operations Navigator user can even see a specific Operations Navigator folder. Application Administration has similar effect on Client Applications such as Client Access Express and various applications under Host Applications. Application Administration is provided using the following “access settings:"

- “Default access”
- Only users with “all object access” system privilege ("ALLOBJ special authority in OS/400 command interfaces)
- Customized access (specific users explicitly listed as “access allowed” or “access denied”).

Note, however, Application Administration is not considered an iSeries “security feature”, but rather a “limit access” feature. This is because any specification of “access denied” or “access allowed” applies only to seeing the “function grouping” supported by Operations Navigator, the client application, or the Host application.

Using Operations Navigator folders as an example, you can actually limit the folder from being displayed for certain users, so the Operations Navigator user cannot perform the functions available through that folder. You can also specify the folder to be displayed. However, when attempting to actually do a function under one of these folders or through some other system interface, any Applications Administration specification is “overridden” by iSeries system security features, such as:

- OS/400 user profile-based privilege class (OS/400 command interface “user class”)  
- OS/400 user profile system privileges (OS/400 command interface “special authority”)  
- Specific object permissions

Keep in mind the following examples while reviewing this chapter:

- OS/400 user profile As0301 has “all object access” and “job control” system privileges. Application Administration explicitly denies As0301 to the Work Management folder. This means when using Operations Navigator user As0301 does not see any Work Management folders. However, from a 5250 workstation, user As0301 can view all active jobs, hold, release and end an active job.
- OS/400 user profile Causer has privilege class User and but does not have job control system privilege. Application Administration explicitly specifies either “default access” for
all users or explicitly specifies “access enabled” for user Causer. Causer can see and use all Work Management folders, including displaying the list of active jobs on the system with his Operations Navigator session. However, when Causer attempts to hold, release, or delete/end a job, an error message window indicates insufficient authority to do the function. Causer will fail attempting to do these functions from a 5250 workstation as well.

Later in this chapter we show examples considering use of Applications Administration and OS/400 security.

For detailed information about Application Administration beyond this chapter, see the iSeries Information Center Web site at:

http://www.iseries.ibm.com/infocenter

Once you reach this site, select Operations Navigator->Application Administration.

### 12.1.1 Application Administration overview

You access the context menu of Application Administration for either a system (1) or a Management Central central system (2) as shown in Figure 12-1. In our example we show iSeries system As80 in both cases.

Figure 12-1   Opening Application Administration

The resulting window for My Connections -> As80 -> Application Administration is shown in Figure 12-2.
In Application Administrations for My Connections -> system you can perform administration under the following categories:

- **AS/400 Operations Navigator**: Contains all Operations Navigator folder hierarchy functions and any plug-ins. We show an example later in this chapter.

- **Client Applications**: Contains client applications such as Client Access Express functions (ODBC, 5250, data transfer, and so forth.)

- **Host Applications**: *Starting with V5R1* this category merits important considerations more than earlier OS/400 releases. For IBM-provided functions in this category through V5R1 you can administer:
  - TCP/IP Utilities - File Transfer Protocol (FTP) functions
  - Digital Certificate Manager functions, including certificate storing and new for V5FR1 Object Signing functions
  - iSeries Service Tools user profile required functions, including:
    - Cluster management
    - Disk unit view and management
    - Logical Partition management
    - Service trace usage (requires guidance from IBM authorized support personnel)

The Applications Administration window for **Management Central** is shown in Figure 12-3.
The Application Administration window for Management Central allows you to control the functions available on the central system that you are currently using. The principles discussed for administering applications on individual systems also apply to Management Central. However, in this chapter we focus on My Connections -> system -> Applications Administration functions.

Each application may contain one or more function groups that are to be administered. In this chapter we consider each function group as if it were a folder in Operations Navigator terms for ease of discussion.

For example Operations Navigator has functions under an Active Jobs folder. Backup and Recovery Media Services, 5722-BR1, when registered with Application Administration, has functions grouped into “folders” such as Backup, Media, Migration, and more. Each of these groupings has sub groupings of functions. All of these “functions” are considered folders in this chapter.

**Important:** Note that all of the online information for Application Administration uses the term functions. From the Operations Navigator category, the term function actually refers to the Operations Navigator “function grouping” at the folder level.

Just keep this in mind that at different levels of Applications Administration for Operations Navigator, Client Applications, or Host Applications, a function being administered may actually refer to a group of functions.

Each function may have multiple settings, called access settings that are used to control access to that function. Users are either denied or allowed access through Operations Navigator interfaces. We discuss these access setting categories in “Administering applications at the function level” on page 442.
Here are three Application Administration general concepts with which you should be familiar:

- **Application registration**

  Applications must be registered on the iSeries system before they can be administered through Application Administration. iSeries provides specific applications as pre-registered to Applications Administration. However, by default, a typical third party application is not registered to be administered.

  IBM provides several applications ready to be administered including Operations Navigator, Client Access and several applications under Host Applications, such as Digital Certificate Manager, Operating System Service applications including Cluster Management, Disk Units, and Logical Partitions.

  If you want to register your own application as an Operations Navigator plug-in, some actions are required if it is to become administrable by Application Administration. You need to modify the plug-in registry file with the information that defines the Application Administration functions. If the plug-in defines Application Administration functions, the plug-in can be registered on the iSeries system and managed with Application Administration.

  Use the Applications dialog within Application Administration to remove Operations Navigator or Client applications. Typically, a Host application that intends to be administered through Operations Navigator Application Administration registers its administrable functions when you install it on the host iSeries system.

  Figure 12-4 shows the OnDemand for AS/400 product ready to be registered to Applications Administration as a plug-in under Operations Navigator.

  ![Figure 12-4 Adding an application to be administered](image)

**Important:** Once you register an application, all users are allowed access to the application's functions by default - “default access”.

For applications that have a PC component, you must install the application on your PC before you can register it on your iSeries system. Once you register an application, any other PC running Application Administration can administer or remove the application's administrable functions from your iSeries system, even if the application is not installed on the PC.
When accessing Application Administration for the first time, if applications are detected on the PC that are not registered on the iSeries system, a message box is presented, as shown in Figure 12-5.

![Figure 12-5 Applications to administer detected on the PC workstation](image)

If an administrator removes an application that is not installed on the PC, they are notified that they need to install the application on the PC to register it later, as shown in Figure 12-6.

![Figure 12-6 Removing an application that is not installed on the PC workstation](image)

**Important:** Removing an application from Application Administration removes the application's administrable functions and associated access settings. This results in all users having access to the application's functions.

Remember, for most Host application, you do not need to explicitly register it, because it registers its administrable functions when it is installed on the iSeries system. Figure 12-7 shows an example of the Host Applications window under Application Administration.
Backup and Recovery and Media Services, 5722-BR1, has already registered itself to be administered. Note, in our example someone has already done some Customized Access for the other “applications” (x under the Customized Access column) automatically provided with V5R1 OS/400. We discuss customization later in this chapter.

**Important:** As shipped from IBM all check boxes are blank (no access from Operations Navigator) for registered TCP/IP Utilities, Digital Certificate Manager, Cluster Management, Disk units, and LPAR management. This means, for example, you would not even see the Disk units folder under **Configuration and Service - > Hardware**, if we had not already explicitly used Application Administration to check All Object Access (users with all object access can see the folder) or used Customized Access.

We discuss this later in this chapter.

For more information on registering your own applications see the iSeries Information Center Web site at: [http://www.iseries.ibm.com/infocenter](http://www.iseries.ibm.com/infocenter)

Once you reach this site, select **Operations Navigator->Application Administration**.

**Working with the settings of a specific user profile**

- You can use Application Administration to identify which functions a user or group may access. You can also customize access for a user or group to specific functions.

- To do this, follow these steps:
  1. In Operations Navigator, expand **Users and Groups**.
  2. Select either **All Users**, **Groups**, or **Users Not in a Group** to retrieve a list of users and groups.
  3. Right-click a user or group, and select **Properties**.
  4. Click **Capabilities**.
  5. Click the **Applications** tab. This shows the Application Administration settings for this user. The windows shown are similar to the Operations Navigator, Client Applications, and Host Applications window shown in this chapter.
We show examples of this in “Administering applications at the user or group level” on page 446.

- Administering applications

The remainder of this chapter focuses on this topic, in which you typically administer a registered application through the context menu Application Administration interface, specifying which users or groups of users can see the Operations Navigator component.

12.1.2 Administering applications

You must have System privilege System administration (*SECADM special authority in the OS/400 command interface) to administer applications. Administering can be done from three interfaces:

- From Management Central -> context menu -> Application Administration.
- From the My Connections -> system name -> context menu -> Application Administration
- From My Connections -> system -> Users and Groups -> user or group profile -> Capabilities -> Applications

In this chapter we focus on the My Connections -> context menu Applications Administration and the Users and Groups -> user profile -> Application interfaces. Except for different functions, the interface for Management Central functions is similar to the one for My Connections -> context menu interface. The Users and Groups -> user profile interface is somewhat unique - it does not support Management Central functions.

We recommend that you administer applications first at the context menu Application Administration level and then when you are familiar with that technique, consider using the user or group level interface.

For each function, you can simply check any or all of the following:

- Default access
- All object access (a user profile with system privilege all object access has full access to the folder
- Customized access (specify access to the folder by explicitly listing a user profile or group profile as “access enabled” or “access denied”

Accessing settings are further defined in “Administering applications at the function level” on page 442.

The following steps outline the suggested order you can follow to actually administer functions with Application Administration. You need not do steps 5 and 6, which use the Users and Groups component interface.

1. Set the Default Access setting at function level.
2. Set the All Object Access setting at function level.
3. Customize the access settings for your group profiles at the folder level.
4. Customize the access setting for your individual profiles at folder level.
5. Set the group access setting at group level.
6. Set user access at user level.

Steps 5 and 6 may seem to be redundant with steps 3 and 4, but it may be useful to review the settings for special users and groups.
Changes you make to a function’s access settings may not be immediately reflected on your client PC. Depending on the application, changes take effect:

- The next time the client PC signs on to the iSeries system. This is the case for Operations Navigator folder functions.
- The next time you restart the client PC, or 24 hours after the change is made, whichever comes first. This is the case for Client Access Express functions.

**Administering applications at the function level**

From the main dialog shown in 1 in Figure 12-8, you can see the Default Access, All Object Access settings are checked (on) for all the Operations Navigator folders shown. The access settings are defined as follows:

- **Default Access**: Determines a user's access to a function when the user and its groups are not explicitly allowed or denied access to the function. If this check box is selected, access will be “allowed”. If the check box is not selected, access will be “denied”.

- **All Object Access**: Indicates whether a user or group with all object system privilege (all object access) is allowed access to the function. If this check box is selected, and the user or group has the all object system privilege, this setting overrides all other access settings. That is, if this box is checked, then a user with OS/400 all object authority/privilege has access to this function, even if that user ID is explicitly excluded from access via the Customize Access function.

  If this check box is not selected, all object system privilege is ignored when determining a user's access.

- **Customize Access**: Indicates whether users or groups are explicitly denied or allowed access to the function. To give users or groups specific access, select the function, and click the Customize button.

As shown in the window at 4, in this example we have selected to customize access to **Basic Operations -> Messages**.

In the window at 2, we have already scrolled down in the list window of user profiles and group profiles to add Dwayne (who does not have All Object Access system privilege) to Access allowed, so that this user can see the Messages folder during his Operations Navigator session.

At window 2 we also have already selected to explicitly deny user profile Itscid15 and group profile Stevegrp. By clicking OK we get the updated window at 3.
This means user Itscid15 and those users in group profile Stevegrp will not see the Messages folder under Basic Operations in their Operations Navigator main window provided they do not have OS/400 All Object Access system privilege as defined through the create or change user/group function. They simply cannot view or respond to messages through the Operations Navigator Basic Operations -> Messages interface.

However, using Itscid15 as an example, a user “denied” to view or respond to messages through Basic Operations - Messages may be able to view and respond to messages through some other system interface. Assume itscid15 is defined in OS/400 to be in Privilege class User (equivalent to User Class *USER through the 5250 interface). By default, this class enables the user to view and respond to messages from a 5250 work station.
See “Operations Navigator - Work Management Example” on page 445, for another example, following the flow chart showing how Applications Administration settings are processed.

Application Administration evaluates a function’s access settings to determine whether a user is allowed or denied access to the function. The flow chart in Figure 12-9 shows the process that Application Administration applies.

**Tip:** If you need to know if a user has access to a function, you can follow the steps in “Administering applications at the user or group level” on page 446, as though you wanted to administer an application at user or group level. On step 6, the resolved access is given as shown in Figure 12-13 on page 448.

![Flowchart](image-url)
Operations Navigator - Work Management Example
The intent of this example is to illustrate that OS/400 has “final say” on whether an Operations Navigator function can be performed, even if Application Administration has been used to enable a function to be accessed through an Operations Navigator folder.

We use as our base Figure 12-10. For the Work Management -> Active Jobs folder we have unchecked the Default access and All Object Access settings. This means that, unless Customized access is specified, no Operations Navigator sessions to As01 will see the Active Jobs folder. In this example, we customized the access by explicitly authorizing only user Userndos to see the Active Jobs folder when Userndos expands the Work Management tree folder.

In windows that are not shown in this book, Userndos has opened the Active jobs window and selected a job to delete (end) or hold. When Userndos attempts to do that function, a window is displayed indicating he is not authorized to do the end or hold function.

The window at (Users and Groups -> user profile Userndos -> Capabilities) shows Userndos has Privilege class of “User” and does not, by default, have the additional System privilege of Job Control.
Managing applications at the user or group level

This is an alternative way to view and assign Application Administration access settings - through a user profile accessed through the Users and Groups Operations Navigator component folder.

<table>
<thead>
<tr>
<th>Function</th>
<th>Default Access</th>
<th>All Object Access</th>
<th>Customized Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>A01 in My Connections</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basic Operations</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Messages</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printer Output</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printers</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jobs Management</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Jobs</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subsystems</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job Queue</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory Pools</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Configuration and Service</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Values</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hardware</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 12-10** Application Administration and OS/400 security example
When Users and Groups is installed on your PC workstation and assuming My Connections -> system name -> context menu -> Application Administration has not denied you to the Users and Groups folders (functions), you can administer applications at a user profile or group profile level. This topic assumes you have access to these folders (functions) as shown in Figure 12-11.

**Note:** You can fully administer applications through Application Administration without going through the User and Group interface. However, if you need to customize access to many applications functions for special users or groups, it is faster to work at a user or group level.

![Operations Navigator Users and Groups component](image)

**Figure 12-11** Operations Navigator Users and Groups component

If the Users and Groups component is missing, install this sub-component by following the instructions given in "Selective setup" on page 60.

To administer an application from a user or group level, follow these steps first, select My Connections -> system name -> Users and Groups -> All Users (or Groups, or Users Not in a Group) -> user profile -> Properties -> Capabilities, as shown in Figure 12-12.
7. Select Capabilities and then select the **Application** tab from the Capabilities window, as shown at Figure 12-13.

Using the pull-down list **Access for:** (shown at 1), select the application category you want to administer for this user or group. In our example, Client applications is selected.

In this example we use Client applications - Client Access Express. Select the check box for the functions you want to allow access. Deselect the check box to deny access. When this dialog is displayed, the access settings are already resolved with the same mechanism explained in “Administering applications at the function level” on page 442. The source of the access listed in the column User Access (Dwayne in our example) is given in the second column Access Derived From.

In this example, we see that the user is denied access to use Excel Add-in Uploads. All other settings come from the Default access.
12.2 Operations Navigator and Client Access Express

Any application that is enabled to use Application Administration can be administered by Application Administration. In this section, we only cover applications that have a direct link with Client Access Express for Windows - Client Access Express and Operations Navigator. See examples using the following topics in this chapter:

- “Administering applications at the function level” on page 442
- “Operations Navigator - Work Management Example” on page 445
- “Administering applications at the user or group level” on page 446

Administrable Operations Navigator functions

All Operations Navigator Client applications and their first level functions are administrable with two kinds of “extra considerations”:

- **Users and Groups, Multimedia, Application Development, AFP Manager and Backup** folders do not provide the granularity of their first level functions. You can only allow or deny access to all sub folders (functions).

- **File systems** folder functions offers a second level function administration for the function Integrated File System. This means you can restrict or allow users to a specific file system (Root, QSYS.lib, or QDLS, for example).

Remember a user not enabled to access a function through Application Administration does not see that “function” (folder) in the Operations Navigator hierarchy tree pane. Using Figure 12-14 as an example, we have removed Default Access to all Work Management functions (folders) but kept All Object Access. The user using window 1 has All Object Access. The user using window 2 does not have All Object Access.

Figure 12-14  Application Administration example with default access to Work Management removed

**Plug-ins**: Application Administration windows display the administrable functions of an Operations Navigator plug-in two places:

- As read-only values in the Operations Navigator hierarchy to specify the location of the plug-in folder function within the hierarchy.

- In a first-level folder for the plug-in. You can administer the access settings for a plug-in’s functions only from this folder.
Administrable Client Access Express for Windows functions

The Express client provides the following functions that can be separately administered through Application Administration:

► 5250 Display and Printer Emulator
► Data Transfer
  – Download from the AS/400 system
    • GUI downloads
    • Use of RTOPCB
    • Autostart downloads
    • Excel Add-in downloads
    • ActiveX Automation Downloads
  – Upload to the AS/400 system
    • Host File Creation (file creation based on an existing AS/400 file and Wizard Creation of an AS/400 file)
    • Appending or replacing host files
    • GUI uploads
    • Using RFROMPCB
    • Autostart uploads
    • Excel Add-un Uploads
    • ActiveX Automation Uploads
► ODBC support
► OLE DB Provider
► Remote command (command line)

When a user is denied access to a Client Access Express for Windows function, they can start the function and configure it, but they cannot process it. For example, if a user is denied access to Data Transfer GUI Upload, they can define an upload and save it. However, they cannot process the Data Transfer to the iSeries system where they were denied access. The windows shown in Figure 12-15 appear when a user is denied access to the PC5250 emulator and GUI Download Data Transfer respectively.

Figure 12-15   Application Administration policy restrictions for 5250 and data transfer

12.3 Administrable host application functions

Host application administration can be very important for a specific third-party applications installed on your system and registered through Operations Navigator Application Administration registration.
Important IBM applications and functions are also “registered” and can be administered through the Host Applications window. These functions include Digital Certificate Manager, Backup Recovery and Media Services, File Transfer Protocol (FTP), and Service Tools security protected functions (including Cluster Management, LPAR management and Disk unit management).

In Figure 12-16 we highlight in window A the Host Applications for IBM-provided applications that must have access enabled for the corresponding functions/folders to appear in the left pane hierarchy tree under either Management Central and My Connections:

- Disk unit management (1)
- Cluster management (2)
- LPAR management (3)

As shipped with V5R1, these checkboxes are not checked for Cluster Management, Disk Unit, and the LPAR management functions. We have checked “All Object Access” in this example.

Explicitly enabling these “Service functions” is one of up to three required set-up actions required to use these “service-oriented” functions under Operations Navigator. You must also:

- Define a Service Tools Server user profile that has been granted privileges to specific service tools functions that correspond to the functions under these folders.

A Service Tools user profile is separate and distinct from any OS/400 user profile and must be specifically defined and granted privileges through the Dedicated Service Tools (DST) interface (via either a 5250 workstation system console or Operations Console).
Add a specific Service Table entry for the Service Tools Server to listen on port 3000. You need this entry active in order for any Disk management, LPAR configuration and administration, or Cluster configuration and management to be attempted over an IP interface. This enables the displaying of the prompt window for Service Tools user profile and password.

An administrator on your system with the appropriate authority (*IOSYSCFG) should perform the following steps to add the required service tools entry:

a. From any 5250 workstation session enter:

   `ADDSRV TBL SERVICE('as-sts') PORT(3000) PROTOCOL('tcp') TEXT('Svc Tools') ALIAS('AS-STS')`

   This command must be specified exactly as shown above.

b. End TCP and Start TCP (use OS/400 commands ENDTCP, STRTCP). You must do this when TCP/IP activity is not required.

c. After TCP/IP has started, use either the OS/400 command NETSTAT *CNN or Operations Navigator My Connections -> system -> Network -> TCP/IP Configuration -> Connections. Scroll down either screen or window until you find information that shows as-sts is “Listening” on port 3000.

All of these steps are required to ensure only the appropriate users are authorized to perform the configuration and administration functions supported for disks, LPAR and Clusters. The system service table is used by the system to manage the mapping of network services to ports and to record the protocols that the services use. An iSeries system is shipped with well-known TCP/IP applications already having listening service table entries for the TCP/IP, Client Access, and DNS servers that you can view under My Connections -> system -> Network -> Servers and Management Central folders.

Values for common functions supported by Transmission Control Protocol/Internet Protocol (TCP/IP) are available to the Internet community in the assigned numbers RFC (Request for Comments) document, a formal specification of proposals and standards for a portion of TCP/IP.

Refer to Tips and Tools for Securing Your iSeries: Version 5, SC41-5300, for additional information.

In 12.3.1, “Host applications disk units example” on page 452, we show a scenario of the Application Administration step and the Service Tools sign on window when performing Disk units functions through the Operations Navigator interface.

### 12.3.1 Host applications disk units example

Operations Navigator Configuration and Service folder support for disk units includes functions that:

- View the disk configuration in list format or graphical displays
- Configure and manage disk pools (dependent and independent) - also known as Auxiliary Storage Pools (ASPs) and Independent Auxiliary Storage Pools (IASPs)

Specific Application Administration - Host Applications access settings and Service Tools Server user profiles are required to perform these functions.

Using Figure 12-17 as a reference, we specify Disk units to have All Object Access (shown in window 1), meaning all users with system privilege All Object Access can see all Disk units folders under My Connections -> system -> Configuration and Service -> Hardware as shown at 2.
Chapter 12. Application Administration component

453

12.3.2 Host application FTP example

A new capability starting with OS/400 V5R1M0 is the ability to administer *File Transfer Protocol* (FTP) as a host application.
The complete list of FTP operations able to be administered are:

- **FTP Client**
  - Initiate Session
  - Specific Operations
    - Change Directory
    - CL Commands
    - Receive Files
    - Send Files

- **FTP Server**
  - Logon Server
  - Specific Operations
    - Change Directory
    - CL Commands
    - Create Directory/Library
    - Delete Directory/Library
    - Delete Files
    - List Files
    - Receive Files
    - Rename Files
    - Send Files

**Restricting access to the FTP logon server**

The FTP Logon Server controls all user logons and authentication when opening an iSeries host via the FTP command from another system. In this example, we work through the steps necessary to deny all users of the system except the user ID Dwayne access to perform any FTP operations to this system.

First we selected the Logon Server under the FTP Server branch from the Application Administration window shown at [1] in Figure 12-19, and then we selected Customize.
In the resulting window we have already opened All Users from the Users and Groups list (shown at 3) and added user ID Dwayne into the list of user IDs with Access allowed.

We have removed the check in the Default access checkbox (2) so default access for all users is not in effect for the Logon Server.

From this point, we selected OK twice to apply the changes to the host system.

In Figure 12-20 we use a 5250 workstation screen to show examples of an attempt to open an FTP session to the system and logon to the system. User ID Dwayne can log on successfully as you would expect from Figure 12-19. However, user ID Declan can also log on to the server, even though we de-selected “Default access”.

Figure 12-19  Customizing access for FTP logon server
Figure 12-20  FTP Logon attempts

In Figure 12-21 we show the My Connections -> system -> Users and Groups sequence for user Declan to show why Declan can also log onto the system.
Figure 12-21 Users and Groups Applications for Declan

For the user profile Declan we selected Properties -> Capabilities to show the window at 1. Note that user Declan has All object access. We then selected Applications to show the window at 2. You can see that user Declan can access the Logon Server because he has All object access System privilege.

Using window 1 in Figure 12-19 as a reference, we removed the check in the All Object Access checkbox. Now, only explicitly "Access allowed" users can use the FTP Logon Server.

In Figure 12-22 you see user Dwayne can continue to log on but user Declan can no longer log on (shown at A).
Figure 12-22  FTP logon attempts
OS/400 system values provide a powerful set of “controlling values” in the areas such as security, date and time, international application environments and performance. This appendix provides a quick reference table for finding a specific OS/400 system value through the Operations Navigator Configuration and Service -> System Values interface.

The OS/400 Work with System Values (WRKSYSVAL) command groups system values into *ALL and eight other types, including Allocation (*ALC), Date and Time (*DATTIM), Editing (*EDT), Library List (*LIBL), Message and Logging (*MSG), Security (*SEC), Storage (*STG), and System Control (*SYSCTL).

Through the Operations Navigator interface all system values have been grouped into a set of easier-to-manage categories. These new categories have no direct relation to the existing WRKSYSVAL system value types.

The table column headings for Table 12-1 on page 460 are defined as follows:

| System Value | Gives the actual system value name as seen and used through the OS/400 WRKSYSVAL, DSPSYSVAL, CHGSYSVAL commands. |

Tip: Details on specific system values are not contained in this appendix. Also, system values may be added or no longer supported after this redbook has been published.

To get details on a specific system value and the user authority (permission or System privilege) required to view and change that value, refer to one of the following sources:

- Operations Navigator online Help text as shown for the specific category properties tab settings. Figure A-1 on page 466 shows an example for the Security category.
- Information Center at [http://www.ibm.com/eserver/iseries/infocenter](http://www.ibm.com/eserver/iseries/infocenter). Select Systems Management -> System Values. Figure A-2 on page 467 shows an example for system values or auditing functions.
- The V4R5 Work Management, SC41-5306-03, manual. The PDF format of this manual can be accessed from V5R1 Information Center under iSeries Supplemental Manuals -> Systems Management. Note, this manual has not been updated since V4R4.
<table>
<thead>
<tr>
<th>System Value</th>
<th>Type</th>
<th>Description</th>
<th>Operations Navigator</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>WRKSYSVAL system value type.</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td>System value described as per the new Operations Navigator terminology.</td>
<td></td>
</tr>
<tr>
<td>Operations Navigator Category</td>
<td></td>
<td>The new easy to understand and use system value categories provided by Operations Navigator.</td>
<td></td>
</tr>
<tr>
<td>Operations Navigator Properties</td>
<td></td>
<td>The Properties tab name, under the specific Operations Navigator category where a particular system value can be found.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Table 12-1 Finding a system value through the Operations Navigator interface.</td>
<td></td>
</tr>
<tr>
<td>QABNORMSW</td>
<td>*SYSCTL</td>
<td>Previous system ending status</td>
<td>Restart</td>
</tr>
<tr>
<td>QACGLVL</td>
<td>*MSG</td>
<td>Accounting information to journal</td>
<td>Messages and Service</td>
</tr>
<tr>
<td>QACTJOB</td>
<td>*ALC</td>
<td>Number of active jobs to allocate storage for at restart</td>
<td>Jobs</td>
</tr>
<tr>
<td>QADLACTJ</td>
<td>*ALC</td>
<td>Number of active jobs to allocate storage for as needed (when QACTJOB has been exceeded)</td>
<td>Jobs</td>
</tr>
<tr>
<td>QADLSPLA</td>
<td>*ALC</td>
<td>Spooling control block additional storage</td>
<td>The system value no longer affects the Operating system</td>
</tr>
<tr>
<td>QADLTOTJ</td>
<td>*ALC</td>
<td>Number of total jobs to allocate storage for as needed (when QTOTJOB has been exceeded)</td>
<td>Jobs</td>
</tr>
<tr>
<td>QALWOBJRST</td>
<td>*SEC</td>
<td>Allow restore of security sensitive objects</td>
<td>Security</td>
</tr>
<tr>
<td>QALWUSRDMN</td>
<td>*SEC</td>
<td>Allowed location for user domain objects that are not always audited or authority checked</td>
<td>Security</td>
</tr>
<tr>
<td>QAST_LVL</td>
<td>*SYSCTL</td>
<td>Assistance level</td>
<td>System Control</td>
</tr>
<tr>
<td>QATNPGM</td>
<td>*SYSCTL</td>
<td>Attention program</td>
<td>System Control</td>
</tr>
<tr>
<td>QAUDCTL</td>
<td>*SEC</td>
<td>Audit control</td>
<td>Auditing</td>
</tr>
<tr>
<td>QAUDENDACN</td>
<td>*SEC</td>
<td>Audit journal error action</td>
<td>Auditing</td>
</tr>
<tr>
<td>QAUDFRCLVL</td>
<td>*SEC</td>
<td>Maximum journal entries before writing to auxiliary storage</td>
<td>Auditing</td>
</tr>
<tr>
<td>QAUDLVL</td>
<td>*SEC</td>
<td>Security action audit level</td>
<td>Auditing</td>
</tr>
<tr>
<td>QAUTOCFG</td>
<td>*SYSCTL</td>
<td>Allow automatic configuration of local controllers and devices</td>
<td>Devices</td>
</tr>
<tr>
<td>QAUTORMT</td>
<td>*SYSCTL</td>
<td>Allow automatic configuration of remote controllers and devices</td>
<td>Devices</td>
</tr>
<tr>
<td>QAUTOSPRPT</td>
<td>*SYSCTL</td>
<td>Automatic system disabled reporting</td>
<td>Not supported by Operations Navigator</td>
</tr>
<tr>
<td>QAUTOVRT</td>
<td>*SYSCTL</td>
<td>Maximum pass-through devices and Telnet for automatic configuration</td>
<td>Devices</td>
</tr>
</tbody>
</table>

Table 12-1 Finding a system value through the Operations Navigator interface.
<table>
<thead>
<tr>
<th>System Value</th>
<th>Type</th>
<th>Description</th>
<th>Operations Navigator</th>
</tr>
</thead>
<tbody>
<tr>
<td>QBASACTLVL</td>
<td><code>STG</code></td>
<td>Maximum eligible threads for Base memory pool</td>
<td>Performance</td>
</tr>
<tr>
<td>QBASPOOL</td>
<td><code>SYSCTL</code></td>
<td>Minimum size of Base memory pool</td>
<td>Performance</td>
</tr>
<tr>
<td>QBOOKPATH</td>
<td><code>SYSCTL</code></td>
<td>Book and bookshelf search path</td>
<td>The system Value no longer affects the Operating system</td>
</tr>
<tr>
<td>QCCSID</td>
<td><code>SYSCTL</code></td>
<td>Coded character set identifier</td>
<td>International</td>
</tr>
<tr>
<td>QCENTURY</td>
<td><code>DATTIM</code></td>
<td>Century</td>
<td>QCENTURY is used by Operations Navigator to determine the 4-digit year for the system date it displays. This value will be updated if the Operations Navigator user changes the system date setting to a new century.</td>
</tr>
<tr>
<td>QCFGMSGQ</td>
<td><code>MSG</code></td>
<td>Message queue for lines, controllers and devices</td>
<td>Messages and Service</td>
</tr>
<tr>
<td>QCHRID</td>
<td><code>SYSCTL</code></td>
<td>Graphic character set and code page</td>
<td>International</td>
</tr>
<tr>
<td>QCHRIDCTL</td>
<td><code>SYSCTL</code></td>
<td>Character identifier control</td>
<td>International</td>
</tr>
<tr>
<td>QCMNARB</td>
<td><code>SYSCTL</code></td>
<td>Communication arbiters jobs, at restart</td>
<td>Performance</td>
</tr>
<tr>
<td>QCMNRCYLMT</td>
<td><code>SYSCTL</code></td>
<td>Communications configuration recovery</td>
<td>Performance</td>
</tr>
<tr>
<td>QCNTRYID</td>
<td><code>SYSCTL</code></td>
<td>Country (or region)</td>
<td>International</td>
</tr>
<tr>
<td>QCONSOLE</td>
<td><code>SYSCTL</code></td>
<td>Console name</td>
<td>System Control</td>
</tr>
<tr>
<td>QCRTOBJAUD</td>
<td><code>SEC</code></td>
<td>Default auditing for newly created objects</td>
<td>Auditing</td>
</tr>
<tr>
<td>QCRTAUT</td>
<td><code>SEC</code></td>
<td>Default authority for newly created objects in QSYS.LIB file system</td>
<td>Security</td>
</tr>
<tr>
<td>QCURSYM</td>
<td><code>EDT</code></td>
<td>Currency symbol</td>
<td>Formats</td>
</tr>
<tr>
<td>QDATE</td>
<td><code>DATTIM</code></td>
<td>System date</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QDATFMT</td>
<td><code>EDT</code></td>
<td>Date format</td>
<td>International</td>
</tr>
<tr>
<td>QDATSEP</td>
<td><code>EDT</code></td>
<td>Date separator</td>
<td>International</td>
</tr>
<tr>
<td>QDAY</td>
<td><code>DATTIM</code></td>
<td>Day of the month</td>
<td>Date and Time</td>
</tr>
<tr>
<td>System Value</td>
<td>Type</td>
<td>Description</td>
<td>Operations Navigator</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>QDAYOFWEEK</td>
<td>*DATTIM</td>
<td>Day of week</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QDBRCVYWT</td>
<td>*SYSCTL</td>
<td>Wait for database recovery before completing restart</td>
<td>Restart</td>
</tr>
<tr>
<td>QDECFMT</td>
<td>*EDT</td>
<td>Decimal format</td>
<td>International</td>
</tr>
<tr>
<td>QDEVNAMING</td>
<td>*SYSCTL</td>
<td>Device naming conventions</td>
<td>Devices</td>
</tr>
<tr>
<td>QDEVRCYACN</td>
<td>*SYSCTL</td>
<td>Action to take when a device error action occurs on the workstation</td>
<td>Devices</td>
</tr>
<tr>
<td>QDSCJOBITV</td>
<td>*SYSCTL</td>
<td>Time-out interval for disconnected jobs</td>
<td>Jobs</td>
</tr>
<tr>
<td>QDSPSGNINF</td>
<td>*SEC</td>
<td>Display sign-on information</td>
<td>Sign-on</td>
</tr>
<tr>
<td>QDYNPTYADJ</td>
<td>*SYSCTL</td>
<td>Dynamically adjust job priorities of interactive jobs</td>
<td>Performance</td>
</tr>
<tr>
<td>QDYNPTYSCD</td>
<td>*SYSCTL</td>
<td>Dynamically adjust job priorities within priority bands</td>
<td>Performance</td>
</tr>
<tr>
<td>QFRCCVNRSST</td>
<td>*SYSCTL</td>
<td>Perform program conversion during restore</td>
<td>System Control</td>
</tr>
<tr>
<td>QHOUR</td>
<td>*DATTIM</td>
<td>Hour of the day</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QHSTLOGSIZ</td>
<td>*MSG</td>
<td>Maximum records in history log</td>
<td>Messages and Service</td>
</tr>
<tr>
<td>QIGC</td>
<td>*SYSCTL</td>
<td>Double-byte capable</td>
<td>International</td>
</tr>
<tr>
<td>QIGCCDEFNT</td>
<td>*SYSCTL</td>
<td>Double byte code font</td>
<td>International</td>
</tr>
<tr>
<td>QIGCFNTSIZ</td>
<td>*SYSCTL</td>
<td>Coded font point size</td>
<td>International</td>
</tr>
<tr>
<td>QINACTITV</td>
<td>*SEC</td>
<td>Time-out interval for inactive jobs</td>
<td>Jobs</td>
</tr>
<tr>
<td>QINACTMSGQ</td>
<td>*SEC</td>
<td>Inactive job time-out action</td>
<td>Jobs</td>
</tr>
<tr>
<td>QIPLDATTIM</td>
<td>*SYSCTL</td>
<td>Scheduled restart</td>
<td>Restart</td>
</tr>
<tr>
<td>QIPLSTS</td>
<td>*SYSCTL</td>
<td>Previous restart type</td>
<td>Restart</td>
</tr>
<tr>
<td>QIPLTYPE</td>
<td>*SYSCTL</td>
<td>Type of restart</td>
<td>General</td>
</tr>
<tr>
<td>QJOBMSGQFL</td>
<td>*ALC</td>
<td>Maximum job message queue size action</td>
<td>Jobs</td>
</tr>
<tr>
<td>QJOBMSGQMX</td>
<td>*ALC</td>
<td>Maximum job message queue size</td>
<td>Jobs</td>
</tr>
<tr>
<td>QJOBMSGQSZ</td>
<td>*ALC</td>
<td>Job message queue initial size</td>
<td>The system Value no longer affects the Operating system</td>
</tr>
<tr>
<td>QJOBMSGQTL</td>
<td>*ALC</td>
<td>Job message queue maximum initial size</td>
<td>Message Queue</td>
</tr>
<tr>
<td>QJOBPSPLA</td>
<td>*ALC</td>
<td>Initial printer output block size per job</td>
<td>Jobs</td>
</tr>
<tr>
<td>QKBDBUF</td>
<td>*SYSCTL</td>
<td>Keyboard buffering</td>
<td>System Control</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System Value</th>
<th>Type</th>
<th>Description</th>
<th>Operations Navigator</th>
</tr>
</thead>
<tbody>
<tr>
<td>QKBDTYPE</td>
<td>*SYSCTL</td>
<td>Default system keyboard</td>
<td>International</td>
</tr>
<tr>
<td>QLANGID</td>
<td>*SYSCTL</td>
<td>Language</td>
<td>International</td>
</tr>
<tr>
<td>QLEAPADJ</td>
<td>*DATTIM</td>
<td>Leap year adjustment</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QLIBLCKLVL</td>
<td>*LIBL</td>
<td>Automatically lock libraries for user jobs</td>
<td>Performance</td>
</tr>
<tr>
<td>QLMTDEVSSN</td>
<td>*SEC</td>
<td>Limit each user to one device session</td>
<td>Sign-on</td>
</tr>
<tr>
<td>QLMTSECOFR</td>
<td>*SEC</td>
<td>Restrict privileged users to specific devices</td>
<td>Sign-on</td>
</tr>
<tr>
<td>QLOCALE</td>
<td>*SYSCTL</td>
<td>The directory path to the Locale file</td>
<td>International</td>
</tr>
<tr>
<td>QMAXACTLVL</td>
<td>*STG</td>
<td>Maximum eligible threads</td>
<td>Performance</td>
</tr>
<tr>
<td>QMAXJOB</td>
<td>*ALC</td>
<td>Maximum jobs allowed on system</td>
<td>Jobs</td>
</tr>
<tr>
<td>QMAXSGNACN</td>
<td>*SEC</td>
<td>Maximum incorrect sign-on attempts action</td>
<td>Sign-on</td>
</tr>
<tr>
<td>QMAXSIGN</td>
<td>*SEC</td>
<td>Maximum incorrect sign-on attempts</td>
<td>Sign-on</td>
</tr>
<tr>
<td>QMAXSPLF</td>
<td>*ALC</td>
<td>Maximum printer output files per job</td>
<td>Jobs</td>
</tr>
<tr>
<td>QMCHPOOL</td>
<td>*STG</td>
<td>Size of Machine memory pool</td>
<td>Performance</td>
</tr>
<tr>
<td>QMINUTE</td>
<td>*DATTIM</td>
<td>Minute of the hour</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QMLTTHDACN</td>
<td>*SYSCTL</td>
<td>Non-threadsafe multi-threaded job action</td>
<td>Jobs</td>
</tr>
<tr>
<td>QMODEL</td>
<td>*SYSCTL</td>
<td>Model number</td>
<td>System Control</td>
</tr>
<tr>
<td>QMONTH</td>
<td>*DATTIM</td>
<td>Month of the year</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QPASTHRSVR</td>
<td>*SYSCTL</td>
<td>Available display station pass-through server jobs</td>
<td>Performance</td>
</tr>
<tr>
<td>QPFRADJ</td>
<td>*SYSCTL</td>
<td>Automatically adjust memory pools and activity levels</td>
<td>Performance</td>
</tr>
<tr>
<td>QPRBFTR</td>
<td>*MSG</td>
<td>Problem log filter</td>
<td>Messages and Service</td>
</tr>
<tr>
<td>QPRBHLDITV</td>
<td>*MSG</td>
<td>Minimum retention in problem log</td>
<td>Messages and Service</td>
</tr>
<tr>
<td>QPRCFEAT</td>
<td>*SYSCTL</td>
<td>Processor feature code</td>
<td>System Control</td>
</tr>
<tr>
<td>QPRCMLTTSK</td>
<td>*SYSCTL</td>
<td>Processor multi-tasking</td>
<td>Not supported by Operations Navigator</td>
</tr>
<tr>
<td>QPRDEV</td>
<td>*SYSCTL</td>
<td>Default printer</td>
<td>Printing</td>
</tr>
<tr>
<td>QPRTKEYFMT</td>
<td>*SYSCTL</td>
<td>Format when using Print key</td>
<td>Printing</td>
</tr>
<tr>
<td>QPRRTTXT</td>
<td>*MSG</td>
<td>Printed page footer</td>
<td>Printing</td>
</tr>
<tr>
<td>QPWDEXPITV</td>
<td>*SEC</td>
<td>Password expiration</td>
<td>Password</td>
</tr>
</tbody>
</table>

Appendix A. System values  463
<table>
<thead>
<tr>
<th>System Value</th>
<th>Type</th>
<th>Description</th>
<th>Operations Navigator</th>
</tr>
</thead>
<tbody>
<tr>
<td>QPWLMTAHC</td>
<td>*SEC</td>
<td>Restrict consecutive digits in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWLMTCHR</td>
<td>*SEC</td>
<td>Restricted characters in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWLMTREP</td>
<td>*SEC</td>
<td>Restrict repeating characters in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWLVL</td>
<td>*SEC</td>
<td>Password level</td>
<td>Password General</td>
</tr>
<tr>
<td>QPWDMAXLEN</td>
<td>*SEC</td>
<td>Maximum password length</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDMINLEN</td>
<td>*SEC</td>
<td>Minimum password length</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDPOSDIF</td>
<td>*SEC</td>
<td>Require a new character in each position in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDRODDGT</td>
<td>*SEC</td>
<td>Require at least one digit in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDRODDIF</td>
<td>*SEC</td>
<td>Password re-use cycle</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDLDPGM</td>
<td>*SEC</td>
<td>Password validation program</td>
<td>Not supported by Operations Navigator</td>
</tr>
<tr>
<td>QPWRDWNLMT</td>
<td>*SYSCTL</td>
<td>Time limit for immediate shut down</td>
<td>Restart General</td>
</tr>
<tr>
<td>QPWRRSTIPL</td>
<td>*SYSCTL</td>
<td>Allow auto-restart after power failure</td>
<td>Restart General</td>
</tr>
<tr>
<td>QQRYDEGREE</td>
<td>*SYSCTL</td>
<td>Parallel processing for queries and indexes</td>
<td>Performance Database</td>
</tr>
<tr>
<td>QQRTIMLMT</td>
<td>*SYSCTL</td>
<td>Database query time limit</td>
<td>Performance Database</td>
</tr>
<tr>
<td>QRCLSPLSTG</td>
<td>*ALC</td>
<td>Automatically clean up unused printer output storage</td>
<td>Storage General</td>
</tr>
<tr>
<td>QRETSVRSEC</td>
<td>*SEC</td>
<td>Allow server security information to be retained</td>
<td>Security General</td>
</tr>
<tr>
<td>QRMTIPL</td>
<td>*SYSCTL</td>
<td>Allow remote power-on and restart</td>
<td>Restart General</td>
</tr>
<tr>
<td>QRMTSIGN</td>
<td>*SEC</td>
<td>Use Telnet or Pass-through for remote sign-on</td>
<td>Sign-on Remote</td>
</tr>
<tr>
<td>QRMTSRVATR</td>
<td>*SYSCTL</td>
<td>Allow remote service of system</td>
<td>Messages and Service Remote</td>
</tr>
<tr>
<td>QSCPFCONS</td>
<td>*SYSCTL</td>
<td>If console problem occurs during restart</td>
<td>Restart Problems</td>
</tr>
<tr>
<td>QSECOND</td>
<td>*DATTIM</td>
<td>Second of the minute</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QSECURITY</td>
<td>*SEC</td>
<td>Security level</td>
<td>Security General</td>
</tr>
<tr>
<td>QSETJOBATR</td>
<td>*SYSCTL</td>
<td>Set job attributes based on locale</td>
<td>International Locale</td>
</tr>
<tr>
<td>QSWERRLOG</td>
<td>*MSG</td>
<td>Log software problems detected by system</td>
<td>Messages and Service Problems</td>
</tr>
<tr>
<td>QSRHMEMCTL</td>
<td>*SEC</td>
<td>Allow access to shared memory and memory mapped stream files</td>
<td>Security Shared Memory</td>
</tr>
<tr>
<td>QSPCENV</td>
<td>*SYSCTL</td>
<td>Default user environment</td>
<td>System Control User Defaults</td>
</tr>
<tr>
<td>QSRLENGR</td>
<td>*SYSCTL</td>
<td>Serial number</td>
<td>System Control</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System Value</th>
<th>Type</th>
<th>Description</th>
<th>Operations Navigator</th>
</tr>
</thead>
<tbody>
<tr>
<td>QPWLMTAHC</td>
<td>*SEC</td>
<td>Restrict consecutive digits in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWLMTCHR</td>
<td>*SEC</td>
<td>Restricted characters in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWLMTREP</td>
<td>*SEC</td>
<td>Restrict repeating characters in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWLVL</td>
<td>*SEC</td>
<td>Password level</td>
<td>Password General</td>
</tr>
<tr>
<td>QPWDMAXLEN</td>
<td>*SEC</td>
<td>Maximum password length</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDMINLEN</td>
<td>*SEC</td>
<td>Minimum password length</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDPOSDIF</td>
<td>*SEC</td>
<td>Require a new character in each position in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDRODDGT</td>
<td>*SEC</td>
<td>Require at least one digit in passwords</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDRODDIF</td>
<td>*SEC</td>
<td>Password re-use cycle</td>
<td>Password Validation</td>
</tr>
<tr>
<td>QPWDLDPGM</td>
<td>*SEC</td>
<td>Password validation program</td>
<td>Not supported by Operations Navigator</td>
</tr>
<tr>
<td>QPWRDWNLMT</td>
<td>*SYSCTL</td>
<td>Time limit for immediate shut down</td>
<td>Restart General</td>
</tr>
<tr>
<td>QPWRRSTIPL</td>
<td>*SYSCTL</td>
<td>Allow auto-restart after power failure</td>
<td>Restart General</td>
</tr>
<tr>
<td>QQRYDEGREE</td>
<td>*SYSCTL</td>
<td>Parallel processing for queries and indexes</td>
<td>Performance Database</td>
</tr>
<tr>
<td>QQRTIMLMT</td>
<td>*SYSCTL</td>
<td>Database query time limit</td>
<td>Performance Database</td>
</tr>
<tr>
<td>QRCLSPLSTG</td>
<td>*ALC</td>
<td>Automatically clean up unused printer output storage</td>
<td>Storage General</td>
</tr>
<tr>
<td>QRETSVRSEC</td>
<td>*SEC</td>
<td>Allow server security information to be retained</td>
<td>Security General</td>
</tr>
<tr>
<td>QRMTIPL</td>
<td>*SYSCTL</td>
<td>Allow remote power-on and restart</td>
<td>Restart General</td>
</tr>
<tr>
<td>QRMTSIGN</td>
<td>*SEC</td>
<td>Use Telnet or Pass-through for remote sign-on</td>
<td>Sign-on Remote</td>
</tr>
<tr>
<td>QRMTSRVATR</td>
<td>*SYSCTL</td>
<td>Allow remote service of system</td>
<td>Messages and Service Remote</td>
</tr>
<tr>
<td>QSCPFCONS</td>
<td>*SYSCTL</td>
<td>If console problem occurs during restart</td>
<td>Restart Problems</td>
</tr>
<tr>
<td>QSECOND</td>
<td>*DATTIM</td>
<td>Second of the minute</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QSECURITY</td>
<td>*SEC</td>
<td>Security level</td>
<td>Security General</td>
</tr>
<tr>
<td>QSETJOBATR</td>
<td>*SYSCTL</td>
<td>Set job attributes based on locale</td>
<td>International Locale</td>
</tr>
<tr>
<td>QSWERRLOG</td>
<td>*MSG</td>
<td>Log software problems detected by system</td>
<td>Messages and Service Problems</td>
</tr>
<tr>
<td>QSRHMEMCTL</td>
<td>*SEC</td>
<td>Allow access to shared memory and memory mapped stream files</td>
<td>Security Shared Memory</td>
</tr>
<tr>
<td>QSPCENV</td>
<td>*SYSCTL</td>
<td>Default user environment</td>
<td>System Control User Defaults</td>
</tr>
<tr>
<td>QSRLENGR</td>
<td>*SYSCTL</td>
<td>Serial number</td>
<td>System Control</td>
</tr>
<tr>
<td>System Value</td>
<td>Type</td>
<td>Description</td>
<td>Operations Navigator</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>------------------------------------------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>QSRTSEQ</td>
<td>*SYSCTL</td>
<td>Sort sequence</td>
<td>International</td>
</tr>
<tr>
<td>QSRVDMP</td>
<td>*MSG</td>
<td>Service log for unmonitored escape messages</td>
<td>Messages and Service Problems</td>
</tr>
<tr>
<td>QSTGLOWACN</td>
<td>*STG</td>
<td>Maximum system storage pool utilization action</td>
<td>Storage</td>
</tr>
<tr>
<td>QSTGLOWLMT</td>
<td>*STG</td>
<td>Maximum system storage pool utilization</td>
<td>Storage</td>
</tr>
<tr>
<td>QSTRPRTWTR</td>
<td>*SYSCTL</td>
<td>Printers started on previous restart</td>
<td>Restart</td>
</tr>
<tr>
<td>QSTRUPPGM</td>
<td>*SYSCTL</td>
<td>Start-up program to set up system</td>
<td>Restart</td>
</tr>
<tr>
<td>QTSTMSG</td>
<td>*MSG</td>
<td>Display status messages</td>
<td>Messages and Service</td>
</tr>
<tr>
<td>QSVRAUITITV</td>
<td>*SYSCTL</td>
<td>Server authentication interval</td>
<td>Security</td>
</tr>
<tr>
<td>QSYSRLIBL</td>
<td>*LIBL</td>
<td>System library list</td>
<td>Library Lists</td>
</tr>
<tr>
<td>QTIME</td>
<td>*DATTIM</td>
<td>Time of day</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QTIMSEP</td>
<td>*EDT</td>
<td>Time separator</td>
<td>International</td>
</tr>
<tr>
<td>QTOTJOB</td>
<td>*ALC</td>
<td>Number of total jobs to allocate storage for at restart</td>
<td>Jobs</td>
</tr>
<tr>
<td>QTSEPOOL</td>
<td>*STG</td>
<td>Move interactive jobs to base pool at end of time slice</td>
<td>Performance</td>
</tr>
<tr>
<td>QUPSDLYTIM</td>
<td>*SYSCTL</td>
<td>Action when power failure occurs</td>
<td>Power Control</td>
</tr>
<tr>
<td>QUPSMSGQ</td>
<td>*SYSCTL</td>
<td>Message queue for power supply</td>
<td>Power Control</td>
</tr>
<tr>
<td>QUSEADPAUT</td>
<td>*SEC</td>
<td>Authorization list for users who can work with programs with adopted authority</td>
<td>Security</td>
</tr>
<tr>
<td>QUSRLIBL</td>
<td>*LIBL</td>
<td>User library list</td>
<td>Library Lists</td>
</tr>
<tr>
<td>QUTCOFFSET</td>
<td>*DATTIM</td>
<td>Offset from Greenwich Mean Time (GMT)</td>
<td>Date and Time</td>
</tr>
<tr>
<td>QVFYOBJRST</td>
<td>*SEC</td>
<td>Verify object signatures during restore</td>
<td>Security</td>
</tr>
<tr>
<td>QYEAR</td>
<td>*DATTIM</td>
<td>Last two digits of the year</td>
<td>Date</td>
</tr>
</tbody>
</table>

Using online help to find system value details

Figure A-1 is an example of using V5R1 Operations Navigator online help to find details for a specific system value. We show an example using the new for V5R1 system value QVFYOBJRST (verify object restore). This value is used to control restoring V5R1 signed objects.
Using Information Center for system value information

Figure A-2 shows three levels of information for system values in the Auditing category - recording actions performed on your system.
Figure A-2 Using Information Center to find system value information - Auditing example

Information Center is the best place to go for up to the minute information on system values.
Operations Navigator server jobs

This appendix lists the OS/400 server jobs associated with Operations Navigator.

The appendix contains two tables, listing:

- TCP/IP Server jobs
- Client Access Server jobs
TCP/IP server jobs

The following OS/400 jobs are associated with TCP/IP Servers (Table B-1). These server jobs may be controlled using Operations Navigator My Connections -> system -> Network-> Servers, or may be started and ended with the STRTCPSVR /ENDTCPSVR OS/400 command.

Table B-1 Server jobs

<table>
<thead>
<tr>
<th>Operations Navigator server</th>
<th>OS/400 job name</th>
<th>Subsystem</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOTP/DHCP Relay Agent</td>
<td>QTODDHCPR</td>
<td>QSYSWRK</td>
<td>DHCP/ Relay agent server job</td>
</tr>
<tr>
<td>BOOTP</td>
<td>QTBOOTP</td>
<td>QSYSWRK</td>
<td>BOOTP server</td>
</tr>
<tr>
<td>DDM</td>
<td>QRWTSRVR</td>
<td>QSYSWRK</td>
<td>Prestarted DRDA server jobs</td>
</tr>
<tr>
<td></td>
<td>QRWTLSTN</td>
<td></td>
<td>DRDA Listener</td>
</tr>
<tr>
<td>DHCP</td>
<td>QTODDHCPS</td>
<td>QSYSWRK</td>
<td>DHCP/Relay agent server job</td>
</tr>
<tr>
<td>RouteD</td>
<td>QTRTDxxxxx</td>
<td>QSYSWRK</td>
<td>RouteD server (there may be several)</td>
</tr>
<tr>
<td>RPC</td>
<td>QNFSRPCD</td>
<td>QSYSWRK</td>
<td>The RPC binder daemon</td>
</tr>
<tr>
<td>TFTP</td>
<td>QTFTxxxxx</td>
<td>QSYSWRK</td>
<td>Trivial FTP server (there may be several)</td>
</tr>
<tr>
<td>NFS</td>
<td>QNFSRPCD</td>
<td>QSYSWRK</td>
<td>The RPC binder daemon</td>
</tr>
<tr>
<td></td>
<td>QNFSBIOD</td>
<td></td>
<td>The block I/O (BIO) daemon</td>
</tr>
<tr>
<td></td>
<td>QNFSNFSD</td>
<td></td>
<td>The NFS server (SVR) daemon</td>
</tr>
<tr>
<td></td>
<td>QNFSMNTD</td>
<td></td>
<td>The mount (MNT) daemon</td>
</tr>
<tr>
<td></td>
<td>QNFSNSMND</td>
<td></td>
<td>The network status monitor (NSM) daemon</td>
</tr>
<tr>
<td></td>
<td>QNFSNLMD</td>
<td></td>
<td>The network lock manager (NLM) daemon</td>
</tr>
<tr>
<td>OS/400 Net Server</td>
<td>QZLSFILE</td>
<td>QSERVER</td>
<td>File share connection job (there may be several)</td>
</tr>
<tr>
<td></td>
<td>QZLSSERVER</td>
<td></td>
<td>File share server</td>
</tr>
<tr>
<td>INETD</td>
<td>QTOGINTD</td>
<td>QSYSWRK</td>
<td>Internet Daemon (INETD) server used by Clustering support</td>
</tr>
<tr>
<td>EDRSQL</td>
<td>QXDAEDRSQL</td>
<td>QSYSWRK</td>
<td>Extended Dynamic Remote SQL server</td>
</tr>
<tr>
<td>SNTP</td>
<td>QTOTNTP</td>
<td>QSYSWRK</td>
<td>Simple Network Time Protocol client job.</td>
</tr>
<tr>
<td>QoS</td>
<td>QTOQSRVR</td>
<td>QSYSWRK</td>
<td>Quality of Service server job</td>
</tr>
<tr>
<td>WebFacing</td>
<td>QQFWFSVR</td>
<td>QSYSWRK</td>
<td>WebFacing server</td>
</tr>
<tr>
<td>Operations Navigator server</td>
<td>OS/400 job name</td>
<td>Subsystem</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Management Central</td>
<td>QYPSSRV</td>
<td>QSYSWRK</td>
<td>Management Central Server job</td>
</tr>
<tr>
<td></td>
<td>QYPSJSVR</td>
<td></td>
<td>Management Central Server job (Java)</td>
</tr>
<tr>
<td></td>
<td>QYPSPRC</td>
<td></td>
<td>Management Central common service</td>
</tr>
<tr>
<td></td>
<td>QYPSBDDTSVR</td>
<td></td>
<td>Package and fixes distribution</td>
</tr>
<tr>
<td></td>
<td>QPMASERV</td>
<td></td>
<td>Performance monitor API</td>
</tr>
<tr>
<td></td>
<td>QYPSMTCMD</td>
<td></td>
<td>Running command</td>
</tr>
<tr>
<td></td>
<td>QYPSGETINV</td>
<td></td>
<td>Inventory collection</td>
</tr>
<tr>
<td></td>
<td>QYPSPTF</td>
<td></td>
<td>Fixes management</td>
</tr>
<tr>
<td></td>
<td>QYPSMCMID</td>
<td></td>
<td>Performance monitor DB conversion</td>
</tr>
<tr>
<td></td>
<td>QYPSAPI</td>
<td></td>
<td>Management Central common service</td>
</tr>
<tr>
<td></td>
<td>QYIVPUBAGT</td>
<td></td>
<td>Inventory collection for LDAP</td>
</tr>
<tr>
<td></td>
<td>QYSPFRCOL</td>
<td></td>
<td>Performance collection</td>
</tr>
<tr>
<td></td>
<td>QYPSDISCOV</td>
<td></td>
<td>Discover system</td>
</tr>
<tr>
<td></td>
<td>QYRMJOBSEL</td>
<td></td>
<td>Job monitor</td>
</tr>
<tr>
<td></td>
<td>OPMACLCT</td>
<td></td>
<td>Performance monitor API</td>
</tr>
<tr>
<td></td>
<td>QYPSUSRADM</td>
<td></td>
<td>User and Group Administration</td>
</tr>
<tr>
<td>DLFM</td>
<td>QZDFMSVR</td>
<td>QSYSWRK</td>
<td>DataLink File Manager</td>
</tr>
<tr>
<td>Virtual Private networking</td>
<td>QTOVMAN</td>
<td>QSYSWRK</td>
<td>VPN Connection manager</td>
</tr>
<tr>
<td></td>
<td>QTOKVPRNIKE</td>
<td></td>
<td>VPN Key Manager</td>
</tr>
<tr>
<td></td>
<td>QTPPANSxxx</td>
<td></td>
<td>PPP Dial-up connections</td>
</tr>
<tr>
<td></td>
<td>QTPPPPL2TP</td>
<td></td>
<td>Layer Two Tunneling Protocol (L2TP) manager job</td>
</tr>
<tr>
<td>Triggered Cache Manager</td>
<td>Based on instance name</td>
<td>QSYSWRK</td>
<td>Instance specific Triggered Cache Manager server job, running under user profile QTCM</td>
</tr>
<tr>
<td>FTP</td>
<td>QTFTPxxxxx</td>
<td>QSYSWRK</td>
<td>FTP connection job (there may be several)</td>
</tr>
<tr>
<td>LPD</td>
<td>QTLPDxxxxx</td>
<td>QSYSWRK</td>
<td>LPD Server (there may be several)</td>
</tr>
<tr>
<td>POP</td>
<td>QTOPxxxxx</td>
<td>QSYSWRK</td>
<td>Pop Server (there may be several)</td>
</tr>
<tr>
<td>Remote Execution</td>
<td>QTRXCxxxxx</td>
<td>QSYSWRK</td>
<td>REXEC server (there may be several)</td>
</tr>
<tr>
<td>SMTP</td>
<td>QTSMTPSRVD</td>
<td>QSYSWRK</td>
<td>Server Daemon</td>
</tr>
<tr>
<td></td>
<td>QTSMTSPSRVP</td>
<td></td>
<td>Server Prestart Job</td>
</tr>
<tr>
<td></td>
<td>QTSMTPCPLTD</td>
<td></td>
<td>Client Daemon</td>
</tr>
<tr>
<td></td>
<td>QTSMTPBRC</td>
<td></td>
<td>Bridge Client</td>
</tr>
<tr>
<td></td>
<td>QTSMTPBRSR</td>
<td></td>
<td>Bridge Server</td>
</tr>
<tr>
<td></td>
<td>QTSMTPCPLTP</td>
<td></td>
<td>Client Prestart Job</td>
</tr>
<tr>
<td></td>
<td>QTSMTPCLNVT</td>
<td></td>
<td>SMTP Client</td>
</tr>
<tr>
<td></td>
<td>QTSMTPSRVR</td>
<td></td>
<td>SMTP Server</td>
</tr>
<tr>
<td>TELNET</td>
<td>QTVDEVICE</td>
<td>QSYSWRK</td>
<td>Telnet device manager (there may be several)</td>
</tr>
<tr>
<td></td>
<td>QTVTTELNET</td>
<td></td>
<td>Telnet server (there may be several)</td>
</tr>
<tr>
<td>Workstation Gateway</td>
<td>QTWSGxxxxx</td>
<td>QSYSWRK</td>
<td>Workstation gateway (there may be several)</td>
</tr>
<tr>
<td>HTTP Administration</td>
<td>ADMIN</td>
<td>QHTTPSVR</td>
<td>Administration HTTP Server (there may be several)</td>
</tr>
</tbody>
</table>
The client access servers may be managed through Operations Navigator or through the use of the STRHOSTSVR / ENDHOSTSVR OS/400 commands (Table B-2).

<table>
<thead>
<tr>
<th>Server name</th>
<th>OS/400 job names</th>
<th>Subsystem</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>QZSCSRVSD QZSCSRVS</td>
<td>QSYSWRK</td>
<td>Central server daemon</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Server prestart job</td>
</tr>
<tr>
<td>Database</td>
<td>QZDASSINIT QZDASOINIT QZDASRVSD</td>
<td>QUSRWRK</td>
<td>Server prestart job</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Server prestart job</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Server daemon job</td>
</tr>
<tr>
<td>Data Queue</td>
<td>QZHQSsrvQ ZHQSrvD</td>
<td>QUSRWRK</td>
<td>Server prestart job</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Server daemon job</td>
</tr>
<tr>
<td>File</td>
<td>QPWFSERVSO QPWFSERVSD QPWFSERVSS</td>
<td>QSERVER</td>
<td>Server prestart job</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Server daemon job</td>
</tr>
<tr>
<td>Net Print</td>
<td>QNPSERVQ QNPSERVD</td>
<td>QUSRWRK</td>
<td>Server prestart job</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Server daemon job</td>
</tr>
<tr>
<td>Remote Command</td>
<td>QZRCRVS QZRCRVSQ</td>
<td>QUSRWRK</td>
<td>Server prestart job</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Server daemon job</td>
</tr>
<tr>
<td>Sign On</td>
<td>QZSOSIGN QZSOSGND</td>
<td>QUSRWRK</td>
<td>Server prestart job</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Server daemon job</td>
</tr>
<tr>
<td>Server mapper</td>
<td>QZSOSMAPD QZSOSMAPD</td>
<td>QSYSWRK</td>
<td>Server daemon job</td>
</tr>
<tr>
<td>Multimedia</td>
<td>QUMBPJTQ CQUMBPJTC</td>
<td>QSYSWRK</td>
<td>Ultimmedia server job</td>
</tr>
</tbody>
</table>

**Client Access servers**

The client access servers may be managed through Operations Navigator or through the use of the STRHOSTSVR / ENDHOSTSVR OS/400 commands (Table B-2).
Operations Navigator functions by release

This appendix is a quick reference list of Operations Navigator functions available and based on OS/400 release levels V4R4, V4R5, and V5R1.
Operations Navigator release cross reference

Table C-1 shows what functions are available in V5R1M0 Operations Navigator for each OS/400 version.

**Table C-1  Operations Navigator functions by release**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>V4R4</th>
<th>V4R5</th>
<th>V5R1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Management Central</strong></td>
<td>Manage groups of systems</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Performance monitoring</strong></td>
<td>Monitor performance</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Commands</strong></td>
<td>Run and save commands</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Packages</strong></td>
<td>Create, save and distribute objects</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Hardware / Software inventory</strong></td>
<td>Collect, display inventory, Send and install software products.</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Scheduling</strong></td>
<td>Schedule Management Central tasks</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Fixes Inventory</strong></td>
<td>Manage software fixes (PTFs)</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Collection Services</strong></td>
<td>Start, End performance data collection</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Graph History</strong></td>
<td>Graphs Collection Services, System monitor data</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>System Values</strong></td>
<td>Display, change, compare, and distribute system value changes</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Distributed User and Group Administration</strong></td>
<td>Create, view, change, and distribute user profiles and group profiles</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Products</strong></td>
<td>Create you own products (&quot;licensed programs&quot;) and fixes, Use Software inventory to distribute.</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Resource Monitors</strong></td>
<td>System Jobs, Messages</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Management Central - Pervasive (java servlet to PDA device)</strong></td>
<td>Monitor system (performance) monitors Monitor system, job, message monitors, control jobs, respond to messages, manage Integrated xSeries Servers</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Extreme Support</strong></td>
<td>Connect to and use IBM services</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Simple Cluster Configuration</strong></td>
<td>Configure and manage two-node clusters</td>
<td></td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

**Basic Operations**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>V4R4</th>
<th>V4R5</th>
<th>V5R1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Messages</strong></td>
<td>Work with Messages</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Printer Output</strong></td>
<td>Work with printer output</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Printers</strong></td>
<td>Manage printers</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Printer output cut/copy/paste</strong></td>
<td>Drag-and-drop, and so on, printouts</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Jobs</strong></td>
<td>Work with user jobs</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>V4R4</td>
<td>V4R5</td>
<td>V5R1</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>-------------------------------------------------------</td>
<td>------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Graphical CL command prompter</strong></td>
<td>Prompt for CL commands on the client</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Work Management</strong></td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Active jobs</td>
<td>Work with active jobs</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Server Jobs</td>
<td>Work with server jobs</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Job Queues</td>
<td>Work with active and all job queues</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory pools</td>
<td>Work with memory pools</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subsystems</td>
<td>Work with active subsystems</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Job log</td>
<td>Display job log for a job</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Call stack</td>
<td>Display a jobs called stack</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Object locks</td>
<td>Work with the object locks for a job</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open files</td>
<td>Work with the open files for a job</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Library list</td>
<td>View, search library of a job’s library list</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Configuration and Service</strong></td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>System values</td>
<td>Work with all the system values</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Hardware Inventory</td>
<td>Display the hardware for the system</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Software Inventory</td>
<td>Display the software for the system</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>DASD Management</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk unit status and capacity, capacity balancing</td>
<td>Display disk units in auxiliary storage pools</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Disk pools (ASPs), HSM, compression, manage units</td>
<td>Manage ASPs, add, move, remove disk units</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphical view</td>
<td>Shows all disk units in a parity set, mirrored pairs, active, and more.</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Independent disk pools (ASPs)</td>
<td>Set up independent disk pools (ASPs)</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Collection Services</strong></td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Collection data</td>
<td>Start, end, manage performance data collection</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View collected performance data</td>
<td>View Graph History of performance metrics</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LPAR Configuration</td>
<td>Configure partitions and manage partition resources</td>
<td>x</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Appendix C. Operations Navigator functions by release 475
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>V4R4</th>
<th>V4R5</th>
<th>V5R1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Internet applications</td>
<td>Access Internet applications</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Point-to-Point communications</td>
<td>Manage point-to-point communication</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>TCP/IP Setup</td>
<td>Set up and manage TCP/IP interfaces</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Server management, including: DNS, DHCP, AS/400 Networks, NFS, DCE, Directory server (LDAP)</td>
<td>Set up and manager server applications</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>IP Security</td>
<td>Set up and manage IP security</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>VPN</td>
<td>Set up virtual private networking</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Additional IP interface and line types</td>
<td>PPP over L2TP and ISDN, WAN and Circuitless IP</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Quality of service support</td>
<td>Manage TCP/IP quality of service</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Netstat Functions</td>
<td>Detailed information for interfaces, routes, connections, physical interface activity</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Connection Utilities</td>
<td>Ping, Trace Route, Lookup Hosts</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Windows Server (Integrated xSeries Server)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server management</td>
<td>Start/stop Windows servers, status</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>User and disk storage management</td>
<td>Manage Windows users and disk storage</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object authority and security system values</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Permissions</td>
<td>Manage object authority</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Security Policies</td>
<td>Maintain security and auditing policies</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Security Configuration Wizard</td>
<td>Configure security</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Users and Groups</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage OS/400 users and groups</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td><strong>Database</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Administration of DB2(TM) Universal Database (UDB) for iSeries</td>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Tables, views, journals, indexes, aliases</td>
<td>Manage DB2 UDB objects</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Run SQL Scripts</td>
<td>Collect and view SQL performance data</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Complex objects, procedures, functions</td>
<td>Work with DB2 UDB complex objects</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
<td>V4R4</td>
<td>V4R5</td>
<td>V5R1</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------</td>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Visual Explain</td>
<td>Visual description of queries</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Database Navigator</td>
<td>Visual description of your database</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>File Systems</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Integrated File System</td>
<td>File System GUI enhancements</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Cut/Copy/Paste, Create, Rename</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>File Shares</td>
<td>List and work with NetServer File Shares</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Additional attributes</td>
<td>Display object attributes</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Drag-and-drop, cut/copy/paste for QSYS</td>
<td></td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>AFP Manager</strong></td>
<td>AFP resources, font mapping tables, PSF</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Backup</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BRMS used for backup</td>
<td>Backup and Recovery and Media Services Licensed Program plug-in performs all backup. Subset of all BRMS functions supported through V5R1Operations Navigator GUI</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Application Development</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Application Administration</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Administration of plug-ins</td>
<td>Control user's access to Operations Navigator plug-ins</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td><strong>Plug-in Support</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Support for Java</td>
<td>Create plug-ins using Java</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Support for C++</td>
<td>Create plug-ins for C++</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>Support for Visual Basic</td>
<td>Create plug-ins using Visual Basic</td>
<td></td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

This table was based upon information at the following location on the Internet: [http://www.ibm.com/servers/eserver/iseries/oper_nav/functiontable.htm](http://www.ibm.com/servers/eserver/iseries/oper_nav/functiontable.htm)
Setting the time values for Management Central functions

V5R1 Management Central functions require correct settings for system values QTIME, QUTCOFFSET, and a Java-based time zone value. Other Operations Navigator functions use only the QTIME system value.

This appendix describes the steps to take that ensure the proper time values are used by the various Operations Navigator and Management Central functions.
Operations Navigator and Management Central time stamps

Many Operations Navigator and Management Central windows show time stamps (date and time of day). The associated functions use the OS/400 system values QTIME and QDATE. OS/400 requires the user to change the QTIME value if there is a change between standard time and daylight savings time.

Management Central functions also require system value QUTCOFFSET (Coordinated Universal Time Offset) to be set correctly. The QUTCOFFSET value represents your location's time value difference (plus or minus hours and minutes) from Greenwich Mean Time (GMT).

Starting with V5R1 Management Central time-dependent scheduling functions and displaying correct time of day for all monitor function (message, job, system) windows also require setting a specific Java time zone value correctly in at least one of the following:

- The locale object pointed to by system value QLOCALE
- SystemDefault.Properties file, in the directory path /qibm/userdata/java400

The Sun Microsystems, Inc Java specification defines the list of valid time zone values, which can be unique per Java Development Kit (JDK) level.

For systems in locations that do not support daylight savings there is no change required for QTIME, QUTCOFFSET or the QLOCALE object/SystemDefault.properties file once the values are initially set correctly.

If your system is in a location that changes between standard time and daylight savings times twice a year, then you must make the appropriate changes to system values QTIME and QUTCOFFSET at the same time. The Java time zone value need not be changed once it has been set correctly for your system.

If the Management Central server or one of the monitors is active while you change any or all of the QTIME, QUTCOFFSET system values or a QLOCALE/SystemDefault.properties time zone value, you must stop and restart it to use the new value.

In a network with a Management Central central system and systems that could or would be used as Management Central endpoint systems, the Management Central server must be stopped and restarted on each of these servers for any change to take affect throughout the network.

If any message, job or system monitor is active on any of the Management Central central system or endpoint systems, the monitor should be stopped and started after the Management Central servers have been stopped and started.

Here are two ways to end and start the Management Central server:

1. Use OS/400 commands: ENDTCPSVR SERVER(*MGTC), then STRTCPSVR SERVER(*MGTC)
2. Use Operations Navigator:
   - My Connections -> system name -> Network
   - Expand Servers
   - Double-click TCP/IP
   - Find the Management Central server, right-click and select Stop. After Stopped status displays, select Start.

The following sections provide more details for QUTCOFFSET and the Java time zone values.
Appendix D. Setting the time values for Management Central functions

**QUTCOFFSET**

OS/400 system value QUTCOFFSET must contain the number of hours and minutes your system is ahead or behind Greenwich Mean Time (GMT). GMT is the official world-wide time, from which all other time zones are established and is sometimes called UTC 0. This “base time”, is called the Coordinated Universal Time Offset.

Locations in the base time zone have a Coordinated Universal Time Offset value of zero (0). The first time zone to the east of the base time zone (offset value 0) has an offset value of +1:00 (one hour ahead of GMT). The first time zone to the west of the base time zone has an offset value of -1:00 (one hour behind GMT). There also may be time zones that have 30 minute differences rather than whole hour (60 minutes) time difference from GMT.

GMT does not have Daylight Savings Time, while other time zone locations may or may not. Using the United States as an example, both Los Angeles, California and Phoenix, Arizona are in the Pacific Standard Time (PST) zone. However, Los Angeles supports daylight savings and Phoenix does not. So, part of the year Phoenix and Los Angeles have the same time and the other part of the year there is a one (1) hour difference.

OS/400 ships with a QUTCOFFSET value of zero (0) and does not automatically adjust the system value QUTCOFFSET based upon time zone or whether there is a change between Standard Time (ST) or Daylight Savings Time (DST). OS/400 uses the Java time zone value along with the QTIME and QUTCOFFSET values for correct time of day processing.

If your system is located outside of the base time zone (GMT/UTC=0), you must first set QTIME appropriately and then set QUTCOFFSET appropriately on each system or LPAR partition running OS/400. You could be using different QTIME and QUTCOFFSET values in each partition, depending on the needs of the application environment for each partition.

Anytime there is a change between local standard time and daylight savings time, remember you must manually (or through an automated program) change both the QTIME and QUTCOFFSET values. This is especially important in a multiple system network so that time values shown on each system reflect the correct local time.

You should make the change at a time when the system is at a “quiesced state”. That is, there are no time-dependent jobs running.

Here are some QUTCOFFSET value examples.

Chicago, Illinois, in the USA is in the US Central Time Zone. Chicago supports daylight savings time. Using this as an example, you must specify -05:00 for QUTCOFFSET when daylight savings time is in effect (typically the last Sunday in March through the last Sunday in October). This is 5 hours behind the GMT, or the base time zone.

In October, when standard time is again in effect, you must change the system value QTIME to the correct time and specify a QUTCOFFSET value of -6:00 for systems in the US Central Time Zone located where daylight savings is supported.

Using New York as another US example, QUTCOFFSET must be set to -04:00 during daylight savings time and -05:00 during standard time.

Here are two European examples: In Belgium, QUTCOFFSET must be set to +02:00 during daylight savings time and +01:00 during standard time; in the United Kingdom, QUTCOFFSET must be set to +01:00 during British Summer Time (daylight savings) and +00:00 during standard time.
Argentina is a South American example, which does not use daylight savings time. QUTCOFFSET must be set to -03:00 hours.

For Sydney Australia, QUTCOFFSET must be set to +11:00 hours during daylight savings and +10:00 during standard time.

For India, which does not use daylight savings time, QUTCOFFSET must be set to +05:30 hours.

As previously stated, any time you change QTIME or QUTCOFFSET values, remember to stop and restart the Management Central server or any active monitors.

### Required Java time zone values

There are two primary techniques to set up the appropriate Java time zone value. You can use either technique to enable the Java-based functions to output the appropriate time of day:

- **OS/400 Locale object**: Create an OS/400 user object of type *LOCALE that includes the appropriate time of day (TOD) statement for your time zone - the *tname* field statement. Set the path to that object in system value QLOCALE.
  
  A locale is a geographic or political region of the world that shares the same language and customs. On OS/400 a locale object includes character set information including time zone difference from GMT, format and sub field character separators for time, date, and numeric format.

- **OS/400 Java SystemDefault.properties file**: Create or update an IFS character-based byte stream file called SystemDefault.properties with the appropriate time zone statement (time.zone= ccccccc).
  
  Place the properties file into the Java400 directory according to the following directory path on each OS/400 system:

  `/qibm/userdata/java400`

**Tip**: Setting the time zone value in the SystemDefault.properties file can be used as an alternative to the system value QLOCALE technique and is quicker to set up - when only the Java time zone parameter needs to be set up correctly. However, your system may need to use other locale object functions which this "properties file" technique does not address.

Read the following topics to determine whether the locale object or SystemDefault.properties file works best for your environment.

As previously stated you need to set the Java time zone value correctly only once per system or partition in an LPAR configuration. The valid time zone acronym values are defined by the Sun Microsystems, Inc. Java specification. The valid Java time zone acronym values representing time zones are relative to Greenwich Mean Time. These values can be unique for each Java Developer Kit (JDK) level. The valid time zone values are specified in the `java.util.timezone` class that ships with each Java Developer Kit (JDK) for each level of the JDK defined by Sun.

V5R1 OS/400 supports JDK levels 1.1.8, 1.2, and 1.3. “Time zone values for java.util.timezone class” on page 487 lists the supported values.

The following topics describe how to set the Java time zone value either using an OS/400 locale object or the Java SystemDefault.properties file.
Using OS/400 LOCALE for the JVM time zone

As previously stated, the Java Virtual Machine (JVM) running under OS/400 must have its own “time zone acronym” value. A user-written Java program may optionally program its own time adjustment outside of a general JVM setting.

This topic shows how to specify a Java time zone value for a general Java function, which includes Management Central, usage through OS/400 LOCALE support.

A locale is an object that can determine how data is processed, printed, and displayed. Locale information includes categories of statements that define language, cultural data, and character sets. Included in this are monetary symbol, date format, date separator character, time format, time separator character, decimal format, sort sequence, and character coded character set identifier (CCSID).

The LC_TOD (Locale Time of Day) category of the locale parameters contains a “time name” field, which contains an acronym representing the supported Java time zone value that corresponds to the time difference from GMT and implicitly indicates whether daylight savings is used for your system’s location.

OS/400 supports LOCALE capabilities at the job and associated thread (if any) level from the following different locale parameters:

- Job’s environment variable for Language
- User Profile object locale specification
- System value QLOCALE (general default for all Java work)
- Java program’s invocation of a method that sets the time of day for its OS/400 job and any associated threads

This topic assumes system value QLOCALE is being used.

Any new iSeries server is shipped with system value QLOCALE set to *NONE and a group of supported locale objects contained in library QSYS. By default, the time zone and time offset information in each locale object shipped with OS/400 are all set to 0.

You can view the OS/400 provided locale object names and the associated CCSID value (identifies a language unique internal versus external character representation) by using the following Work with Objects command example:

   WRKOBJ OBJ(QSYS/*ALL) OBJTYPE(*LOCALE)
Figure D-1 shows a snapshot of the WRKOBJ command output:

![Work with Objects](image)

You can see the CCSID associated with each locale, but you cannot tell what is being used for several parameters within each locale object, such as monetary symbol, or time zone. To determine these values you need to view the source file member that corresponds to the locale object.

To view the locale contents, create your own locale object and specify its path in the system value QLOCALE, use the following information.

1. You can view and edit a locale source file member associated with each shipped locale object provided you have installed the following no charge OS/400 option on your system:
   - 5722SS1, Option 21 OS/400 - Extended NLS Support
2. Assuming Option 21 has been installed, the associated locale source file member for each locale object is contained in file QLOCALESRC within library QSYSLOCALE. To set time zone and other information, you must first copy the IBM-provided QLOCALESRC source file member that supports your particular geographic location to one of your own libraries.
   
   In our example we copied the EN_US member to library OURLIB and renamed the member EN_USRB, just to distinguish the member we are modifying from the base member EN_US shipped with OS/400 option 21.
3. Edit the file. Since we focus only on the Java time zone value, you only have to edit the `iname` field. Two ways to edit the local source file member for this field include:
   a. Use the OS/400 Start Programming Development Manager (STRPDM) command to find and specify to edit the member.
   b. Alternatively you could use the OS/400 Edit File command. Using our EN_USRB member in our library OURLIB, we edit the file with:  
      
      ```plaintext
      EDTF FILE(OURLIB/QLOCALESRC) MBR(EN_USRB)
      ```
4. Continuing with our member example - EN_USRB, we scanned that source file member's records to find the LC_TOD statements section. In the following example we have changed several statements from the original source, but only the tname field needs to be changed for our Java time zone example:

```
LC_TOD

tzdiff   -300
    tname   "<C><S><T>"  
    dstname "<C><D><T>"
    dststart 4,1,1,7200
    dstend  10,-1,1,7200
    dstshift 3600

END LC_TOD
```

In this example we specify some acronyms, time values and dates associated with the tname of “CST” (<C><S><T>) to represent the Central Standard Time zone which applies to locations within Canada, the US, Latin and South America with the same time as Chicago, Illinois, USA and that use daylight savings. Actually, the Java specification supports more than one time zone value to represent the same time difference from GMT and whether daylight savings is to be used.

See “Time zone values for java.util.timezone class” on page 487, which contains a listing of the time zone acronyms for the JDKs currently supported under OS/400.

5. After you have updated the locale source file member with the appropriate Java time zone value, create an OS/400 *LOCALE object using that edited member and give the object a name that is meaningful to you. Use a CCSID that matches the CCSID of the locale object shipped by IBM in library QSYS.

As shown a in Figure D-1, the US English CCSID value we are using is 37. So we used the following command to place our en_usitso locale into library ourlib:

```
CRTLOCALE LOCATE('/qsys.lib/ourlib.lib/en_usitso.locale')
SRCFILE('/qsys.lib/ourlib.lib/qlocalesrc.file/en_usrb.mbr') CCSID(37)
```

6. After this object has been successfully created, place the path to this object in system value QLOCALE. For example:

```
CHGSYSVAL SYSVAL(QLOCALE) VALUE('/qsys.lib/ourlib.lib/EN_USITSO.locale')
```

Where, the *LOCALE object is EN_USITSO stored in library OURLIB.

7. Alternatively you can use Operations Navigator to specify the path in system value QLOCALE by following these steps:
   a. **My Connections -> system name -> expand Configuration and Service.**
   b. Select System Values.
   c. Right-click International and select Properties.
   d. Select the Locale tab and add the path name of the *LOCALE object that you created as described above.
   e. Click OK. The change takes effect immediately.

Remember to stop and start any active Management Central servers or monitors after making a change.
Using OS/400 SystemDefault.properties file for the JVM time zone

OS/400 supports the SystemDefault.properties file to specify Java parameter default values for the Java Virtual Machine to use when running Java programs under OS/400. Two parameters that can be specified in this properties file are the default Java Development Kit (JDK) level to use, such as for a WebSphere Java application and the default time zone as described in this topic.

This file may or may not already exist on your system. As shipped from IBM Java support does not include a SystemDefault.properties file. However, a Java programmer may have already generated a file by this name for other programming purposes, such as specifying the default JDK level used under OS/400.

This topic assumes Operations Navigator and Management Central use the default time zone values specified in this file. However, a user-written Java program may optionally program its own time adjustment outside of a general JVM setting.

Create the file if it does not already exist. The following assumes the SystemDefault.properties file does not exist on your system when you want to use it to specify the correct time zone value.

Here is one of the ways to create the file as required into the Java400 subdirectory:

1. On the iSeries server set up the root directory as a file share.
2. On your PC workstation, add a Network drive to the target iSeries server to the shared root directory (folder). Drill down to Java400 sub directory - /QIBM/UserData/Java400. Alternatively, use Windows Explorer to get to the Java400 sub directory.
3. Open the Java400 sub directory. Click File->New->Text Document. Name the file SystemDefault.txt.
4. Rename the file to SystemDefault.properties. Click OK on the warning message window.
5. Once the file is on the system in the Java400 subdirectory, open the file with the Windows-provided Notepad (or equivalent) editor. Add the time zone statement as described below. We use the CST “time.zone acronym” in our example:

   user.timezone=CST

6. Save the file, then exit the editor.

Important:

- It is important to not insert a blank character on either side of the = character. Java will stop searching the text when it finds a blank character.
- You may also use the OS/400 Edit File (EDTF) command to edit the file by specifying:

  EDTF STMF('\qibm\userdata\java400\systemdefault.properties')

- When you open the file, it may be blank (no entries) or already contain an entry. An example of an entry other than the user.timezone entry is one that specifies the default Developer Took Kit for Java (JDK) level to use on your system, such as:

  java.version=1.2.

Remember to stop and start any active Management Central servers or monitors after making a change.
We used time zone value of “CST” as an example. This represents the Central Standard Time zone which applies to locations within Canada and Latin and South America with the same time as Chicago, Illinois, USA.

Another time zone acronym example would be “ECT” for European Central Standard Time.

“Time zone values for java.util.timezone class” on page 487 lists the supported values.

Managing time zone values on multiple systems with Management Central

To set system values on multiple systems you could use a 5250 workstation using SNA Display Pass-through or TCP/IP-based Telnet to sign on to each system in your network and use the Change System Value (CHGSYSVAL) command or Work with System Values (WRKSYSVAL) command to view and change system values QUTCOFFSET and QLOCALE.

You could use TCP/IP File Transfer Protocol (FTP) to transfer the SystemDefault.properties file to each system.

Alternatively you could use Operations Navigator and Management Central functions to set and manage the system values or the SystemDefault.properties files on multiple systems. The functions you should consider using for this include:

- System Values support for each system defined under My Connections. Alternatively you may also use the Management Central collect inventory function for system values on endpoint systems or systems within a system group and then do compare and update for the Date and Time - Offset from GMT (QUTCOFFSET) or International -> Locale system values.
- Management Central’s Packaging support to distribute the SystemDefault.properties file using a list of Endpoint systems or systems within a system group.

If all systems are in the same time zone changing the values during a time of little activity could be simple and straightforward.

If one or more systems are in different time zones you may need to update each system at a unique “time of quiescence”. You also may need to send a different locale object or SystemDefault.properties file for each system.

Time zone values for java.util.timezone class

We used “CST” (Central Standard Time) and also showed “ECT” (European Central Time) in our Java time zone examples.

Actually, the Java specification supports more than one time zone value to represent the same time difference from GMT and whether daylight savings is to be used. Select the value that most appropriately applies to your location from the list of time zone values in the following topics that applies to the default JDK level used on your system.

The acronym in the left most column is the value you set in either the QLOCALE source file tname field or in the SystemDefault.properties file time.zone=acronym statement.

In the right column you can view the hour and minutes difference from GMT. Use the right column information to help you make the appropriate choice from the left hand column. Note that in many cases you can actually specify a geographical location name, not just a three character acronym.
### JDK 1.1.8

<table>
<thead>
<tr>
<th>Time Zone</th>
<th>Date/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMT</td>
<td>Thu Apr 19 GMT 2001</td>
</tr>
<tr>
<td>UTC</td>
<td>Thu Apr 19 GMT+00:00 2001</td>
</tr>
<tr>
<td>ECT</td>
<td>Thu Apr 19 CEST 2001, European Central Standard Time</td>
</tr>
<tr>
<td>EET</td>
<td>Thu Apr 19 GMT+02:00 2001</td>
</tr>
<tr>
<td>ART</td>
<td>Thu Apr 19 GMT+02:00 2001</td>
</tr>
<tr>
<td>EAT</td>
<td>Thu Apr 19 GMT+03:00 2001</td>
</tr>
<tr>
<td>MET</td>
<td>Thu Apr 19 GMT+04:30 2001</td>
</tr>
<tr>
<td>NET</td>
<td>Thu Apr 19 GMT+04:00 2001</td>
</tr>
<tr>
<td>PLT</td>
<td>Thu Apr 19 GMT+05:00 2001</td>
</tr>
<tr>
<td>IST</td>
<td>Thu Apr 19 GMT+05:30 2001</td>
</tr>
<tr>
<td>BST</td>
<td>Thu Apr 19 GMT+06:00 2001</td>
</tr>
<tr>
<td>VST</td>
<td>Fri Apr 20 GMT+07:00 2001</td>
</tr>
<tr>
<td>CTT</td>
<td>Fri Apr 20 CST 2001</td>
</tr>
<tr>
<td>JST</td>
<td>Fri Apr 20 JST 2001</td>
</tr>
<tr>
<td>ACT</td>
<td>Fri Apr 20 GMT+09:30 2001</td>
</tr>
<tr>
<td>AET</td>
<td>Fri Apr 20 GMT+10:00 2001</td>
</tr>
<tr>
<td>SST</td>
<td>Fri Apr 20 GMT+11:00 2001</td>
</tr>
<tr>
<td>NST</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>MIT</td>
<td>Thu Apr 19 GMT-11:00 2001</td>
</tr>
<tr>
<td>HST</td>
<td>Thu Apr 19 HST 2001</td>
</tr>
<tr>
<td>AST</td>
<td>Thu Apr 19 KDT 2001</td>
</tr>
<tr>
<td>PST</td>
<td>Thu Apr 19 PDT 2001</td>
</tr>
<tr>
<td>PNT</td>
<td>Thu Apr 19 MST 2001</td>
</tr>
<tr>
<td>MST</td>
<td>Thu Apr 19 MDT 2001</td>
</tr>
<tr>
<td>CST</td>
<td>Thu Apr 19 CDT 2001</td>
</tr>
<tr>
<td>EST</td>
<td>Thu Apr 19 EDT 2001</td>
</tr>
<tr>
<td>IET</td>
<td>Thu Apr 19 EST 2001</td>
</tr>
<tr>
<td>PRT</td>
<td>Thu Apr 19 GMT-04:00 2001</td>
</tr>
<tr>
<td>CNT</td>
<td>Thu Apr 19 NDT 2001</td>
</tr>
<tr>
<td>AGT</td>
<td>Thu Apr 19 GMT-03:00 2001</td>
</tr>
<tr>
<td>BET</td>
<td>Thu Apr 19 GMT-03:00 2001</td>
</tr>
<tr>
<td>CAT</td>
<td>Thu Apr 19 GMT-01:00 2001</td>
</tr>
</tbody>
</table>

### JDK 1.2

<table>
<thead>
<tr>
<th>Time Zone</th>
<th>Date/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pacific/Niue:</td>
<td>Thu Apr 19 GMT-11:00 2001</td>
</tr>
<tr>
<td>Pacific/Apia:</td>
<td>Thu Apr 19 GMT-11:00 2001</td>
</tr>
<tr>
<td>MIT</td>
<td>Thu Apr 19 GMT-11:00 2001</td>
</tr>
<tr>
<td>Pacific/Pago_Pago:</td>
<td>Thu Apr 19 GMT-11:00 2001</td>
</tr>
<tr>
<td>Pacific/Tahiti:</td>
<td>Thu Apr 19 GMT-10:00 2001</td>
</tr>
<tr>
<td>Pacific/Fakaofo:</td>
<td>Thu Apr 19 GMT-10:00 2001</td>
</tr>
<tr>
<td>Pacific/Honolulu:</td>
<td>Thu Apr 19 HST 2001</td>
</tr>
<tr>
<td>HST</td>
<td>Thu Apr 19 HST 2001</td>
</tr>
<tr>
<td>America/Adak:</td>
<td>Thu Apr 19 GMT-09:00 2001</td>
</tr>
<tr>
<td>Pacific/Rarotonga:</td>
<td>Thu Apr 19 GMT-10:00 2001</td>
</tr>
<tr>
<td>Pacific/Marquesas:</td>
<td>Thu Apr 19 GMT-09:30 2001</td>
</tr>
<tr>
<td>Pacific/Gambier:</td>
<td>Thu Apr 19 GMT-09:00 2001</td>
</tr>
<tr>
<td>America/Anchorage:</td>
<td>Thu Apr 19 AKDT 2001</td>
</tr>
<tr>
<td>AST</td>
<td>Thu Apr 19 AKDT 2001</td>
</tr>
<tr>
<td>Pacific/Pitcairn:</td>
<td>Thu Apr 19 GMT-08:30 2001</td>
</tr>
<tr>
<td>America/Vancouver:</td>
<td>Thu Apr 19 GMT-07:00 2001</td>
</tr>
<tr>
<td>America/Tijuana:</td>
<td>Thu Apr 19 GMT-07:00 2001</td>
</tr>
<tr>
<td>America/Los_Angeles:</td>
<td>Thu Apr 19 PDT 2001</td>
</tr>
<tr>
<td>PST</td>
<td>Thu Apr 19 PDT 2001</td>
</tr>
<tr>
<td>America/Dawson_Creek:</td>
<td>Thu Apr 19 GMT-07:00 2001</td>
</tr>
<tr>
<td>America/Phoenix:</td>
<td>Thu Apr 19 MST 2001</td>
</tr>
</tbody>
</table>
JDK 1.3

java.version=1.3.0

Pacific/Niue: Thu Apr 19 GMT-11:00 2001
Pacific/Apia: Thu Apr 19 GMT-11:00 2001
MIT: Thu Apr 19 GMT-11:00 2001
Pacific/Pago_Pago: Thu Apr 19 GMT-11:00 2001
Pacific/Tahiti: Thu Apr 19 GMT-10:00 2001
Pacific/Fakaofo: Thu Apr 19 GMT-10:00 2001
Pacific/Honolulu: Thu Apr 19 HST 2001
HST: Thu Apr 19 HST 2001
America/Adak: Thu Apr 19 GMT-09:00 2001
Pacific/Rarotonga: Thu Apr 19 GMT-10:00 2001
Pacific/Marquesas: Thu Apr 19 GMT-09:30 2001
Pacific/Gambier: Thu Apr 19 GMT-09:00 2001
America/Anchorage: Thu Apr 19 AKDT 2001
AST: Thu Apr 19 AKDT 2001
Pacific/Pitcairn: Thu Apr 19 GMT-08:30 2001
America/Vancouver: Thu Apr 19 GMT-07:00 2001
America/Tijuana: Thu Apr 19 GMT-07:00 2001
America/Los_Angeles: Thu Apr 19 PDT 2001
PST: Thu Apr 19 PDT 2001
America/Dawson_Creek: Thu Apr 19 GMT-07:00 2001
America/Phoenix: Thu Apr 19 MST 2001
PNT: Thu Apr 19 MDT 2001
America/Edmonton: Thu Apr 19 GMT-06:00 2001
America/Mazatlan: Thu Apr 19 GMT-06:00 2001
America/Denver: Thu Apr 19 MDT 2001
MST: Thu Apr 19 MDT 2001
America/Belize: Thu Apr 19 GMT-06:00 2001
America/Regina: Thu Apr 19 GMT-06:00 2001
Pacific/Galapagos: Thu Apr 19 GMT-06:00 2001
America/Guatemala: Thu Apr 19 GMT-06:00 2001
America/Tegucigalpa: Thu Apr 19 GMT-06:00 2001
America/EL_Salvador: Thu Apr 19 GMT-06:00 2001
America/Costa_Rica: Thu Apr 19 GMT-06:00 2001
America/Winnipeg: Thu Apr 19 GMT-05:00 2001
Pacific/Easter: Thu Apr 19 GMT-06:00 2001
America/Mexico_City: Thu Apr 19 GMT-05:00 2001
America/Chicago: Thu Apr 19 CDT 2001
CST: Thu Apr 19 CDT 2001
America/Porto_Acre: Thu Apr 19 GMT-05:00 2001
America/Bogota: Thu Apr 19 GMT-05:00 2001
America/Guayaquil: Thu Apr 19 GMT-05:00 2001
America/Jamaica: Thu Apr 19 GMT-05:00 2001
America/Cayman: Thu Apr 19 GMT-05:00 2001
America/Managua: Thu Apr 19 GMT-05:00 2001
America/Panama: Thu Apr 19 GMT-05:00 2001
America/Lima: Thu Apr 19 GMT-05:00 2001
America/Indiana: Thu Apr 19 EST 2001
IET: Thu Apr 19 EST 2001
America/Nassau: Thu Apr 19 GMT-04:00 2001
America/Montreal: Thu Apr 19 GMT-04:00 2001
America/Havana: Thu Apr 19 GMT-04:00 2001
America/Port-au-Prince: Thu Apr 19 GMT-05:00 2001
America/Grand_Turk: Thu Apr 19 GMT-04:00 2001
America/New_York: Thu Apr 19 EDT 2001
EST: Thu Apr 19 EDT 2001
America/Antigua: Thu Apr 19 GMT-04:00 2001
America/Anguilla: Thu Apr 19 GMT-04:00 2001
America/Curacao: Thu Apr 19 GMT-04:00 2001
Appendix D. Setting the time values for Management Central functions
Appendix D. Setting the time values for Management Central functions

Asia/Nicosia: Thu Apr 19 GMT+03:00 2001
Europe/Tallinn: Thu Apr 19 GMT+03:00 2001
Africa/Cairo: Thu Apr 19 GMT+02:00 2001
ART: Thu Apr 19 GMT+02:00 2001
Europe/Helsinki: Thu Apr 19 GMT+03:00 2001
Europe/Athens: Thu Apr 19 GMT+03:00 2001
Asia/Jerusalem: Thu Apr 19 IDT 2001
Asia/Amman: Thu Apr 19 GMT+02:00 2001
Asia/Beirut: Thu Apr 19 GMT+03:00 2001
Europe/Vilnius: Thu Apr 19 GMT+02:00 2001
Europe/Riga: Thu Apr 19 GMT+03:00 2001
Europe/Chisinau: Thu Apr 19 GMT+03:00 2001
Europe/Bucharest: Thu Apr 19 EEST 2001
Europe/Kaliningrad: Thu Apr 19 GMT+03:00 2001
Asia/Damascus: Thu Apr 19 GMT+03:00 2001
Europe/Kiev: Thu Apr 19 GMT+03:00 2001
Europe/Istanbul: Thu Apr 19 GMT+03:00 2001
EET: Thu Apr 19 GMT+03:00 2001
Asia/Bahrain: Thu Apr 19 GMT+03:00 2001
Africa/Djibouti: Thu Apr 19 GMT+03:00 2001
Africa/Asmera: Thu Apr 19 GMT+03:00 2001
Africa/Addis_Ababa: Thu Apr 19 GMT+03:00 2001
EAT: Thu Apr 19 GMT+03:00 2001
Africa/Nairobi: Thu Apr 19 GMT+03:00 2001
Indian/Comoro: Thu Apr 19 GMT+03:00 2001
Asia/Kuwait: Thu Apr 19 GMT+03:00 2001
Indian/Antananarivo: Thu Apr 19 GMT+03:00 2001
Asia/Qatar: Thu Apr 19 GMT+03:00 2001
Africa/Mogadishu: Thu Apr 19 GMT+03:00 2001
Africa/Dar_es_Salaam: Thu Apr 19 GMT+03:00 2001
Africa/Kampala: Thu Apr 19 GMT+03:00 2001
Asia/Aden:Thu Apr 19 GMT+03:00 2001
Indian/Mayotte: Thu Apr 19 GMT+03:00 2001
Asia/Riyadh: Thu Apr 19 GMT+03:00 2001
Asia/Baghdad: Thu Apr 19 GMT+04:00 2001
Europe/Simferopol: Thu Apr 19 GMT+03:00 2001
Europe/Moscow: Thu Apr 19 GMT+04:00 2001
Asia/Tehran: Thu Apr 19 GMT+04:30 2001
MET: Thu Apr 19 GMT+04:30 2001
Asia/Dubai: Thu Apr 19 GMT+04:00 2001
Indian/Mauritius: Thu Apr 19 GMT+04:00 2001
Asia/Muscat: Thu Apr 19 GMT+04:00 2001
Indian/Reunion: Thu Apr 19 GMT+04:00 2001
Indian/Mahe: Thu Apr 19 GMT+04:00 2001
Asia/Yerevan: Thu Apr 19 GMT+05:00 2001
NET: Thu Apr 19 GMT+05:00 2001
Asia/Baku: Thu Apr 19 GMT+05:00 2001
Asia/Aqtau: Thu Apr 19 GMT+05:00 2001
Europe/Samara: Thu Apr 19 GMT+05:00 2001
Asia/Kabul: Thu Apr 19 GMT+04:30 2001
Indian/Kerguelen: Thu Apr 19 GMT+05:00 2001
Asia/Tbilisi: Thu Apr 19 GMT+05:00 2001
Indian/Chagos: Thu Apr 19 GMT+05:00 2001
Indian/Maldives: Thu Apr 19 GMT+05:00 2001
Asia/Dushanbe: Thu Apr 19 GMT+05:00 2001
Asia/Ashkhabad: Thu Apr 19 GMT+05:00 2001
Asia/Tashkent: Thu Apr 19 GMT+05:00 2001
Asia/Karachi: Thu Apr 19 GMT+05:00 2001
PLT: Thu Apr 19 GMT+05:00 2001
Asia/Bishkek: Thu Apr 19 GMT+06:00 2001
<table>
<thead>
<tr>
<th>Time Zone</th>
<th>Date/Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pacific/Guadalcanal:</td>
<td>Fri Apr 20 GMT+11:00 2001</td>
</tr>
<tr>
<td>SST:</td>
<td>Fri Apr 20 GMT+11:00 2001</td>
</tr>
<tr>
<td>Pacific/Noumea:</td>
<td>Fri Apr 20 GMT+11:00 2001</td>
</tr>
<tr>
<td>Asia/Magadan:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Norfolk:</td>
<td>Fri Apr 20 GMT+11:30 2001</td>
</tr>
<tr>
<td>Pacific/Kosrae:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Tarawa:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Majuro:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Nauru:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Funafuti:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Wake:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Wallis:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Fiji:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Antarctica/McMurdo:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Asia/Kamchatka:</td>
<td>Fri Apr 20 GMT+13:00 2001</td>
</tr>
<tr>
<td>Pacific/Auckland:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>NST:</td>
<td>Fri Apr 20 GMT+12:00 2001</td>
</tr>
<tr>
<td>Pacific/Chatham:</td>
<td>Fri Apr 20 GMT+12:45 2001</td>
</tr>
<tr>
<td>Pacific/Enderbury:</td>
<td>Fri Apr 20 GMT+13:00 2001</td>
</tr>
<tr>
<td>Pacific/Tongatapu:</td>
<td>Fri Apr 20 GMT+13:00 2001</td>
</tr>
<tr>
<td>Asia/Anadyr:</td>
<td>Fri Apr 20 GMT+14:00 2001</td>
</tr>
<tr>
<td>Pacific/Kirimiti:</td>
<td>Fri Apr 20 GMT+14:00 2001</td>
</tr>
</tbody>
</table>
Management Central problem determination traces

The appendix provides instructions for collecting trace information on the work performed by the two Management Central servers jobs - QYPSSRV and QYPSJSVR. This trace information is to be collected only when requested by your IBM service representative.

Initial problem determination efforts should be directed toward:

1. Reviewing standard Management Central “error windows” and Scheduled Tasks and Task Activity “status” information.
2. Reviewing the job logs for the QYPSSRV and QYPSJSRV jobs.

If additional problem determination efforts are required, follow the instructions in this chapter.
Collecting Management Central server job traces

If there is a suspected problem with Management Central, you may need to provide trace information as part of the problem documentation. Starting with V5R1 a new Java Management Central server QYPSJSVR runs on the iSeries systems. Management Central Java Server and Java Client GUI code was added to support the System Value, Job Monitor, and Message Monitor functions. As of V5R1 when the client connects to Management Central central system, it must successfully connect with the C++ server (QYPSSRV) as well as the new with the Java server (QYPSJSVR), depending on the function being performed.

Note: If you are experiencing connection problems always verify the IP address, host name, and DNS server are active and correctly configured as discussed in the Management Central chapter and Network chapter in Managing OS/400 with Operations Navigator V5R1, Volume 1: Overview and More, SG24-6226.

Assuming the problem remains unresolved, the connection problem may be with the C++ server or with the Java server. It is suggested trace be collected for both servers, unless you can isolate the problem to one of the three previously mentioned Java applications. Then only Java traces should be needed. Conversely only C++ traces should be needed for problems that can be isolated to other functions.

The steps below describes how to collect Management Central trace information on the iSeries and PC workstation for these two language environments (C++ and Java).

Setting up the traces

The following topics show you how to setup a trace on the iSeries server and the PC workstation.

Set up iSeries server traces and job logs

This is for the central system and problem endpoints.

1. End the servers if they are running with the ENDTCPsvR SERVER(*MGTC) command.
2. Make sure the QYPSSRV and QYPSJSVR jobs are no longer running. If the Operations Navigator session is active you can use My Connections -> system -> Network -> TCPIP and scroll down to find the Management Central server and select to Stop or view Server Jobs.

Alternatively, from a 5250 command interface, use WRKSBSJOB for subsystem QSYSWRK. Roll down to verify the QYPSSRV and QYPSJSVR jobs are not shown.
3. From a 5250 workstation session, run "ADDENVVAR ENVVAR(QYPS_TRACE) VALUE('0') LEVEL(*SYS)" or if the environment variable already exists, you will have to enter the following:
   "CHGENVVAR ENVVAR(QYPS_TRACE) VALUE('0') LEVEL(*SYS)"
4. Run "ADDENVVAR ENVVAR(QYPSJ_TRACE) VALUE('2') LEVEL(*SYS)" or if the environment variable already exists, you will have to enter the following:
   "CHGENVVAR ENVVAR(QYPSJ_TRACE) VALUE('2') LEVEL(*SYS)"
5. Run "STRTCPSVR SERVER(*MGTC)" or use Operations Navigator My Connections -> system -> Network -> Servers -> TCP/IP and scroll down to find the Management Central server and select Start.
This starts both servers. Note the job number of the server QYPSSRV and job number of the server QYPSJSVR.

**Note:**
1. You can do a WRKENVVAR LEVEL(*SYS) to list the environment variables.
2. Uppercase is needed for the name of the envvar, i.e. it must be QYPS_TRACE, not qyps_trace.
3. The LEVEL(*SYS) is important, if you add them as the default *JOB level, they will not be recognized.
4. The values are numbers, like the number zero, not the letter O.

---

### Set up PC workstation client GUI traces

1. End Operations Navigator, if it is running.
2. Go to the Client Access Folder. This is found on your desktop with Start Menu -> Programs -> IBM AS400 Client Access Express -> Service folder, and click Start Diagnostic Tools.

The rest of the setup is dependent on what Windows operating system you are using, such as:

#### Windows NT/2000/XP

1. Right-click My Computer, and go to Properties in the context menu.
2. Click the Environment tab, add a new user variable of QYPS_TRACE with value of "0" (this is s a zero, not the letter O).
4. On the File menu there should now be an option called Java Trace. Select this and go to Options.
5. Error, Information, and Warning will probably already be checked. Check Thread as well.
6. Start the trace from this menu item if it isn’t started already.
7. From the same menu, also clear the trace.
8. Recreate the error.

#### Windows 95/98

1. Open a DOS prompt.
2. Change directory (CD) to the OpNav directory (usually C:\Program Files\IBM\Client Access\).
3. Enter the command: “set QYPS_TRACE=0”.
4. Run Operations Navigator from the DOS prompt (the program to run is: cwbunnav).
5. On the File menu there should now be an option called Java Trace. Select this and go to Options.
6. Error, Information, and Warning will probably already be checked, check Thread as well.
7. Start the trace from this menu item if it isn’t started already.
8. From the same menu, also clear the trace.
9. Recreate the error.
Collect traces

Once you are done recreating the error, do the following:

1. Close Operations Navigator on your workstation.
2. On the iSeries server, end the Management Central servers - ENDTCPVR SERVER(*MGTC) command.

iSeries server traces

User Work with Links (WRKLNK) or from another Windows PC workstation use a Network drive, or Operations Navigator My Connections -> system -> File Systems -> Integrated File System to locate the trace file:

1. You will find a trace in /QSYS.LIB/USRSYS.LIB/QAUSYSLOG.FILE/QSRVxxxxx.MBR, where xxxxxx is the job number of the QYPSSRV job.
2. Get the spool file for the job log of the QYPSSRV job.
3. Get the file:
   /qibm/userdata/os400/mgtc/service/Mc.<jobnumber>.QYPSJSVR.QYPSJSVR.java.service.log
   (Where "jobnumber" is the job number of QYPSJSVR job).
4. Get the file:
   /qibm/userdata/os400/mgtc/service//Mc.<jobnumber>.QYPSJSVR.QYPSJSVR.Management Central.java.service.log
   (Where, "jobnumber" is the job number of QYPSJSVR job)
5. Get the spool file for the job log of the QYPSJSVR job.

PC client workstation traces

Find the following trace files in the PC workstation's file system.

1. C:\QAYPSLOG

Unfortunately, for every Windows operating system these files get put in different places. You will need to search for MgmtCtrl.Java.Service.log and OpNav.Java.Service.log.

Note, that for some operating systems you must put in the whole file name to find it. If you just search for service.log, you may not find it ("." is not processed). Verify the modified date of the file, to be sure it really contains the trace you just collected.

As a general rule, the following lists where these PC files will be found (this can be different when you are not logged onto the Windows operating system as user 'Administrator'):

- Win2000: C:\Documents and Settings\Administrator\My Documents\IBM\Client Access\Service
- Win98and Win95: C:\My Documents\IBM\Client Access\Service
- WinNT: C:\Winnt\Profiles\Administrator\Personal\IBM\Client Access\Service
Collecting trace summary

After this is all done, you should now have the eight following files:

- Server:
  - /QSYS.LIB/QUSRSPS.LIB/QAYPSLOG.FILE/QSRV<job number>.MBR
  - QYPSSRV job spool file
  - Mc.<jobnumber>.QYPSJSVR.QYPSJSVR.java.service.log
  - Mc.<jobnumber>.QYPSJSVR.QYPSJSVR.Management Central.java.service.log
  - QYPSJSVR job spool file

- Client:
  - QAYPSLOG
  - MgmtCtrl.Java.Service.log
  - OpNav.Java.Service.log

If you are unable to find any of these traces, please let your service representative know. If the traces are not being created, this is a different problem.

After you have collected the trace information you must turn tracing off for the PC workstation Operation Navigator GUI and iSeries server after you are done collection problem determination information.
V5R2 iSeries Navigator enhancements summary

The V5R2 iSeries Navigator (rebranding of earlier releases of Operations Navigator) contains a significant set of enhancements over V5R1 Operations Navigator. There is no redbook that includes the integration of V5R2 Navigator functions with V5R1 Navigator level of functions. However this appendix does give a summary overview of these V5R2 changes.

For information beyond this summary you are referred to:

V5R2 Information Center content:

  Select **Connecting to iSeries -> What to connect with -> iSeries Navigator**.

V5R2 information at the following Web site:

  Select iSeries Navigator.
  In the left Navigation bar, select New in V5R2. This includes links to several groupings of topics including iSeries for Wireless. There are links to additional “drill down topics”, such as Management Central, Database, Network and other enhancements.

General Connections and user interface updates

The following lists several changes in this area.

- Several context menu option actions are on secondary context menus, such as:
  
  **My Connection -> Connections to Servers -> Add a new connection**

- The menu bar **Options** menu item list on many windows is now accessed by menu bar View and secondary context menus. For example, the Work Management Active Jobs right pane control for specifying what jobs to include or columns of data to display are now accessed via **View -> Customize this view -> Sort/Include/Columns/Auto Refresh**.
When defining a new connection there is an additional “sign on option” - to use a Kerberos principal name. You need to have your iSeries configured in a Kerberos network (typically used to implement a single sign on to a network of multiple computers and operating systems).

You can review Information Center articles (search word “kerberos”). Kerberos capabilities originated from the Massachusetts Institute of Technology (MIT) in the US. Kerberos specifications are in the public domain. The Internet Engineering Task Force (IETF) formally defines the Kerberos protocol in Request for Comments 1510.

You can customize your own Task Pad area in the bottom pane area of a window.

Applications Administration

For all V5R2 systems and iSeries Navigator client workstations you can configure Application Administration settings for specific iSeries Navigator folders based upon a central iSeries V5R2 administration system to supply central settings. These central settings can be defined for all folder options or be integrated with local settings (corresponds to all V5R1 Application Administration setting) on each client workstation.

You can define a set of environments to be used by a client, and customize many of the connection, service, language, and password settings used by the clients.

This support is a new way of implementing Client Access Express policies, available in previous releases.

System values

There are several very useful new capabilities for OS/400 system values:

- When viewing or compare and updating system values there is a new category - Restore.
- This is a very useful new function that synchronizes the QDATE, QTIME and QUTCOFFSET system values across several V5R2 iSeries systems. This function is accessed by right-clicking an active system under MyConnections and selecting System Values -> Synchronize Date and Time.

Work Management

The powerful Work Management facilities provided with V5R1 have V5R2 enhancements in the areas of:

- Viewing “system status” information (corresponds to information and functions available with the OS/400 Work with System Status (WRKSYSSTS) command. This includes viewing system wide information such as total disk storage consumption, current number of active jobs and job thread and other “system status” information. Based upon the system component information you are viewing you can see associated system values and additional details information.
  - For example, for job related information you can access job-related system values and the currently active jobs.
- Viewing and managing spool output queues directly. The range of functions is similar to those available with the OS/400 Work with Spool Files (WRKSPFLF) command. This is in addition to previously available access to output queues through the Basic Operations -> Printers interface.
You can access this function by right-clicking the Work Management folder itself.

- For a job you can view threads information and the last SQL statement, if any. There are some moderate enhancements to job log and locked objects functions.

## Hardware management

Under **Configuration and Services -> Hardware** you can:

- View and vary on/off tape devices.
- Work with RAID protection parity sets information
- Configure the enhanced Independent Auxiliary Storage Pools (IASPs) - private disk pools. There are now Primary and Secondary IASPs.

## Network

The Network tree folders now show new sub folders with associated functions for:

- IPv4 (historically available) and IPv6 (newly available IP protocols. IPv6 has new functions and includes the larger IP addressing requirements. Since IPv6 is an emerging standard (RFCs in a state of change), your iSeries can support both IPv4 and IPv6 when properly configured.
- Enterprise Identity Mapping (EIM) functions: This involves setting up the iSeries to participate in a Kerberos network (single signon) and act as an EIM server/client that enables the Kerberos authentication information (a “ticket”) to automatically sign on to other systems supporting EIM. V5R2 OS/400 is the first IBM operating system to EIM, with EIM on additional IBM operating systems and non-IBM operating systems planned to occur during 2003.
- The TCP/IP Configuration folder has moved higher in the Network Windows operating system tree structure.
- The lines folder now shows all physical interfaces.
- Enhanced Virtual Private Network (VPN) and Quality of Service (QoS) functions.
- New Network Authentication service wizard.

## Windows Administration

The Windows Administration folder enhancements include:

- Additional status information on active Windows servers
- Wizards for installing/uninstalling fixes on the Windows operating system
- Wizards to assist for installing Windows Service Pack
- Management support for Windows servers defined as Microsoft Cluster Services (MCS) servers. Specific notes regarding Windows administration functions (start, stop, status information, disk management, and user administration) include:
  - While the iSeries Navigator hierarchy tree interface and functions supporting OS/400-based cluster functions may look very similar to the MCS console interfaces there is no integration between the two “clustering functions.”
  - The Navigator Windows administration functions (start stop, status, and so forth) have no “knowledge” that the MCS is running in the Integrated xSeries Server for iSeries.
MCS is treated the same as other supported Windows operating systems. Any unique MCS functions are performed through an attached MCS console device.

As long as the hardware and installed Windows operating system remains functional, the Navigator Windows administration functions support the older Integrated PC Server, Integrated Netfinity Server, and Integrated xSeries Servers that are “attached” either internally to the iSeries or externally via the HSL adapter and cables.

**Security**

There is support for additional Object Signing and signature verification capabilities.

**Database**

The Database folder has significant enhancements with some of the functions moved to different or new sub folders. New and enhanced functions include:

- Support of the, new with V5R2, set of industry-standard SQL functions.
- SQL Assistant: This is the long awaited Navigator prompting for SQL statement syntax support. This is a superset of the prompting support also available through the OS/400 Start SQL (STRSQL) command interface.
- Added support for multiple databases on the same iSeries. This is implemented using the V5R2 inclusion of OS/400 library-based (QSYS.LIB) objects within an Independent Auxiliary Storage Pool (IASP). The context menu option for Run SQL Scripts is now selected on a database name folder instead of the Database folder itself. On a single database system (only support until V5R2 IASPs) the database name defaults to the system name.
- The Libraries, Database Navigator, and SQL Performance Monitor folders are now also under the database name folder.
- New folders to access transaction level detail information for (jobs/threads) implementing commitment control cycles:
  - Database Transactions (single system commitment control)
  - Global Transactions (multiple system commitment control)
- Improved Database Navigator (shows database objects inter-relationships) graphical displays.

**Integrated File System**

The IFS support now includes:

- Access to IASPs containing new in V5R2 QSYS.LIB object support.
- For a specific IFS object, displaying any jobs using that object.

**Managements Central-related enhancements**

Management Central covers a wide range of functions. This topic summarizes the more significant enhancements and new functions:
Additional monitors:

- File monitor: You can monitor an action performed on a byte stream file, database file (table), and QHST history log.

- B2B Activity Monitors: Actually added to V5R1 through a Client Access Service Pack, this enables sophisticated monitoring of “Business to Business” transactions as defined by the Connect for iSeries products, for example (5733-B2B). You must have Connect for iSeries installed on the system to take advantage of this monitoring support.

Software Management

- The support for fixes inventory has been enhanced. You can select and deselect individual missing fixes and can choose to do a compare and update or only an update with the Compare and Update wizard. This enhancement allows you to update the target system directly from the model system without viewing the compare results.

- You can specify whether to collect fixes only when changes have occurred to the fixes data or to collect fixes even when no changes have occurred since the last collection.

Inventory collection now includes network attributes, service contact information and service attributes. This information can be routed to IBM as part of its inventory information for your system.

Partition interfaces now include managing Linux Partitions including transfer of processor between Linux and non-Linux partitions.

Plug-in support for Backup includes additional functions available in the Backup Recovery and Media Services (BRMS) software product - 5722-BR1. Access to key BRMS functions include:

- Global policy properties
- New Move Policy wizard
- Enhanced Restore wizard

Collection Services collects additional performance metrics data for Domino and HTTP servers. This data can be placed into the performance database files (QAPM prefix) that can be processed by user-written queries. The V5R2 Performance Tools for iSeries, 5722-PT1, software product includes printed report information based upon the collected HTTP performance data.

Performance Tools for iSeries, 5722-PT1, can now be installed as a plug-in. With this plug-in support you can graphically display approximately 15 performance metrics contained in the associated QAPMxxxx performance database files. Managing OS/400 with Operations Navigator V5R1, Volume 5: Performance Management, SG24-6565, contains an appendix that summarizes this graphics support.

Management Central - Pervasive is a set of Java-based servlets that provide a browser-based interface (includes Personal Digital Assistant (PDA) devices) to many of the System, Job, and Message monitoring functions available through the Navigator interface on a client workstation running a supported Windows operating system.

You must define and start these monitors and collect hardware inventory through the Navigator interface to enable the Pervasive monitoring support (includes responding to messages and taking job actions) and management of Windows operating systems on the Integrated xSeries Servers for iSeries.

With V5R2 Management Central - Pervasive support is part of the iSeries Access for Wireless, 5722-XP1, product. With V5R1 the support is provided through PTF SI06014.
Related publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

IBM Redbooks

For information on ordering these publications see “How to get IBM Redbooks” on page 515.

- Stored Procedures and Triggers on DB2 Universal Database for iSeries, SG24-6503
- Advanced Database Functions and Administration on DB2 Universal Database for iSeries, SG24-4249
  This book contains detailed examples of V5R1 Operations Navigator interfaces to iSeries database functions.
- TCP/IP Tutorial and Technical Overview, GG24-3376
- IBM @server iSeries Wired Network Security: OS/400 V5R1 DCM and Cryptographic Enhancements, SG24-6168
- Implementation and Practical Use of LDAP on IBM @server iSeries, SG24-6193
- V4R4 TCP/IP for AS/400: More Cool Things Than Ever, SG24-5190
- The AS/400 NetServer Advantage, SG24-5196
- AS/400 TCP/IP Auto configuration: DNS and DHCP Support, SG24-5147
- AS/400 Internet Security: Implementing AS/400 Virtual Private Networks, SG24-5404
- AS/400 Internet Security: Developing a Digital Certificate Infrastructure, SG24-5659
- Direct Attach xSeries for the IBM @server iSeries Server: A Guide to Implementing xSeries Servers in iSeries, SG24-6222
- LPAR Configuration and Management: Working with IBM @server iSeries Logical Partitions, SG24-6251
- Clustering and IASPs for Higher Availability on the IBM @server iSeries Server, SG24-5194
- IBM @server iSeries Printing VI: Delivering the Output of e-business, SG24-6250, Redpiece
- IBM AS/400 Printing V, SG24-2160
- AS/400 Client Access Express for Windows: Implementing V4R4M0, SG24-5191
- Performance Considerations for Domino Applications, SG24-5602
- AS/400 Internet Security: IBM Firewall for AS/400, SG24-2162
- Exploring NFS on AS/400, SG24-2158
- Lotus Domino for AS/400 R5: Implementation, SG24-5592
Other resources

These publications are also relevant as further information sources.

**iSeries Information Center CD-ROM**
For the titles and articles listed here, see the *iSeries 400 Information Center*, SK3T-4091 — CD-ROM, and *IBM eServer iSeries Information Center Supplemental Manuals*, SK3T-4092 — CD-ROM, or the Information Center Web site at:


- **OS/400 Work Management V4R4**, SC41-5306
- “Performance Overview”. From the main Information Center window left Navigation bar select Systems management -> Performance -> Print this topic.
- **OS/400 TCP/IP Configuration and Reference**, SC41-5420
- **Client Access Express for Windows - Setup**, SC41-5507
- “Windows Servers on iSeries”. From the main Information Center window left Navigation bar select Networking -> Windows servers on iSeries -> Print this topic
- For documentation on various TCP/IP-based communications functions and set up, use the Information Center topics. From the main Information Center window—left Navigation bar—select Networking and select the topic in which you are interested.

**Other titles**
- *IBM eServer iSeries 400 Setup and Operations*, SK3T-4098
- *iSeries Operations Console Update*, SK3T-4114
- *iSeries Security Reference*, SC41-5302
- *AS/400 Client Access Host Servers V4R4*, SC41-5740
- *Integrated File System Introduction*, SC41-5711
- *Backup and Recovery*, SC41-5304
- *CL Programming*, SC41-5721
- *AFP Workbench for Windows NT and 95 Technical Reference*, S544-5602
- *IBM CM OnDemand for iSeries 5.2 Common Server Planning and Installation*, SC27-1158
- *IBM CM OnDemand for iSeries 5.2 Common Server Administration Guide*, SC27-1161

**Referenced Web sites**

These Web sites are important as further information sources:

- iSeries Information Center
- IBM Support:
  http://techsupport.services.ibm.com/eserver/support
- iSeries and AS/400 Technical Support:
  http://as400service.ibm.com/
- iSeries Services Network:
Related publications

- PartnerWorld:
  http://www.as400.ibm.com/developer/

- Technical studio:
  http://www.as400.ibm.com/tstudio

- IBM @server iSeries University
  http://www-1.ibm.com/servers/eserver/iseries/education/

- iSeries home page and corresponding Web sites:
  http://www-1.ibm.com/servers/eserver/iseries/
  http://www-1.ibm.com/servers/eserver/iseries/clientaccess/
  http://www-1.ibm.com/servers/eserver/iseries/access/supportedos.htm
  http://www-1.ibm.com/servers/eserver/iseries/tcpip/
  http://www-1.ibm.com/servers/eserver/iseries/lpar/
  http://www-1.ibm.com/servers/eserver/iseries/ha/
  http://www-912.ibm.com/

How to get IBM Redbooks

Search for additional Redbooks or Redpieces, view, download, or order hardcopy from the Redbooks Web Site

ibm.com/redbooks

Also download additional materials (code samples or diskette/CD-ROM images) from this Redbooks site.

Redpieces are Redbooks in progress; not all Redbooks become redpieces and sometimes just a few chapters will be published this way. The intent is to get the information out much quicker than the formal publishing process allows.

IBM Redbooks collections

Redbooks are also available on CD-ROMs. Click the CD-ROMs button on the Redbooks Web Site for information about all the CD-ROMs offered, updates and formats.
Index

Symbols
(?) field level help 113
(?) Help for related tasks 85
*ADD 131
*DLT 131
*JOBCTL 131
*MGTCOL 271
*READ 131
*SPLCTL 131

Numerics
5722JS1 400
5722PT1 271

A
about Operations Navigator 114
access settings 437, 442
Active -> Ineligible 172
Active -> Wait 172
Active Jobs 15, 83, 100, 141, 143
active pools 169
activity level 168
add a new route 303
Add Reply List Entry command 121
address resolution protocol 306
ADMIN 471
administering applications 438, 441
Administrable Host Applications function 450
Advanced Job Scheduler 42, 51, 62, 385, 400
monitoring 409
properties 414
time usage 401
AFP Manager 9
AFP Manager component 43
AFP Viewer 220
AFP Workbench Viewer 43, 127
all object access 442
alt key 104
Application Administration 9, 19, 40, 44, 105, 106, 508
Client Access 44
Operations Navigator 44
application administration 435
application administration at the user or group level 446
application administration for Client Access Express 449
application administration for Operations Navigator 449
Application Administration Host applications 44
application development 8
Application Development component 33
application registration 438
applications to administer detected on PC workstation 439
applying service packs 71
ARP cache 306
AS/400 NetServer integration 131
associated routes 307
auditing policy 25
AUTCHK 131
authorization list 24
auxiliary storage pool 18

B
B2B Activity Monitor 511
B2B activity monitor 39, 186, 241
backup 7, 32
Backup and Recovery and Media Services (BRMS) 8, 33
Backup and Recovery Media Services (BRMS) 51, 62
backup policies 32
base pool 169
Basic Operations 4
BRMS 385, 392
IFS Integration 397
Management Central 398

cancel request 88
central server 191
central system 187
central system DNS settings 191
CFGTCPAPP 301
change IPL attributes 91
Change Message Queue 243
CHGFTPA 330
Client Access Express verifying level installed 70
Client Access server 22
jobs 469
cluster 208
cluster nodes 46, 48
cluster support 47
clustering 10, 182
collection object 271
Collection Services 5, 19, 46, 185, 255, 271, 511
detailed data 274
graph data 269, 274
performance data 275
setup 273
starting 272
summary data 269, 274
column selection 101
column width 101, 103
columns 102
command 8, 275, 276, 280
new based on 282
sharing 279
command definition 278, 283
<table>
<thead>
<tr>
<th>Command Prompt</th>
<th>34, 54</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command Prompter</td>
<td>108</td>
</tr>
<tr>
<td>Compare and Update</td>
<td>50</td>
</tr>
<tr>
<td>Complex Functions</td>
<td>10</td>
</tr>
<tr>
<td>Components</td>
<td>59</td>
</tr>
<tr>
<td>Deselection</td>
<td>67</td>
</tr>
<tr>
<td>Configuration and Service</td>
<td>5, 16, 212</td>
</tr>
<tr>
<td>Connections</td>
<td>74, 308</td>
</tr>
<tr>
<td>Context Menu</td>
<td>14, 88</td>
</tr>
<tr>
<td>Context Sensitive Menu</td>
<td>53, 86</td>
</tr>
<tr>
<td>Context Sensitive Tool Bar</td>
<td>86</td>
</tr>
<tr>
<td>Coordinated Universal Time Offset</td>
<td>481</td>
</tr>
<tr>
<td>Copy and Paste</td>
<td>92, 93, 343</td>
</tr>
<tr>
<td>Copy and Paste - QSYS.LIB Objects</td>
<td>342</td>
</tr>
<tr>
<td>Copying Files</td>
<td>351</td>
</tr>
<tr>
<td>Create Logical File</td>
<td>31</td>
</tr>
<tr>
<td>Create Physical File</td>
<td>31</td>
</tr>
<tr>
<td>Creating a Library</td>
<td>357</td>
</tr>
<tr>
<td>Creating a New Directory</td>
<td>351</td>
</tr>
<tr>
<td>CRTPFRDTA</td>
<td>275</td>
</tr>
<tr>
<td>Cryptographic Access Provider</td>
<td>54</td>
</tr>
<tr>
<td>Cryptographic Coprocessor</td>
<td>23, 291</td>
</tr>
<tr>
<td>Customize Access</td>
<td>442</td>
</tr>
<tr>
<td>Database</td>
<td>7, 343</td>
</tr>
<tr>
<td>Database Components</td>
<td>10</td>
</tr>
<tr>
<td>Database Folder</td>
<td>510</td>
</tr>
<tr>
<td>Database Navigator</td>
<td>29, 30</td>
</tr>
<tr>
<td>Database Transactions</td>
<td>510</td>
</tr>
<tr>
<td>Dedicated Service Tools</td>
<td>39, 49</td>
</tr>
<tr>
<td>Default Access</td>
<td>442</td>
</tr>
<tr>
<td>Default JDK Level</td>
<td>487</td>
</tr>
<tr>
<td>Definition</td>
<td>275, 279</td>
</tr>
<tr>
<td>Definitions Folder</td>
<td>33</td>
</tr>
<tr>
<td>Delete Entries</td>
<td>268</td>
</tr>
<tr>
<td>Delete Monitor Entries</td>
<td>242</td>
</tr>
<tr>
<td>Deleting a Task</td>
<td>220</td>
</tr>
<tr>
<td>Desktop</td>
<td>53</td>
</tr>
<tr>
<td>Desktop Icons</td>
<td>97</td>
</tr>
<tr>
<td>Creating</td>
<td>97</td>
</tr>
<tr>
<td>Details Pane</td>
<td>82</td>
</tr>
<tr>
<td>Digital Certificate Manager</td>
<td>23, 291, 292</td>
</tr>
<tr>
<td>Digital Certificates</td>
<td>292</td>
</tr>
<tr>
<td>Directory Server</td>
<td>22</td>
</tr>
<tr>
<td>Directory Services</td>
<td>22, 141</td>
</tr>
<tr>
<td>Disabled User IDs</td>
<td>328</td>
</tr>
<tr>
<td>Discover Systems</td>
<td>205</td>
</tr>
<tr>
<td>Discovery Logic (Endpoint Systems)</td>
<td>205</td>
</tr>
<tr>
<td>Disk Configuration</td>
<td>18</td>
</tr>
<tr>
<td>Disk Pool</td>
<td>18</td>
</tr>
<tr>
<td>Disk Units</td>
<td>19</td>
</tr>
<tr>
<td>DNS</td>
<td>22, 58, 191, 192</td>
</tr>
<tr>
<td>DNS Server</td>
<td>188</td>
</tr>
<tr>
<td>Domain</td>
<td>192</td>
</tr>
<tr>
<td>Domino</td>
<td>51, 385</td>
</tr>
<tr>
<td>EZ-Setup Wizard</td>
<td>424</td>
</tr>
<tr>
<td>Managing a Domino Server</td>
<td>429</td>
</tr>
<tr>
<td>Domino for iSeries</td>
<td>62</td>
</tr>
<tr>
<td>Domino Plug-in</td>
<td>424</td>
</tr>
<tr>
<td>Drag and Drop</td>
<td>92, 343</td>
</tr>
<tr>
<td>Drag and Drop IFS Files</td>
<td>342</td>
</tr>
<tr>
<td>Drag and Drop Spooled File</td>
<td>135</td>
</tr>
<tr>
<td>DST</td>
<td>39, 40</td>
</tr>
<tr>
<td>E</td>
<td>481</td>
</tr>
<tr>
<td>Edit an Integrated File System File</td>
<td>342</td>
</tr>
<tr>
<td>Editing Files</td>
<td>340</td>
</tr>
<tr>
<td>EIM</td>
<td>509</td>
</tr>
<tr>
<td>Elapsed Performance Statistics</td>
<td>154</td>
</tr>
<tr>
<td>End TCP Server</td>
<td>301</td>
</tr>
<tr>
<td>Endpoint Systems</td>
<td>46, 183, 187, 207</td>
</tr>
<tr>
<td>Adding</td>
<td>208</td>
</tr>
<tr>
<td>Discover Systems</td>
<td>205</td>
</tr>
<tr>
<td>ENDTCPVR</td>
<td>301</td>
</tr>
<tr>
<td>Enterprise Identity Mapping</td>
<td>509</td>
</tr>
<tr>
<td>Environments</td>
<td>74</td>
</tr>
<tr>
<td>Adding Systems</td>
<td>77</td>
</tr>
<tr>
<td>Deleting Systems</td>
<td>81</td>
</tr>
<tr>
<td>Exporting</td>
<td>75</td>
</tr>
<tr>
<td>Importing</td>
<td>74</td>
</tr>
<tr>
<td>Importing and Exporting</td>
<td>76</td>
</tr>
<tr>
<td>Setting Up</td>
<td>74</td>
</tr>
<tr>
<td>Sign on Options</td>
<td>79</td>
</tr>
<tr>
<td>Event Log</td>
<td>249</td>
</tr>
<tr>
<td>Job Monitor</td>
<td>246</td>
</tr>
<tr>
<td>Message Monitor</td>
<td>174</td>
</tr>
<tr>
<td>Expert Cache</td>
<td>14, 92</td>
</tr>
<tr>
<td>Explore</td>
<td>19, 27, 49, 222</td>
</tr>
<tr>
<td>File Formats</td>
<td>222</td>
</tr>
<tr>
<td>Extreme Support</td>
<td>5, 20, 182</td>
</tr>
<tr>
<td>Field Level Help</td>
<td>113</td>
</tr>
<tr>
<td>File</td>
<td>32</td>
</tr>
<tr>
<td>Sending</td>
<td>340</td>
</tr>
<tr>
<td>File Monitor</td>
<td>511</td>
</tr>
<tr>
<td>File Shares</td>
<td>336, 349, 354</td>
</tr>
<tr>
<td>Removing</td>
<td>355</td>
</tr>
<tr>
<td>File System Hints and Tips</td>
<td>350</td>
</tr>
<tr>
<td>File Systems</td>
<td>7</td>
</tr>
<tr>
<td>Assigning Permissions</td>
<td>360</td>
</tr>
<tr>
<td>Windows-Based</td>
<td>31</td>
</tr>
<tr>
<td>Find</td>
<td>99</td>
</tr>
<tr>
<td>Finding the Active Window</td>
<td>104</td>
</tr>
<tr>
<td>Finding the Current Operations Navigator Window</td>
<td>104</td>
</tr>
<tr>
<td>Fixes</td>
<td>5, 49, 275</td>
</tr>
<tr>
<td>Cleanup</td>
<td>19</td>
</tr>
<tr>
<td>Copy</td>
<td>19</td>
</tr>
<tr>
<td>Install</td>
<td>19</td>
</tr>
<tr>
<td>Send</td>
<td>19</td>
</tr>
<tr>
<td>Sending</td>
<td>231</td>
</tr>
<tr>
<td>Fixes Inventory</td>
<td>19</td>
</tr>
<tr>
<td>Cover Letter</td>
<td>227</td>
</tr>
<tr>
<td>Group Fix (PTF)</td>
<td>227</td>
</tr>
</tbody>
</table>
send planning tip 227
fixes management 511
fixes tip 227
folder 13, 83
font mapping tables 43
FTP 205, 294
FTP server 330
function availability 60, 105
function availability to determine missing components 60, 105
functions by release 474

G
general navigation 53
terminology 83
general navigation window 83
Global Transactions 510
Graph History 20, 38, 46, 186, 255
grayed out 86
Greenwich Mean Time (GMT) 201
group profiles 24, 26
GUI prompter 108

H
hardware 5, 17, 49
hardware inventory 225
Help 54
  function specific 115
  index 50
  index tab 115
  Information Center 114
  menu bar 114
  what can I do with 115
Help button 113
Help for related tasks 50
Help information 143
Help topics 51, 115
hierarchy tree 82
host application administration 450
host AS/400 438
host domain 296
Host lookup 292
host lookup 23
host server 81
host server jobs 81
host servers 54
  starting 81
host table 189, 192, 298
HTTP Server for iSeries 54

I
IASPs 509
IBM (AS/400) Toolbox for Java 54
IBM Developer Kit for Java 54
importing and exporting environments 76
  include 100
  include settings 100
independent (private) disk pool 47
Independent Auxiliary Storage Pool (IASP) 47
Independent Auxiliary Storage Pools 509
independent disk pool 47
INETD 470
Information Center 4, 50, 117, 507
  accessing 117
installation 54, 55, 57
  custom 58, 67
  example 63
  full 58
  migration wizard 61
  PCS250 58
  selective setup 60, 67
  silent 60
tailored 67
tailored imager 60
installation options 60
installation requirements 54
installation sources 57
installed plug-ins 386
installing Client Access Express 57
Integrated File System 336, 337, 510
interactive pools 169
interfaces 302
Internet 291
  23
Internet Printer Protocol 291
inventory 27, 45, 49, 184, 215, 220
  accessing the information 223
  compare and update system values 234
  fixes 222, 226
  hardware 225
  hardware features installed 221
  search 235
  searching software 236, 239
  software 225
  software products installed and supported 221
  system values 222, 234
  users and groups 222, 232
  users and groups search 239
inventory collection 511
inventory collection tip 223
IP address 188
IP policies 21, 291
IPC objects 33
IPP 23, 291
IPv4 509
iSeries 400 Information Center 113
iSeries Client Access Express 54
iSeries Navigator xi, 1

J
Java 344
Java (JDK) default properties file 201
Java Development Kit 480
Java Virtual Machine 483, 486
JDBC 22, 146
JDK 480, 486
JDK 1.1.8 488
JDK 1.2 488
menu bar 13, 83
menu bar file inventory 84
menu bars 53
message handling 15
message monitor 37, 39, 121, 241, 242
event log 247
messages to monitor 244
new 243
message monitor (new) 243
message monitor actions 246
message monitor example 247
message monitor threshold 244
message monitor parameters 245
message queues 185
message reply 144
messages 15
delete 123
refresh 122
security 123
send 123
messages in Basic Operations 121
metrics 19
migration wizard 60, 61
model system 188
monitor colors 199
monitoring jobs 253
monitoring servers 253
monitors 8, 15, 133, 148, 240
business to business transaction logs of Connect for iSeries 186
changes 262
event logs 242
sharing 242
sharing property 244
monitors component 37
My Connections 74
setting up connections 74
setting up your environments 74
signon default actions 78
signon options 79
system name 84
inventory 84

N
NAT 307
navigation 53, 82
NetServer 22, 131
NetServer configuration tips 330
NetServer share 57
NETSTAT 23
network 6, 21
network address translation 307
Network Authentication 509
network component 10, 21
Network functions 509
network stations 23, 292
new endpoint system 207
new folder 338
NFS Export 338

O
object sharing 199, 279
ODBC 22, 146
OnDemand 51, 62, 385
Common Server Administration 420
Media Administration 419
Monitor Definitions 422
Report Migration Policies 418
Spool File Archive Administration 416
Tape Device usage 420
OnDemand plug-in 415
online Help 50, 362
open 14, 92
open actions 92
open options 92
Operation Navigator components 59
Operations Navigator 1
finding the active window 104
Operations Navigator installation components 58
installation example 63
installation sources 57
installation types 58
iSeries server requirements 54
migration wizard 61
PC client workstation requirements 55
plug-ins 62
selective setup 60
silent installation 61
tailored installation image 61
typical installation 58
Operations Navigator navigation
main window 82
OPRCTL 131
options
include 121, 145
sort 102
OS/400 HA switchable resources 49
output queues 508
overview 12

P
package
sending 286
snapshot 35
package permissions 283
package support 275
packaged defining 282
packages 35, 46, 184, 276, 358
packages and products 8
packet rules 307
password 196
password policy 25
performance
database files 20, 511
graphically display metrics 511
Managing OS/400 with Operations Navigator V5R1 Volume 1: Overview and More

performance (SQL) 29
performance database files 20, 271
performance monitor 20
performance overview
   Information Center document 271
performance system values 142
Performance Tools for iSeries 511
Performance Tools for iSeries, 5722PT1 20, 271
permissions 24, 29, 32, 195, 360, 362
ping 23, 188, 292
Plug-ins
   third-party applications 432
plug-ins 50
   auto detection 200
PM/400 46, 271
point-to-point 22
policies 25
port restrictions 299
Print 99
print 99
print disk information 243
print preview 99
printer device description
   create 137
printer output 15, 125, 132, 147
   copy 124
   drag and drop 93
   hold 124
   release 124
   reply 124
   security 126
   send 124
printer properties 130
printers 15
   hold 129
   include 134
   publishing 128
   release 129
   security 131
   sharing 128
   start 129
   stop 129
   tips 131
printers function 127
private disk pools 509
privilege class 24
problem determination 501
products 19, 35, 49, 276
program temporary fix 58
properties 90
   job 148
   properties windows 90
PRTDSKINF 243
PSF
   Print Services Facilities 43
PSF configurations 43
PTF 58
publishing 128
pull-down menus 88, 89
Pv6 509

Q
QBATCH 144
QCTL 144
QDIRSRV 472
QDLS 337
QFPRADJ 168
QGLDPUBA 472
QINTER 144
Qinter 146
QLOCALE 201
QLOCALE example 484
QFPRADJ 142, 175
QPWFSERVSD 472
QPWFSERVS0 472
QPWFSERVSS 472
QSERVER 144, 472
QSYS.LIB 49, 337, 342
QSYSOPR 121
QSYSWRK 144, 470
QTIME 201, 480
QTVDEVICE 471
QTVTELNET 471
Quality of Service 21, 299
QUSRWRK subsystem 317
QUTCOFFSET 201, 480, 481
QWTCHGJB 254
QYPSGETINV 223
QYPJSVR 502
QYPJSVR job 190, 471
QYPSPFRCOL 471
QYPSPRC 287, 471
QYPSSRV 204, 502
QYPSSRV job 471
QYPSSRV server job 190
QYRMJOBSEL 471
QYRMJOBSEL job 471
QZDASOINIT 472
QZDASRVSD 472
QZDASSINIT 472
QZLSFILE 470
QZLSSERVER 470
QZSCSRVS 472
QZSCSRVSD 472
QZSOSGND 472
QZSOSIGN 472
QZSOSMAPD 472

R
RADIUS 22
RAID 509
Redbooks Web Site 515
Redbooks Web site
   Contact us xv
registering applications 438
Remote Access Services 22, 291
reset statistics 142, 155
restart 91
restore 35
retrieve disk information 243
retrieving information 96
routes 308
run command 110, 275
run command options 112
Run SQL Scripts 510
running commands 46

S
Sample DASD Message 243
SAV 282
SAVDLO 282
save 35
SAVOBJ 282
scheduled tasks 47
scheduling tasks 216
schema 29
SCPF 144
searching software inventory 236
Secure Sockets Layer 54, 69, 91, 196, 292
security 6, 23, 26, 510
Management Central 195
printers 131
TCP/IP 24
wizard 26
security administration 44
security administrator 24
security component 24
security policy 25
security properties 195
selective setup 14, 60
send 339
send and install a product 237
send user profile 233
server 81
server jobs 15, 83, 120, 141, 149, 155, 470
IP address 179
managing 157
network 157
properties 179
reference table 469
server properties 150, 156
servers 22, 185, 291
servers to start 300, 301
service packs 57
applying to an installation image 71
downloading 72
installing as an iSeries fix 72
levels
comparing iSeries and workstation 71
SI01907 69
SI02795 69
service tools 40
service tools authorization 19
service tools server 452
setting correct time value 200
shared pools 142, 169, 175
managing 176
shared storage pools 169
sharing 199, 208, 338
tasks 107
sharing tab 258
shortcuts 53, 75, 97
creating 98
shortcuts to work management 178
shorthand representations 83, 84
SI01907 69
SI02795 39
signon 79
signon policy 25
signon procedures 195
signon rules 79
silent installation 61
simple clustering 47
snapshot 35
SNMP 205
SOCKS 302
software 5, 19, 49
software licensing information 237
software inventory 225
software product properties 237
sorting 101
source system 188
spool pool 169
spool writers 15
spooled files 124, 137
drag and drop 135
move, copy, send 124
spooled output 15
drag and drop 135
spreadsheet 93
SQL 29, 31
generate statements 29
Visual Explain 29
SSL 69, 196, 293, 294, 331
applications supported 292
SST 39
Start Based On action 214
start service tools 451
start subsystem 142
start TCP server 301
starting TCP/IP 202
starting the Management Central server 202
stopping a task 220
STRPFRMON 20, 275
STRTCPSVR 301, 470
subsystem 16, 173
active 166
end 165
jobs 165
selecting jobs viewed 167
shortcut 167
start 165
supplemental manuals 117
switched disk 47
system group 46, 183, 188, 207
new 207
system jobs 144
system monitor 37, 38, 240, 241, 254, 268
event log 267
maximum graphing value 261
hold job 147
job details 151
job properties 148
job queues 142
job security 148
library list 151
locked objects 152
memory pools 142, 168
open files 153
options
columns 177
include 177
sort 177
release job 148
reset statistics 147
security 143
server jobs 141, 156
subsystems 142, 164
work management tips 177
Work with All Printers 127
Work with Job Queues 158
Work with Job Scheduler Entries 42
Work with System Values 175
WRKACTJOB 140, 144
WRKJOBO 140
WRKJOBSCE 214
WRKLNK 337
WRKSBS 140
WRKSBSJOB 140
WRKWTR 127
Managing OS/400 with Operations Navigator V5R1
Volume I: Overview and More
Managing OS/400 with Operations Navigator V5R1
Volume I: Overview and More

OS/400 Operations Navigator is the graphical interface to manage your IBM iSeries runtime environment. V5R1 Operations Navigator contains major function and interface enhancements over previous releases. This IBM Redbook presents an overview of all V5R1 Operations Navigator functions. It is the first volume in the “Managing OS/400 with Operations Navigator V5R1” series.

The key enhancements include a new Work Management component; new job, message, and B2B activity monitors; and new graph history for viewing performance data. It also includes new and updated interfaces to networking capabilities like Quality of Service, Virtual Private Network, TCP/IP configuration and connection verification utilities. And it includes new and improved multiple system management of system values and user and group profiles. V5R1 Operations Navigator has also improved Windows operating systems administration and the online help.

This volume focuses on installation and function navigation, and provides an overview of all V5R1 Operations Navigator functions. It also provides details on specific Operations Navigator components, most of which are essential to understanding the functions described in the other volumes of this redbook volume set.